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9 Ability to communicate 10

10 Maintenance of dairy 10

Total 100
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UNIT - I 

1 Introduction to Computer systems and Hardware  

1.1 Introduction to computers, generations of computer 

1.1.1. What is a computer 

1.1.2. Characters of a computer 

1.1.3. Generation  of  computers 

1.2 Classification of Computer 

1.3  Anatomy a computer 

1.4  Number Systems 

1.4.1 Converting data 

1.5  Basic I/O Operations 

1.5.1 Input Device 

1.5.2 Output Device 

1.6 Basic diagram of CPU 

1.7  Memory Unit-Primary and Auxiliary memory 

1.7.1 memory sizes 

1.7.2 memory classification 

1.8  Programming Languages, general software features trends and utilities. 

1.8.1 What is language? 

1.8.2 Programming languages 

1.8.3 Software 

1.8.4 Utilities 

 

1. Introduction to Computer systems and Hardware  

1.1 Introduction to computers, generations of computer 

Wooden abacus laid basis for the computers long time back. Which was a simple calculating tool 

introduced in China, is known to be the foundation of today’s computers. But in essence this tool 

cannot be compared with the super computers of today. After abacus, came slide rule in year 

1622 A.D introduced by William Oughtred. Growth of computers had to go through various 

phases, starting with difference engine by Charles Babbage in year 1822. 

1.1.1 What is Computer? 

Getting the right kind of information is a major challenge as is getting information to make 

sense. In that Computer technology is radically changing the domains in Science and 

Engineering. The applications of computers are endless because of its memory, high speed and 

perfection. Millions of calculations can be made in just a fraction of time. It has been used in all 

walks of human life like science, logistic and ordering functions, military, industry, education 

etc. Today, they are used right from scientific research to paying household monthly bills. We as 
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users cannot even imagine of living without computers. It is the greatest invention of men and 

has paved ways for many other inventions. 

 

Computer: 

A computer can be described as an electronic calculating device that accepts raw data as input, 
processes it and produces meaningful information as an output. A computer system is made up of 
both hardware and software components. Hardware consists of the physical components of a 
computer system like input devices, output devices, processing device (CPU) and the storage 
device. Software represents the set of programs and instructions that govern the operation of a 
computer system. 
 
 
 
 
 
 
 
 

Fig 1.1 basic components of computer system 
 

1.1.2 Characteristics of a computer 

1. Speed: - As you know computer can work very fast and no human being can compete to 
solving the complex computation, faster than computer. It takes only few seconds for 
calculations that we take hours to complete. You will be surprised to know that computer can 
perform millions (1,000,000) of instructions and even more per second. Therefore, we determine 
the speed of computer in terms of Mega Hertz (MHz) or Gega Hertz (GHz). From this you can 
imagine how fast your computer performs work. For example powering of  63 and 91 i.e (63^91) 
can take a couple of minutes if a human performs such calculations, but computer can perform 
millions of such calculations in a fraction of second. 

2. Accuracy: - Computer is programmed, so the accuracy of computer is very high and every 
calculation is performed with the same accuracy. Whatever input we give it gives result with 
accurately.  The errors in computer are due to human and inaccurate data. 

3. The efficiency of computers does not decrease with age. The computers can perform repeated 

ask with the same efficiency any number of times without exhausting there selves. Even if they 

are instructed to execute millions of instructions, they are capable of executing them all with the 

same speed and efficiency without exhaustion. 

3. Diligence: - A computer is free from tiredness, lack of concentration, fatigue, etc. Computer 

can work for hours without any break and creating error. If millions of calculations are to be 

input Computer 

storage 

output 
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performed, a computer will perform every calculation with the same accuracy. Due to this 

capability it overpowers human being in routine type of work.  

4. Versatility: - We can use computer to perform completely different type of work at the same 
time. It means that the computers having capacity to perform completely different type of work 
in different fileds.  

5. Power of Remembering: - Computer has the power of storing any amount of information or 

data. Any information can be stored and recalled as long as you require it, for any numbers of 

years. It depends entirely upon you how much data you want to store in a computer and when to 

lose or retrieve these data.  

6. No IQ: - Computer is a dumb machine and it cannot do any work without instruction from the 

user. It performs the instructions at tremendous speed and with accuracy. It is you to decide what 

you want to do and in what sequence. So a computer cannot take its own decision as you can.  

7. No Feeling: - It does not have feelings or emotion, taste, knowledge, emotions, knowledge, 

feeling and experience. Thus it does not get tired even after long hours of work. It does not 

distinguish between users. 

8. Storage: - Storage capacity is another big characteristic of a computer. A computer can store 

large amount of data. This data can be used at any time and also from any location. The storage 

capacity of a computer is measured in Mega Byte, Gega Byte, Tera Byte. You can also store data 

in secondary storage devices such as floppies, which can be kept outside your computer and can 

be carried to other computers. 

9. No Intelligence 

Computers don’t have any intelligence of their own. They follow a set of instructions fed into 

them by manufacturer. The user knows what to do and when to perform a specific task. 

10. They can communicate 

Computers have the ability to communicate, but of course there needs some sort of connection 
(either Wired or Wireless connection). Two computers can be connected to send & receive data. 
Special software’s are used for text and video chat. Friends & family can connect over the 
internet and share files, photos & videos online. 

11. We can do multitasking 

Multitasking is also a computer characteristic. Computers can perform several tasks at a time. 
For example you can listen to songs, download movies, and prepare word documents all at the 
same time. 
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1.1.3 Generations of computer system: 

The principal electronic computer was designed and manufactured at the University of 
Pennsylvania based on vacuum tube technology. Vacuum tubes were used to do logic operations 
and to store data. Generations of computers has been divided into five generations.   

I Generation: 1945 – 55  

II Generation: 1955 – 65  

III Generation: 1965 – 75  

IV Generation: 1975 – 89  

V Generation: 1989 to present   

First Generation 

In first generation ENIAC (Electronic Numerical Integrator And Calculator), EDSAC 
(Electronic Delay Storage Automatic Calculator), EDVAC (Electronic Discrete Variable 
Automatic Computer) and UNIVAC (Universal Automatic Computer IBM 701) Vacuum tubes 
were used to perform basic arithmetic operations and it took few milliseconds  

Characteristics of first generation computers: 

1. Bulky   
2. Consume more power with limited performance  
3. High cost  
4. Uses assembly language – to prepare programs. These were translated into machine level 

language for execution.  
5. Fixed point arithmetic was used  
6. Punched cards and paper tape were invented to feed programs and data and to get results. 
7. Magnetic tape / magnetic drum were used as secondary memory  
8. Mainly used for scientific computations.   

Second Generation 

In second generation starts the Manufacturers of IBM 7030, Digital Data Corporation’s PDP 
1/5/8 Honeywell 400 and Transistors were used in place of vacuum tubes. 

Characteristics of second generation computers: 
1. Small in size  
2. Lesser power consumption and better performance 
3. Lower cost  
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4. Magnetic ferrite core memories were used as main memory which is a random-access 
non-volatile memory  

5. Magnetic tapes and magnetic disks were used as secondary memory. 
6. Hardware for floating point arithmetic operations was developed.  
7. High level languages such as FORTRAN, COBOL etc. were used - Compilers were 

developed to translate the high-level program into corresponding assembly language 
program which was then translated into machine language.  

8. Separate input-output processors were developed that could operate in parallel with CPU. 
 

Third Generation 

In Third Generation System 360 Mainframe from IBM, PDP-8 Mini Computer from 
Digital Equipment Corporation is designed with Integrated circuits. Small Scale Integration and 
Medium Scale Integration technology were implemented in CPU, I/O processors etc.  
 

Characteristics of third generation computers: 

1. Smaller & better performance  
2. Comparatively lesser cost  
3. Faster processors  
4. In the beginning magnetic core memories were used. Later they were replaced by 

semiconductor memories (RAM & ROM)  
5. Introduced microprogramming, Microprogramming, parallel processing, 

multiprogramming, multi-user system etc. was introduced.  
6. Operating system software were introduced (efficient sharing of a computer system by 

several user programs)  
7. Cache and virtual memories were introduced High level languages were standardized by 

ANSI eg. ANSI FORTRAN, ANSI COBOL etc. 
8. Database management, multi-user application, online systems like closed loop process 

control, airline reservation, interactive query systems, automatic industrial control etc 
emerged during this period.  

 
Fourth Generation: 
In Fourth Generation Microprocessors were introduced as CPU– Complete processors and 
large section of main memory could be implemented in a single chip. 

Characteristics of fourth generation computers: 

1. Tens of thousands of transistors can be placed in a single chip (VLSI design 
implemented)  

2. CRT screen, laser & ink jet printers, scanners etc were developed.  
3. Semiconductor memory chips were used as the main memory.  
4. Secondary memory was composed of hard disks – Floppy disks & magnetic tapes were 

used for backup memory  
5. Introduced C language, Unix OS and Graphical User Interface   
6. Less power consumption  
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7. High performance, lower cost and very compact  
8. Much increase in the speed of operation. 

 
Fifth Generation 
 
In Fifth Generation, IBM notebooks, Pentium PCs-Pentium 1/2/3/4/Dual core/Quad core..  SUN 
work stations, Origin 2000, PARAM 10000, IBM SP/2 are used occasionally to describe some 
current computer system that have a dominant organizational or application driven feature.  

Characteristics of fifth generation computers: 

1. Computers based on artificial intelligence are available  
2. Computers use extensive parallel processing, multiple pipelines, multiple processors etc.  
3. Introduced ULSI (Ultra Large Scale Integration) technology – Intel’s Pentium 4 

microprocessor contains 55 million transistors millions of components on a single IC 
chip. 

4. Superscalar processors, Vector processors, SIMD processors, 32 bit micro controllers and 
embedded processors, Digital Signal Processors (DSP) etc. have been developed. 

5. Memory chips up to 1 GB, hard disk drives up to 180 GB and optical disks up to 27 GB 
are available (still the capacity is increasing)   

6. Object oriented language like JAVA suitable for internet programming has been 
developed. 

7. Portable note book computers introduced. 
8. Storage technology advanced – large main memory and disk storage available   
9. Introduced World Wide Web. (and other existing applications like e-mail, e Commerce, 

Virtual libraries/Classrooms, multimedia applications etc.)  
10. New operating systems developed – Windows 95/98/XP/…, LINUX, etc.  
11. The recent development in the application of internet is the Grid technology which is still 

in its upcoming stage.  
12. Quantum mechanism and nanotechnology will radically change the phase of computers.    

1.2 Classification of Computers 

The computer systems are classified into various types depends on their usage of the computer, 

operations done in the computers and their sizes. They are 

1. General purpose computers. 

2. Special purpose computer. 

1. General Purpose Computers: These computers are generally used for any type of 

applications. These computers can be used in solving day to day small business 

applications and also used to solve mathematical equation with same accuracy and 

consistency. Today’s Most of the computers are used in house hold purpose are general 

purpose digital computers.  

 



 

 

Paper I Computer Fundamentals and MS-Office 

7 

 

 

 

2. Special Purpose Computers:  

These digital computers are designed, made and used for any specific job. These are 

frequently used for those purposes. Which are serious and essential great accuracy and 

response like Satellite launching. According to the operational principle of computers, they 

are divided into analog, digital and hybrid computers. 

Analog Computers: These are nearly extinct today. These are unlikefrom a digital computer 

because an analog computer can do several mathematical operations simultaneously. It uses 

continuous variables for mathematical operations and utilizes mechanical or electrical energy. 

Digital Computers: They use digital circuits and are designed to operation two states, namely 

bits 0 and 1 and they are analogous to states ON and OFF. Data on these computers is denoted as 

a series of 0s and 1s. Digital computers are suitable for complex computation and have advanced 

processing speeds and they are programmable. Digital computers are either one general purpose 

computers or special purpose ones. General purpose computers, as their name proposes, are 

designed for particular types of data processing while general purpose computers are meant for 

general use. 

Hybrid Computers: These computers are a mixture of both digitalandanalog computers. In this 

type of computers, the digital sections perform process control by transformation of analog 

signals to digital ones. 

Based On the sizes of the computers, the computers are classified as follows. 

Supercomputers: The extremely calculation-intensive tasks can be effectivelydone by means of 

supercomputers. Quantum physics, mechanics, weather forecasting, molecular theory are best 

calculated by means of supercomputers. Their ability of parallel processing and their well-

designed memory order give the supercomputers, large transaction processing powers. 

Ex. PARAM developed in India. 

Servers: They are computers designed to offer services to clientmachines in a computer network. 

They have bigger storage capacities and powerful processors. Running on them are programs 

that assist client requests and allocate resources like memory and time to client machines. 

Generally they are very large in size, as they have large processors and many hard drives. They 

are designed to be fail-safe and resistant to crash. 

Mainframe Computers: Huge organizations use mainframes for highlyserious applications 

such as bulk data processing and ERP. Most of the mainframe computers have abilities to host 
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multiple operating systems and operate as a number of virtual machines. They can temporary for 

several small servers. 

Wearable Computers: A record-setting step in the progress of computerswas the creation of 

wearable computers. These computers can be worn on the body and are often used in the study of 

behaviour modelling and human health. Military and health professionals have incorporated 

wearable computers into their daily routine, as a part of such studies. When the users’ hands and 

sensory organs are engaged in other activities, wearable computers are of great help in tracking 

human actions. Wearable computers do not have to be turned on and off and remain in operation 

without user intervention. 

Minicomputers: In terms of size and processing capacity, minicomputerslie in between 

mainframes and microcomputers. Minicomputers are also named mid-range systems or 

workstations. The term initiated to be popularly used in the 1960s to denote to relatively smaller 

third generation computers. They took up the space that would be required for a refrigerator or 

two and used transistor and primary memory technologies. The 12-bit PDP-8 minicomputer of 

the Digital Equipment Corporation was the major successful minicomputer. 

Microcomputers: A computer with a microprocessor and its centralprocessing unit is known as 

a microcomputer. They do not occupy space as much as mainframes do. When supplemented 

with a keyboard and a mouse, microcomputers can be named personal computers. A monitor, a 

keyboard and other related input-output devices, computer memory in the form of RAM and a 

power supply unit come packaged in a microcomputer. These computers can suitable on desks or 

tables and prove to be the best choice for single-user tasks. 

Desktops: A desktop is planned to be used on a single location. Thespare parts of a desktop 

computer are freely available at relatively lower costs. Power consumption is not as critical as 

that in laptops. Desktops are commonly popular for daily use in the workplace and households. 

Laptops: Similar in operation to desktops, laptop computers are reducedand optimized for 

mobile use. Laptops run on a single battery or an external adapter that charges the computer 

batteries. They are enabled with an inbuilt keyboard, touch pad acting as a mouse and a liquid 

crystal display. Their portability and capacity to operate on battery power have proven to be of 

great help to mobile users. 

Notebooks: They fall in the category of laptops, but are cheap andrelatively smaller in size. They 

had a smaller feature set and lesser capacities in comparison to regular laptops, at the time they 

came into the market. But with passing time, notebooks too began featuring almost everything 

that notebooks had. 

Personal Digital Assistants (PDAs): It is a handheld computer andgenerally known as a 

palmtop. It has a touch screen and a memory card for storage of data. PDAs can also be used as 

portable audio players, web browsers and smart phones. Most of them can access the Internet by 

means of Bluetooth or Wi-Fi communication. 
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Tablet Computers: Tablets are mobile computers that are very handy touse. They use the touch 

screen technology. Tablets come with an onscreen keyboard or use a stylus or a digital pen. 

Apple’s iPad redefined the class of tablet computers. 

1.3 Anatomy of Computer:A computer is an electrical device and it consists of hardware 
and softwarecomponents. 

. 

Fig 1.2 Basic model of computer system 

A computer system is made up of three main parts. 
  

1. Input 
2. System Unit(CPU) 
3. Output 

 

Hardware  
The physical components of computer system are denoted to as hardware. All electronic 

and mechanical parts that constitute computer system drop into the category of hardware. For 
instance, keyboard, mouse, monitor, printer, processor etc. are hardware. 
 

Input devices 
An input device sends information to a computer system for processing.An inputdevice 

can send data to another device, but it cannot receive data fromanother device. Instances of an 
input device include: 

• Keyboard 

• mouse  
• Scanner  
• Joystick  
• light pen and  
• track ball 
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Which can send data (input) to the computer, but they cannot receive or replicate information 
(output) from the computer. Which can receive data 
send information (input) to the computer.
 
 
 

Processor  

It is also called as CPU (Central Processing Unit). It is the brain of the computer that is 
answerable for controlling and executing program instructions entered through the input devices 
like keyboard and mouse. 
1.4 Number System 

In our daily life data can be represent in form of alphabets, numbers, and special symbols but 

mostly human uses decimal system for representing numeral data. Even if it is any kind of data 

the computer system represents in binary number s

number systems are used to represents the data.

The number system 

Basically Number system is divided in to four types

1. Binary Number System
2. Octal Number system
3. Decimal Number system
4. Hexa-decimal Number System

 

1. Binary Number System:

representing any number. The value of the numbers is represented as power of 2 i.e. 

the radix of the system. These power increases with the position of the digits as 

follows 

Ex: 11001(2) 

2.Octal Number System :- It is base of 8 and it has only eight digits { 0 ,1,2,3,4,5,6 ,7} for 

representing any number. The value of the numbers is represented as power of 8. These power 

increases with the position of the digits as follo
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to the computer, but they cannot receive or replicate information 
(output) from the computer. Which can receive data (output) from the computer, but they cannot 

on (input) to the computer. 

It is also called as CPU (Central Processing Unit). It is the brain of the computer that is 
answerable for controlling and executing program instructions entered through the input devices 

In our daily life data can be represent in form of alphabets, numbers, and special symbols but 

mostly human uses decimal system for representing numeral data. Even if it is any kind of data 

the computer system represents in binary number system. Generally the following four types of 

number systems are used to represents the data. 

Basically Number system is divided in to four types 

Binary Number System 
Octal Number system 
Decimal Number system 

decimal Number System 

nary Number System:-It is base(radix) of 2 and it has only two digits i.e 0 and 1for 

representing any number. The value of the numbers is represented as power of 2 i.e. 

the radix of the system. These power increases with the position of the digits as 

It is base of 8 and it has only eight digits { 0 ,1,2,3,4,5,6 ,7} for 

representing any number. The value of the numbers is represented as power of 8. These power 

increases with the position of the digits as follows. 

to the computer, but they cannot receive or replicate information 
from the computer, but they cannot 

It is also called as CPU (Central Processing Unit). It is the brain of the computer that is 
answerable for controlling and executing program instructions entered through the input devices 

In our daily life data can be represent in form of alphabets, numbers, and special symbols but 

mostly human uses decimal system for representing numeral data. Even if it is any kind of data 

ystem. Generally the following four types of 

It is base(radix) of 2 and it has only two digits i.e 0 and 1for 

representing any number. The value of the numbers is represented as power of 2 i.e. 

the radix of the system. These power increases with the position of the digits as 

 

It is base of 8 and it has only eight digits { 0 ,1,2,3,4,5,6 ,7} for 

representing any number. The value of the numbers is represented as power of 8. These power 
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Ex : (25)8 

3.Decimal Number System :- It is base of 10 and it has only ten digits { 0,1,2,3,4,5,6 ,7,8,9} for 

representing any number. The value of the numbers is represented as power of 10. These power 

increases with the position of the digits as 

EX: (256)10 

4.Hexa Decimal Number System :

,7,8,9,A,B,C,D,E,F} for representing any number. The value of the numbers is represented as 

power of 16. These power increases with the positi

EX: (2A2)16 

1.4.1 Converting the data from any system to any other system 

1. Decimal to Binary 

To convert from decimal to binary divide the decimal number by 2 repeatedly until zero and note 

the remainders from bottom to top.
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It is base of 10 and it has only ten digits { 0,1,2,3,4,5,6 ,7,8,9} for 

representing any number. The value of the numbers is represented as power of 10. These power 

increases with the position of the digits as follows 

4.Hexa Decimal Number System :- It is base of 16 and it has only ten digits { 0,1,2,3,4,5,6 

,7,8,9,A,B,C,D,E,F} for representing any number. The value of the numbers is represented as 

power of 16. These power increases with the position of the digits as follows 

1.4.1 Converting the data from any system to any other system  

To convert from decimal to binary divide the decimal number by 2 repeatedly until zero and note 

the remainders from bottom to top. 

It is base of 10 and it has only ten digits { 0,1,2,3,4,5,6 ,7,8,9} for 

representing any number. The value of the numbers is represented as power of 10. These power 

 

It is base of 16 and it has only ten digits { 0,1,2,3,4,5,6 

,7,8,9,A,B,C,D,E,F} for representing any number. The value of the numbers is represented as 

 

To convert from decimal to binary divide the decimal number by 2 repeatedly until zero and note 
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Example: 

Convert  (75)10=(?)2 

 

 

thus   (75)10  = (1001011)2 

2. Decimal to Octal: 

 

To convert from decimal to octal divide the 

decimal number by 8 repeatedly until 

zero and note the remainders from bottom to 

top. 

Convert  (177)10=(?)8 

 

 

 

 

thus   (177)10  = (261)8 

3. Decimal to hexadecimal: 

To convert from decimal to Hexa Decimal divide the decimal number by 16 repeatedly until 

zero and note the remainders from bottom to top. 

 

Convert  (4768)10=(?)16 

 

 

 

 

Hence  (4768)10    = (1 2 A 0)16 

4. Binary to Decimal: 

Multiply the binary number with the weights of binary system according to 

their position and note the sum. 

2 75 Remainder 

2 37 1  (LSB) 

2 18 1 

2 9 0 

 2 4 1 

2 2 0 

2 1 0 

 0 1(MSB) 

8 177 Remainder 

8 22 1 (LSB) 

8 2 6 

  2(MSB) 

16 4768 Remainder 

16 298 0 (LSB) 

16 18 10 (10=A) 

16 1 2 

 0 1(MSB) 
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Ex : convert (11001)2 = (?)10 

 =      1x24  + 1x23  + 0x22  + 0x21  + 1x20 

              =   16+  8   +1 

  =       (25 )10 

 

 

5. Octal to Decimal 

Multiply the octal number with the weights of octal number system 

according to their position and note the sum. 

Ex: convert (632)8 = (?)10 = (6 x 82) + (3 x 81) + (2 x 80) 

= (6 x 64) + (3 x 8) + (2 x 1) 

= 384 + 24 + 2 

= (410)10 

 

6. Hexa Decimal to Decimal 

Multiply the Hexa Decimal number with the weights of HexaDecimal  number 

system according to their position and note the sum. 

Ex : convert (F4C)16 = (?)10 

= (F x 162) + (4 x 161) + (C x 160) 

= (15 x 256) + (4 x 16) + (12 x 1) 

=(3916)10 

1.5 Basic I/O Operations: 

The computer system will be of no use without it is able to communicate with the outside world. 

Input/output devices are necessary for users to communicate with the computer. All input 

devices bring data INTO the computer and output devices bring data OUT of a computer system. 

These input/output components are also known as peripherals since they surround the CPU and 

memory of a computer system. Some generally used Input/output devices are listed in table 

below. 

Input Devices Output Devices  
 

• Keyboard 

• Mouse  

• Joystick  

• Scanner  

• Monitor  

• LCD  

• Printer  

• Plotter 
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• Light Pen  

• Touch Screen  
 

 

 

1.5.1 Input Devices 

(a) Keyboard: it is one of the major hardware components in computer system. It is a text base 

input device and it allows the user to input alphabets, numbers and other characters. It consists 

several keys on a board to give data. 

Alphanumeric Keypad:  

It consist the keys of English alphabets, 0 to 9 numbers, and special characters like / + − % $ / * ( 

) etc.  

Function Keys: 

 There are 12 function keys labelled from F1 to F12. The functions allotted to these keys differ 

from one software package to another. These function keys are also user programmable keys.  

Special-function Keys 

These keys have different functions assigned to them and can be used only for those special 

purposes. Functions of some of the important keys are defined below.  

• Enter 

It is like to the ‘return’ key of the typewriter and is used to execute a command or program.  

• Spacebar It is used to enter a space at the current cursor location.  

• Backspace it is used to move the cursor one position to the left and also delete the 

previous entered character in that position.   

• Delete It is used to delete the character at the cursor position in text.  

• Insert Insert key is used to pin between insert and overwrite mode during data entry.  

• Shift This key is used to type capital letters when pressed along with an alphabet key and 

also used to type the special characters located on the upper-side of a key that has two 

characters defined on the same key.  

Caps Lock Cap Lock is used to pin between the capital lock features. When ‘on’, it locks the 

alphanumeric keypad for capital letters input only.    

Tab it is used to move the cursor to the next tab position defined in the document. Also, it is 

used to insert indentation into a document.  
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Ctrl 

Control key is used in conjunction with other keys to provide extra functionality on the 

keyboard.  

Alt it is also similar to the control key, Alt key is used in combination with other keys to perform 

specific tasks.  

Esc this key is commonly used to negate a command and it is also used to cancel or abort 

executing programs.  

Numeric keypad it  is found on the right side of the keyboard and consists of keys having 

numbers (0 to 9) and mathematical operators (+ − * /) defined on them. This keypad is provided 

to support quick entry for numeric data.  

Cursor Movement Keys These arrow keys and are used to move the cursor in the direction 

shown by the arrow (up, down, left, right). 

(b) Mouse 

The mouse is used to point to a specific place on the screen and select in order to perform one or 

more activities. It can be used to select menu, menu sub menu, size windows, start programs etc.  

The straightest kind of mouse has two buttons on top: the left one being used most frequently 

and it is most used for selecting components. Right button mostly used for viewing the properties 

of the selected components.    

Mouse Actions  

Left Click: Used to select an item.  

Double Click: Used to start or execute a program or open a file.  

Right Click: Usually used to display a set of commands and properties.  

Drag and Drop: It allows you to choose and move an item from one location to another. To 

achieve this place the cursor over an item on the monitor, click the left mouse button and while 

holding the button down move the cursor to where you want to place the item, and then release 

it.    

 (c) Joystick  

The joystick is a vertical stick which moves the graphic cursor in the monitor in a way the stick 

is moved. It usually has a button on top that is used to select the option pointed by the cursor. 

Joystick is used as an input device mainly used with video games, training simulators and 

controlling robots 
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 (d)Scanner  

The scanner is an input device used for direct data entry from the documents into the computer. 

It translates the document image into digital form so that it can be stored into the computer. 

Capturing data like this reduces the possibility of errors normally experienced during large data 

entry.      

Hand-held scanners are usually seen in big stores to scan codes and price data for each of the 

items. They are also called the bar code reader. 

(e) Bar codes  

A bar code is a set of lines of unlike thicknesses that represent a number. Bar Code Readers are 

used to input data from bar codes. Maximum products in shops have bar codes on them .Bar 

code readers work by shining a beam of light on the lines that make up the bar code and 

detecting the amount of light that is reflected back       

 (f) Light Pen 

It is a pen shaped input device used to select objects on a display screen. It is relatively like the 

mouse in functionality but uses a light pen to move the pointer and select any object on the 

monitor by pointing to the object. The Users of Computer Aided Design (CAD) applications 

commonly use the light pens to directly draw on screen. 

(g) Touch Screen  

It allows the user to operate selections by simply touching the display screen. Common examples 

of touch screen include information smart phones and bank ATMs.  

(h)Digital camera A digital camera can store many more pictures than an ordinary camera. 

Pictures taken using a digital camera are stored inside its memory chip and can be send to a 

computer by connecting the camera to it. A digital camera takes pictures by translating the light 

passing through the lens at the front into a digital image. 

 (i) The Speech Input Device   

The “Microphones - Speech Recognition” is a speech Input device. To operate it we need using a 

microphone to talk to the computer. Also we require adding a sound card to the computer 

system. The Sound card digitizes audio input into 0/1s .A speech recognition program can 

process the input and translate it into   machine-recognized commands or input.   
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1.5.2 Output Devices   

(a) Monitor  

Monitor or screen is an output device that looks like the television screen and uses a 

Cathode Ray Tube (CRT) to display information. The monitor is associated with a 

keyboard for manual input of characters and displays the data as it is keyed in. It also 

displays the program or application output.  Like the television, monitors are also 

available in various sizes. 

 

 

  

(b) Liquid Crystal Display (LCD)  

LCD was announced in the 1970s and is now useful to display terminals also. Its benefits like 

low energy consumption, smaller and lighter have paved its way for usage in portable computers 

(laptops).          

 (c) Printer  

Printers are used to generate paper (commonly known as hardcopy) output. Based on the 

technology used, they can be categorized as Impact or Non-impact printers.  

Impact printers use the typewriting printing mechanism wherein a hammer strikes the paper 

through a ribbon in order to produce output. For example consider the Dot-matrix and Character 

printers fall under this category.  

Non-impact printers do not touch the paper while printing. They use chemical, heat or electrical 

signals to print the symbols on paper. For example consider the Inkjet, Deskjet, Laser, Thermal 

printers fall under this category of printers. When we discuss about printers we mention to two 

basic qualities related with printers: resolution, and speed. Print resolution is calculated in terms 

of number of dots per inch (dpi).  Print speed is estimate in terms of number of characters printed 

in a unit of time and is denoted as characters-per-second (cps), lines-per-minute (lpm), or pages-

per-minute (ppm).    

 

 

 

 

 

Figure 1.3: The Printer 



 

 

Paper I Computer Fundamentals and MS-Office 

18 

 

(d) Plotter  

Plotters are used to print graphical output on paper. It interprets computer commands and makes 

line drawings on paper using multi-coloured automated pens. It is capable of producing graphs, 

drawings, charts, maps etc.  

Computer Aided Engineering (CAE) applications like CAD (Computer Aided Design) and CAM 

(Computer Aided Manufacturing) are typical usage areas for plotters.           

 

 

 

 

 

 

 

Figure 1.4: The Plotter 

(e) Audio Output: Sound Cards and Speakers:   

The Audio output is the capability of the computer to output sound and it need Two components 

that they are Sound card – Plays contents of digitized recordings, Speakers – Attached to sound 

card.   

 

 

 

 

 

 

Fig 1.5 Sound Cards and Speakers: 

 

1.6 Block diagram of CPU 
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Computer is an electronic device which accepts input data, does arithmetic logic and shift 

operations then stores the data in memory, and outputs the information in desired format to the 

end user.Despite the fact that the size, shape, execution, quality and cost of PCs have been 

changing throughout the years, the essential coherent structure proposed by Von Neumann has 

not change. The internal structures of the computers are varying from one system model to 

another. A block diagram of the basic computer organization is shown below. Here the strong 

lines indicate the flow of instruction; data and the dotted lines represent the control practiced by 

the control unit. 

 

 

Fig 1.6 block diagram of computer system 

The Computer system majorly consists four basic functional units 

1. Input unit, 

2. Processor unit 

3. Output 

4. Storage.  

 

1. INPUT UNIT 

 This is the process of entering data and programs in to the computer system. Therefore, the input 

unit takes data from us to the computer in an organized manner for processing through an input 
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device such as keyboard, mouse, MICR, OCR, Etc. The keyboard is wired so that whenever a 

key is pressed, the corresponding letter or digit is automatically translated into its corresponding 

code and sent directly to either the memory or the processor and other kinds of input devices are 

Joy stick, track ball, mouse (pointing devices), scanner etc.   

 

2. PROCESSOR UNIT 

 The heart of the computer system is the Processor unit.  It consists two major components. 

 

1. Arithmetic and Logic Unit 

2. Control Unit.  

Arithmetic and Logic Unit (ALU) 

The actual processing of the data and instruction are performed by Arithmetic Logical Unit of 

the processor. The major operations performed by the ALU are addition, subtraction, 

multiplication, division, logic and comparison. Data is transferred to ALU from storage unit 

when required. After processing the output is returned back to storage unit for further processing 

or getting stored.For example considered two numbers (operands) located in the main memory 

are to be added. First, these operands are fetched into arithmetic unit and actual addition is 

carried. Second, the result is then stored in the memory for instant use. Processor contains a 

number of high speed storage elements called Registers, which may Note that all operands may 

not reside in the main memory some time may store in registers. These registers are used for 

temporary storage of frequently used operands. Each register can store one word of data and 

Access times to registers are 5 to 10 times faster than access time to memory. Most computer 

instructions are executed in ALU (Arithmetical and logical) of the processor.  

Control Unit 

The operations of all the units are controls by the control unit, which acts like the supervisor. It 

controls all the Functionalities of a computer system using Timing signal.Timing 

signals that directs the I/O transfers are generated by the Control Unit. 

Synchronization signals are also generated by the Control Unit and these used for 

synchronizing instruction execution. It provides an environment to the end user for 

executing programs. It controls a monitors various devices with in the system. The 

control unit by selecting, interpreting and executing the program instructions decides the 

sequence in which computer programs and instructions are executed. The control unit and 

ALU’s are usually many times faster than other devices connected to a computer system. 
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3. OUTPUT UNIT  

This is the process of producing results from the data for gettinguseful information. Similarly the 

output produced by the computer after processing must also be kept somewhere inside the computer 

before being given to you in human readable form through the screen or printer i.einput unit and 

Output devices accepts binary data from the computer - decodes it into original form and 

supplies this result to the outside world. E.g. Printer, Video terminals (provides both input & 

output functions), graphic displays etc. 

4. MEMORY UNIT 

The memory unit stores program and data. There are two classes of memory devices :- 

1. Primary memory  

2.  Secondary memory.  

Primary memory  

Primary memory is also called as Main memory and it contains a large number of semiconductor 

cells. Each cell having capable of storing one bit of information. These cells in memory are 

processed in group of fixed size called WORD with ‘n’ bit length. The total Number of bits in 

each word is called the word length and it may be different from 16 to 64 bits.  The main 

memory is organized such that the contents of one word can be stored or retrieved in one basic 

operation. To be accessing data in memory a distinct address is associated with each word 

location and before executing a program there is need of storing data and programs into main 

memory. Once turn off the computer system the data stored with in the memory are lost. Fast 

memory Expensive Time required to access one word is called Memory Access Time - 10nS to 

100nS. This time is fixed and independent of the location.    Eg. Random Access Memory 

(RAM)    

Secondary storage 

They are used when large amount of data have to be stored permanently in memory It is also 

known as auxiliary memory. It is closely linked with the main memory. Thus secondary storage 

is used to hold mass of information i.e., system software, application programs, cinemas, games 

and data files. Obviously the capacity of secondary storage is very high compared to main 

memory. Auxiliary memory usually in the form of Magnetic disk, Magnetic tape, CD’s, Memory 

cards, Pen drives, Compact Disk, Floppy Disk Etc., 

1.7 Memory units 

As human beings we all understand decimal system but the computer can only understand binary 

system. Because memory is a large number of integrated circuits inside the computer can be 

considered as switches. The resulting of continues switch ON or OFF generate the data in form 

of 1’s and 0’s Even human gave any kind of data and program, In computer’s memory both are 

stored in the binary form. The binary system has only two values 0 and 1.Therefore, the 
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computer that takes the information or data in decimal form from you, converts it into binary 

form, processes it, producing output in binary form and finally again converts the output to 

decimal form. 

In memory a single storage cell is called Bit and within one cell stores either 1 or 0 only. Which 

stands for one binary piece of information.Every number in binary system can be converted to 

decimal system and vice versa. Memory unit is made up of several small storage locations called 

cells. Each of these cells can store a fixed number of bits called word length. Each cell has a 

unique number assigned to it called the address of the cell and it is used to identify the cells. The 

address starts at 0 and goes up to (N-1). You should know that the memory is like a large cabinet 

containing as many drawers as there are addresses of memory. Each drawer contains a word and 

the address is written on outside of the drawer. 

 

1.7.1 Memory sizes(Capacity): 

The size of memory is termed in terms KB, MB, GB etc., 

1Bit    -   8 Bits 

8 Bits    - 1 Byte  

1024 Bytes   - 1 Kilo Byte  

1024 Kilo Bytes  - 1 Mega Byte 

1024 Mega Bytes  - 1 Giga Byte  

1024 Giga Bytes   – 1 Tera Byte 

1024 Tera Bytes   – 1 Peta Byte  

1024 Peta Bytes –  1Exa Byte 

1024 Exa Bytes – 1 Zetta Byte 

12024 Zetta Bytes – 1Yotta Byte     

1) How many number of bits for 1 GB   

1GB =1024*1024*1024*8 

 =233 

 =8589934592 bits  
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2) A computer system consist 15 MB then find how many number of bytes it 

consist  

15MB=15*1024*1024 

   =220 *15  

   =15728640 bytes 

 

1.7.2 Memory classifications 

Memories majorly classified into 3 categories. they are  

                                         1. Main memory (or) primary memory  

                                         2. Second memory (or) Auxiliary memory 

                                         3. Cache memory 

1. Main memory 

It is also called as primary memory (or) direct access storage and it is available inside the 
CPU. It is a fast memory made up of a huge number of cells having a fixed capacity of storage 
and has unique address. Each address represent inform of Hex Decimal number and starts with 
0hx. In computer system majorly uses two different types of main memories, they are 

 
                               a) Random access memory (RAM) 

                               b) Read only memory (ROM) 

 

a) Random access memory 

The primary storage is denoted as Random Access Memory (RAM) because it is potential to 

randomly select and use any location of the memory directly to store and retrieve data. It 

takes same time to any address of the memory as the first address. RAM is the hardware 

location in the computer where the operating system, application programs and data 

in current use are saved so that they can be accessed by the computers processor. 

The user has direct access to this part of memory i.e., the user can read and can write 

into this memory. Hence this memory is also known as Read / writes memory. 

Main memory combines 1 or more bytes into a single unit which is called word. The 

larger the word size of computer. Early PC’s used to have single byte for a word. 

The major IBM PC’s have 2 bytes for a word. The present Intel-based PC’s have 4 

bytes for a word. Every word in the main memory is given a unique number as an 

unsigned address. It is volatile in nature i.e., the data in RAM available there only as 

long as the computer is running. When the computer turned off, the data in RAM is 

lost. 



 

 

Paper I Computer Fundamentals and MS-Office 

24 

 

RAM is of two different types. 

 
                                            i) Static RAM 

                                           ii) Dynamic RAM 

i) Static RAM (SRAM) 

 Static RAM uses a set of flip-flop (or) latch as a basic cell to store bit information. SRAM is 
expensive, needs more power to operate and yields lot of heat. SRAM does notneed to be 
refreshedperiodically.SRAM keeps its contents as long as electrical power is provided to the chip. 
If the power is turned off, its contents are lost. 
 

SRAM is very fast but more expensive than DRAM. SRAM is frequently used as cache 
memory due to its high speed. 

 

 

 

ii) Dynamic RAM (DRAM) 

DRAM uses a small capacitor as a basic cell to store a bit information. DRAM is less 
expensive, consumes less power and produces less heat when related with SRAM. DRAMS want 
periodic refreshing to retain their contents. 
            Even when power is turned off, DRAM has very short data life typically about four 
milliseconds.  
 
b) Read – Only Memory(ROM) 

In this portion of memory some instructions are permanently loaded during the manufacturing of 
the computer system. ROM is non-volatile memory because even when the computer is turned 
off, the contents of ROM remain available. It is a permanent memory because once we write any 
data in the ROM those are remaining unchanged in memory. ROM performs the necessary 
Booting process to start the system and then transfers the control to the operating system.  
Types of ROM 

There are different types of ROM such as  

1. PROM (Programmable Read Only Memory) 

2. EPROM (Erasable Programmable ROM) 

3. EEPROM ( Electrically Erasable Programmable ROM) 

 

1. PROM (Programmable Read Only Memory) 

Building a ROM Chip from scratch is time consuming and expensive process. Due to this 
reason, developers created a type of ROM well-known as PROM which can be programmed. 
Special instruments are used to write the content into PROM. Once a PROM has been 
programmed, its contents can never be altered. 
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2) EPROM (Erasable Programmable ROM) 

An EPROM is programmed in exactly the same manner as PROM. But unlike PROM, an 
EPROM can be removed and reprogrammed repeatedly. It can be removed by simply exposing 
the device to a strong source of ultraviolet light for a firm amount of time. When erased, all the 
contents of EPROM will be erased. 

 

3) EEPROM (Electrically Erasable Programmable ROM) 

EEPROM can be erased by electrical signals in its place of ultraviolet light. EEPROM 
can be removed one byte at a time, rather than removing the entire chip data. Hence the process 
of reprogramming is flexible, but slow.  
 

 

 

Auxiliary Memory (or) Secondary Memory 

You are currently clear that the working speed of primary memory or main memory should be as 

fast as possible to deal with the CPU speed. These fast storage devices are extremely costly and 

thus the cost per bit of capacity is likewise high.Again, the storage capacity of the main 

memory is also very limited. 
 

Often it is required to store a huge number of bytes of data for the CPU to process. Therefore, 

additional memory is required in all the computer systems. This memory is called auxiliary memory or 

secondary storage. In this type of memory, the cost per bit of storage is low. However, the operating speed is 

slower than that of the primary memory. Huge amount of data are stored here on permanent basis and 

transferred to the primary storage as and when required. Most widely used secondary storage devices are 

magnetic tapes, magnetic disks and floppy disks, Compact disks and Pen drives etc., 

Magnetic Tape 

 
Magnetic tapes are used for large computers similar to mainframe computers where large volume of data 

is stored for a longer time. In computer system also you can use tapes in the form of cassettes. The cost of 

storing data in tapes is cheap. Tapes consist of magnetic materials that store data permanently. It can be 

12.5 to 25 mm wide plastic film-type and 500 meter to 1200 meter long. Magnetic tape himself is 

a strip of plastic coated with a magnetic recording medium. Bits are stored as magnetic spots on 

the tape along several concentric circles called tracks. Data and programs are stored in blocks 

referred as records. It provides serial access and so records can access one after another as the 

tape moves along a fixed read-write mechanism. Information can be removed by recording new 

data in its place. A tape unit is addressed by specifying the record number and the number of 

characters in the record. Direct access to a specific record is not possible. It is one of the cheapest 

and slowest systems for storage and has the advantage that tapes can be removed when not in use. 

Advantages of Magnetic Tape 
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Compact: A 10-inch diameter reel of tape is 2400 feet long and is able to hold 800, 1600 or 6250 

characters in each inch of its length. The maximum capacity of such type is180 million 

characters. Thus data are stored much more compact on tape.

Economical: The cost of storing characters on tape is very less as compared to other storage 

devices. 

Fast: Copying of data is easier and fast.
 

Long term Storage and Re-usability:

can be used repeatedly without loss of data.

Magnetic disk 

A Magnetic disk is a circular plate built of metal (or) plastic coated with magnetized 
material. Regularly the two sides of the disc are utilized 

spindle with read/write heads availa
in spots along concentric circles called tracks. 
called sectors. The subdivision of one disk surface into tracks and sectors is shown in the fig

 

Access is accomplished 

surface. A disk system is addressed by address bits that identify the disk number, the disk 
surface, the sector number and track within the
simultaneous transfer of bits from several tracks at the same time. Magnetic disks are of two 
types. 

 
1. Hard disk: Disks that are permanently attached to the unit assembly and cannot remove by 
the occasional user are called hard disks.

 
2. Floppy disk: A disk drive with removable disks is called a floppy disk. 
Floppy Disk: 
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inch diameter reel of tape is 2400 feet long and is able to hold 800, 1600 or 6250 

characters in each inch of its length. The maximum capacity of such type is180 million 

characters. Thus data are stored much more compact on tape. 

The cost of storing characters on tape is very less as compared to other storage 

Copying of data is easier and fast. 

usability: Magnetic tapes can be used for long term storage and a tape 

dly without loss of data. 

A Magnetic disk is a circular plate built of metal (or) plastic coated with magnetized 
Regularly the two sides of the disc are utilized and some discs may be used on one 

spindle with read/write heads available on each surface. Bits are stored in the magnetized surface 
in spots along concentric circles called tracks. The tracks are usually partitioned into 

called sectors. The subdivision of one disk surface into tracks and sectors is shown in the fig

 

Fig 1.7 magnetic disc 

accomplished by moving a read-write mechanism to a track in the magnetized 
surface. A disk system is addressed by address bits that identify the disk number, the disk 
surface, the sector number and track within the sector. Disks may have multiple heads and 
simultaneous transfer of bits from several tracks at the same time. Magnetic disks are of two 

: Disks that are permanently attached to the unit assembly and cannot remove by 
are called hard disks. 

A disk drive with removable disks is called a floppy disk.  

inch diameter reel of tape is 2400 feet long and is able to hold 800, 1600 or 6250 

characters in each inch of its length. The maximum capacity of such type is180 million 

The cost of storing characters on tape is very less as compared to other storage 

Magnetic tapes can be used for long term storage and a tape 

A Magnetic disk is a circular plate built of metal (or) plastic coated with magnetized 
and some discs may be used on one 

ble on each surface. Bits are stored in the magnetized surface 
The tracks are usually partitioned into sections 

called sectors. The subdivision of one disk surface into tracks and sectors is shown in the figure.   

write mechanism to a track in the magnetized 
surface. A disk system is addressed by address bits that identify the disk number, the disk 

sector. Disks may have multiple heads and 
simultaneous transfer of bits from several tracks at the same time. Magnetic disks are of two 

: Disks that are permanently attached to the unit assembly and cannot remove by 
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It is like to magnetic disk discussed above. It is 3.5 inch in diameter. The capacity of a 3.5 inch 

floppy is 1.44 megabytes. It is inexpensive than any other storage devices and is portable. The 

floppy is a low price device particularly suitable for personal computer system.  
 
 
 
 
 
 
 
 
 
 
 

Fig. 1.8 Floppy Diskette 

Optical Disk 
 

With each application and software there is more demand for memory capacity. It is the want to 

store large volume of data that has managed to the development of optical disk storage medium. 

Optical disks can be divided into the following categories. 
 

1. Compact Disk/Read Only Memory (CD-ROM): CD-ROM disksare made of reflective 

metals. CD-ROM is written during the process of manufacturing by high power laser 

beam. Here the storage density is very high, storage cost is very low and access time is 

relatively fast. Each disk is approximately 4 1/2 inches in diameter and can hold over 600 

MB of data. As the CD-ROM can be read only we cannot write or make changes into the 

data contained in it. 
 

2. Write Once Read Many (WORM): The inconvenience that we cannot write anything in to a 

CD-ROM is avoided in WORM. A WORM allows the user to write data permanently on the disk. 

Once the data is written it can never be erased without physically damaging the disk. Here data 

can be recorded from keyboard, video scanner, OCR equipment and other devices. The advantage 

of WORM is that it can store vast amount of data amounting to gigabytes. Any document in a 

WORM can be accessed very fast. 
 

3. Erasable Optical Disk: These are optical disks where data can bewritten, erased and re-

written. This also applies a laser beam to write and re-write the data. These disks may be 

used as alternatives to traditional disks. Erasable optical disks are based on a technology 

known as magnetic optical (MO). To write a data bit on the erasable optical disk the MO 

drive’s laser beam heats a tiny, precisely defined point on the disk’s surface and 

magnetizes it. 

 

Flash drive: Flash drives have many names - jump drives, thumb drives,pen drives, and USB 

keychain drives. Regardless of what you call them, they all refer to the same thing, which is a 

small data storage device that uses flash memory and has a built-in USB connection. Flash drives 

are typically no more than two to three inches in length and less than an inch in width. Their size 

and shape may resemble a thumb or a small pen (which is where the names “thumb drive” and 

“pen drive” come from).  
 



 

 

Paper I Computer Fundamentals and MS-Office 

28 

 

Flash drives are also very thin, often having a depth of less than a centimetre. Because of their 

small form factor, they are highly portable and can easily fit in a pocket or on a keychain (hence 

the name “keychain drive”). 
 
Nowadays flash drives can store several gigabytes of information. Since they are small in size but 

have large storage capacities, flash drives have replaced most previous portable data storage mediums 

such as floppy disks and removable hard disks like Zip disks. Because they have a built-in USB 

connection, flash drives also don’t require a special disk drive to be used. Instead, they can be used on 

any computer with a USB port, which nearly all modern computers have. Below is the diagram of a 

pen drive. 
 
 
 

 

 

 

 

Fig 1.9 flash drive 

1.8 Programming Language, general software features, trends and utilities 

 

1.8.1 What is Language? 
 
You are aware with the term language. It is a coordination of communication between you and 

me. Some of the basic natural languages that we are used for communication for example 

English, Hindi, and Tamil etc. These are the languages used to communicate among various types 

of persons. But how you will communicate with your computer. Your computer will not know 

any of these natural languages for transfer of data and instruction. So there are programming 

languages especially developed so that you could send your data and instructions to the computer 

to do specific job. This type of language is called Artificial languages. For example consider 

FORTRAN, BASIC, COBOL etc. These are programming languages. So instructions or 

programs are written in a specific language based on the type of program. As an example, for 

scientific application FORTRAN and C languages are used. On the other hand COBOL is used 

for business applications. 
 
1.8.2 Programming Languages 

The processes of a computer are controlled by a set of instructions called a computer program.  

The set of instructions to construct a program is called programming language. However, all 

programs must ultimately be converted into a machine language program which a computer can 

understand. 
 
There are two major types of programming languages. These are Low Level Languages and High 

Level Languages. Low Level languages are additional divided in to Machine language and 

Assembly language. 
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Fig 1.9 levels of programming languages

1. Machine Language: 

   Computer is an electronic device which can understand any instruction given to it in a 
binary coded form( 0 or 1).  A program written in binary form is ca
as machine language. 
Example: 11000000000000011000010011000000000001000
Every instruction consists of minimum 2 parts
 
 
 
 
The instruction part is also called as opcode which conveys the comput
such as add, subtract, multiply etc. The second part says about the data on which operation has to 
be done.  
Advantages 

 1. Execution speed is very fast 
2. Efficient use of primary memory
3.It does not need any translation becau

 

Disadvantages 

1. Writing a program in machine language is a very difficult. 
2. Every machine has its own machine language.
3. Error prone 
4. Difficult to modify 

 

Assembly Language 

  In assembly language, the in

shorten the program. Hence, it is easy to write and understand assembly language programs for 
programmers than machine language programs. Since computer can understand only machine 
language, it is required to translate the assembly language program into machine language 
program during execution. For this, a translator is needed to translate the assembly language 
program to machine language program. Such translator is called Assembler. The mnemonics are 

instruction part or 
Opcode part 
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Fig 1.9 levels of programming languages 

Computer is an electronic device which can understand any instruction given to it in a 
binary coded form( 0 or 1).  A program written in binary form is called 

11000000000000011000010011000000000001000 
Every instruction consists of minimum 2 parts 

The instruction part is also called as opcode which conveys the computer the operation to be done 
such as add, subtract, multiply etc. The second part says about the data on which operation has to 

2. Efficient use of primary memory 
3.It does not need any translation because machine code is directly understood by the computer.

Writing a program in machine language is a very difficult.  
Every machine has its own machine language. 

In assembly language, the instructions are written by mnemonics (symbols) to 

Hence, it is easy to write and understand assembly language programs for 
programmers than machine language programs. Since computer can understand only machine 

o translate the assembly language program into machine language 
program during execution. For this, a translator is needed to translate the assembly language 
program to machine language program. Such translator is called Assembler. The mnemonics are 

instruction part or data part or Operand 
part 

Computer is an electronic device which can understand any instruction given to it in a 

er the operation to be done 
such as add, subtract, multiply etc. The second part says about the data on which operation has to 

se machine code is directly understood by the computer. 

structions are written by mnemonics (symbols) to 

Hence, it is easy to write and understand assembly language programs for 
programmers than machine language programs. Since computer can understand only machine 

o translate the assembly language program into machine language 
program during execution. For this, a translator is needed to translate the assembly language 
program to machine language program. Such translator is called Assembler. The mnemonics are 
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nothing but the word replacements for binary opcode also decimal numbers and labels substitutes 
memory addresses. 
Assembler: 
An assembler is a computer program that converts assembly language instructions into machine 
language instructions. 
 

 

 

 

 

 

 

Advantages 

  
1. Easier to memorize and use: Assembly language program is easy to use,understand and 

memorize because it uses mnemonic codes in place of binary codes. 
  

2. Easy to write input data: In assembly language programs the input data can bewritten in 
decimal number system, later they are converted into binary. 

 

3. It is easier to correct errors and modify program instructions.  
4. The Assembly Language has the similar efficiency of execution as the machine level 
language. Because this is one-to-one translator among assembly language program and its 
equivalent machine language program. 
Disadvantages 

  
1. Machine dependent. A program written for one computer might not run in other 

computers with different hardware configuration.  

2. Knowledge of hardware is needful. 
3. Time consuming 
4. Translators required (i. e Assembler )  

 

High Level Language 

  In High level language, instructions are written using natural language such as English 
and mathematical symbols like +, -, %, / etc. for its program construction.. Normally used high 
level languages are FORTRAN, COBOL and PASCAL etc. 
 
  Therefore it is easy to write and understand High level language programs than Assembly 
language programs and machine language programs. We know computer can understand only 
machine language. So to translate the high level language program into machine language 
program during execution, it needs a translator such as compiler or interpreter is used. 
Higher level languages are problem-oriented languages because the instructions are suitable for 

solving a particular problem. For example COBOL (Common Business Oriented Language) is 
mostly suitable for business oriented language where there is very little processing and huge 

output. There are mathematical oriented languages like FORTRAN (Formula Translation) and 

BASIC (Beginners All-purpose Symbolic Instruction Code) where very large processing is 

required. 

Assembly 

language 

Machine 

language 

Assembler 

(Translator) 
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Advantages 

1. It is easy to study and understand the high level language than machine and assembly 
languages. 

2. Takes less time to write. 
3. Easy to maintain. 
4. Better documentation. 

 
Compiler 
It is a program translator that translates the instruction of a higher level language to machine 

language. Thus compiler is a program translator like assembler but more refined. It takes the total 

program one at time and translates into low level language.  

 

 

 

 

 
 
 

The programs written by the programmer in higher level language is called source program and 

after this program is transformed to machine languages by thecompiler it is called object 

program. Object program produced by compiler is machine dependent. It means programs 

compiled for one type of machine will not run in another type. Therefore every type of machine 

must have its personal compiler for a particular language. Machine independence is achieved by 

using one higher level language in different machines. 

Interpreter 
An interpreter is one more type of program translator used for converting higher level language 

into machine language. It takes one statementof higher level languages, convert it into machine 

language and directly execute it. Translation and execution are carried out for each statement. It 

varies from compiler, which translate the entire source program into machine code and does 

include in its execution. 
 
The benefit of interpreter compared to compiler is its fast response to changes in source program. 

It removes the need for a separate compilation after changes to each program. Interpreters are 

easy to write and do not need large memory in computer. The disadvantage of interpreter is that it 

is time consuming method because each time a statement in a program is executed then it is first 

converted. Thus compiled machine language program runs much faster than an interpreted 

program. 

 

1.8.3 Software 

Previously stated that programs or instructions have to be fed to the computer to do particular 

task. So it is needed to provide sequence of instructions so that your work can be done because to 

High Level 

Language 

Program 

Machine 

language 

Compiler 

(Translator) 
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do any particular task with in computer system there is need of software. We can divide the 

computer components into two major areas, namely, hardware and software.  

Hardware 

The physical parts, which you can see and touch, are collectively called hardware. It is the 

machine itself and its several individual equipment. It includes all mechanical, electronic and 

magnetic devices such as monitor, scanner, printer, electronic circuit, mouse, key board floppy 

and hard disk. Software, on the other hand, refers to the instructions, or programs, that tell the 

hardware what to do. In this lesson we will discuss about the other part, namely, software. 

 

What is Software? 
 

As you know computer cannot do anything without instructions from the user. In order to do any 

particular job you have to give a sequence of instructions to the computer. This set of instructions 

is called a computer program. Software refers to the set of computer programs, procedures that 

defines the programs. We can say that it is the group of programs, which increase the capabilities 

of the hardware. Software guides the PC at every step where to start and halt during a specific 

job. The process of software development is called programming. 

 

Software Types 
Computer software is usually categorized into two broad categories. 

1. Application Software 
 

2. System software 
 
Application Software: Application Software is a set of programs to carryout operations for a 

particular application. Application software is useful for word processing, presentations, billing 

system, accounting, producing statistical report, medical analysis, small business processing, 

analysis of numerous data in research, weather forecasting, etc. In future modules you will learn 

about MS WORD, Excel, Power Point, etc. All these are application software’s. 
 
One more example of application software is programming language. Among the programming 

languages COBOL (Common Business Oriented Language) is more suitable for business 

application whereas FORTRAN (Formula Translation) is useful for scientific application.  

Application software is broken in to two classes. They are general-purpose software and 
application –specific software.  
 
General purpose software is purchased from a software developer and can be used for more 
than one application. Examples of general purpose software include word processors, database 
management systems, and computer aided design systems. They are considered general purpose 
because they can solve different types of user computing problems.  
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Application –specific software can be used only for its intended purpose. 
A general ledger system used by accountants and a material requirements planning system used 
by a manufacturing organization are examples of application-specific software. They can be used 
only for the task for which they were designed they cannot be used for other generalized tasks.  
Features of application software are as follows 
 

1. Close to user 

2. Easy to design  
3. More interactive  
4. Slow in speed  
5. Generally written in high-level language  
6. Easy to understand  
7. Easy to manipulate and use  
8. Bigger in size and needs large storage space 

 
 
System Software: System software is a set of one or more programs designed to control the 

operation of computer system. System software consists of programs that manage the hardware 

resources of a computer and performing tasks such as controlling, monitoring  all operations 

required to do the internal and external functionalities of the computer. It communicates with 

printers, card reader, disk; tapes etc. monitor the use of several hardware like memory, CPU etc. 

Also system software is important for the development of applications software. System Software 

allows application packages to be run on the computer with less time and effort. Remember 

thatitis not possible to run application software without system software. DOS, UNIX and 

WINDOWS are some of the commonly used system software. Out of these UNIX and Windows-

NT are multi-user operating systems while DOS and WINDOWS are single-user systems. 

These programs are categorized into three classes. They are operating system, system support, 
and system development. 
 

Operating System: 
The operating system offers services such as a user interface, file and database access, and 
interfaces to communication systems such as Internet protocols. The main purpose of this 
software is to keep the system operating in an efficient way while allowing the users access to 
the system. 

 

System support 

System support software offers system utilities and other operating services. Examples of 
system utilities are sort programs and disk format programs. Operating services consists of 
programs that provide performance statistics for the operational staff and security monitors to 
protect the system and files. 
 

System development software 

System development software contains the language translators that translate programs into 
machine language for execution, debugging tools to confirm that the programs are error free 
and computer –assisted software engineering (CASE) systems. 

Ex: Compilers, Interpreters, Assemblers 
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Features of system software are as follows: 
a. Close to system  
b. Fast in speed  
c. Difficult to design  
d. Difficult to understand  
e. Less interactive  
f. Smaller in size  
g. Difficult to manipulate  
h. Generally written in low-level language 

1.8.4 Utilities 
 
Utility: A program that does a specific task related to the organization of computer functions, 

resources, or files, as password protection, memory management, virus protection, and file 

compression. 

 

Viruses: There are several nasty computer critters out there trying toget into your PC. The most 

common term we call it virus but it may be virus, Trojan horse, worm and blended threat. 

 

Virus: A virus is a program that replicates itself. It spread by creatingcopies of itself on a 

computer or by inserting computer code into program or operating system files. Viruses don’t 

always damage files or computers, but they usually affect a computer’s performance and stability. 

 

Are all Viruses harmful? 
 
Yes, to varying degrees. Virus harm can range from slowing computer performance to a loss of 

data and programs. In the worst case, viruses delete or modify data and programs on your 

computer. Some e mail viruses send personal data in messages when spreading. Even when 

avirus is not directly damaging the data, the process of replication can slow your PC and Internet 

connection. 

 

Worm An unwanted computer program that duplicates itself through a computer network. It 
uses up the network’s storage space and resources and can interfere with the ability of network to 
function at all. Most worms begin as e mail attachments that infect a computer when they’re 
opened. 
 
Trojan horse A Trojan horse is a malicious software program that hides inside other programs. 
It enters a computer hidden inside a genuine program, such as a screen saver or any other 
genuine software. It then puts code into the operating system, which allows a hacker to access 
the infected computer. Trojan horses do not typically spread by themselves; they are spread by 
viruses, worms, or downloaded software. 
 
Blended threat  

A blended threat is a mixture of some or all of the malicious programs discussed in the sections 
above. Blended threats often begin when someone interacts with a virus. The virus automatically 
spreads using worm behaviour, and then installs a Trojan horse on the infected computer. 
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How do I prevent viruses? 
 
Prevention of infection is done by installing an antivirus program. To be most effective, an 

antivirus program should always be runnig, should scan incoming e mail, and should scan file 

access. 

 

How do I know if my computer has a virus? 
 
There is no single indicator of a virus infection, but some of the more common effects include 

poor computer performance, pop-up ads displaying (even when you have turned on a pop-up 

blocker or disconnected from the Internet). 

Summary 

The distinguish between Computers and human beings are: 

1. Computer is an electrical device and it cannot do any work without instruction from the 

user. It is you to decide what you want to do and in what sequence. So a computer cannot 

take its own decision as you can. 

2. It does not have feelings or emotion, taste, knowledge and experience. It does not 

differentiate between users. Computers cannot learn by experience as like humans. 

 These were some of the several types of computers used today. Looking at the rate of 

progression in technology, we can definitely seem forward to many more types of PC's in the 

near future. As like a digestive system of a human body ,With the block diagram of PC's we can 

have a basic idea of operations in PC's .Computer knows only two states that one is ON and  

second one is OFF. Binary system has only two digits 0 and 1. So the Binary system is adopted 

in computers. 

Distinguish between a Number and digit as follows 

 Number means set of digits whereas digit means 0,1,2,3,4,5,6,7,8 or 9.Suppose 47 is a 

number and it has only two digits 4 and 7. We can convert from any system to any other system 

as follows. for example, if we need to convert from binary to octal system , first we translate 

from binary to decimal system and then translate from decimal to octal system. 

 There are some direct methods to translate from any computer to any other computer. 

Input is pass to the computer not only through input devices , we can also pass the  input from 

remote area through internet. We also get output from remote area through internet. 

 In  this unit we discussed about two types of software, namely  system software and 

application software. System software controls the hardware part of the computer. It is designed 

for performing tasks such as controlling all operations essential to move data into and out of the 

computer. It interacts  with printer, card reader, disk, tapes, etc. and monitors the use of different 

components like memory, CPU, etc and DOS, UNIX and WINDOWS are three important system 

software's. Application software is a set of programs written for specific purpose to do the 

functionalities by the users. Examples of application software's  are MS WORD, Lotus 1-2-3, 
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COBOL, BASIC and FORTRAN. We have discussed about levels of computer language and 

generation of computer systems. 

 Printer is used to print the require data on printer. The printed copy is known as printout 

or hard copy. The storage devices are becoming many more types in day to day changes of our 

lives. In future very small storage devices can store very much large amount of data. We have 

discussed about levels of computer language. Both compiler and interpreter are program 

translators used for converting high level language into machine language. While compiler 

convert the entire program first and then convert it into machine code once the program is 

converted by interpreter then execute many number of time without recompilation. An 

Interpreter converts the program line by line. and 

To improve the system performance and to keep the standards we must use utilities such as File 

management programs, Disk management programs, Memory management, Backup programs, 

data recovery programs , Data compression programs and Antivirus programs. 

 

Short Answer Type Questions 

1. What is a Computer? 

2. What are the components used in Second generation computers? 

3. What are the types computers based on purpose? 

4. What are the types computers based on operation? 

5. What are the different number systems? 

6. Convert (22)10 into (?)2 

7. Convert (44)10 into (?)8 

8. Convert (43)10 into (?)16 

9. Convert(1110)2 into (?)10 

10. Convert(25)8 into (?)10 

11. Convert(2A)16 into (?)10 

12. Convert(420)8 into (?)2 

13. Convert(FF)16 into (?)2 

14. Convert(101010)2 into (?)8 

15. Convert(101110)2 into (?)16 

16. Convert(3D)16 into (?)8 

17. Convert (125)8 into (?)16 

18. Why binary numbers are used in computers. 

19. Define input device. 

20. Define output device. 

21. Write the names of two input and two output devices. 

22. What is a scanner? 

23. What is a light pen? 

24. What is a printer and printout? 

25. Distinguish between bit and byte. 
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26. Define volatile and non-volatile memory. 

27. how many bytes for 1 GB memory? 

28. Expand RAM,ROM,PROM and EAPROM 

29. Write the names auxiliary storage devices. 

30. What is cache memory? 

31. What are registers? 

32. What is software and hardware? 

33. What is computer Language? 

34. Name the three different categories of computer languages. 

35. What is machine language? Why is it required? 

36. What are advantages and disadvantages of machine language . 

37. What is assembly language? What are its advantages over machine languages? 

38. What is the difference between source program and object program? 

39. What is higher level languages? Why are higher level languages are easier to use.? 

40. What is compiler? Why is it required? 

41. What is interpreter? How does it differ from compiler? 

42. What is an utility? 

43. What is a virus? 

44. What is a worm? 

45. What is Trojan horse? 

46. What is blended threat? 

 

Long Answer Type Questions 

1. Write about the generations of computers. 

2. Explain the characteristics of computers. 

3. Explain various computers based on purpose.(3 marks) 

4. Explain various computers based on operation(3 marks) 

5. Explain various computers based on size.(6 marks) 

6. Draw the Block diagram of digital computer and explain each unit neatly. 

7. Write about number systems. 

8. Write about input devices. 

9. Write about output devices. 

10. Write about primary memory and secondary memory. 

11. Write about secondary storage devices. 

12. Write about RAM and ROM. 

13. Write about different types of software in details 
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UNIT - II 

2 Overview of Operating System  

2.1 Introduction to operating system, function and its types 

2.1.1 What is an operating system 

2.1.2 Abstract view of computer system 

2.1.3 Functions of operating system 

2.1.4 Types of operating system 

2.2 Features of DOS 

2.2.1 about DOS 

2.3 working with DOS Commands 

2.3.1 Working framework 

2.3.2 Internal Commands 

2.3.3 External Commands 

2.4 Features of Windows 

2.4.1 Introduction to Windows 7 

2.4.2 Desktop Gadgets 

2.4.3 Help and Support 

2.4.4 Differences between office 2010 and office 2007 

2.5 Components of Windows 

2.5.1 Multi-tasking 

2.5.2 File System 

2.5.3 Desktop Components 

2.5.4 Control Panel 

2.5.5 Windows Explore 

2.5.6 Device Manager 

2.5.7 File Manager 

2.5.8 Program Manager 

2.5.9 Display Properties 

2.5.10 Taskbar Properties 
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2. Overview of Operating System 

2.1 Introduction to operating system, function and its types 

 In the early days digital computer system does not have any Operating System but rather 

programs for dialing the system and using the hardware quickly appeared. In 

the mid 1960's, UNIVAC and Control Data Corporation, were Supply pretty wide tools for 

development, scheduling, and execution of jobs on batch processing systems. In the period 1960-

1962 IBM System/360 introduces a whole line of computers.It is the first operating system to 

work on different Computer System and which it is supporting the Hard disc and time sharing 

Environment. Multices was one more well recognized OS that provides the time sharing 

environment. It motivated more than a few OS’s including Unix operating systems and VMS. In 

1974 first microcomputer are introduced by Intel 8080/8085 and It is the predecessor for IBM’s 

PC DOS and MS DOS. In the 1980’s DOS dominated the Intel based PC’s and Its major 

contribution was the FAT file system. 

 Computer systems need basic system software known as an Operating System (OS) to 

work. The OS is the first software to be loaded when a computer starts up. The entire application 

programs are loaded after the OS. The process of loading operating system in main memory is 

called Booting. Whenever an application needs information it requests the OS, which in turn 

queries the System clock on the motherboard. User interacts with the computer through the OS 

then OS interprets the inputs given by a user through the Keyboard, Mouse or other input device 

and takes appropriate actions. 

2.1.1 What is an Operating System?  

The Operating System acts as an interface between the User, Application Programs, Hardware 

and the System Peripherals. The major objective of the OS is providing an environment in which 

the user can execute programs.   

Computer Hardware – Central Processing Unit, memory, Input/output devices provide basic 

computing resources. 

System and Application Programs – Assemblers, Linkers, Compilers, database systems, 

games, business programs, etc. define the ways the computing resources are used to solve 

the users' problems.  

Operating System – Controls and coordinates the computing resources among the system and 

application programs for the users.  

End User – Views the computer system as a set of applications. The End User is generally not 

concerned with various details of the hardware. 
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Fig 2.1 Abstract view of operating System 

 

2.1.2 Abstract View of Computer system 

When the user want interact with computer system, then user sends their request through 

application and system software. Such request is converted into interrupt by the operating system 

and handles the request by the hardware. Finally the operating system sends back the result in the 

same way to the end user. The following diagram expresses the interaction between user and 

hardware using operating system. 

 

Fig 2.2 hierarchal view of operating system 

Operating System objectives: 

• Convenience: An Operating System makes a computer more helpful to use. 
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• Efficiency: An Operating System allows the computer system resources to be used in an 

efficient manner. 

• Ability to evolve: An Operating system should be constructed in such a way as to allow 

the efficient development, testing, and introduction of new system functions without 

interfering with the service. 

 

2.1.3 Functions of Operating System: 

Program development: 

• The Operating System gives a mixture of facilities and services, for example editors and 

debuggers, to assist the programmer in creating programs.  

Program execution: 

Execute a program the program must be loaded into main memory. Generally a program is a 

collection of Instructions and data. A number of steps need to be performed to execute a 

program. So along with loading programs into main memory there is a need to prepared other 

services like I/O devices, files must be initialized and other resources must be prepared. 

Access to I/O devices: 

The Operating System gives a uniform interface that hides these details so that programmers can 

access such devices using simple reads and writes. Each Input Output device requires its own set 

of instructions or control signals for operation. 

Controlled access to files: 

In the multiple programming and multitasking environment, the OS may provide protection 

mechanisms to control access to For file access. The Operating System must understand the 

nature of the I/O device and the structure of the data stored in files. 

System access: 

In shared or public systems, the OS controls Theaccess of data within the files and the device is 

protected from unauthorized users and resolve the conflicts for resources. 

Error detection and response: 

A variety of errors can happen while a computer system is running.  these include internal and 

external hardware errors, for example a memory error, device failure, and various software 

errors. In each case, the OS must provide a response that clears the error condition with minimal 

effect on running applications. 

Accounting: 

A good OS will collect usage statistics for various resources and monitor performance 

parameters like  response time, waiting time and number of users within the system.. 
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Operating system goals:  

1. The primary goal of an Operating System is make the computer convenient to use.  

2.  A secondary goal is to use the computer hardware in an efficient manner. 

3. Execute user programs and make solving user problems easier. 

Major Components of Operating System and it’s functionality 

1. Process Management: 

The process is nothing but a program under execution and it is a heavy weight component. 

During executing a program operating system need to manage the following functionalities 

1. Creation and Deletion of user and system processes. 
2. Suspension and resumption of processes. 
3. Provision of mechanisms for process synchronization. 
4. Provision of mechanisms for process communication. 
5. Provision of mechanisms for deadlock handling. 
 
2. Memory Management 
Processes must be loaded into main memory to be executed. The major objective of the memory 
management is Increase system performance and Maximize memory utilization. The following 
list of functionalities managed by Operating system. 

1. Keep track of which parts of memory are being used and by what processes. 
2. Decide which processes are to be loaded into memory when memory space becomes 

available. 
3. Allocate and de-allocate memory as needed. 

 
3.File Management  
Almost everything is stored in the secondary storage. Therefore, secondary storage accesses must 
be efficient and convenient Creation and deletion of files.The following list of functionalities 
managed by Operating system. 

1. Creation and deletion of directories. 
2. The support of primitives for manipulating files and directories. 
3. Mapping of files onto secondary storage. 
4. Backup of files onto stable storage media. 

 
4. I/O Management  
 Operating system offer an abstract level of Hard ware devices and keep the details from  
applications to make certain proper use of devices, to prevent errors, and to provide users with 
convenient and efficient programming environment. The following list of functionalities 
managed by Operating system. 
 

1. Hide the details of H/W devices  
2. Manage main memory for the devices using cache, buffer, and spooling  
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3. Maintain and provide device driver interface. 
 
5 Networking  
Allow communications between computers in distributed and client server environment.. 
 
6 Protection 
Protect hardware resources, Kernel code, processes, files, and data from erroneous  programs and 
malicious programs.  
 1.7 Command Interpreter  
Command Interpreter is one of the most important system programs. Because 
almost Every OS provides `system programs, some people argue that the command interpreter is 
a part Of OS. It Allow the users to interact with the OS and Provide a convenient programming 
environment. The following list of functionalities managed by Operating system. 

1. Execute a user command by calling one or more number of underlying  system programs 
or system calls  

  Examples:  
1. Windows DOS command window  
2. Bash of Unix/Linux  
3. CSHELL of Unix/Linux  
4.  

2.1.4 Types of Operating Systems: 

1. Batch Processing Batch processing is a technique in which an Operating System collects the 

programs and Data simultaneously in a batch before processing starts. An operating system does 

the following Activities related to batch processing: 

1. The Operating System defines a job which has predefined series of commands, programs and 

data as a single unit.  

2. The Operating System keeps a number a jobs in memory and executes them without any 

manual information.  

3.  All Jobs are processed in the first come first served  order, 

4. When a job completes its execution, its memory is free and the output for the job gets copied 

into an output spool for later printing or processing.  

Advantages  

1. Batch processing takes much of the work of the operator to the computer.  

2. Improved performance as a new job get started as soon as the previous job is finished, 

without any manual intervention.  

Disadvantages  

1. Difficult to debug programs.  

2. A job could enter an infinite loop.  

3. Due to lack of protection scheme, one batch job can affect other pending jobs. 
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2. Multitasking  

Multitasking is when multiple jobs are executed by the CPU simultaneously by 

switching Between them. Switches occur so frequently that the users may interact with each 

program While it is running. An OS does the following activities related to multitasking: 

1. The user gives instructions to the operating system or to a program directly, and receives 

an immediate response.  

2. The OS handles multitasking in the way that it can handle multiple operations / executes 

multiple programs at a time.  

3. Multitasking Operating Systems are also known as Time-sharing systems.  

4. These Operating Systems were developed to provide interactive use of a computer system 

at a reasonable cost.  

5. A time-shared operating system uses the concept of CPU scheduling and 

multiprogramming to provide each user with a small portion of a time-shared CPU.  

6. Each user has at least one separate program in memory.  

 

3. Multiprogramming  

Sharing the processor, when two or more programs reside in memory at the same 

time, Is referred as multiprogramming. Multiprogramming assumes a single shared processor. 

Multiprogramming increases CPU utilization by organizing jobs so that the CPU always has one 

to execute. An OS does the following activities associated to multiprogramming.  

1. The operating system keeps several jobs in memory at a time.  

2. This set of jobs is a subset of the jobs kept in the job pool.  

3. The operating system picks and begins to execute one of the jobs in the memory.  

4. Multiprogramming operating systems monitor the state of all active programs and  

system resources using memory management programs to ensures that the CPU  is never idle, 

unless there are no jobs to process 

4.Time-Sharing Systems 

Multiprogramming systems : several programs use the computer system 

Time-sharing systems : several (human) users use the computer system interactively. 

Characteristics: 

• Using multiprogramming to handle multiple interactive jobs 

• Processor’s time is shared among multiple users 

• Multiple users simultaneously access the system through terminals 
 
Time sharing is multiprogramming. The key differences between time-sharing systems and batch 
multiprogramming systems are given in the table above 
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 Multiprogramming Time Sharing 

Principal objective Maximize processor use Minimize response time 

Source of Directives to operating 

System 

Job control language commands 

provided with the job 

Commands entered at eh 

terminal 

 
5. Real-Time Systems  

Real-time systems are usually dedicated, embedded systems. An operating system does  

the following activities related to real-time system activity.  

1. In such systems, Operating Systems typically read from and react to sensor data.  

2. The Operating system must guarantee response to events within fixed periods of  

time to ensure correct performance.  

6. Distributed Environment  

A distributed environment refers to multiple independent CPUs or processors in a computer  

system. An operating system does the following activities related to distributed environment 

1. The OS distributes computation logics among several physical processors.  

2. The processors do not share memory or a clock. Instead, each processor has its  

Own local memory.  

2.2 Features of DOS 
2.2.1 about DOS 

An Operating system is system software that acts an access interface between the User, Software 

and Hardware. For all the computers the essential basic software is known as an Operating 

System (OS) to function.  The OS is the first system software to be loaded when a computers 

turn on.  The total application programs are loaded after the OS.  Whenever an application needs 

information it needs the OS which in turn queries the PC clock on the motherboard.  User 

communicates with the computer through the OS then OS interprets inputs given by a user 

through the Keyboard, Mouse or input device and takes proper actions. 

An Operating System can be of Three Types: 

 Single User MS-Dos, MS-Win 95-98, Win-ME 

 Multi User UNIX, Linux, XENIX 

 Network Novel Netware, Win-NT, Win-2000-2003 

1. Single User: If the single user operating system is loaded in computer’s memory; the 

computer system would be able to handle one user at a time. 
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2. Multi user: If the multi-user operating system is loaded in computer’s memory; the 

computer system would be able to handle more than one user at a time. 

3. Network: If the network operating system is loaded in computer’s memory; the computer 

system would be able to handle more than one computer at time. 

 

Disk Operating System 

 
MS-DOS is abbreviation for Microsoft Disk Operating System and is usually referred to as 

DOS.  Microsoft Disk operating system (MS-DOS) is a non-graphical command line desk 

operating system derived from 86-DOS that was created for IBM compatible computers. MS-

DOS was first presented by Microsoft in August 1981 and was last updated in 1994 when MS-

DOS 6.22 was released. Now, MS-DOS is no longer used; however, the command shell, more 

usually known as the Windows command line is still used by many users.  

 
DOS is a text-based operating system.  In disparity to Windows, which has a graphical user 
interface, and uses the mouse and icons to send commands to the system, DOS commands are 
entered at the command line in text format. 
 

The major functions of DOS are to manage disk files, allocate system resources according to the 

requirement. DOS provides features necessary to control hardware devices such as Keyboard, 

Screen, Disk Devices, Printers, Modems and programs. 

 

Basically, DOS is the medium through which the user and external devices attached to the system 

communicate with the system. DOS convert the command issued by the user in the format that is 

understandable by the computer and instruct computer to work accordingly. It also converts the 

result and any error message in the format for the user to understand. 

 
 
 
DOS Boot-up Sequence: When we turn on the computer, if the systemis MSDOS based, then the 

sequence of files to be executed as follows. The process is called Booting Process. 
 
IO.SYS: A hidden file in the root directory of the primary drive. This fileoffers the basic I/O 

capabilities for the system, allowing it the ability to communicate with the different peripherals. 

IO.SYS directs the whole process of loading the Operating System. 
 
MSDOS.SYS: Also a hidden file in the root directory sometimes termedthe kernel for DOS. 

When an application wants to access a device or peripheral, this file converts the request into 

actions that IO.SYS can perform. 
 
CONFIG.SYS: A user-configurable text file that typically contains devicedrivers and system 

setup values. 
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COMMAND.COM: This is the Command Interpreter. It can takecommands from the user, 

launch programs and transfer this Information to MSDOS.SYS.
 
AUTOEXEC.BAT: Another user

load TSRs. 

Command Prompt 
 
Later Completion of booting process, the Command prompt appears. Command Prompt offers an 

entry point for typing MSDOS commands and other computer commands. The most significant 

thing to know is that by typing commands, y

Prompt is typically only used by advanced users.
 
When you’re using Command Prompt, the word command prompt also refers to the right angle 

bracket (>, also known as the greater than character) that specifies the co

can accept commands. It looks like C:

 

Where C:  denotes the Drive letter (Curent Drive)

 \ denotes the current folder / Directory

 > denotes the end of the Prompt and

 _ blinking element (represents the Curs

 

Always a cursor position decides that the current input letter from the keyboard will appear on 

that position. 

2.3 Working with DOS commands
 
2.3.1 Working Framework 
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: This is the Command Interpreter. It can takecommands from the user, 

launch programs and transfer this Information to MSDOS.SYS. 

: Another user-configurable text file that is used to setsystem variab

Later Completion of booting process, the Command prompt appears. Command Prompt offers an 

entry point for typing MSDOS commands and other computer commands. The most significant 

thing to know is that by typing commands, you can do tasks on your computer. Command 

Prompt is typically only used by advanced users. 

When you’re using Command Prompt, the word command prompt also refers to the right angle 

bracket (>, also known as the greater than character) that specifies the command line interface 

can accept commands. It looks like C:\>. 

 2.3 Home page of DOS 

denotes the Drive letter (Curent Drive) 

denotes the current folder / Directory 

denotes the end of the Prompt and 

blinking element (represents the Cursor) 

Always a cursor position decides that the current input letter from the keyboard will appear on 

2.3 Working with DOS commands 

: This is the Command Interpreter. It can takecommands from the user, 

configurable text file that is used to setsystem variables and 

Later Completion of booting process, the Command prompt appears. Command Prompt offers an 

entry point for typing MSDOS commands and other computer commands. The most significant 

ou can do tasks on your computer. Command 

When you’re using Command Prompt, the word command prompt also refers to the right angle 

mmand line interface 

 

Always a cursor position decides that the current input letter from the keyboard will appear on 
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The working framework (OS) is the primary program that must be loaded into the memory of 

your PC before you can use it for any application.  You can begin your computer with disk 

operating system (DOS) or some other operating system, for example Windows 95, 97, 98 or 

Windows NT that might be introduced in the Hard disk.  In this chapter, we should talk about the 

basic facilities available in DOS.  Switch to MS-DOS and go through most of the text given in 

this and the next two chapters.  If your PC is running under windows 95/98 or Windows NT, 

perform the following steps to switch to MS-DOS. 

• Click the start button in the taskbar and press the windows logo key to open the start 

menu then click programs in the start menu. 

• Windows displays the program submenu. 

• In the program menu click MS-DOS Prompt and your screen displays a window that 

contains MS-DOS Prompt, such as “C:\windows>_”. 

If you like you can also restart your computer in MS-DOS mode by using the following steps: 

1. Close any open programs 

2. Click the Start Button in the Task Bar or Press the Windows Logo Key to open the 

Start Menu. 

3. Click “restart in MS-DOS Mode” and then click OK. 

Wait for some time and your PC restarts in MS-DOS Mode. 

Loading Disk Operating System (DOS) 

Different version of DOS, such as 2.0, 3.0, 3.2, 4.0, 5.0, 6.0, 6.2, 6.22, 7.0, 7.2 are available.  The 

latest versions have more features and commands.  However, the basic commands and features 

are included in all versions.  You can load DOS prompt the floppy disk drive or Hard Disk 

Drive.  The process of loading the Operating System into main memory is called Booting of the 

computer.  Complete the following steps to load DOS in your PC. 

 

 

To Load DOS from Hard Disk: 

To Load DOS from the Hard Disk of your computer, follow these steps: 

1. Switch on the computer by using power ON/OFF switch of the CPU unit of your PC and 

the power ON/OFF switch is usually located in the front or the rear of the CPU unit. 

2. If your display unit (Monitor) has an ON/OFF switch, turn that switch ON too. 
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3. Do not put any Diskette is drive A: 

Wait for some time your PC perform a Self-Test and loads DOS. 

Your monitor displays “C>” or “C :\> _” and a DOS prompt message. 

To load DOS from Floppy Disk: 

If DOS is not installed on the Hard Disk of your PC, or you need to load DOS from the Floppy 

disk drive due to any reason, follow these steps: 

1. Put the DOS diskette in drive A:, Close the drive door if necessary. 

2. Switch on the computer by using the power ON/OFF switch of the CPU unit of your PC 

and the power ON/OFF switch is commonly located in the front or the rear of the CPU 

unit. 

3. If your display unit (Monitor) has an ON/OFF switch, turn that switch ON too. 

Wait for some time your PC perform a Self-Test and loads DOS. 

Your monitor displays “A>” or “A :\> _” and a DOS prompt message. 

 

Resetting the Computer: 

At some point you may need to reset your PC while it is as yet running since DOS does not 

work properly. To reset your PC you have two choices: 

1. Press and hold Ctrl and Alt keys and Press Del.  Then release all keys restarting PC 

without switching OFF the power is called Cold Booting. 

2. Press the “Reset” button that is commonly located in the front of the CPU unit.  This 

kind of Booting is called Warm Booting. 

 

System Prompt: 

On loading (or Switching to) DOS, the screen shows C :\>, C>, A :\> or a similar message.  The 

message shown by DOS is called DOS Prompt or System Prompt.  This prompt serves two 

purposes: 

1. It specifies that DOS is ready to accept a command from the keyboard. 

2. It shows the default drive name.  For instance, C>, C :\>, indicates that drive C: is a 

default drive.  DOS will use the default drive for all file operations if the user does 

not specify any drive name with commands. 
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Changing Default Drive: 

To change a default drive type the new drive letter followed by colon (:) and then press Enter.  

For instance, if the default drives is A and you type C: and press Enter, DOS selects drive C: as 

the default drive.  DOS replays this by changing the prompt to C:\> or a similar message.  If you 

enter a drive letter that does not exists in your PC, DOS displays a message “Invalid Drive 

Specification”. 

When you select a floppy drive as the default drive, ensure that there is a diskette is inserted in 

that drive. Something else DOS gives the following message: 

 “Not ready reading drive A 

 Abort, Retrieve, Fail? 

If you get this message, insert a diskette in the floppy drive and then press “r” to Retrieve. 

What is a File? 

File is a collection of text or data stored on a storage device, such as a Floppy Disk or Hard Disk.  

If you are beginner to computers, it may understand a bit difficult.  Well, a computer file is not 

much not the same from a conventional paper file that you must have used, or at least seen being 

used.  Just as you stored various types of documents (invoice, letters, reminders, memos etc.) in 

conventional files, computer files too store information.   

 

File Name  

Each file is given a name so that it can be referred to future. This name is called Filename. The 

filename in DOS can be up to eight alpha-numeric characters long. It can also have a period (.) 

followed by an extension name. The extension name specifies the type of the file. For example 

‘DOC’ may suggest that it is a document file; and ‘COM’ may suggest that is a command file.  

The extension name the up to three characters long. For instance, consider the following 

filename: 

                 mk2.txt   

                 sample.doc 

 

Here sample is a filename. While naming files, you can use the following characters in filename: 

A- Z, a- z, 0 – 9, @, #, $, %, ^, &, -, _, { },`, ~,( ) 
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You cannot use remain characters, such as comma (,) colon (:), semicolon (;), <, >, \, /, etc. in 

filename. Moreover, you cannot use space in filenames. Some examples of invalid file names 

are: 

Filename    Reason 

PSCMR 2    Contains space 

PASSENGER   Contains more than eight characters 

MY, dATA    Contains commas 

CHAP_01.DOC3   Extension name contains more than 3 characters 

When you are specify a file name more than eight characters in the filename or more than three 

characters in the extension name, DOS may automatically truncate the filename by removing 

extra characters. Further, some file names, such as COM 1, COM 2, LPT1, com and PRN are 

fixed by DOS for its own use. Therefore, do not use these names to name your file.  

WHAT IS A Directory? 

The storage capacity of the hard disk is commonly quite large (10 MB to a few GB). You can 

store bulk of files in your hard disk. Even the capacity of a floppy disk is large enough to store 

many files. A directory is nothing but a named section of a storage device, such as hard disk, 

floppy disk. In other words, to organize file on hard disk or floppy disk, these are divided into 

various sections called directories. You can store any number of files in each directory. The 

directory helps to maintain your file in an efficient manner. Using directories in a storage device 

is belongs to saving different types of files in an office in individual drawers of a filing cabinet. 

For example, ABC Company may keep all sales files in the first drawer, all purchase files in the 

second drawer and all employees’ files in the third drawer of a filing cabinet. In the same way, 

when XYZ Company computerizes its operation, it may store all sales files in the SALES 

directory, all purchase files in the PURCHASE directory and all employees’ files in the 

EMPOLYEES directory. In the same way, the user Krishna may keep his personal files in the 

Krishna directory and the secretary of XYZ Company may store the letters in the LETTERS or 

DOC directory.  
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DOS always creates a root directory in each device. You can create new directories in the root 

directory of the hard disk or floppy disk. You can store files in these directories. Moreover, 

beside files, each directory can also have directories and files. Those, the file and directory 

organization in DOS looks like the roots of a tree, as show in above figure. 

Here, the root directory in drive C contains few files and two directories – WORD and EXCEL. 

The WORD directory contains a few files as well as a directory TEN. Occasionally, the second 

level directory (TEN in this case) is called sub-directory. The root directory contains another 

directory – EXCEL. This directory contains a few files as well as two directories – PURCHASE 

and ITEMS. Both these directories contain files. 

Pathname 

You can denote to any file in any directory on the system by using its pathname. A pathname is 
a group of characters that defines what directory the file is in, as well as the name of the file. The 
full path always starts from the ROOT directory.  The ROOT directory is the top directory in a 
file system. 
 
The pathname of a file in the current working directory is just the name of the file by itself.  
Files and directories that are in a different directory than the current working directory can be 
mentioned to using: 
 

1. An absolute pathname describes another directory in a way that does not depend on 
where you are. The absolute pathname is always the same, regardless of your working 
directory. 

Dirve C 

<root directory> 

 

 

Files:    Diretory   Directory 

     <word>   <excel> 
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2. A relative pathname describes another other file or directory's location relative to the 
current working directory.   The relative path changes depending on where you are in the 
directory tree. 

 
There are two types of commands in MSDOS. They are internal and external 

commands. 

2.3.2 Internal Commands 
 
The internal commands reside in COMMAND.COM, which loads into memory 

when the computer system is turned on; these commands do not reside on disk. 

Commands are executed from the MS-DOS prompt only. (?)is used to know the 

description of any command followed by the command. Ex: dir/? Displays the 

syntax of directory command. 

Here some internal commands as follows 
 
 

Common Micro Soft-DOS Commands 

Command Description Usage 

dir Lists all files in current directory Command: C:\>dir 

Result: 

List of directories 

Homework, Personal, Work 

and the file info.doc 

md Makes a new directory in the 

directory specified in the command, 

or in the current working directory if 

none other is specified  

Command:  

md <directory name> 

 

cd Changes the current directory to the 

one specified. 

Command: 

C:\>cd <directory name> 

cd .. The command changes the directory 

to the parent directory of the current 

directory. 

Command:  

cd .. 

 

cd \ The command changes to the root 

directory of the current drive. 

Command:  cd \ 

 

move This command moves files or 

directories from the original directory 

specified to the new directory. 

To move a file or files, you specify 

the name and location of the file or 

files you want to move followed by 

the destination.  

Examples: 

move 

<source><destination> 
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copy This command copies files from one 

location to another. 

Command: 

copy 

<source><destination> 

rename Changes the name under which files 

and/or directories are stored. 

Command: 

rename <original 

name><new name> 

rd Removes (deletes) a directory. 

 

Note: to remove a directory, 

directory must be empty.  You must 

delete all files and subdirectories in 

order to delete a parent directory. 

Command:   

rd<directory name> 

del Used to delete files. If a directory 

name is given in the command, all 

files in the directory are deleted. 

Command: 

del <file/directory name> 

 

* Wildcard character, a special symbol 

that stands for one or more 

characters.  Operating systems care 

the use of wild cards for identifying 

Files and Directories. 

Usage: 

M* searches for all files and 

directories that start with 

the letter M. 

 

edit Command used to run the DOS Text 

Editor program. 

Command: edit 

exit Closes the DOS window Command: exit 

 

CLS CLS is a command that allows a user to 

clear the complete contentsof the screen 

and leave only a prompt 

Command:cls 

 
DATE Display the current date and prompt 

for a new one. If no date is entered, 

the current date will be kept. 

Command: date 

TIME Allows the user to view and edit the 

computer’s time(system time). 

Command: time 

VER It displays the version of MSDOS Command: ver 

REN Used to rename files and directories from 

the original name to a newname 

Command: ren 

TYPE 
 
Displays the contents of text files. 

 

Command: type 
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2.3.3 External Commands 
 
The external commands are files that do reside on disk and have an extension of 

.COM, .EXE, or .BAT. 
 
Format : Format is used to delete information off of a computer diskette orfixed 

drive. 

The syntax of format command as follows. 
 
FORMAT volume [/FS:file-system] [/V:label] [/Q] [/A:size] [/C] [/X] 
 
FORMAT volume [/V:label] [/Q] [/F:size] 
 
FORMAT volume [/V:label] [/Q] [/T:tracks /N:sectors] 
FORMAT volume [/V:label] [/Q] [/1] [/4] 
FORMAT volume [/Q] [/1] [/4] [/8] 
 
Volume 

  
Specifies the drive letter (followed by a colon), mount 

point, or volume name. 
 

/FS:filesystem 
 
States the file system (FAT, FAT32, or NTFS). 
 

/V:label 
 
Specifies the volume label. 
 

/Q 
 
Does a quick format. 
 

/C 
 
Files created on the new volume will be compressed by 
default. 
 

/X 
 
Forces the volume to dismount first if needed. All 

opened handles to the volume would no longer be 

valid.
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Examples 
 
When using the format command, remember all information on the drive you wish 

to format will be completely erased. 
 
format a: 
 
Would erase all the contents off a disk. Commonly used on a diskette that has not 

been formatted or on a diskette you wish to erase. 
 
format a: /q 
 
Quickly erases all the contents of a floppy diskette. Commonly used to quickly erase 

all information on the diskette. 
 
format c: 
This would erase the contents of your C: hard disk drive. In other words, unless you 

wish to erase all your computer’s information, this command should not be done 

unless you’re planning to start over. 
 
FDISK: Fdisk is used to delete and create partitions on the harddiskdrivein earlier 

versions of MS-DOS and Windows. 

 

Syntax 
 
FDISK [/STATUS] /X 
 
/Status Displays partition information 
 
/X Ignores extended disk-access support (will not use LBAsupport). Use this switch 

if you receive one of the below symptoms 
 
Unable to access a drive from DOS versions prior to 7 
 
Disk access messages. 
 
Stack overflow messages 
 
High amounts of data corruption 
 
Extra drive letters 
 
 

2.4 Features of Windows 
 
2.4.1 Introduction to Windows 7?  
 
 
 
 

 

Windows 7 is the latest version of a series of Operating Systems that Microsoft has released for 

use on personal computers. It is the follow-up to the Windows Vista Operating System which 

was launched in 2006. An operating system allows your computer to manage software and 
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perform necessary tasks. It is also a Graphical User Interface that allows you to visually 

interact with your computer’s functions in a logical, fun and easy way. 
 
For instance, in Windows 7 you can view two windows side by side by using the 

Aero Snap feature.  
 
 
 
 
 
 
 
 
 
 
 
Fig 2.4 Two Windows Overlapping 

 

This feature automatically sizes or snaps two windows to fit together on the screen 

and allowing you to viewing them next to each other. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig 2.5 Aero Snap View 
 
What Can You Do on Windows 7?  
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Paper I Computer Fundamentals and MS-Office 

58 

 

 

Fig 2.6Aero Flip 3D 
 
Aero 
 
Sort over open windows with Aero Flip 3D. 
 
Aero is an interface that creates your visual interactions with the desktopfun and easy. 

Aero Peek creates your open windows transparent. So you may seeyou’re desktop. It 

also permits you to peek at items in your taskbar for a thumbnail preview. 
 
Aero Snap is a fast way to resize your windows to make them easierto read, compare and 

organize. 

Aero Flip permits you to preview all your open windows from a centralwindow or 

3D view that you can flip through. 
 
Aero Shake allows you to take your mouse and shake only the openwindow you 

need to focus on and the rest will disappear. 
 
Taskbar  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig 2.7 Taskbar 
 
Get instant access with Jump List 
 
The taskbar is now more useful to use with larger views and easier access. 
 
Jump Lists permit you to right click on an icon in the taskbar andquickly access 

items like music, videos or web pages that you use on a regular basis. 
 
Pin allows you to place programs on the taskbar and readjust theorder of the icons as 

you wish. 
 
Action Centerallows you to control the alerts and pop-ups you receiveregarding 

maintenance and security.Search Find documents fast with the new Search  
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Fig 2.8 Search Bar 
 
Once you start typing in the Search bar of the Start Menu you will immediately see 

a list of relevant options collected by categories with highlighted keywords and text. 

This allows you to simply scan for the documents, music, pictures and email you are 

looking for. 
 
2.4.2 Desktop Gadgets   
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig 2.9 Desktop Gadgets 
 
Windows holds mini-programs called gadgets, which suggest information at a glance 

and provide simple access to frequently used tools. For instance, you can use gadgets 

to display a picture slide show, view continuously updated headlines, or look up 

contacts. 
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Why use desktop gadgets? 
 
Desktop gadgets can store information and tools readily available for you. For 

instance, you can display news headlines right next to your open programs. This 

way, if you need to store track of what’s happening in the news while you work, you 

don’t have to stop what you’re perform to switch to a news website. 
 
You can use the Feed Headlines gadget to display the latest news headlines from 

sources you select. You don’t have to stop working on your document, because the 

headlines are continuously visible. If you see a headline that interests you, you can 

click that headline, and your web browser will open directly to the story. 
 
Getting started with gadgets 
 
To know how to use gadgets, let’s explore three gadgets: the Clock, Slide Show, and 

Feed Headlines. 
 
How does the Clock work? 
 
When you right-click the Clock, you’ll see a list of tasks that what you can do with 

the gadget, including closing the Clock, keeping it on top of your open windows, and 

modifying the Clock’s options such as its name, time zone, time format and 

appearance. 
 
You can right-click a gadget to see a list of tasks you can do with it. 
 
Tip 
 
If you point to the Clock gadget, a Close button and an Options button will present 

near its upper-right corner. 
 

• Right-click Slide Show and click Options. 

• In the Show each picture list, choose the number of seconds to show each 

picture. 

• In the Transition among pictures list, select the transition you want and click 
OK. 

• Right-click Feed Headlines and click Options. 

• In the Display this feed list, click the feed you want to display and click OK  
Adding and removing gadgets 
 
You can add any gadget by installed on your computer to the desktop. If you need, 

you can add multiple instances of a gadget. For instance, if you are storing track of 

time in two time zones, you can add two instances of the Clock gadget and set the 

time of each accordingly. 
 
Right-click the gadget and then click Close Gadget. 
 
Organizing gadgets 
 
You can drag a gadget to a new position anyplace on the desktop. 
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2.4.3 Help and support 
 
At one point, you’re likely to run into a computer problem or confusing task. To 

figure it out, you’ll essential to know how to get the right help. This article delivers 

an summary of the best techniques. 
 
Windows Help and Support is the predefined help system for Windows. It’s a place 

to get fast answers to common questions, suggestions for troubleshooting, and 

instructions for how to do works. If you want help with a program that’s not part of 

Windows, you’ll want to consult that program’s Help (see “Getting help with a 

program” below).   
To open Windows Help and Support, click the Start button then click 

Help and Support. 

  
, and 

 

Get the latest Help content 
 
If you’re connected to the Internet, make sure Windows Help and Support is set to 

Online Help. Online Help contains new Help topics and the newest versions of 

existing topics. 
 

• On the toolbar in Windows Help and Support, click Options, and then choose 

Settings. 
 

• Under Search results, choose the Improve my search results by using online 

instruction check box, and then click OK. The words Online Help will be 

displayed in the lower-right corner of the Help and Support window when 

you are connected. 
 
Search Help 
 
The fastest way to get help is to type a word or two in the search box. For instance, 

to get information about wireless networking, type gadgets, and then 
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press Enter. A list of results seems, with the most useful results shown at the top. 

Click on the results to read the topic.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig 2.10 Search Help 
 
Tip 
 

• You can also access Help by pressing F1. This function key opens Help in 

almost any program. 

2.4.4 The difference between Office 2010 and Office 2007 

Here we look at the new MS Office 2010 Features and Functions. 

The Ribbon interface has been extended to all applications in Office, most notably Outlook and 
OneNote. Users now have the ability to customise the Ribbon. 

The Office button in 2007 has been replaced by a File Menu icon. 

Main features of Office 2010: 

1. New picture formatting tools like artistic effects and colour saturation in Word 2010 and 
PowerPoint 2010 give you more power to express your ideas visually. 

2. Co-Authoring documents in real time in Word, PowerPoint, One note, and Excel Web 
App. Note SharePoint workspace or a windows live account is required. 

3. Excel 2010 has a newly introduced Slicers feature for Pivot tables allowing you to filter 
data on the fly.  

4. In addition, Excel's new Sparkline’s feature allows you view trends in data by adding an 
additional column right alongside your data, containing the graphs in each cell: 
PowerPoint 2010 has the ability to edit and customize videos, you can trim, add fades and 
bookmark points in your video. In addition you can record a presentation as a video and 
save it’s as a Windows Media filed. 

5. PowerPoint 2010 allows you to broadcast a presentation over the internet. The recipients 
of the broadcast can view the presentation in a Web browser and do not need to have 
PowerPoint installed. 
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6. Outlook 2010 provides you with a new conversation view which allows you to group e-
mail replies from a single message into a single mail item. The new quick steps feature in 
Outlook helps you manage your e-mails more effectively by allowing you to customise 
actions for certain e-mails you choose. 

7. Outlook 2010 allows you to import contacts from social networks such as Facebook or 
LinkedIn. 

8. The new file menu icon exposes the new backstage view which permeates every 
application. The backstage view not only deals with printing and saving but has options 
for sharing, versioning, protection and removing metadata. 

9. The new backstage view allows you not only to save to local or network PC's but you can 
save a document to Share point or Windows SkyDrive. (Note in the latter case a windows 
live account is required). 

10. A new Power pivot adds in is available for Excel 2010. Power pivot allows you analyse 
large volumes of data from a SQL server database. 

11. Access 2010 ships with the following new features: web based databases, Application 
parts, Quick start fields, conditional formatting and Navigation form controls. 

2.5 Components of Windows 
 
Introduction 
 
In this chapter we discuss the about multitasking, windows explorer, program and file manager, 

control panel, file system, desktop components, device manager, etc., 
 
2.5.1 Multitasking  
 
Multitasking allows the user to perform more than one task at a time. For instance, work on a 

document file in MSWORD programs, while editing data automatically the beginning character 

convert into Capitalization and in the same time spell checking is done. Another example for 

multitask is while playing games along visual effects audio and score counting is done at a time. 

With Windows 10 operating system, the user can do more than one task a time. 
 
2.5.2 File system 
 
File system uses to perform files and folder in a systematic manner. The following operations are 

performed in file systems. They are creating, copying, moving, saving, opening, finding, 

renaming, deleting of files or folders. 
 
Working with files and folders 
 
A file is an item that consist information—for example, text or images or music. When opened, a 

file can look very much like a text document or a picture that you might find on someone’s desk 

or in a filing cabinet. On your computer, files are represented with icons;(icon is a small picture 

that represents file, folder, program or other object or function) this makes it easy to recognize a 

type of file by looking at its icon. Here is an icon: 
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A folder is a container you can use to store files and sub folders in. If you had thousands of paper 

files on your desk, it would be nearly difficult to find any particular file when you wanted it. 

That’s why people often store paper files in folders inside a filing cabinet. On your computer, 

folders work the same way. Here are some typical folder icons: 

 

 
An empty folder (left); a folder containing files (right) 
 
Folders can also store other folders. A folder within a folder is usually called a subfolder. You 

can create any number of subfolders, and each can hold any number of files and additional 

subfolders. 
 
Using libraries to access your files and folders 
 
When it comes to getting organized, you don’t need to start from scratch. You can use libraries a 

feature new to this version of Windows, to access your files and folders, and arrange them in 

different ways. Here’s a list of the four default libraries and what they’re typically used for: 
 
Documents library. Use this library to organize and arrange word-processing documents, 

spreadsheets, presentations, and other text-related files. 
 
Pictures library. Use this library to organize and arrange your digitalpictures, whether you get 

them from your camera, scanner, or in e mail from other people. 
 
Music library. Use this library to organize and arrange your digitalmusic, such as songs that you 

rip from an audio CD or that you download from the Internet. 
 
Videos library. Use this library to organize and arrange your videos,such as clips from your 

digital camera or camcorder, or video files that you download from the Internet. 

To open the Documents, Pictures, or Music libraries, click the Start button , and then click 

Documents, Pictures, or Music. 
 
Viewing and arranging files and folders 
 
When you open a folder or library, you can change how the files look in the window. For 

example, you might prefer larger (or smaller) icons or a view that lets you see different kinds of 

information about each file. To make these kinds of changes, use the Views button in the toolbar.  
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Fig 2.11 Arranging Files and Folders 
 
Each time you click the left side of the Views button, it changes the way your files and folders are 

displayed by cycling through five different views: Large Icons, List, a view called Details that 

shows several columns of information about the file, a smaller icon view called Tiles, and a view 

called Content that shows some of the content from within the file. 
 
Finding files 
 
Depending on how many files you have and how they are organized, finding a file might mean 

browsing through hundreds of files and subfolders—not an easy task. To save time and effort, use 

the search box to find your file. 
 
 
 
 
 
 
 
 
Fig 2.12 Finding Files 
The search box is located at the top of every window. To find a file, open the folder or library that 

makes the most sense as a starting point for your search, click the search box, and start typing. 

The search box filters the current view based on the text that you type. Files are displayed as 

search results if your search term matches the file’s name, tags or other properties, or even the 

text inside a text document. 
 
Copying and moving files and folders 
 
Occasionally, you might want to change where files are stored on your computer. You might 

want to move files to a different folder, for example, or copy them to CDs or memory cards. 
 
Copying 
 

• Select the folder to be copied, 

• Click on Copy 

• Move the pointer(cursor) to the desired location to where you want 

• Click on Paste 
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Moving 
 

• Select the folder to be copied, 

• Click on Cut 

• Move the pointer(cursor) to the desired location to where you want 

• Click on Paste 
 
Most people copy and move files using a method called drag and drop. Start by opening the 

folder that contains the file or folder you want to move. Then, open the folder where you want to 

move it to in a different window. Position the windows side by side on the desktop so that you 

can see the contents of both. 
 
Creating and deleting files 
 
The most common way to create new files is by using a program. For example, you can create a 

text document in a word-processing program or a movie file in a video-editing program. 
 
Saving After creation of a file , it has to be saved for need in the future.  
 
When you are ready to save your work, click the Save button. In the dialog box that appears, 
type a file name that will help you find the file again in the future, and then click Save. 
 
By default, most programs save files in common folders like My Documents and My Pictures, 

which makes it easy to find the files again next time. You can also save your files in the desired 

location. 
 
Deleting 
 
When you no longer need a file, you can remove it from your computer to save space and to keep 

your computer from getting cluttered with unwanted files. To delete a file, open the folder or 

library that contains the file, and then select the file. Press Delete on your keyboard and then, in 

the Delete File dialog box, click Yes. 
 
When you delete a file, it’s temporarily stored in the Recycle Bin. Think of the Recycle Bin as a 

safety net that allows you to recover files or folders that you might have accidentally deleted. 
 
Opening an existing file 
 
To open a file, double-click it. The file will usually open in the program that you used to create or 

change it. For example, a text file will open in your word-processing program. 
 
That’s not always the case, though. Double-clicking a picture file, for example, will usually open 

a picture viewer. To change the picture, you need to use a different program. Right-click the file, 

click Open with, and then click the name of the program that you want to use.  
2.5.3 The Desktop Components (Overview) 
 
The desktop is the main screen area that you see after you turn on your computer and log on to 

Windows. Like the top of an actual desk, it serves as a surface for your work. When you open 

programs or folders, they appear on the desktop. You can also put things on the desktop, such as 

files and folders, and arrange them however you want. 
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The desktop is sometimes defined more broadly to include the taskbar. The taskbar sits at the 

bottom of your screen. It shows you which programs are running and allows you to switch 

between them. It also contains the Start 
 

button  , which you can use to access programs, folders, and computer settings. 
Working with desktop icons 
 
Icons are small pictures that represent files, folders, programs, and other items. When you first 

start Windows, you’ll s ee at least one icon on your desktop: The Recycle Bin (more on that 

later). Your computer manufacturer might have added other icons to the desktop. Some examples 

of desktop icons are shown below. 
 
Examples of desktop icons  
 
 
 
 
 
 
 
 
 
 
 
Fig 2.13 Desktop Icons 
 
Double-clicking a desktop icon starts or opens the item it represents. 
 
Adding and removing icons from the desktop 
 
You can choose which icons appear on the desktop—you can add or remove an icon at any time. 

Some people like a clean, uncluttered desktop with few or no icons. Others place dozens of icons 

on their desktop to give them quick access to frequently used programs, files, and folders. 
 
If you want easy access from the desktop to your favorite files or programs, you can create 

shortcuts to them. A shortcut is an icon that represents a link to an item, rather than the item 

itself. When you double-click a shortcut, the item opens. If you delete a shortcut, only the 

shortcut is removed, not the original item. You can identify shortcuts by the arrow on their icon. 
 
 
 
 
 
 
 
 
 
 

 

Fig 2.10 A file icon(left) and a shortcut icon(right) 
 
A file icon (left) and a shortcut icon (right) 
Right-click the icon, and then click Delete. If the icon is a shortcut, only the shortcut is removed; 

the original item is not deleted. 
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Moving icons around 
 
Windows stacks icons in columns on the left side of the desktop. But you’re not stuck with that 

arrangement. You can move an icon by dragging it to a new place on the desktop. 
 
You can also have Windows automatically arrange your icons. Right-click an empty area of the 

desktop, click View, and then click Auto arrange icons. Windows stacks your icons in the upper-

left corner and locks them in place. To unlock the icons so that you can move them again, click 

Auto arrange icons again, clearing the check mark next to it. 
 
Selecting multiple icons 
 
To move or delete a bunch of icons at once, you must first select all of them. Click an empty area 

of the desktop and drag the mouse. Surround the icons that you want to select with the rectangle 

that appears. Then release the mouse button. Now you can drag the icons as a group or delete 

them.  
 
 
 
 
 
 
 
 
 
 
 
Fig 2.14 Selecting Multiple Icons 
 
Select multiple desktop icons by dragging a rectangle around them 
 
Hiding desktop icons 
 
If you want to temporarily hide all of your desktop icons without actually removing them, right-

click an empty part of the desktop, click View, and then click Show desktop items to clear the 

check mark from that option. Now no icons are displayed on the desktop. You can get them back 

by clicking Show desktop items again. 
 
The Recycle Bin 
 
When you delete a file or folder, it doesn’t actually get deleted right away— it goes to the 

Recycle Bin. That’s a good thing, because if you ever change your mind and decide you need a 

deleted file, you can get it back. 
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Fig 2.12 The Recycle Bin when full (left) and empty (right) 
 
If you’re sure that you won’t need the deleted items again, you can empty the Recycle Bin. Doing 

that will permanently delete the items and reclaim any disk space they were using. 
 
2.5.4 Control Panel 
 
You can use Control Panel to change settings for Windows. These settings control nearly 

everything about how Windows looks and works, and they allow you to set up Windows so that 

it’s just right for you.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig 2.15 Control Panel 
 
 

 

2.5.5 Windows Explorer  

It is also referred as File Explorer or Windows Explorer, Explorer.Explorer is a file browser 

found in every type of Microsoft Windows since Windows 95. It is used to navigate and manage 

the drives, folders, and files on your computer. 

Open Windows Explorer 

There are a number of ways to open a new Explorer window, which vary a little depending on 

which version of Windows you are running. 

In all versions of Windows: 

• Press Win + E (hold down the Windows key and press E), or 
• Click Start and select Run (or press Win + R), then type explorer or explorer.exe and 

press Enter. 

In Windows 10: 

• Press the Win + X to open the Power User Tasks Menu, then select File Explorer(or 
press E), or 
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• Click Start, select Programs, select Accessories, then Windows Explorer or Explorer. 

In Windows 8 and 8.1: 

• Right-click the bottom-left corner of the screen to open the Power User Tasks Menu and 
choose File Explorer (or press E). 

In Windows 7 and earlier versions: 

• Right-click the Start button and select Explorer or Open Windows Explorer. 

Instances of how Windows Explorer could be used 

Below are instances of what can be done in Explorer. 

Open a document 

Microsoft has made it easier to find your documents in Windows by creating a My 

Documents folder. When in Explorer, you can open My Documents and double-click the 

document file to open the document. 

Open a program 

Although most programs create a shortcut to programs in the Start Menu or Start Screen after it 

has been installed, you can also open a program through Explorer. To open a program in 

Explorer, browse to the Program Files folder by opening the C: drive and then double-clicking 

the Program Files folder. In the listing of folders, find the program you want to open and double-

click its folder. Finally, once in the program folder, find the executable file and double-click that 

file to run the program. Since file extensions are disabled by default, you can determine an 

executable by looking for a file with the same name of the program or that has an icon 

representing the program. 

Search for a file or folder 

Within the Search tab you can find files or folders on your computers. Press the F3shortcut key 

to open search at any time while in Windows Explorer. 

Other system tasks and functions 

Using Windows Explorer, you can also perform any of the system tasks listed below: 
• Copy a file 
• Move a file 
• Rename a file or folder 
• Delete a file or folder 
• Create a shortcut 
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2.5.6 Device Manager 
 
Using Device Manager, you can view and update the device drivers installed on your 

computer, check to see if hardware is working properly, and modify hardware 

settings.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig 2.16 Device Manager 
 
If you are prompted for an administrator password or confirmation, type the 

password or provide confirmation. 
 
Note 
 
Here’s another way to open Device Manager: Click the Start button 
 

. In the search box, type Device Manager, and then, in the list of results, click 
Device Manager.  

2.5.7 File Manager 

File manager may refer to any of the following: 

1. A file manager is a software program that helps a user manage all the files on their computer. 

For example, all file managers allow the user to view, edit, copy, and delete the files on their 

computer. 

Tip: With recent versions of Microsoft Windows, Windows Explorer (Explorer) is considered 

the default file manager. With Apple computers, Finder is considered the default file manager. 

Note: Although a file manager helps the user view and manager their files it is actually 

the operating system that is responsible for accessing and storing the files on a storage device. 
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2. When referring to Microsoft Windows 3.x, File Manager is a program included 

with Windows 3.x that enabled users to manage their files on the computer. File Manager was 

replaced with Explorer and the My Computer organizational metaphor in Windows 95 
2.5.8 Program Manager  

Program Manager is the main window of Microsoft Windows that permits users to execute 

each program on their computer. Users familiar with later versions of Microsoft Windows, such 

as Windows 98, can think of program manager as the Desktop of Windows 3.x. below is an 

example of how the Program Manager appeared in Windows 3.1. 

 

Fig 2.17 program manager 

Program manager is quiet available in all versions of Microsoft Windows. Users running 

Windows 95, 98, NT, 2000, or XP can open it by clicking Start, Run, and typing "program" and 

clicking ok. The file is known as progman.exe and is located in the root directory of Windows; 

deleting this file can cause problems with your computer. 

Creating program manager Icon 

in, such as main (you can tell that it is selected because the top blue bar will be blue). Once the 

group has been selected, click File, New, and select Program Item. 

For the description, you fill in what you want your icon to be named; for example, Notepad. 

Where it says command line, this is where you are going to specify where the file is; so if you 

were creating a shortcut for Notepad, you would need to put in c:\windows\notepad.exe. If you 



 

 

Paper I Computer Fundamentals and MS-Office 

73 

 

do not know the path to your program, use the Browse button. Once the information is 

completed, click ok. 

Creating a group in Program Manager 

Within Program Manager click File, New, and select program group.Once the Program Group 

Properties window opens type the new name for the group. For example, "Games" is a good 

example of what a group could be. 

2.5.9 Display properties 

Setting Monitor Display Properties 

It is easy to modify the look and feel of your computer by altering the display settings of your 
monitor. Changing these properties lets you set the background of the desktop, screen savers, 
sound schemes and more.  

To do this 

• Right-click anywhere on your desktop (except on an icon or shortcut) and select 
“Personalize” from the menu that appears. That will open a window that allows you to 
change the display properties of the monitor. 

• You can click the “Window Color” hyperlink (“Window Color and Appearance” 
hyperlink in Windows Vista) to select a color scheme to use for Windows.  

• If your PC is capable of enabling transparency, then you can check the “Enable 
transparency” hyperlink to enable transparent window display in Windows.  

• You can also use the “Color intensity:” slider to set the intensity of color selected. When 
you are finished, you can click the “Save Changes” button (“OK” button in Windows 
Vista) to apply the changes to the color scheme. 

You can click the “Desktop Background” hyperlink to display a window where you can select a 
background image or video for your Windows desktop. You can select a choice from the 
“Picture location” drop-down (“Location” drop-down in Windows Vista) to select from the video 
or pictures shown. You can also click the “Browse…” button to open a “Browse” window where 
you can navigate to the video file or image that you want to use as the background. You can then 
select it, and click the “Open” button to use the selected image or video clip as your Windows 
background. At the bottom of the window, you can select the desired option to choose how to 
position the picture or video. When you are done, you can click the “Save Changes” button 
(“OK” button in Windows Vista) to apply the background. 

Setting screen saver 

You can click the “Screen Saver” hyperlink to open the “Screen Saver Settings” window. A 
screen saver is an animated graphic created so that the desktop image displayed on a computer 
screen will not burn into the monitor permanently due to constant, unchanging display onscreen. 
Use the “Screen saver” drop-down to pick the screen saver you want and then click the 
“Preview” button to see how it looks. Hit the “Esc” button on your keyboard, or move your 
mouse, to stop the preview and return to the “Screen Saver” tab. The screen saver that is 
currently selected can be adjusted by clicking the “Settings…” button. Depending on the screen 
saver selected, the options of what you can change (if any) will be different. Make any selections 
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you would like in the settings dialog box and then click “OK” to return to the “Screen Saver” 
tab. In the “Wait:” box, you can set the number of minutes that the computer is inactive before 
the “Screen saver” starts. If the check box “On resume, display logon screen” is selected, the 
user’s login password will be required to return to the desktop after the screen saver has been 
activated. 

When you are finished using the “Personalize” dialog box, you can then close the window by 
clicking the “X” in the upper right corner of the window. 

 

2.5.10 The Taskbar  
 
The taskbar is the long horizontal bar at the bottom of your screen. Unlike the desktop, which can 

get obscured by open windows, the taskbar is almost always visible. It has three main sections:  

1. The Start button  , which opens the Start menu.  
2. The middle section, which shows you which programs and files you have open and allows 

you to quickly switch between them. 
 

3. The notification, which includes a clock and icons (small pictures) that communicate the 
status of certain programs and computer settings.  

a. Start menu  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig 2.18 Start Menu 
 
b. Middle section 
 
You’re likely to use the middle section of the taskbar the most, so let’s look at it first. 
 
If you open more than one program or file at a time, you can quickly start piling up open 

windows on your desktop. Because windows often cover each other or take up the whole screen, 

it’s sometimes hard to see what else is underneath or remember what you’ve already opened.  
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Fig 2.19 Each program has its own button on the taskbar 
 
Click a taskbar button to switch to that window 
That’s where the taskbar comes in handy. Whenever you open a program, folder, or file, 

Windows creates a corresponding button on the taskbar. The button shows an icon that represents 

the open program. In the picture below, two files are opened in ms word named “2.5 

multitasking” and one more file “the taskbar”. 
 
Minimize and restore windows 
 
When a window is active (its taskbar button is highlighted), clicking its taskbar button minimizes 

the window. That means that the window disappears from the desktop. Minimizing a window 

doesn’t close it or delete its contents— it temporarily removes it from the desktop. 
 
c. The Notification Area 
 
The notification area, on the far right side of the taskbar, includes a clock and a 

group of icons. It looks like this.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig 2.20 Notification Area 
 
These icons communicate the status of something on your computer or provide access to certain 

settings. The set of icons you see depends on which programs or services you have installed and 

how your computer manufacturer set up your computer. 
 
When you move your pointer to a particular icon, you will see that icon’s name or the status of a 

setting. For example, pointing to the volume icon shows the current volume level of your 

computer. Pointing to the network icon displays information about whether you are connected to 

a network, the connection speed, and the signal strength. 
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Double-clicking an icon in the notification area usually opens the program or setting associated 

with it. For example, double-clicking the volume icon opensthe volume controls. Double-clicking 

the network icon opens Network and Sharing Center. 
 
To reduce clutter, Windows hides icons in the notification area when you haven’t used them in a 

while. If icons become hidden, click the Show hidden icons button to temporarily display the 

hidden icons.Click the Show hidden icons button to display all icons in the notification area 
 
Customize the Taskbar 
 
There are many ways to customize the taskbar to suit your preferences. For example, you can 

move the entire taskbar to the left, right, or top edge of the screen. You can make the taskbar 

larger, have Windows automatically hide it when you’re not using it, and add toolbars to it. 

 
 

Summary 

Operating system can be treated as Master mind as it performs many functions. It provides 

Booting without an Operating System. It allows us to increase the Logical Memory. For this the 

Physical Memory of the Computer System can be used. It also provides different Types of 

Formats like NTFS and FAT File Systems. An Operating System is also responsible for 

controlling the Errors those have been occurred in the Program. It also helps with system 

recovery when the System gets Damaged i.e., due to Some Hardware Failure or if System 

doesn’t Works properly. It also rectifies the system errors and provides us the Backup Facility. 

Every large program is divided into smaller programs by operating system called 

‘Threads’.These threads are executed one by one. 

Today, many computer users are only familiar with Graphical user interface (i.e., tasks are done 

using mouse and virtual icons provided on the screen) of Microsoft Windows. MS-DOS is a 

command user interface in which commands are used for performing tasks. For example, in 

windows double click is done to open the folder and see the files in it. In MS-DOS “cd (space) 

dirname” is used to display list of files in a directory. Where dirname is nothing but directory 

name. 

Before Windows has been introduced users used to operate MSDOS. But Nowadays MSDOS 

operating system is used rarely. Everybody is familiar with Windows because it is Graphical 

User Interface (GUI), where as in MS-DOS user has to remember the commands. There are 

many commands both internal and external. Here we cannot explain all the commands. But there 

is a facility to know about any command by using? Followed by particular command. 

 

Windows 7 introduces aero, gadgets etc in latest versions 

 

The following editions of Windows 7 include Aero: 

 

Windows 7 Enterprise 
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Windows 7 Home Premium Windows 7 Professional 

Windows 7 Ultimate 

 

Aero is not included in Windows 7 Home Basic or Windows 7 Starter. You can find out current 

edition of Windows on which you are working by opening System in Control Panel. 

 

The difference between Copy and Move is When you make a copy a file it will be available both 

at source as well as in the destination, whereas when you make a move the file is only in the 

destination and no more it is available in the in the source place. 

 

 

Model Questions 

 

Short Answer Types Questions 

1. Define an operating system. 

2. What is GUI? 

3. What is CUI? 

4. Expand GUI, CUI, BIOS and MSDOS. 

5. What are the main functions of DOS? 

6. What is an internal command? 

7. What is an external command? 

8. What is an aero? 

9. What is search bar? 

10. What is gadget? 

11. What is help and support in windows? 

12. What is multitasking? 

13. What is file system? 

14. What are four default libraries in library? 

15. What is an icon? 

16. What is a folder? 

17. What is desktop? 

18. What is recycle bin? 

19. What is control panel? 

20. What is device manager? 

21. What is notification area in taskbar? 
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Long Answer Types Questions 

1. Write the main functions of an operating system? 

2. Write the Booting process in MSDOS. 

3. Write about some internal commands. 

4. Write about format and fdisk commands. 

5. Write about aero options. 

6. Write about gadgets. 

7. Explain the help and support in windows. 

8. Write about file system. 

9. Write about desktop components 

10. Write about control panel 

11. Write about device manager 

12. Write about taskbar? 
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UNIT - III 

MS-Word 

3.1 Introduction to Word Processing  

3.1.1 Getting to Know word 2010 

3.1.2 The Ribbon or Menu Bar 

3.1.3 Backstage view 

3.1.4 The Quick Access toolbar 

3.1.5 Compatibility mode 

3.2 Editing a Document 

3.2.1 Opening a New Document 

3.2.2 Opening an Existing Document 

3.2.3 Saving a Document 

3.2.4 Renaming Documents 

3.2.5 Working on Multiple Documents 

3.2.6 Document Views 

3.2.7 Closing a Document 

3.2.8 Typing and inserting Text 

3.3 Move and Copy text and  Help System 

3.3.1 Selecting Text 

3.3.2 Inserting Additional Text 

3.3.3 Rearranging Blocks of Text 

3.3.4 Deleting Blocks of Text 

3.4 Formatting text and Paragraph 

3.4.1 Formatting text 

3.4.2 Formatting Paragraph 
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3.8.2 Design and Layout 

3.8.3 Inserting column 

3.9 Using Graphics, Templates and Wizards 

3.9.1 introduction to Graphics 

3.9.2 TEMPLATES 

3.9.3 Document Wizard 

3.10 Using Mail Merge 

3.11 Miscellaneous features of word 

3.11.1 Lists 

3.11.2 Word Art 

3. MS-Word 

3.1 Introduction to Word Processing 

Word 2010 is a word processor that allows you to create various types of documents such as 
letters, papers, flyers, and faxes. In this lesson, you will be introduced to the Ribbon and the new 
backstage view, and you'll learn how to create new documents and open existing ones. 

 

Fig: 3.1File Menu 

3.1.1 Getting to know Word 2010 

Word 2010 is a bit different from earlier versions, so even if you've used Word before you 
should take some time to familiarize yourself with the interface. The toolbars are similar to those 
in Word 2007, and they include the Ribbon and the Quick Access toolbar. Unlike Word 2007, 
commands such as Open and Print are housed in backstage view, which replaces the Microsoft 

Office button. 
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Fig 3.2 Screen Layout 

3.1.2 The Ribbon or Menu Bar 

The new tabbed Ribbon system was introduced in Word 2010 to replace traditional menus. The 
Ribbon contains all of the commands you'll need in order to perform common tasks. It contains 
multiple tabs, each with several groups of commands, and you can add your own tabs that 
contain your favorite commands. Some groups have an arrow in the bottom-right corner that you 
can click to see even more commands. 

 
Fig 3.3 tabbed ribbons or menu bar 

Certain programs, such as Adobe Acrobat Reader, may install additional tabs to the Ribbon. 
These tabs are called add-ins. 

 



 

 

Paper I Computer Fundamentals and MS-Office 

82 

 

To minimize and maximize the Ribbon: 

The Ribbon is designed to be easy to use and responsive to your current task; however, you can 
choose to minimize it if it's taking up too much screen space. 

1. Click the arrow in the upper-right corner of the Ribbon to minimize it. 

 

Fig 3.4 maximizes and minimizes ribbon  

 

2. To maximize the Ribbon, click the arrow again. 

When the Ribbon is minimized, you can make it reappear by clicking on a tab. However, the 
Ribbon will disappear again when you're not using it. 

To customize the Ribbon: 

You can customize the Ribbon by creating your own tabs with the commands you want. 
Commands are always housed within a group, and you can create as many groups as you want in 
order to keep your tab organized. If you want, you can even add commands to any of the default 
tabs, as long as you create a custom group in the tab. 

1. Right-click the Ribbon and select customize the Ribbon. A dialog box will appear. 

 

Fig 3.5 customize the ribbon 
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2. Click New Tab. A new tab will be created with a new group inside it. 
3. Make sure the new group is selected. 
4. Select a command from the list on the left, then click Add. You can also drag commands 

directly into a group. 
5. When you are done adding commands, click OK. 

 

Figs 3.6 customize the ribbon and key board shortcuts. 

If you don't see the command you want, click the Choose commands from: drop-down box, 
then select All Commands. 
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Fig 3.7 customizes the ribbon and key board shortcuts. 

 

3.1.3 Backstage view 

Backstage view gives you various options for saving, opening, printing, and sharing your files. 
It's similar to the Microsoft Office button menu from Word 2007 and the File menu from 
earlier versions of Word. However, instead of just a menu it's a full-page view, which makes it 
easier to work with. 

To get to Backstage view: 

1. Click the File tab. 

 

Fig 3.8 Backstage View 

2. You can choose an option on the left side of the page. 
3. To get back to your document, click any tab on the Ribbon. 

Click the buttons in the interactive below to learn about the different things you can do in 
Backstage view. 
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Fig 3.9 permission and prepare for sharing in back stage view 

 

3.1.4 The Quick Access toolbar 

The Quick Access toolbar, located above the Ribbon, lets you access common commands no 
matter which tab you're on. By default, it shows the Save, Undo, and Repeat commands. You 
can add other commands to make it more convenient for you. 

To add commands to the Quick Access toolbar: 

1. Click the drop-down arrow to the right of the Quick Access toolbar. 
2. Select the command you want to add from the drop-down menu. It will appear in the 

Quick Access toolbar. 

 

Fig 3.10 Quick Access menu bar 
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The Ruler 

The Ruler is located at the top and to the left of your document. It makes it easier to adjust your 
document with precision. If you want, you can hide the Ruler to free up more screen space. 

 
Fig 3.11 ruler for document adjustment 

To hide or view the Ruler: 

1. Click the View Ruler icon over the scrollbar to hide the ruler. 
2. To show the ruler, click the View Ruler icon again. 

 

Fig 3.12 view and hide button for ruler 

 

3.1.5 Compatibility mode 

Sometimes you may need to work with documents that were created in earlier versions of 
Microsoft Word, such as Word 2007 or Word 2003. When you open these types of documents, 
they will appear in Compatibility mode. 

Compatibility mode disables certain features, so you'll only be able to access commands found in 
the program that was used to create the document. For example, if you open a document created 
in Word 2007, you can only use tabs and commands found in Word 2007. 

In the image below, you can see how Compatibility mode can affect which commands are 
available. Because the document on the left is in Compatibility mode, it only shows commands 
that were available in Word 2007. 
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Fig 3.13 comparison of drawing tools in 2007 and 2010

To exit Compatibility mode, you'll need to 
However, if you're collaborating with others who only have access to an earlier versi
it's best to leave the document in Compatibility mode so the format will not change.

You can review this support page
disabled in Compatibility mode. 

To convert a document: 

If you want access to all Word 2010 features, you can 
format. 

Note that converting a file may cause some changes to the 

1. Click the File tab to access Backstage view.
2. Locate and select the Convert

3. A dialog box will appear. Click 
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Fig 3.13 comparison of drawing tools in 2007 and 2010 

To exit Compatibility mode, you'll need to convert the document to the current version type. 
However, if you're collaborating with others who only have access to an earlier versi
it's best to leave the document in Compatibility mode so the format will not change.

support page from Microsoft to learn more about which features are 
 

If you want access to all Word 2010 features, you can convert the document to the 2010 file 

file may cause some changes to the original layout of the document.

tab to access Backstage view. 
Convert command. 

Fig 3.14 converting document 

A dialog box will appear. Click OK to confirm the file upgrade. 

 

the document to the current version type. 
However, if you're collaborating with others who only have access to an earlier version of Word, 
it's best to leave the document in Compatibility mode so the format will not change. 

from Microsoft to learn more about which features are 

the document to the 2010 file 

of the document. 
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Fig 3.15 popup for converting 

4. The document will be converted to the newest file type 

3.2 Editing a Document 
 

There are several ways to create a new document, opening an existing document, 
and saving documents in Word 
 

3.2.1 Opening a New Document: 

Click the Microsoft Office Button  and Click New or 
 
Simply use the shortcut key creating a new empty documentCTRL+N (Depress the 
CTRL key while pressing the “N”) on the keyboard 
 
You will notice that when you click on the Microsoft Office Button and Click New, 
you have many choices about the types of documents you can create. If you wish to 
start from a blank document, click Blank. 

 
Fig 3.16 open for blank document 



 

 

Paper I Computer Fundamentals and MS-Office 

89 

 

 
You have a search option where you can type the template which       you want and 
you can browse it 
 
 
3.2.2 Opening an Existing Document 
 

• Click the Microsoft Office Button  and Click Open, or 

• Press CTRL+O (Depress the CTRL key while pressing the “O”) on the 
keyboard, or 

• If you have recently used the document you can click the Microsoft Office 
 

Button  and click the name of the document in the Recent Documents section 
of the window Insert picture of recent docs 
 
3.2.3 Saving a Document: 
 

• Click the Microsoft Office Button and Click Save or Save As(remember, if you’re 
sending the document to someone who does not have Office 2007, you will need to click 
the Office Button, click Save As, and Click Word 97-2003 Document), or 

• Press CTRL+S (hold the CTRL key and press  “s”) on the keyboard, or 
 

• Click the File icon on the Quick Access Toolbar 
 
 
 
 
 
 
 
 
 
Fig 3.17 Saving a Document 
 
3.2.4 Renaming Documents 
To rename a Word document  
 

• Click the Office Button  and find the file you want to rename. 

• Right-click the document name with the mouse and select Rename from the 
shortcut menu. 

• Type the new name for the file and press the ENTER key. 
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Fig 3.18 renaming word document 

 

3.2.5 Working on Multiple Documents 
We can work with more than one document at a time. All open documents will be 
listed in the View Tab of the Ribbon when you click on Switch Windows. The 
current document has a checkmark beside the file name. Select another open 
document to view it. 
 
 
 
 
 
 
 
Fig 3.19 Working on Multiple Documents 
 
3.2.6 Document Views 
 
There are many ways to view a document in Word. 
 
Print Layout: This is a view of the document as it would appear when printed. It 
includes all tables, text, graphics, and images. 
 
Full Screen Reading: This is a full view length view of a document. 
 
Good for viewing two pages at a time. 
 
Web Layout: This is a view of the document as it would appear in a web browser. 
 
Outline: This is an outline form of the document in the form of bullets. 
 
Draft: This view does not display pictures or layouts, just text. 
 
To view a document in different forms, click the document views shortcuts at the bottom of the 

screen or 
 
Click the View Tab on the Ribbon 
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Click on the appropriate document view. 
 
 
 
 
 
 
 
 

Fig 3.20 print layouts of word document
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3.2.7 Closing a Document: 

To close a document: 
 
Click the Office Button ->Click Close 
 
3.2.8 Typing and inserting Text 
 
To enter text, just start typing! The text will appear where the blinking cursor is 
located. Move the cursor by using the arrow buttons on the keyboard or positioning 
the mouse and clicking the left button. The keyboard shortcuts listed below are also 
helpful when moving through the text of a document: 
 
 

Move Action Keystroke 

Beginning of the line HOME 
End of the line END 
Top of the document CTRL+HOME 

End of the document CTRL+END 
 
3.3 Move and Copy Text: 

In order to move or copy the text from one place to another place first we have to select the text 

which we want to copy or move 

3.3.1 Selecting Text 

To change any attributes of text it must be highlighted first. Select the text by dragging the 

mouse over the desired text while keeping the left mouse button depressed, or hold down the 

SHIFT key on the keyboard while using the arrow buttons to highlight the text. The following 

table contains shortcuts for selecting a portion of the text: 

Selection Technique 

Whole Word Double-click within the word 

Whole paragraph Triple-click within the paragraph 

Several words or lines Drag the mouse over the words , or hold down SHIFT 

while using the arrow keys 

 Choose Editing | Select | SelectAll from the Ribbon , 

or use ctrl+A 
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Deselect the text by clicking anywhere outside of the selection on the page or press an arrow key 
on the keyboard. 

 

3.3.2 Inserting Additional Text 

Text can be inserted in a document at any point using any of the following methods: 

Type Text: Put your cursor where you want to add the text and begintyping 

Copy and Paste Text: Highlight the text you wish to copy and right click and click  

Copy (ctrl+c), put your cursor where you want the text in the document and right click and click 

Paste (ctrl+v). 

Cut and Paste Text: Highlight the text you wish to copy and right click and click Cut, put your    

cursor where you want the text in the document and right click and click Paste. 

Drag Text: Highlight the text you wish to move, click on it and drag itto the place where you 

want the text in the document. 

You will notice that you can also use the Clipboard group on the Ribbon. 

 

 

 

 

 

 

 

 

 

 

Fig 3.21 Clipboard button 

 

3.3.3 Rearranging Blocks of Text 

To rearrange text within a document, you can utilize the Clipboard Group on the Home Tab of 

the Ribbon. Insert picture of clipboard group labeled. 

Move text: Cut and Paste or Drag as shown above 
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Copy Text: Copy and Paste as above or use the Clipboard group on the Ribbon 

Paste Text: Ctrl + V (hold down the CTRL and the “V” key at thesame time) or use the 

Clipboard group to Paste, Paste Special, or Paste as Hyperlink 

 
 

 

 

 

 

 

 

 

Fig 3.22 Paste button 

3.3.4 Deleting Blocks of Text 

Use the BACKSPACE and DELETE keys on the keyboard to delete text. Backspace will delete 

text to the left of the cursor and Delete will erase text to the right. To delete huge amount of data 

simply select the data which you want to delete and simply press delete key on the keyboard. 

Help System 

Click the Microsoft Office Help button  in the upper right or the F1 key on your keyboard to 

open Help on your computer. The first time you use the Help feature in Microsoft Office 

programs, the online Help window appears in a default location and size on your screen. You 

can change the way the Help window is displayed. After that, when you open the Help window, 

the settings that you made are maintained. 

Each program in Microsoft Office has a separate Help window. This means that when you open 

the Help window from one program, such as Microsoft Office Word, and then go to another 

program, such as Microsoft Office Outlook, and open Help, you see two separate Help windows. 

Microsoft Office maintains unique settings for each of these Help windows. For example, the 

Help window for Word maintains a different position, size, and Keep on Top state than the Help 

window for viewpoint. 

3.4 Formatting Text and Paragraph 

To create and design effective documents, you need to know how to format text. In addition to 

making your document more appealing, formatted text can draw the reader's attention to 

specific parts of the document and help communicate your message. 
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Fig: 3.23 font styles 

In this lesson, you'll learn to format the font size, style, and color; highlight the text; and use the 

bold, italic, underline, and change case commands. 

3.4.1 Formatting text: 

Formatted text can emphasize important information and help organize your document. In 

Word, you have several options for adjusting the font of your text, including size, color, and 

inserting special symbols. You can also adjust the alignment of the text to change how it is 

displayed on the page. 

To change the font size: 

1. Choose the text you want to modify. 
2. Click the drop-down arrow next to the Font Size box on the Home tab. A drop-

down menu appears. 
3. Select the desired font size from the menu. Instead, you can type the value you 

want and then press Enter on your keyboard. 

 

Fig: 3.24 slider for font sizes 

You can also use the Grow Font and Shrink Font commands to change the size. 
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Fig: 3.25 font shrink and growing buttons 

To change the font: 

1. Select the text you want to modify. 
2. Click the drop-down arrow next to the Font box on the Home tab. The Font 

drop-down menu appears. 
3. Move the mouse pointer over the various fonts. A live preview of the font will 

appear in the document. 

 

Fig:3.26 different types of font styles 

4. Select the font you want to use. The font will change in the document. 

To change the font color: 

1. Select the text you want to modify. 
2. Click the Font Color drop-down arrow on the Home tab. The Font Color menu 

appears. 
3. Move the mouse pointer over the various font colors. A live preview of the color 

will appear in the document. 
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Fig:3.27 custom  font color 

4. Select the font color you want to use. The font color will change in the document. 

Your color choices aren't limited to the drop-down menu that appears. Select More Colors at the 

bottom of the list to access the Colors dialog box. Choose the color you want, then click OK. 

To Highlight text: 

1. From the Home tab, click the Text Highlight Color drop-down arrow. The 
Highlight Color menu appears. 

 

Fig:3.28 font colors 

2. Select the desired highlight color. 
3. Select the text you want to modify. It will then be highlighted. 
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Fig:3.29 font high lighting 

4. To switch back to the normal cursor, click the Text Highlight Color command. 

To use the bold, italic, and underline commands: 

1. Select the text you want to modify. 
2. Click the Bold(ctrl+b), Italic(ctrl+i), or Underline(ctrl+u) command in the Font 

group on the Home tab. 

 

Fig:3.30 bold selected text 

To change text case: 

1. Select the text you want to modify. 
2. Click the Change Case command in the Font group on the Home tab. 
3. Select the desired case option from the list. 

 

Fig: 3.31 case sensitivity of font 

To change text alignment: 
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1. Select the text you want to modify. 
2. Select one of the four alignment options from the Paragraph group on the Home tab. 

• Align Text Left: Aligns all selected text to the left margin 

• Center: Aligns text an equal distance from the left and right margins 

• Align Text Right: Aligns all selected text to the right margin 

• Justify: Aligns text equally on both sides and lines up equally to the 
right and left margins; used by many newspapers and magazines 

 

Fig: 3.32 font alignment 

Copy Formatting 

 

If you have already formatted text the way you want it and would like another 

portion of the document to have the same formatting, you can copy the formatting. 

To copy the formatting, do the following: 

 

Select the text with the formatting you want to copy. 

Copy the format of the text selected by clicking the Format Painter button on the 

Clipboard Group of the Home Tab. 

 

 

 

 

Fig 3.33 Copy formatting 

Apply the copied format by selecting the text and clicking on it. 

Clear Formatting 

To clear text formatting: 

Select the text  to which you want to clear the formatting 



 

 

Paper I Computer Fundamentals and MS-Office 

100 

 

Click the Styles dialogue box on the Styles Group on the Home Tab 

Click Clear All 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig 3.34 clear formatting 

3.4.2 Formatting Paragraph 

Formatting paragraphs allows you to change the look of the overall document. You 

can access manyofthe tools of paragraphformatting by clicking the Page Layout Tab 

of the Ribbon or the Paragraph Group on the Home Tab of the Ribbon. 

 

 

 

 

 

 

Fig 3.35 Formatting paragraph 

 

The paragraph alignment allows you to set how you want text to appear. 

To change the alignment: 

Click the Home Tab 
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Choose the appropriate button for alignment on the Paragraph Group. 

Align Left: the text is aligned with your left margin. 

Center: The text is centered within your margins. 

Align Right: Aligns text with the right margin. 

Justify: Aligns text to both the left and right margins. 

 

 

 

 

 

Fig 3.36 Paragraph alignment 

Indent Paragraphs 

 

Indenting paragraphs allows you set text within a paragraph at different margins. 

There are several options for indenting: 

First Line: Controls the left boundary for the first line of a paragraph 

Hanging: Controls the left boundary of every line in a paragraph exceptthe first one 

Left: Controls the left boundary for every line in a paragraph 

Right: Controls the right boundary for every line in a paragraph 

 

To indent paragraphs, you can do the following: 

 

 

 

 

 

Fig 3.37 Indent alignment 

Click the Indent buttons to control the indent. 

Click the Indent button repeated times to increase the size of the indent. 
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Click the dialog box of the Paragraph Group 

Click the Indents and Spacing 

TabSelect your indents 

 

 

 

 

 

 

 

 

 

 

 

 

Fig 3.38 Paragraph group 

Add Borders and Shading 

You can add borders and shading to paragraphs and entire pages. To create a border 

around a paragraph or paragraphs: 

Select the area of text where you want the border or shading. 

Click the Borders Button on the Paragraph Group on the Home Tab 

Choose the Border and Shading 

Choose the appropriate options 
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Fig 3.39 Borders and Shading 

Apply Styles 

Styles are a present collection of formatting that you can apply to text. To utilize 

Quick Styles: 

Select the text you wish to format. 

Click the dialog box next to the Styles Group on the Home Tab. Click the 

style you wish to apply. 

 

 

Fig 3.40 Paragraph group 

Change Spacing Between Paragraphs and Lines 

You can change the space between lines and paragraphs by doing the following: 

Select the paragraph or paragraphs you wish to change. 

On the Home Tab, Click the Paragraph Dialog Box 

Click the Indents and Spacing Tab 

In the Spacing section, adjust your spacing accordingly. 
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Fig 3.41 Spacing between paragraph and lines 

3.5 Find and Replace Text and Spell Checking 
 
3.5.1 Find and Replace Text 
 
To find a particular word or phrase in a document: 
 

• ClickFindon theEditing Groupon the Ribbon 
 

• To find and replace a word or phrase in the document, clickReplaceon the Editing 

Group of the Ribbon. 
 
Undo Changes 
 
To undo changes: 
 

• Click theUndo Buttonon the Quick Access Toolbar  
 
 
 
 
 
 
Fig 3.42 Undo group 
3.5.2 Spell Checking: 

Introduction: 

Are you worried about making mistakes when you type? Don't be. Word provides you with 
several proofing features that will help you produce professional, error-free documents. In this 
lesson, you will learn about the various proofing features, including the spelling and grammar 
tool. 

Checking spelling and grammar: 

To make your document appear professional, you'll want to make sure it is free from spelling 

and grammar errors. Word has several options for checking your spelling. You can run a 
spelling and grammar check, or you can allow Word to check your spelling automatically as 
you type. 

To run a spelling and grammar check: 

1. Go to the Review tab. 
2. Click on the Spelling & Grammar command. 
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Fig 3.43 spelling and grammar 

3. The Spelling and Grammar dialog box will open. For each error in your document, 
Word will try to offer one or more suggestions. You can select a suggestion and click 
Change to correct the error. 

 

Fig 3.44 spelling and grammar checking 

4. If no suggestions are given, you can manually type the correct spelling. 

Ignoring "errors" 

The spelling and grammar check is not always correct. Particularly with grammar, there are 
many errors Word will not notice. There are also times when the spelling and grammar check 
will say something's an error when it's actually not. This often happens with people's names, 
which may not be in the dictionary. 

If Word says something is an error, you can choose not to change it. Depending on whether it's a 
spelling or grammar error, you can choose from several options: 

For spelling "errors" 

• Ignore Once: This will skip the word without changing it. 
• Ignore All: This will skip the word without changing it, and it will also skip all other 

instances of this word in the document. 
• Add to Dictionary: This adds the word to the dictionary so it will never come up as an 

error. Make sure the word is spelled correctly before choosing this option. 
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For grammar "errors" 

• Ignore Once: This will skip the "error" without changing it. 
• Ignore Rule: This will skip this "error" and all other instances that relate to this grammar 

rule. 
• Next Sentence: This skips the sentence without changing it and leaves it marked as an 

error. This means it will still show up if you do another spelling and grammar check later 
on. 

If you're not sure about a grammar error, you can click Explain to see why Word thinks it's an 
error. This can help you determine whether you want to change it. 

Automatic spelling and grammar checking 

By default, Word automatically checks your document for spelling and grammar errors, so you 
may not even need to run a separate spelling and grammar check. These errors are indicated by 
colored wavy lines. 

• The red line indicates a misspelled word. 
• The green line indicates a grammatical error. 
• The blue line indicates a contextual spelling error. This feature is turned off by default. 

 

 

 

 

 

 

Fig 3.45 graphical representation of contextual, grammatical and spelling errors 

A contextual spelling error occurs when the wrong word is used but the word is spelled 
correctly. For example, if you write Deer Mr. Theodore at the beginning of a letter, deer is a 
contextual spelling error because dear should have been used. Deer is spelled correctly, but it is 
used incorrectly in this letter. 

To use the spelling check feature: 

1. Right-click the underlined word. A menu will appear. 
2. Click the correct spelling of the word from the listed suggestions. 
3. The corrected word will appear in the document. 
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Fig 3.46 features of spell checking 

You can choose to ignore an underlined word, add it to the dictionary, or go to the Spelling 
dialog box for more options. 

To use the grammar check feature: 

1. Right-click the underlined word or phrase. A menu will appear. 
2. Click the correct phrase from the listed suggestions. 
3. The corrected phrase will appear in the document. 

You can also choose to Ignore an underlined phrase, go to the Grammar dialog box, or click 
About This Sentence for information on the grammar rule. 

To change the automatic spelling and grammar check settings: 

1. From Backstage view, click Options. 
2. Select Proofing. The dialog box gives you several options to choose from. 

� If you don't want Word to automatically check spelling, uncheck Check 

spelling as you type. 
� If you don't want grammar errors to be marked, uncheck Mark grammar 

errors as you type. 
� To check for contextual spelling errors, check Use contextual spelling. 
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Fig 3.47 proofing 

If you've turned off the automatic spelling and/or grammar checks, you can still run a check by 
going to the Review tab and clicking the Spelling & Grammar button. 

To hide spelling and grammar errors in a document: 

If you're sharing a document like a resume with someone, you might not want that person to see 
those annoying red, green, and blue lines. Turning off the automatic spelling and grammar 
checks only applies to your computer, so the lines may still show up when someone else views 
your document. Luckily, you can hide spelling and grammar errors in a document so the lines 
will not show up on any computer. 

1. From Backstage view, click Options. 
2. Select Proofing. 
3. In the drop-down box next to "Exceptions for:" select the correct document (if you have 

more than one document open). 
4. Put a check mark next to Hide spelling errors in this document only and Hide 

grammar errors in this document only. 
5. Click OK. 

3.5.3 Thesaurus 
 
The Thesaurus allows you to view synonyms. To use the thesaurus: 
 

• Click theReviewTab of the Ribbon 

• Click theThesaurusButton on the Proofing Group. 
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• The thesaurus tool will appear on the right side of the screen and youcan 

view word options. 
 
 
 
 
 
 
 
 
 
 
 
 

Fig 3.48 Thesaurus 
 
You can also access the thesaurus by right-clicking any word and choosing 

Synonyms on the menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig 3.49 Synonyms 
 
Add AutoText to the Quick Access Toolbar 
 

1. Click the Microsoft Office Button, and then click Word Options. 
2. Click Customize. 
3. In the list under Choose commands from, click All Commands. 
4. Scroll through the list of commands until you see AutoText. 
5. Click AutoText, and then click Add. 

 
The AutoText button now appears in the Quick Access Toolbar. Click AutoText to 

choose from a gallery of AutoText entries. 
 
Create a new AutoText Entry 
 

1. In your Word document, select the text that you want to add to your 

gallery of AutoText entries. 

2. In the Quick Access Toolbar, click AutoText, and then click Save 

Selection to AutoText Gallery. 
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Fill out the information in the Create New Building Block dialog box: 

• NameType a unique name for the building block. 

• GallerySelect the gallery that you want the building block to show up in. 
 

• CategorySelect a category, such asGeneralorBuilt-In, or createa new 

category. 
 

• DescriptionType a description of the building block. 

• Save inClick the name of the template in the drop-down list. Atemplate must 

be open to be displayed in the drop-down list of template names. 

• OptionsChoose one of the following: 

• SelectInsert content in its own pageto place the building block ona separate 

page with page breaks before and after the building block. 
 

• SelectInsert content in its own paragraphto make the content intoits own 

paragraph, even if the user’s cursor is in the middle of a paragraph. 
 

• SelectInsert content onlyfor all other content.Note:After typing theshort 

name of autotext gallery, press function key F3, then it is replaced by the 

lengthy name. 
 
Customize AutoCorrect 
 
You can set up the AutoCorrect tool in Word to retain certain text the way it is. To 

customize AutoCorrect: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig 3.50 Customize Autocorrect 
 

• Click theMicrosoft Officebutton 

• Click theWord OptionsButton 

• Click theProofingtab 

• ClickAutoCorrect Optionsbutton 

• On theAutoCorrect Tab, you can specify words you want to replaceas you 

type. 
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Create a New Default Dictionary 
 
Often you will have business or educational jargon that may not be recognized by the 

spelling and/or grammar check in Word. You can customize the dictionary to 

recognize these words. 
 

• Click theMicrosoft Officebutton 

• Click theWord OptionsButton 

• Click theProofingtab 

• Click theWhen correcting Spellingtab 

• ClickCustom Dictionaries 

• ClickEdit Word List 

• Type in any words that you may use that are not recognized by thecurrent 

dictionary. 
 
 
 
Check Word Count 
 
To check the word count in Word 2007 look at the bottom left corner of the screen. It 

will give you a total word count or if you have text highlighted it will tell you how 

many words are highlighted out of the total. 
 
 
 
 
 
 
 
 
 
Fig 3.51 Check Word Count 

3.6 Tabs 

Using tabs gives you more control over the placement of text. By default,                          on 
pressing a tab key the insertion point will be 0.5” towards right. On continuing pressing the 
points will be 0.5”,1.0”,1.5” and so on. By adding tab stops to the Ruler you can change the size 
of the tabs, and one can apply more than one tab stop to a single line in Word. For example, on a 
resume you could left-align the beginning of a line and right-align the end of the line by adding 
a Right Tab, as shown in the image below. 
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If you can't see the Ruler, select the

Fig 3.53 enable ruler through View menu

The tab selector is located to the left of horizontal ruler. Hovering the mouse over the  tab 
selector displays the name of the active

Fig 3.54 tab selector to view or

Types of tab stops: 

1. Left Tab  left-aligns the text at the tab stop.
2. Center Tab  centers the text around the tab stop.
3. Right Tab  right-aligns the text at the tab stop.
4. Decimal Tab  aligns decimal numbers using the decimal point.
5. Bar Tab  draws a vertical line on the document.
6. First Line Indent  inserts the indent marker on the Ruler and indents 

the first line of text in a paragraph.
7. Hanging Indent  inserts the hanging indent marker and indents all 

lines other than the first line.
 

8. Tab stop position: Type the position on the ruler where you want to createa 

new tab stop, or select an existing tab stop from the list to modify its 

properties. 

 
9. Default tab stops: Specifies amount of spacing that is applied each timeyou 

press the TAB key. 
 

10. Tab stops to be cleared: 

fordeletion from the Tab stop position

list when you click OK. 
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Fig 3.52 sample of using tabs 

If you can't see the Ruler, select the View tab, then click the check box next tothe

 

Fig 3.53 enable ruler through View menu 

is located to the left of horizontal ruler. Hovering the mouse over the  tab 
selector displays the name of the active tab stop. 

 

Fig 3.54 tab selector to view or hide ruler 

aligns the text at the tab stop. 
centers the text around the tab stop. 

aligns the text at the tab stop. 
aligns decimal numbers using the decimal point. 

aws a vertical line on the document. 
inserts the indent marker on the Ruler and indents 

the first line of text in a paragraph. 
inserts the hanging indent marker and indents all 

lines other than the first line. 

Type the position on the ruler where you want to createa 

new tab stop, or select an existing tab stop from the list to modify its 

: Specifies amount of spacing that is applied each timeyou 

ops to be cleared: Displays tab stops that have been marked 

Tab stop position list. Cleared tabs are deleted from the 

 

ick the check box next tothe Ruler.

is located to the left of horizontal ruler. Hovering the mouse over the  tab 

Type the position on the ruler where you want to createa 

new tab stop, or select an existing tab stop from the list to modify its 

: Specifies amount of spacing that is applied each timeyou 

Displays tab stops that have been marked 

list. Cleared tabs are deleted from the 



 

 

Paper I Computer Fundamentals and MS-Office 

113 

 

3.6.1 Alignment 

Left: Sets a left start position of text that will then run to the right as youtype. 

Center: Sets the position of the middle of the text. The text centers on thisposition 

as you type. 

Right: Sets a right start position of text that will then run to the left as you type. 
 

Decimal: Aligns numbers around a decimal point. Independent of the number of 

digits, the decimal point will be in the same position. 

Bar: Inserts a vertical bar at the tab position. Not used for positioning text. 

3.6.2 Leader 

1. Omits any lead characters to be added in front of the tab stop. 

2. Specifies for a tightly dotted line to be added in front of the tab stop. 

3. Specifies for a line of dashes to be added in front of the tab stop. 

4. Specifies for a solid line to be added in front of the tab stop. 

5. Specifies for a loosely dotted line to be added in front of the tab stop. 

Set: Creates a new tab or updates a previously set tab stop position withthe options 

you specified 

Clear: Marks a selected tab stop position for deletion. Cleared tabs aredeleted from 

the list when you click OK. 

Clear All: Marks all stored tab stop positions for deletion. Cleared tabsare deleted 

from the list when you click OK. 

 

 

3.7 Enhancing a Document (Page Layout) 
 
Before printing a document we have to set the pages by using page setup.In this we 

can set margins, orientation(portrait or landscape),paper size, multiple columns, page 

breaks, page borders, page colors ,water marks, etc., 
 
3.7.1 Modify Page Margins and Orientations 
The page margins can be modified through the following steps: 

• Click thePage LayoutTab on the Ribbon 

• On thePage SetupGroup, ClickMargins 

• Click aDefault Margin, or 

• ClickCustom Marginsand complete the dialog box 
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Fig 3.55 Page layout margins 
 
To change the Orientation, Size of the Page, or Columns: 

• Click thePage LayoutTab on the Ribbon 

• On the Page Setup Group, Click theOrientation,Size, orColumnsdrop down 

menus 

• Click the appropriate choice  
3.7.2 Apply a Page Border and Color 

• To apply a page border or color: 

• Click thePage LayoutTab on the Ribbon 

• On the Page Background Group, click thePage ColorsorPageBorders drop 

down menus. 
 
 
 
 
 
 
 

Fig 3.56 Page colorsnd borders 
 
3.7.3 Insert Common Header and Footer Information 
 
To insert Header and Footer information such as page numbers, date, or title, first, 

decide if you want the information in the header (at the top of the page) or in the 

Footer (at the bottom of the page), then: 
 

• Click theInsertTab on the Ribbon 

• ClickHeader or Footer 

• Choose a style  
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Fig 3.57 Header & footer 
 

• TheHeader/Footer DesignTab will display on the Ribbon 
 

• Choose the information that you would like to have in the header orfooter 

(date, time, page numbers, etc.) or type in the information you would like to 

have in the header or footer.  
 
 
 
 
 
 
 
 
 
Fig 3.58 Design tab 

 
3.7.4 Create a Page Break 
To insert a page break: 

• Click thePage LayoutTab on the Ribbon 

• On thePage SetupGroup, click theBreaks Drop Down Menu 

ClickPage Break 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig 3.59 Create a page break 
3.7.5 Insert a Cover Page 
 
To insert a cover page: 

• Click theInsertTab on the Ribbon 

• Click theCover PageButton on the Pages Group 

• Choose a style for the cover page 
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Fig 3.60 Inserting of cover page 
 
3.7.6 Insert a Blank Page 
 
To insert a blank page: 
 
� Click theInsertTab on the Ribbon 
� Click theBlank PageButton on the Page Group  
 
 
 
 
 
 
 
 
 

Fig 3.61 Inserting a blank page 

Insert a blank table: 
1. Place your insertion point in the document where you want the table to appear. 
2. Select the Insert tab. 
3. Click the Table command. 
4. Hover your mouse over the diagram squares to select the number 

of columns and rows in the table. 
5. Click your mouse, and the table appears in the document. 
6. You can now place the insertion point anywhere in the table to add text. 
7. Adding a page number: 

 We can add page numbers to the header or footer by clicking the Page Number command and 
then selecting Top of Page or Bottom of Page. If you have an existing header or footer, it will 
be removed and replaced with the page number. 
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Fig 3.62 page number of top and bottom 

 
3.8 Tables 

A Table is a collection of cells which are arranged in rows and columns. A Table can be used for 
various tasks mainly for presenting both textual data and numerical data.  
 
Look at the table below. In word we can create such tables easily. The tables facility 

in word is very powerful and flexible. Table can have any number of rows and 

columns.   
Stud .id Name English     Telugu Hindi 
     

101 Sirisha 65 59 72 

102 Manisha 85 75 81 

103 Hanisha 76 78 80 
 
Tables are used to display data in a structured format i.e., in rows and columns.  
 
3.8.1 Create a Table 
 
To create a table: 
 

• Place the cursor on the page where you want the new table 
 

• Click theInsertTab of the Ribbon 
 

• Click theTablesButton on the Tables Group. You can create a tableone of 

four ways: 
 

• Highlight the number of row and columns 
 

• ClickInsert Tableand enter the number of rowsandcolumns. 

 

• Click theDraw Table, create your table by clicking andentering the rows and columns. 

 

• ClickQuickTablesand choose a table 
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Fig:3.63 Inserting a new blank table 

Enter Data in a Table 
 
Place the cursor in the cell where you wish to enter the information. Begin typing. 
 
Modify the Table Structure and Format a Table 
 
To modify the structure of a table: 
 
� Click the table and notice that you have two new tabs on the Ribbon:  
3.8.2 Design and Layout. These pertain to the table design and layout.  
 
 
 
 
 
 
 
 
 

Fig 3.64 Design and layout 
 
On the Design Tab, you can choose: 
 

• Table Style Options 

• Table Styles 

• Draw Borders 
 
To format a table, click the table and then click the Layout Tab on the  
Ribbon. This Layout tab allows you to: 
 

• View Gridlines and Properties(from the Table Group) 

• Insert Rows and Columns (from the Rows & Columns Group) 

• Delete the Table, Rows and/or Columns(from the Rows & ColumnsGroup) 

• Merge or Split Cells(from the Merge Group) 

• Increase and Decrease cell size(Cell Size Group) 

• Align text within the cells and change text directions(AlignmentGroup). 

 
To ADD a Row or a Column for an existing table: 

Inserting Row: 

1. To add a Row place the insertion point in a row below the location where you want to 
add a row. 

2. Right-click the mouse. A menu appears. 
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3. Select Insert Rows Above/Below

Fig 3.65 inserting a new column

1. A new row appears above/below

3.8.3 Inserting column: 

1. Place the insertion point

the new column to appear. 
2. Right-click the mouse. A menu appears.

Fig 3.66 insert column to the right or left

3. Select Insert Insert Columns to the Lef

new column appears 

To Delete a Row: 

1. Select the row or column.

2. Right-click your mouse. A menu will appear.

3. Select Delete Cells.  

4. Select Delete entire row 
options based on requirement) 

 

3.9 Graphics, templates and wizards

In this chapter discussed about graphics, templates and wizards.
 

3.9.1 introduction to Graphics 

Word provides a set of drawing tools that you can use to create simple graphics

pictures, clip art, shapes, smart art, equations etc are available in insert tab.Word 
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Insert Rows Above/Below. 

 
Fig 3.65 inserting a new column 

above/below the insertion point. 

insertion point in a column adjacent to the location where you want 

click the mouse. A menu appears. 

 
Fig 3.66 insert column to the right or left 

Insert Columns to the Left or Insert Columns to the Right

Select the row or column. 

click your mouse. A menu will appear. 

 

 or Delete entire column, then click OK.(Or use shift 

3.9 Graphics, templates and wizards 

In this chapter discussed about graphics, templates and wizards. 

 

Word provides a set of drawing tools that you can use to create simple graphics. The 

pictures, clip art, shapes, smart art, equations etc are available in insert tab.Word 

to the location where you want 

Insert Columns to the Right. A 

Or use shift 

. The 

pictures, clip art, shapes, smart art, equations etc are available in insert tab.Word 
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2007 allows you to insert special characters, symbols, pictures, illustrations, and 

watermarks. 
 
 

Symbols and Special Characters 
 

Special characters are punctuation, spacing, or typographical characters that are not 

generally available on the standard keyboard. To insert symbols and special 

characters: 
 

• Place your cursor in the document where you want the symbol 
• Click on the Insert Tab on the Ribbon 

• Click on the Symbol button on the Symbols Group 

• Select the appropriate symbol.  
 
 
 
 
 
 
 
 
 
 

 

\ 

 

 

 

 

 

 

 

Fig 3.67 Shapes 

 
 

Equations 
 

Word 2007 also allows you to insert mathematical equations. To access the 

mathematical equations tool: 
 

• Place your cursor in the document where you want the symbol� 

• Click the Insert Tab on the Ribbon 

 
 
 
 
 
 
 
 
 
Fig 3.68 Equations 
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• Click the Equation Button on the Symbols Group 

• Choose the appropriate equation and structure or click Insert New Equation 

• To edit the equation click the equation and the Design Tab will be available 

in the Ribbon 

Illustrations, Pictures, and Smart Art 

Word allows you to insert illustrations and pictures into a document. 
 

To insert illustrations: 

• Place your cursor in the document where you want the illustration/ picture 

• Click the Insert Tab on the Ribbon 

• Click the Clip Art Button 

• The dialog box will open on the screen and you can search for clip art. 

Choose the illustration you wish to include 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig 3.69 Clip art 
 

To insert a Picture 

• Place your cursor in the document where you want the illustration/ picture 

• Click the Insert Tab on the Ribbon 

• Click the Picture Button 

• Browse to the picture you wish to include 

• Click the Picture 

• Click Insert  
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Fig 3.70 Inserting of picture 
 

Smart Art is a collection of graphics you can utilize to organize informationwithin 

your document. It includes timelines, processes, or workflow. To insert SmartArt. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig 3.71 Smart art 

Place your cursor in the document where you want the illustration/ picture 

• Click the Insert Tab on the Ribbon 

• Click the SmartArt button 

• Click the SmartArt you wish to include in your document 
• Click the arrow on the left side of the graphic to insert text or type  the text in 

the graphic. 
 

Resize Graphics 

All graphics can be resized by clicking the image and clicking one corner of the 

image and dragging the cursor to the size you want the picture. 

Watermarks 
 
A watermark is a translucent image (it may be either text or an image) that appears 

behind the primary text in a document. To insert a watermark: 
 

• Click the Page Layout Tab in the Ribbon 
 

• Click the Water mark button in the Page Background Group 
 

• Click the Watermark you want for the document or click  Custom Watermark and 

create your own watermark 

• To remove a watermark, follow the steps above, but  click Remove Watermark 
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Fig 3.71 Watermark 

3.9.2 TEMPLATES 

A template is a predesigned document you can use to design documents quickly 

without formatting them. A template may have predefined margin size, font style and size, 

and spacing etc.  

Creating a new document with a template 

Templates can help you create a more professionally designed document. Templates are 

designed for many purposes —whether you need to create a business card or a simple award 

certificate. To use templates, you'll need to know creating a new document with a template 

and inserting text into the template. 

To insert a template: 

1. Click the File tab to go to Backstage view. 

2. Select New. The New Document pane appears. 

3. Click Sample templates to choose a built-in template, or select an Office.com 

template category to download a template. 

 

Fig 3.72 sample templates 
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4. Select the desired template, then click on Create. A new document will appear 

with the template you have selected. 

 

Fig 3.73 creating document using templates 

Entering information into a template 

To insert text into a template: 

Templates contain placeholder text that is surrounded by brackets. To personalize your 

document, you have to replace the placeholder text with your own text. 

Some templates simply use regular text as the placeholder. In that case, delete the text and type 

in your own text. 

1. Click the text you want to replace. The text will appear highlighted, and a 

template tag will appear. 

2. Enter some text that will replace the placeholder text. 

3.9.3Document Wizard 
The Document Wizard offers an easy way to create a basic document that you can use as a 
starting point. On one occasion you have created the basic document, you can use the Document 
Editor to more improve the document’s definition, formatting, and layout to create a refined, 
visually pleasing, boardroom-quality document. 
Use the following procedure to create a basic document with the Document Wizard. 
You can also make a document using a document template, which permits you to start with a 
predefined structure. You can also create a document from a report, which displays the report 
within a document. For more information on these various methods, including instructions.. 
To create a document using the Document Wizard 

1. Open MicroStrategy Developer 
2. Log in to the MicroStrategy Analytics Modules project source using the login ID User. 

Leave the password blank and click OK. 
3. Expand the MicroStrategy Tutorial project, then expand My Personal Objects, and then 

select My Objects. This is where you can make your document. 
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4. From the File menu, point to New and then choose Document. The New Document 
dialog box opens. 

5. Select Document Wizard and click OK. The Document Wizard opens and the Welcome 
page is displayed. The Welcome page describes the process that the wizard guides you 
through. Click Next to begin. The Select the Document’s Data Source and Specify a Title 
page opens. 

6. You must specify the object to be used as the source for the document’s data; this is 
typically a report. Click to navigate to the Regional Profit and Margins report. This report 
is located in Reports\Subject Areas\Enterprise Performance Management. Then click 
Select. 

7. In the Document title field, type Regional Profit and Margins and then click Next. The 
Select Fields for the Document page opens. 

8. Determine the objects to be used in the document. You can add or remove objects later 
using the Document Editor. Click the double right arrows   to move all the objects to the 
selected fields list and click Next. The Select How the Document Is Grouped page opens. 

9. This determines how the data is grouped in the document. 
Select Region and click the right arrow -> to move it to the right side of the page. Select Year 
and click the right arrow ->again. Region should be above Year in the selected fields list. Use the 
up and down arrows to change the order if necessary. In this case, with Region above Year, data 
is grouped first by Region and then by Year within each region. When you are finished, click 
Next. The Specify Group Sorting page opens. 

10. Each grouping item selected in the previous page is listed in the Sort By table, with 
Criteria and Order columns for each item. The Criteria is what the object is sorted by. 
Since the items are all attributes, you can choose which attribute form to sort on. The 
Order determines whether the grouping item is sorted in ascending or descending order. 
Since the Criteria is defined as Default, you cannot select the Order. 

Leave the default selections and click Next. The Select a Template for the Document's Layout 
page opens. 

11. These selections determine the general layout (the position and placement of items on the 
document) to be used as a starting point. In the next part of this evaluation you learn to 
modify the layout of the document using the Document Editor. Select Stepped in the list 
of Available layouts. Then select the Portrait orientation option and click next. The Select 
the Document's Formatting Auto style page opens. 

12. This page allows you to select the Auto style for your document. An Auto style is a 
predefined collection of formatting properties, which is applied to a document to change 
its formatting and appearance. 

Select the Tutorial Sample Autostyle and click Finish. 
The document is created and displays in the Document Editor, with all your selections appearing 

in the appropriate document sections as shown in the following image. The layout and 

formatting, such as colored sections and text characteristics, are already applied as a result of the 

layout and auto style you selected. 

3.10 Mail Merge 

Mail Merge is a very useful tool that allows user to produce multiple letters, envelopes, labels, 

name tags, and more using information stored in a list, database, or spread sheet. When 
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implementing a Mail Merge, user need a Word document (you can start with an existing one or 

create a new one) and a recipient list, which is an Excel workbook. 

    USING MAIL MERGE 

1. Open a Word document (create new if not exist). 

2. In the Mailings tab, click on the Start Mail Merge command and select Step by Step 

Mail Merge Wizard from the menu obtained. 

 

Fig 3.74 mail merge menu and their sub menus 

There are six main steps to complete a merge. The appeared Mail Merge pane and will guide you. 

The following example explains how to create a form letter and merge the letter with a recipient 

list. 

Step 1: 

• Choose the type of document you want to create. Let us select Letters in our example. 

Then click Next: Starting document to move to Step 2. 

 

 

Fig 3.75 type of documents in mail merge 
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Step 2: 

• Select Use the current document and then click Next: Select recipients to move to Step 

3. 

 

Fig 3.76 mail merge with current document 

Step 3: 

Now you'll need an address list so that Word can automatically place each address into the 

document. The list can be in an existing file, such as an Excel workbook, or you can type a new 

address list from within the Mail Merge Wizard. 

1. From the Mail Merge task pane, select Use an existing list and then click Browse... to 

select the file. 

2. Locate your file and click Open. 

3. If the address list is in an Excel workbook, select the worksheet that contains the list and 

click OK. 

4. In the Mail Merge Recipients dialog box, you can check or uncheck each box to control 

which recipients are included in the merge. By default, all recipients should be selected. 

When you're done, click OK. 
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Fig 3.77 mail merge recipient dialog box 

5. From the Mail Merge task pane, click Next: Write your letter to move to Step 4. 

If you don't have an existing address list, you can click the Type a new list button and 

click Create. You can then type your address list. 

Step 4: 

Now you're ready to write your letter. When it's printed, each copy of the letter will basically be 

the same; only the recipient data (such as the name and address) will be different. You'll need 

to add placeholders for the recipient data so Mail Merge knows exactly where to add the data. 

To insert recipient data: 

1. Place the insertion point in the document where you want the information to 

appear. 

2. Choose one of the four placeholder options: Address block, Greeting 

line, Electronic postage, or More items. 

3. Based on your selection, a dialog box may appear with various options. Select the 

desired options and 

click OK. 

 

Fig 3.78 selection of options 

4. A placeholder will appear in your document (for example, «Address Block»). 
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5. Repeat these steps each time you need to enter information from your data record. 

In our example, we'll add a Greeting line. 

6. When you're done, click Next: Preview your letters to move to Step 5. 

For some letters, you'll only need to add an Address block and Greeting line. 

Sometimes, however, you may want to place recipient data within the body of the letter 

to personalize it even further. 

Step 5: 

1. Preview the letters to make sure the information from the recipient list appears 

correctly in the letter. Also left and right scroll arrows can be used to view each 

document. 

2. Click Next: Complete the merge to move to Step 6. 

Step 6: 

1. Click Print... to print the letters. 

2. A dialog box will appear. Click All, then click OK. 

3. The Print dialog box will appear. Adjust the print settings if needed, then 

click OK. The letters will be printed. 
 

3.11 Miscellaneous Features of Word 
Finally there are some more facilities such as list (bullets and numbers) and word art.In the 

documents if we desire to explain point wise, then we can give numbering or can give bullets. 
 
3.11.1 Lists 
Lists allow you to format and arrange text with numbers, bullets, or in and summarize. 

Bulleted and Numbered Lists 
Bulleted lists have bullet points, numbered lists have numbers, and summarize lists combine 

numbers and letters depending on the organization of the list. 

To add a list to existing text 

• Select the text you wish to make a list 

• From the Paragraph Group on the Home Tab, Click the Bulleted or Numbered Lists 

button. 
 
 
 
 
 
 
 
 

Fig 3.79 different types of list 
 
To create a new list 

• put your cursor where you wish for the list in the document 

• Click the Bulleted or Numbered Lists button  
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• Begin typing 
 
Nested Lists 
A nested list is list with a number of levels of indented text. To create a nested List: 
 

• Create your list following the directions above 

• Click the Increase or Decrease Indent button 

 
 
 
 
 

 

Fig 3.80 Increase or Decrease Indent button 
Formatting Lists 
The bullet image and numbering format can be altered by using the Bulletsor Numbering 

dialog box. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Fig 3.81 formatting list 
1. Select the whole list to change all the bullets or numbers, or Place the cursor on one line 

within the list to modify a single bullet 

2. Right click 
3. Click the arrow next to the bulleted or numbered list and decide a bullet or numbering 

style. 
 
3.11.2 Word Art 
 
Word art is used to shown the textual data with diverse styles and various sizes. Sometimes we 

have to design textual data in a mixture of styles. Then we have to prefer word art On the Insert 

tab, in the Text group, click WordArt, and then choose the WordArt style that you want. 
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1. Type your text in the text boxWord 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Fig 3.82 different kinds of word arts 
Do one or more of the following: 

1. To modify the text, select it, and then make the changes that you want. 
2. To modify the font, see Change the font, font size, or font colour, or Apply bold, italic, or 

highlight formatting to text. 

3. To add an effect to WordArt, see Add or delete a fill, summarize, or effect for text or 

WordArt. 

4. To rotate the WordArt, observe Rotate or flip a picture, shape, or WordArt in Word 

2007. 

5. To resize the WordArt, observe Change the size of a picture, shape, text box, or Word 

Art. 

6. To align the WordArt, observe Align or arrange a picture, shape, text box, or WordArt. 

7. To move the WordArt, notice to Move a picture, shape, text box, or WordArt 
 

Summary 

In windows 10, the screen layout is changed from the previous versions of windows. In 

windows10 ribbon, tabs, groups and buttons are also looking in different. 

To edit a document, you want to open it. On selecting the file,open command, word displays the 

open dialogue box. If the file you need to open is not there in the current directory, you can 

change the directory and then select the file for opening. 

To move the cursor to the preferred location on the screen, you can either take the help of the 

mouse or use the keyboard. You can scroll the document vertically or horizontally by using 

scroll bars. To fasten the editing we must know the short cuts of keyboard. Suppose if you press 
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ctrl+home the cursor must be beginning of the document. You can use undo , redo etc for 

editing. 

You can easily move the selected text to any part of the document. word allows you to move the 

text with the keyboard as well as mouse. When you make copy(copy and paste) it is present at 

both places source and destination. When you make a move(cut and paste) it is present only at 

the destination and no more in the source. 

Students should practice copy and move only by using keyboard without using mouse and also 

only by using mouse without keyboard.Help system provides facility to the each and every 

feature in word you are using and it is readily available by showing the icon.Word allows you to 

format the paragraph by applying various font styles, colors, highlighting, strikethrough, spacing 

between lines, borders and shading, alignment etc. whatever the facility you used to the 

document looks better. 

In the document we can use find with many options such as match case, whole words only, 

pattern matching and sounds like etc., to find a text.Spell checker is used to make error free 

document. Autocorrect automatically fixes errors based on a list. Auto text is normally used to 

quickly type lengthy or difficult to type text that you need routinely in your document. 

To create a multi column table ,you can use tabs. By default, word creates tabs at every 0.5" 

position. However we can define our own tabs stop position. .We can create four types tabs. 

These are left aligned, right aligned, centered and decimal aligned.After completion of setups in 

the page layout , we must see print preview before printing a document . If there are any changes 

have to be made we can change by using page layout again. 

When you enter text in the cell of a table ,word automatically changes the cell height to 

accommodate the text you type. Use the tab key to move the cursor to the next cell and Shift+tab 

key to move the cursor to the previous cell. Text entered in the table can be formatted by using 

the normal text formatting commands. 

With the help of this graphics ,you can create lines, rectangles, squares, ellipses, circles, arcs, 

text boxes, etc. You can also control the line thickness , colour and styles of the lines you draw. 

You can also insert the pictures and also you can drag the pictures as well as objects to the 

desired location.In sample mail merge we have shown only three addresses but we can perform 

many more.We need not use the default fields and also can change the field names as we require 

such as designation, post, etc. For changing the name of a field follow 

Select recipients > type new list > customize columns > add > field name . 

In the documents, sometimes the sentences may be required to give numbering or marking. For 

this we have to use lists. If we want to make special effects to any text we prefer word art. 
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Model Questions 

Short Answer Type Questions 

1. What is a Ribbon? 

2. What is office button? 

3. What is quick access toolbar? 

4. What are the tabs in the ribbon? 

5. What are the shortcuts for open and save a file? 

6. What are the shortcuts for new and close a file? 

7. What is the difference between copy and move? 

8. What is help system? 

9. What are the alignments in paragraph? 

10. What are the indents in paragraph? 

11. What is formatting a text? 

12. What is auto text? 

13. What is autocorrect? 

14. What is word count? 

15. What is default dictionary? 

16. What is thesaurus? 

17. What is undo changes? 

18. What are different types tab alignments? 

19. What are the options in page layout? 

20. What is orientation? 

21. What is header and footer? 

22. Draw a table with any data of your choice. 

23. What is clip art? 

24. What is smart art? 

25. What is water mark? 

26. What is mail merge? 
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Long Answer Type Questions 

1. Write the stepwise procedure to create, edit and save a document in word 

2. Write about document views. 

3. Write about move and copy. 

4. Write about formatting the paragraph. 

5. Write about find and replace. 

6. Write about spell checker. 

7. Write about tabs. 

8. Explain the options in detail in page layout 

9. Write about tables. 

10. Write about graphics. 

11. Write about mail merge. 

12. Write about bullets and numbering. 

13. Write about word art. 
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UNIT - IV 

MS-Excel 

4.1 Introduction to Spread Sheet 

4.1.1 Microsoft Office Button/FILE Button 

4.1.2 Ribbon or Menu Bar 

4.1.3 Quick Access Toolbar 

4.1.4 Mini Toolbar 

4.2 Creating Worksheets and feeding data 

4.2.1 Create a Workbook 

4.2.2 Feeding Data  

4.3 Using functions 

4.4 Editing  cells and Using commands and functions 

4.5 Moving and Copying, Inserting and  Deleting Rows and Columns 

4.6 Formatting worksheet 

4.6.1 Add Borders and Colors to Cells  

4.6.2 Change Column Width and Row Height  

4.6.3 Hide or Unhide Rows or Columns 

4.6.4 Merge Cells 

4.6.5 Align Cell Contents 

4.7 Opening, Saving and Printing a Workbook 

4.8 Working with Charts 

4.8.1 Create a Chart 

4.8.2 Modify a Chart 

4.8.3 Chart Tools 

4.9 Macros 

4.10 Tables and Pivot Tables 

4.10.1 Tables 

4.10.2 PivotTables 
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4.1 Introduction to Spread Sheets  
Let’s begin with Excel 2010 you will notice that there are many related features to previous 

versions. You will also observe that there are many new features that you’ll be able to utilize. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 4.1 Spread Sheet Preview 
There are three main features that you should remember as you work within Excel 2010: File, the 
Quick Access Toolbar, and the Ribbon. In 2007 instead of having FILE button consist Microsoft 

Office Button. The function of these features will be more fully discussed below. 
Spread sheet 
A spread sheet is an electronic document that stores different types of data. There are vertical 

columns and horizontal rows. The intersecting part of rows andcolumn is called cell. So spread 

sheet is a collection cells. A cell can contain data and can be used in calculations of data within 

the spread sheet. Each cell can be represents by it ids like A1, A2… And B1, B2..., etc. An 

Excel spread sheet can have workbooks and worksheets. The workbook is the folder for related 

worksheets. 

4.1.1 Microsoft Office Button/FILE Button 
The Microsoft Office Button or FILE button does many of the functions that were located in the 

beginning of the Excel. This button allows you to create a new workbook, Open an existing 

workbook, save and save as, print, send, or close, view the recent workbooks.  
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Fig. 4.2 Microsoft Office Button 
4.1.2 Ribbon or Menu Bar 
The ribbon or Menu Bar is the panel at the top portion of the document. It consist several menus 

in form separate tabs. It has seven tabs: Home, Insert, Page Layouts, Formulas, Data, Review, 

and View. Each tab is divided into groups or sub menus. The sub menus are logical collections of 

features designed to perform function that you will utilize in developing or editing your Excel 

spread sheets.  
 
 
 
 
 
 
 
 
 

Fig. 4.3 Ribbon 
 
Commonly utilized features are displayed on the Menu Bar. To view extra features within each 

group and to change the default setting, click the arrow at the bottom right corner of each group.  
1. Home: Clipboard, Fonts, Alignment, Number, Styles, Cells, Editing 

2. Insert:Tables, Illustrations, Charts, Links, Text 

3. Page Layouts: Themes, Page Setup, Scale to Fit, Sheet Options, Arrange 

4. Formulas: Function Library, Defined Names, Formula Auditing, Calculation 

5. Data: Get External Data, Connections, Sort & Filter, Data Tools, Outline 

6. Review: Proofing, Comments, Changes 

7. View: Workbook Views, Show/Hide, Zoom, Window, Macros 

4.1.3 Quick Access Toolbar 
 
The quick access toolbar is a customizable toolbar that has commands that you may want to use. 

You can place the quick access toolbar above or below the ribbon. To modify the location of the 

quick access toolbar, select on the arrow at the end of the toolbar and click Show below the 

Ribbon. 
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Fig. 4.4 Quick Access Toolbar 
You can also add items to the quick access toolbar. Right click on any item in the Office Button 

or the Ribbon and click Add to Quick Access Toolbar and a shortcut will be added.  
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 4.5 adding short cut for Quick Access toolbar 
4.1.4 Mini Toolbar 
A new feature in Office 2007 is the Mini Toolbar. This is a floating toolbar that is displayed 

when you select text or right-click text. It displays common formatting tools, such as Bold, 

Italics, Fonts, Font Size and Font Color. 

 

 
 
 
 
 
 

Fig. 4.6 Mini Toolbar 
4.2 Creating a Work Sheets and Feeding the data 

 

Firstly you want to create the worksheet so that you can enter the data and perform 

many other operations. 

4.2.1 Create a Workbook 

 
Select Microsoft Office Toolbar->Select New->Select Blank Document 
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The procedure of opening a new or opening an existing document is like to opening a new or 
existing document in MS Word 
 
 
 
 
 
 
 
 
 
 

Fig 4.7 creating a new workbook 

Note: Workbook is the group of one or more than one work sheets 

Creating a Single Worksheet: 

Every Excel workbook contains at least one or more worksheets. If you are working with a 
large amount of related data, you can use worksheets to help organize your data and make it 
easier to work with. 
Note: By default every excel workbook will have 3 worksheets  

To rename worksheets: 

1. Right-click on the worksheet tab to which you need to change the name. The worksheet 
menu appears. 

2. Select Rename. 

 

Fig 4.8 Renaming worksheet 

3. The text is now highlighted by a black box. Type the name of your worksheet. 
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Fig 4.9 Highlighting name for renaming 

4. Click anywhere outside the tab. The worksheet is renamed. 

 

Fig 4.10 worksheet after renaming 

To insert new worksheets: 

To create a new worksheet you have to click the Insert Worksheet icon. A new worksheet will 
appear. 

 
Fig: 4.11 Insert worksheet icon to create new work sheet 

You can modify the setting for the default number of worksheets that appear in Excel 
workbooks. To access this setting, go into Backstage view and click Options. 

Note: Shortcut key to create a new worksheet ->shift+f11 

To delete worksheets: 

You can also delete the worksheets from the workbook, with those containing data. 
Select the worksheets you want to delete. 

1. Right-click one of the choose worksheets. The worksheet menu appears. 
2. Click on Delete. The selected worksheets will be deleted from your workbook.  
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Fig 4.12 pop-up menu to delete  a worksheet 

To copy a worksheet: 

1. Right-click the worksheet you want to copy. The worksheet menu appears. 
2. Select Move or Copy. 

 

Fig 4.13 pop-up menu for move or copy a work sheet 

3. The Move or Copy dialog box seems. Tick on the Check box to Create a copy. 

 

Fig: 4.14 pop-up for creating a new excel copy 
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4. Click on OK. Your worksheet is copied. It will have the same title as your original 
worksheet, but the name will include a version number, such as 

To move a worksheet: 

1. In order to move a worksheet from one place to another place you have to click the 
worksheet you want to move. The mouse will modify to show a small worksheet icon.

2. Drag the worksheet icon until a small black arrow 
worksheet to be moved. 

3. Release your mouse, and the worksheet will be moved.

To color code worksheet tabs: 

You can color worksheet tabs to help organize your worksheets and make your workbook easier 
to navigate. 

1. Right-click the worksheet tab you want to color. The 
2. Select Tab Color. The color

3. Select the color you want to change your tab.
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. Your worksheet is copied. It will have the same title as your original 
worksheet, but the name will include a version number, such as January (2)

 

Fig 4.15 moving 

In order to move a worksheet from one place to another place you have to click the 
worksheet you want to move. The mouse will modify to show a small worksheet icon.
Drag the worksheet icon until a small black arrow appears where you want the 

 

Release your mouse, and the worksheet will be moved. 

 

 

You can color worksheet tabs to help organize your worksheets and make your workbook easier 

sheet tab you want to color. The worksheet menu appears.
color menu appears. 

Select the color you want to change your tab. 

. Your worksheet is copied. It will have the same title as your original 
January (2). 

In order to move a worksheet from one place to another place you have to click the 
worksheet you want to move. The mouse will modify to show a small worksheet icon. 

s where you want the 

You can color worksheet tabs to help organize your worksheets and make your workbook easier 

menu appears. 
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Fig 4.16 moving color 

4. The tab color will change in the workbook. If your tab still appears white, it is because 
the worksheet is still selected. Select any other worksheet tab to see the color change. 

 

Grouping and ungrouping worksheets 

You can work with each worksheet in a workbook individually, or you can work with multiple 
worksheets at the same time. Worksheets can be combined into a group. Any changes made to 
one worksheet in a group will be made to every worksheet in the group. 

To group worksheets: 

1. Select the first worksheet you want in the group. 
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Fig 4.17 grouping worksheet 

2. Press and hold the Ctrl key on your keyboard. 
3. Select the next worksheet you want in the group. Continue to select worksheets until all 

of the worksheets you want to group are selected. 

 

4. Release the Ctrl key. The worksheets are now grouped. The worksheet tabs appear 
white for grouped worksheets. 

While worksheets are grouped, you can navigate to any worksheet in the group and make 
changes that will appear on every worksheet in the group. If you click a worksheet tab that's not 
in the group, however, all of your worksheets will become ungrouped. You will have to group 
them again. 

To ungroup all worksheets: 

1. Right-click one of the worksheets. The worksheet menu appears. 
2. Select Ungroup. The worksheets will be ungrouped. 

Freezing worksheet panes 

One of the most useful feature in Excel is it has the ability to freeze specific rows or columns in 
your work sheet . It is called freezing panes. When you freeze panes, you select rows or 
columns that will remain visible all the time, even as you are scrolling. This is particularly 
helpful when working with large spreadsheets. 

To freeze rows: 

1. Select the row below the rows you want frozen. For example, if you want rows 1 and 2 to 
always appear at the top of the worksheet even as you scroll, then select row 3. 
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2. Click the View tab. 
3. Click the Freeze Panes command. A drop-down menu appears. 
4. Select Freeze Panes. 

 

Fig 4.18 freeze panes 

5. A black line appears below the rows that are frozen in place. Scroll down in the 
worksheet to see the rows below the frozen rows. 
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Fig 4.19 freeze rows 

 

To freeze columns: 

1. Select the column to the right of the columns you want frozen. For example, if you want 
columns A and B to always appear to the left of the worksheet even as you scroll, select 
column C. 

 

Fig 4.20 freeze columns 

2. Click the View tab. 
3. Click the Freeze Panes command. A drop-down menu appears. 
4. Select Freeze Panes. 
5. A black line appears to the right of the frozen area. Scroll across the worksheet to see the 

columns to the right of the frozen columns. 
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To unfreeze panes: 

1. Click the View tab. 
2. Click the Freeze Panes command. A drop-down menu appears. 
3. Select Unfreeze Panes. The panes will be unfrozen, and the black line will disappear. 

 

Fig 4.21 unfreeze panes 

4.2.2 Feeding Data  

Introduction 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 4.22 Feeding 

In the work sheet the rows are specified by 1, 2, 3, 4…and the columns are specified by A, B, C, 

D,.. . The cell address denoted by means of column number and row number. For example a cell 

B3 means row number 3 and column number B. 
 
There are many ways to enter data in Excel: 

We can directly feed the data in the active cell or we can enter the by using the formula bar. 

To enter data in an active cell. 

• choose the cell where you want to enter the data -> and start typing 
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To enter the data by using the formula bar:  
 
 
 
 
 
 
 
 
 
 
 
 
                         Fig. 4.23 Selecting a Random cell 
 

• choose  the cell where you would like to enter the data 

• Place the cursor in the Formula Bar 
 

• Start typing the data  
 
 
 
 
 
 
 

 

Fig. 4.24 Formula Bar 
4.3 Using functions 
Simple formulas 

A formula is an equation that performs a calculation. Like a calculator, Excel can execute 
formulas that financial, text, auto sum, logical, date & Time..Etc. One of Excel's most valuable 
features is its ability to calculate using a cell address to denote. You can create a simple formula 
to add, subtract, multiply or divide values in your worksheet. Simple formulas always start with 
an equal sign (=), followed by constants that are numeric values and calculation operators such 
as plus (+), minus (-), asterisk (*), or forward slash (/) signs. 
Overview of Function Library: The function library is a large group of functions onthe 

Formula Tab of the Ribbon. These functions include 

AutoSum: Easily calculates the sum of a range 

Recently Used: All recently used functions 

Financial: Accrued interest, cash flow return rates and additional financialfunctions 

Logical: And, If, True, False, etc. 
Text: Text based functions 
Date & Time: Functions calculated on date and time 
Math & Trig: Mathematical Functions 
Note: 

The key thing to remember is that all the formulas in Excel must begin with an equals sign (=). 
The following are represents different way to enter formulas in excel. 

Manually enter Excel formulas: 

Long Lists: =SUM (B4:B13)=>syntax: SUMS(Starting cell: Ending cell) 
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Short Lists: =SUM (B4, B5, B6,B7); =SUM (B4+B5+B6+B7). Or, place your cursor in the first 
empty cell at the bottom of your and press the plus sign, then click B4; press the plus sign again 
and click B5; and so on to the end; then press Enter. Excel adds/totals this list you just “pointed 
to:” =+B4+B5+B6+B7. 
 

 
Fig 4.25 formulas to perform basic calculations, 

 
2. Click the Insert Function button 

Use the Insert Function button under the Formulas tab to select a function from Excel’s menu 
list: 
=COUNT (B4:B13) Counts the numbers in a range (ignores blank/empty cells). 
=COUNTA (B3:B13) Counts all characters in a range (also ignores blank/empty cells). 
3. Select a function from a group (Formulas tab) 

Narrow your search a bit and choose a formula subset for Financial, Logical, or Date/Time, 
month and hour, for example. 
=TODAY () Inserts today’s date. 
= 
4. The Recently Used button 

Select the Recently Used button to show functions you've used recently. It's a welcome 
timesaver, especially when working with an extra spreadsheet. 
=AVERAGE (B4:B13) adds the list, divides by the number of values, then provides the average. 
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5. Auto functions under the AutoSum button 

Auto functions are my editor's personal favorite, because they're so fast. Select a cell range and a 
function, and your result appears with no muss or fuss. Here are a few examples: 
=MAX(B4:B13) returns the highest value in the list. 
=MIN(B4:B13) returns the lowest value in the list. 

 
Fig 4.26 auto sum formulas 

 
Use the AutoSum button to calculate basic formulas such as SUM, AVERAGE, COUNT, etc. 
We have some pre-defined functions in Excel. In order to use that functions simply we have 

click on that function and we have to provide the parameters 

=>Complete the Number 1 box with the first cell in the range that you want calculated 
 
=>Complete the Number 2 box with the last cell in the range that you want calculated. 
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Fig. 4.15 Functions with Arguments 

Fig 4.27function arguments 

4.4 Editing cells and using commands and functions 

In Excel we have so many  editing features such as undo, redo, find a particular word  and 
replace that word with another word, go to ,spell check etc..  
Undo and Redo: 

 For example,   if you have committed any action accidentally in your document then don’t 
worry there is an option calledUNDO ,which will remove the last action which you had 
performed in your document 
And similarly if you had deleted the content or any other accidentally by undo then we use 
REDO option which will give you the last deleted data in your document 
� On the Quick Access Toolbar 

 
� Click Undo or Redo  

 
 
 
 
 
 
 
 
 
 
 

 

Fig. 4.28 Undo and Redo 

 

Note: Shortcut key for undo is ctrl+zand for redo isctrl+y 

Auto Fill: 
 
The Auto Fill feature fills cell with data or series of data in a worksheet into a selected range of 

cells.  If you want the same data in all the cells then only you have to enter that data in one cell 

and you have to first select that cell and drag to the no.of cells in which you want that data. If 

you want to have a series of data in immediate cells (for example, days of the week) fill in the 

first two cells in the series and then use the auto fill feature. 
 
� Click the Fill Handle 

� Drag the Fill Handle to complete the cells  
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Fig. 4.29 Fill Handle 

Find and Replace 
 
For example, Assume that you are typing a document and accidentally you have entered the 
name of a person as Murali but actually his name in Krishna, then simply you can use this 
feature Find and Replace  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig. 4.30 Find and Replace 

Enter the name Murali in the Find what field and enter Krishna in Replace with field, then all the 
Murali words in your present working worksheet will replace with the word Krishna   
� Click the Find & Select button on the Editing group of the Home tab 

 
� Choose Find or Replace 

 
� Complete the Find What text box 

 
� Click on Options for more search options 

 
Go To Command: 
 
The Go To command will takes you to a specific cell either by cell reference (the 

Column Number and the Row Number) or by cell name. 
 
� Click the Find & Select button on the Editing group of the Home tab 

 
� Click Go To  
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Fig. 4.31 Goto Function 
 
 

Spell Check 

This option is used to Check the Spelling within the Current working worksheet 
To check the spelling: 
On the Review tab click the Spelling button 

  
 
 
 
 
 
 
 
 
 
 

 

Fig. 4.32 Spell Check 
 
Split the screen 
Split the window into multiple resizable panes containing views of your worksheet. By this 
feature you can  view  distant parts of your worksheet at once. 
 
It is in the view tab, select on the split as shown below  
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 Fig. 4.33 Split Screen 

 

Calculate with Functions: 
 
A function is a built in formula in Excel. A function consists of two fields namely Function name 

and arguments (the mathematical function) in parentheses. Here we give a sample worksheet. Let 

us understand the concept of functions by using this figure  
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 4.34 Calculate with Functions 
 
Mathematical functions 
  
1.POWER: Used to find  the results of a number raised to a power and returns the result 
 
Syntax 
 
POWER(number,power) 
 
Here, 

Number is any real number. 
 
Power is the exponent to which the base number is raised. 
Example: 
 
POWER(C2,E2) gives result 25 because (4

2
 = 16) 
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2.FACT: Used to calculate the factorial of a number. 
 
Syntax: 
 
FACT(number) 
 
Here, 

Number is the non-negative number for which you want the factorial. Ifnumber is 

not an integer, it is truncated. 
 
Example 
 
FACT(C2) gives 24 because B2 in Figure 4.23 contains 4 i.e (1 x 2 x 3 x 4  = 24). 

3.SQRT: Finds the square root of a value in the cell. 
Syntax 
 
SQRT(number) 
 
Number is the number for which you want to find the square root. 
 
Remark 
 
If number is negative, SQRT returns the #NUM! error value. 
 
Example 
 
SQRT(C2) gives 2 because square root of 4 is 2. 
 
4. SUM 
 
The SUM function adds all the numbers that you specify as arguments (argument: A value that 

provides information to an action, an event, a method, a property, a function, or a procedure.). 

Each argument can be a range (range: Two or more cells on a sheet. The cells in a range can be 

adjacent or nonadjacent.), a cell reference (cell reference: The set of coordinates that a cell 

occupies on a worksheet. For example, the reference of the cell that appears at the intersection of 

column B and row 3 is B3.), an array (array: Used to build single formulas that produce multiple 

results or that operate on a group of arguments that are arranged in rows and columns. An array 

range shares a common formula; an array constant is a group of constants used as an argument.), 

a constant (constant: A value that is not calculated. For example, the number 210 and the text 

“Quarterly Earnings” are constants. An expression, or a value resulting from an expression, is 

not a constant.), a formula (formula: A sequence of values, cell references, names, functions, or 

operators in a cell that together produce a new value. A formula always begins with an equal 

sign (=).), or the result from another function. For example, SUM(A1:A5) adds all the numbers 

that are contained in cells A1 through A5. For another example, SUM(A1, A3,A5) adds the 

numbers that are contained in cells A1, A3, and A5. 
 
Syntax 
 
SUM(number1, [number2],[number3],[number4],…) 
 
The SUM function syntax has the following arguments: 
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number1Required 
 
number2, number3 are optional 
 
Example: 
 
SUM(A2:E2) Gives the result 20 because(3 + 5 +4 + 6 + 2 = 20) 
5. SUMIF 
 
You use the SUMIF function to sum the values in a range that meet criteria that you 

specify. It will check the condition if the condition is true then only it will return the 

value 
 
SYNTAX: 
 
SUMIF(RANGE , CRITERIA) 
 
Example: 
 
SUMIF(A2:E2,”>4”) Gives result 11 because (5 + 6). 
 
6.MOD 
 
Returns the remainder as the result  after number is divided by divisor. The sign of 

the result is same as the sign as divisor. 
 
Syntax 
 
MOD(number,divisor) 
 
Number is the number for which you want to find the remainder. 
 
Divisor is the number by which you want to divide number. 
 
Ex1: MOD(B2,A2) gives result 2 because remainder is 2 when 5 is divided by 3. 
  
Statistical functions 
 
1. Average: Returns average(arithmetic mean) of the  arguments 
 
The AVERAGE function syntax has the following arguments  
 
Number1 Required. The first number, cell reference (cellreference: Theset of 

coordinates that a cell occupies on a worksheet. For example, the reference of the 

cell that appears at the intersection of column B and row 3 is B3.), or range for 

which you want the average. 
 
Syntax: average(number1,number2,..) 
Example: 
 
Average(a2:e2) gives result 4 because (3+5+4+6+2)/5 = 4 
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2. Count 
 
The COUNT function is used to count the number of cells that contain numbers and 

counts numbers within the list of arguments. Use the COUNT function to get the 

number of entries in a number field that is in a range or array of numbers. 
 
Syntax 
 
Count(value1,[value2] ,...) 
 
The COUNT function syntax has these arguments. They are 
 
value1(Required) The first item, cell reference, or range within which youwant to 

count numbers. 
 
value2,(Optional) Up to 255 additional items, cell references, or rangeswithin which 

you want to count numbers. 
 
Example 
Count(a4:e4) gives result 3 because (12,8,4 are 3 values) 
 
3. Count A 
 
The COUNTA function counts the number of cells that are not empty in a range  

Syntax 
 
COUNTA(value1, [value2], ...) 
 
The COUNTA function syntax has the following arguments (argument: A value that 

provides information to an action, an event, a method, a property, a function, or a 

procedure.): 
 
value1 (Required) The first argument representing the values that you wantto count 

of. 
 
value2(Optional) 
Ex: counta(A4:E4) gives the result 4 because the range contains 4 values. 
Count Blank 
 
Returns the count of no.of empty cells present in a specific range. 
 
Syntax 
 
COUNTBLANK(range) 
 
Range is the range from which you want to count the blank cells. 
 
Example: 
 
Countblank(A4:E4) gives result 1 because the range contains one blank. 
 
5.Count If 
 
The COUNTIF function counts the number of cells within a range that meet a single 

condition that you specify. For example, you can count all the cells that start with a 
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certain letter, or you can count all the cells that contain a number that is larger or 

smaller than a number you specify. 

Syntax: 

COUNTIF(range, criteria) 
 
The COUNTIF function syntax has the following arguments  
 
=>range (Required) One or more cells to count, including numbers or names,arrays, 

or references that contain numbers. Blank and text values are ignored. 
 
=>Condition(Required) Anumber, expression, cell reference, or text string 

thatdefines which cells will be counted. For example, criteria can be expressed as 32, 

“>32”, B4, “apples”, or “32”. 
 
Ex: 
Countif(A4:E4,”>10") gives result 1 because the range contains only one value that 

is greater than 10. 

6.MAX: 
 
Returns the maximum value in the range 
 
Syntax: 

MAX(number1,number2,...) 
 
Number1, number2, ...are 1 to 255 numbers for which you want to findthe 

maximum value. 
 
Ex : max(A2:E2) gives result 6 because 6 is the maximum value in that range. 
 
7.MIN: Returns the minimum value in the range 
 
Syntax: 

MIN(number1,number2,...) 
 
Number1, number2, ...are 1 to 255 numbers for which you want to findthe 

minimum value. 
 
Ex : max(A2:E2) gives result 2 because 6 is the minimum value in that range 

4.5 Moving and copying, inserting and deleting Rows and Columns: 
 
Excel allows you to perform some operations on the cells like moving a cell, copying a cell, and 

paste cell and we can perform cut and paste operation as well as copy and paste operation on 

the data present in the cells. In order to perform the cut and paste , copy and paste operations first 

we have to select the data on which we want to perform those operations. 
 
Select Data 
 
To select a cell or data: 
Click the�cell  
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                            Fig. 4.35 copy one cell 

To select multiple cells just click and drag the cursor.   
 
Fig. 4.36 copying multiple cells 
Select a Row or Column 
 
To select a row or column click on the row or column header.  
 
 
 
 

 

Fig. 4.37 selecting rows and columns 
 
Copy and Paste: 
 
To copy and paste data: 
 
� Select the cell(s) that you wish to copy 

 
� On the Clipboard group of the Home tab, click Copy  

 
 
 
 
 
 
 
 
 
 
 

 

Fig. 4.38 Copy and Paste Buttons 

� Select the cell(s) that you wish to copy 
 
� On the Clipboard group of the Home tab, click Paste 

 

Cut and Paste: 
 
To cut and paste data: 
 
� Select the cell(s) that you wish to cut 

 
� On the Clipboard group of the Home tab, click Cut  
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Fig. 4.39 Cut Buttons  
� Select the cell(s) that you wish to paste 

 
� On the Clipboard group of the Home tab, click Paste 

 

 

Inserting Rows or Columns: 

Place the cursor in the row below where you want to insert the new row, or in the 

column to the left of where you want to insert the  new column 
 
� Click the Insert button on the Cells group of the Home tab 

 
� Click the appropriate choice: Cell, Row, or Column 

 
 
 
 
 
 

 

Fig. 4.40 Insert Commands 

Delete Cells, Rows and Columns: 
 
You can also delete some unwanted cells from your worksheet. To delete cells, rows, and 
columns: 
 
� Place the cursor in the cell, row, or column that you want to delete 

 
� Click the Delete button on the Cells group of the Home tab 

 
� Click the appropriate choice: Cell, Row, or Column  

 
 
 
 
 
 
 
 
 
 
 
 

 
`   Fig. 4.41 Delete Cells and Rows 
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4.6 Formatting a Worksheet: 
 
Formatting the worksheet contains six options numbers, alignment, font, border, fill and 

protection to the work sheet. 
 
Changing fonts in Excel will allow you to emphasize titles and headings. To modify a font: 
 
� Select the cell or cells that you would like to apply the font  

 
� Go to the Font group on the Home tab, choose the font type, size, bold(ctrl+b), 

italics(ctrl+i), underline(ctrl+u), or color 

 
 

 

 

 

 

 

 

 

Fig. 4.42 Modifying Fonts 
 
In Excel, you can also apply specific formatting to a cell. Process of applying formatting to a cell 

or group of cells: 
 
� Select the cell or cells that will have the formatting 

 
� Click the Dialog Box arrow on the Alignment group of the Home tab  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Fig. 4.43 Formatting Cells 

 
There are several tabs on this dialog box that allow you to change properties of the cell or cells. 
 
Number : Allows for the display of different types of numbers  and decimalplaces 



 

 

Paper I Computer Fundamentals and MS-Office 

162 

 

 
Alignment: Allows for the horizontal and vertical alignment(arrangement) of text,wrap text, 

shrink text, merge cells and the direction of the text. 
 
Font : Allows for control of font, font style, size, color, and additionalfeatures 
 
Border : Border styles and colors 
 
Fill : Cell fill colors and styles 
 
4.6.1 Add Borders and Colors to Cells 
 
Borders and colors can be added to cells manually or through the use of styles. To add borders 

manually: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                         

Fig. 4.44 Adding Borders to Cells 
 
 
Click the Borders drop down menu on the Font group of the Home tab 
 
=>Choose the appropriate border  
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Fig. 4.45 Adding Colors 
 
To apply borders and colors using styles:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 4.46 Applying Borders and Color 

 
� Click Cell Styles on the Home tab 

 
� Choose a style or click New Cell Style 

 
4.6.2 Change Column Width and Row Height: 
 
To change the width of a column or the height of a row: 
 
� Select  the Format button on the Cells group of the Home tab 

 
� Manually adjust the height and width by clicking Row Height or ColumnWidth 

 
If you want to use AutoFit click AutoFit Row Height or AutoFit Column Width  
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Fig. 4.47 Changing Column Width and Row 

4.6.3 Hide or Unhide Rows or Columns: 
To hide or unhide rows or columns: 
 
� Select the row or column you wish to hide or unhide 

 
� Select the Format button on the Cells group of the Home tab 

 
� Select  Hide or Unhide  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 4.48 Hide and Unhide Rows and Columns 
4.6.4 Merge Cells: 
 
In order to merge the cells firstly you have to select the cells to merge and click the Merge 

&Center button on the Alignment group of the Home tab. The four choices formerging cells 

are: 
 
� Merge & Center: Combines the cells and centers the contents in the 

new,larger cell 

� Merge Across: Combines the cells across columns without centering data 
� Merge Cells: Combines the cells in a range without centering 

 
� Unmerge Cells: Splits the cell that has been merged 
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Fig. 4.49 Merge and Unmerge Cells 
 
4.6.5 Align Cell Contents 
 
To align cell contents, Select the cell or cells you want to align and click on the options within 

the Alignment group on the Home tab. There are several options for alignment of cell contents: 
 

• Top Align: Aligns text to the top of the cell 
 

• Middle Align: Aligns text between the top and bottom of the cell 
 

• Bottom Align: Aligns text to the bottomof the cell 
 

• Align Text Left: Aligns text to the left of the cell 
 

• Center: Centers the text from left to right in the cell 
 

• Align Text Right: Aligns text to the right of the cell 
 

• Decrease Indent: Decreases the indent between the left border and thetext 
 

• Increase Indent: Increase the indent between the left border and the text 
 

• Orientation: Rotate the text diagonally or vertically 
 
 
 
 
 
Fig. 4.50 Alignments 
4.7 Opening, Saving and Printing a Workbook 
 
The work sheet that you have worked so far has been stored in RAM (Random Access 

Memory) of your system. The RAM is volatile. i.e., it loses its contents ,if the power is 

switched off to system. Therefore you must save the work sheet for future reference. You can 

also change the name of file and location of file by using “save as” . 

 
 
When you save a workbook, you have two choices: Save or Save As. 
 
To save a document: 
 
� Click the Microsoft Office Button 

 
� Click Save option  
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Fig. 4.51 Saving a File 
 
You have to use the Save As feature when you have to save a workbook under a different name 

or to save it in another location. Remember that older versions of Excel will not be able to open 

an Excel 2007 worksheet unless you save it as an Excel 97-2003 Format. Inorder to use the Save 

As feature: 
 
� Click the Microsoft Office Button 

 
� Click Save As 

 
� Type in the name for the Workbook 

 
� In the Save as Type box, choose Excel 97-2003 Workbook  
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Fig. 4.52 Saving A File 
Open a Workbook 
 
To open an existing workbook: 
 
� Click the Microsoft Office Button 
� Click Open 
� Browse to the workbook 
� Click the title of the workbook 
� Click Open 

Print a worksheet or workbook: 
 
You can print entire or partial worksheets or workbooks, one at a time, or several at once.  
  
You can also print a workbook to a file instead of to a printer. This is useful when you need to 

print the workbook on a different type of printer from the one that you originally used to print it. 
 
Print a workbook to a file 
 

1.ClickMicrosoft Office Button , and then click Print.  
Keyboard shortcut You can also press CTRL+P. 
 
2. In the Name box, select the printer on which you want to print the file. 
3.Select the Print to file check box, and then click OK. 
 
4.In the Print to File dialog box, under Output File Name, type a name for the file 

that you want to print. 
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4.8 Working with Charts 
 
A chart is a tool you can use in Excel to communicate data graphically. Often a work sheet 

contains so much numeric data that is becomes difficult to accurately analyse it and to take a 

correct decision. In such cases , the facility to represent data in the form of charts(graphs) comes 

very useful. Because charts convey the message clearly and quickly without any effort, they play 

important role in the business world. Excel offers many types of charts including: Column, Line, 

Pie, Bar, Area, Scatter and more. To view the charts available select the Insert Tab on the 

Ribbon. 
 
Suppose there is a table of a company containing area wise sales details as shown below. For this 

to draw a simple chart , select the range B4 : E7,click insert tab, click on charts in the columns 

group . if you select 2D , then chart has to be displayed as follows.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig. 4.53 Bar Chart 
4.8.1 Create a Chart 
 
In order to create a chart: 
�  First you have to select the cells that contain the data you want to use in the chart 

 
� Click the Insert tab on the Ribbon 

 
� Click the type of Chart you want to create  
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Fig. 4.54 Creating Chart 
4.8.2 Modify a Chart 
 
Once you have created a chart you can do several things to modify the chart. 
 
To move the chart: 
 
� Click the Chart and Drag it another location on the same worksheet, or 

� Click the Move Chart button on the Design tab 
 
� Choose the desired location (either a new sheet or a current sheet in the 

workbook) 
 
 
 
 
 
 
 
 
 
 
 
  
                                Fig. 4.55 Modifying a Chart 
 
 
To change the data included in the chart: 

� Click the Chart 
 
� Click the Select Data button on the Design tab 
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Fig. 4.56 Selecting a Data Source 
To reverse data are displayed in the rows and columns: 
 
� Click the Chart 

 
� Click the Switch Row/Column button on the Design tab  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig. 4.57 Reverseing the data chart 

To modify the labels and titles: 
 
� Click the Chart 

 
� On the Layout tab, click the Chart Title or the Data Labels button 

 
� Change the Title and click Enter 

 
4.8.3 Chart Tools 
 
The Chart Tools appear on the Ribbon when you click on the chart. The tools are located on 

three different tabs: Design, Layout, and Format. 
 
Within the Design tab you can control the chart type, layout, styles, and location. 
 
 
 
 
 
 
 
 

 

Fig. 4.58 Chart Tools 
 
Within the Layout tab we have so many features like we can control inserting pictures, shapes 

and text boxes, labels, axes, background, and analysis. 
 
Within the Format tab you can modify shape styles, word styles and size of the 

chart. 
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Fig. 4.59 Format Tab 
Copy a Chart to Word 
 
� Select the chart 

 
� Click Copy on the Home tab 

 
� Go to the Word document where you want the chart located Select 

Paste on the Home tab 

4.9 Macros 
 
The macro is a useful feature of excel that helps to automatic key strokes (commands) required 

to execute any command or task. Macros can be used for numeric tasks such as 
 
� Formatting of ranges 

 
� Printing a worksheet range 

 
� Creating charts 

 
� Accepting data from the user and putting that in a database 

 
Macros are advanced features in Excel that can speed up editing or formatting operations you 

may perform.  They record sequences of menu selections that you choose so that a series of 

actions can be completed in one step. 
 
Recording a Macro 
 
Inorder to record a Macro we have to do the following: 
 
� Click the View tab on the Ribbon 

 
� Click Macros 

 
� Select Record Macro 
� Enter a name (without spaces) 

 
� Enter a Shortcut Key 

 
� Enter a Description  
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Fig. 4.60 Recording a Macro 
� Perform the Macro 
� Click Macros 
� Select Stop Recording  

 
 
 
 
 
 
 
 
 

Fig. 4.61 Stoping a Macro 

 

Running a Macro 
 
In order to run a Macro from your Keyboard shortcut, simply press the keys that 

you have programmed to run the Macro. Or you can view all macros and run by: 
 
� Click Macros 

 
� Click View Macros 

 
� Choose the Macro and click Run 
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Fig. 4.62 Saving a Macro 
4.10 Tables and Pivot Tables 

4.10.1 Tables 
 
The data can be shown in the form of tables as shown below. It is an example table for a student 

marks details. Table contains rows and columns. 

STUDENT MARKS  
 
 
 
 
 
 
 
 
 
 
Create a Table 
There are two ways to create a table. You can insert a table in the default table style or you can 

format your data as a table in a style that you select. 

Insert a table 

On a worksheet, choose the range of cells that you need to include in the table. The cells can be 
empty or can contain data. 
 

• On the Insert tab, in the Tables group, click Table.  
 
 
 
 
 
 
 
 
 

Fig. 4.63 Inserting a Table 

student 
name maths science social 

reesha 100 100 100 

varun 100 100 100 

sohan 100 100 100 
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Keyboard shortcut you can also press CTRL+L or CTRL+T.  
1. If the choose range contains data that you need to display as table headers, choose the My 

table has headers check box. 

Table headers display default names if you do not choose the My table hasheaders check box. 

You can modify the default names by typing the text thatyou need. 

Dissimilar lists in Office Excel 2003, a table does not have a special row (marked with *) for fast 

adding new rows. For more details about how to add or insert rows in a table, see Add or delete 

table rows and columns in an Excel table. 
 
Format data as a table 
 

1. On the worksheet, choose a range of empty cells or cells that hold the data that you need 

to quickly format as a table. 
 

2. On the Home tab, in the Styles group, click Format as Table.  
 
 
 
 
 
 
 

Fig. 4.64 Formatting data as table 
 
When you use Format as Table, Office Excel automatically inserts a table. 
 

1. Under Light, Medium, or Dark, click the table style that you want to use. 
 
Note: Custom table styles are offered under Custom after you createone or more of them. For 

details about how to create a custom table style, view Format an Excel table. 

Convert a table to a range of data 
 
1. Click anywhere in the table. 
Tip :This displays the Table Tools, adding the Design tab. 
2. On the Design tab, in the Tools group, click Convert to Range.  
 
 
 
 
 
 
 
 
 

Fig. 4.65 Coverting a Table 
 
Note Table features are no longer available after you convert the tableback to a range. For 

instance, the row headers no longer contain the sort and filter arrows, and structured references 

(references that use table names) that were used in formulas turn into regular cell references. 
 
Delete a table 

• On a worksheet, select a table. 
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• Press DELETE. 
 
4.10.2 PivotTables 
 
PivotTables are used to looking at data in several dimensions; For instance, sales by region, sales 

by sales representatives, sales by product category, and sales by month, etc. Such capability is 

provided in numerous decision support applications under several function names. For instance, 

in a spread sheet , a pivot table provides these views and enables quick switching among them. 

A PivotTable report is an interactive way to quickly summarize large amounts of data. Use a 

PivotTable report to analyse numerical data in detail and to answer unanticipated questions about 

your data. A PivotTable report is especially designed for: 
 

• Querying large amounts of data in many user-friendly ways. 

• Subtotalling and aggregating numeric data, summarizing data by categories and 

subcategories, and creating custom calculations and formulas. 

• Expanding and collapsing levels of data to focus your results, and drilling down to details 

from the summary data for areas of interest to you. 

• Moving rows to columns or columns to rows (or “pivoting”) to see different summaries 

of the source data. 

• Filtering, sorting, grouping, and conditionally formatting the most useful and interesting 

subset of data to enable you to focus on the information that you want. 

• Presenting concise, attractive, and annotated online or printed reports. 
 
You often use a PivotTable report when you want to analyse related totals, especially when you 

have a long list of figures to sum and you want to compare several facts about each figure. In the 

PivotTable report illustrated below, you can easily see how the third-quarter golf sales in cell F3 

compare to sales for another sport, or quarter, or to the total sales.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig. 4.66 Graph showing Figures 

1. Source data, in this case, from a worksheet 
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2. The source values for Qtr3 Golf summary in the PivotTable report 
3. The entire PivotTable report 
4. The summary of the source values in C2 and C8 from the source data 
In the above pivotTable grand total for golf and qtr3 is $7,930($1500+$6430). 
 
In a PivotTable report, each column or field in your source data becomes a PivotTable field that 

summarizes multiple rows of information. In the preceding example , the Sport column becomes 

the Sport field, and each record for Golf is summarized in a single Golf item. 
 
A value field, such as Sum of Sales, provides the values to be summarized. Cell F3 in the 

preceding report contains the sum of the Sales value from every row in the source data for which 

the Sport column contains Golf and the Quarter column contains Qtr3. By default, data in the 

Values area summarize the underlying source data in the PivotChart report in the following way: 

numeric values use the SUM function, and text values use the COUNT function. 
 
To create a PivotTable report, you must define its source data, specify a location in the 

workbook, and lay out the fields. 
 
For more information, see Create or delete a PivotTable or PivotChart report and Create and 

modify the field layout in a PivotTable report. 
 
Ways to work with a PivotTable report 
 
After you create the initial PivotTable report by defining the data source, arranging fields in the 

PivotTable field List, and choosing an initial layout, you can perform the following tasks as you 

work with a PivotTable report: 
 
Explore the data by doing the following: 
 

• Expand and collapse data, and show the underlying details that pertain to the values. 

• Sort, filter, and group fields and items. 

• Modify summary functions, and add custom calculations and formulas. 
 
Modify the form layout and field arrangement by doing the following: 
 

• Modify the PivotTable report form: compact, outline, or tabular. 

• Add, rearrange, and remove fields. 

• Modify the order of fields or items. 
 
Modify the layout of columns, rows, and subtotals by doing the following: 
 

• Turn column and row field headers on or off, or display or hide blank lines. 

• Display subtotals above or below their rows. 

• Adjust column widths on refresh. 

• Move a column field to the row area or a row field to the column area. 

• Merge or unmerge cells for outer row and column items. 
 
Modify the display of blanks and errors by doing the following: 
 

• Modify how errors and empty cells are displayed. 

• Modify how items and labels without data are shown. 
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• Display or hide blank lines 
 
Modify the Format by doing the following: 
 
Manually and conditionally format cells and ranges. 

• Modify the overall PivotTable format style. 

• Modify the number format for fields. 

• Include OLAP Server formatting. 

• You can automatically create a PivotChart report when you first create a PivotTable 

report, or you can create a PivotChart report from an existing PivotTable report. 

 

 

Summary 

Whenever userenters some data in the tabular form such asrow wise and column wise, the work 

sheet is very much applicable because it provides automatic recalculations of all formulae, 

several built in functions, formatting work sheetetc. It provides professional look to the 

worksheet and avails with graph formats and others. 

A worksheet is nothing but a single spreadsheet page but a workbook is a collection of all the 

worksheets belongs to a single file. A book contains pages similarly a workbook contains 

worksheets. A workbook consists of one or more worksheets. On opening a work book it 

contains 3 work sheets by default. The number of worksheets can be increased and they can be 

named and renamed as well. One can know the maximum no of rows (ctrl + down arrow) and 

maximum no of columns (ctrl + right arrow) in excel 2007. 

On entering a formula, it automatically shows the list of the formulaethose which match the 

characters of the formula which we have entered. Thus it is very easy to enter the formula and 

the parameters required. While working on a work sheet, if you want to cancel the last action you 

have done, you can use the undo command in the quick access tool bar (one clear the mistakes 

done accidentally). It provides 2 features namely find and replace with which we canfind the 

words required and can replace them if needed. If there is any spelling mistake, we can also 

correct them using spell check. The functions are very helpful for calculations in the worksheets. 

Excel allows you to copy a cell or collection of cells to any location either within the work sheet 

or to another work sheet. In the same way you can move a cell or collection of cells to any part 

of any work sheet. For copy and paste you can use commands or buttons. We can insert and 

delete rows and columns as we require and can also number them. Your worksheet can be given 

professional look by giving variations using formatting commands. Some of the commonly used 

styles are bold, italic and underline. They can be applied by clicking the respective buttons on the 

formatting toolbar. Alternatively press the keyboard shortcut keys to apply same these styles. 

e.gCtrl+B for Bold, Ctrl+I for Italic and Ctrl+U for underline. 
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Save is used to store the file with same name but save as is used to store with another name and 

also can be stored in another location. If you print a workbook to a file so that you can later print 

the file on a different type of printer from the one that was originally used to print the document, 

the page breaks and font spacing may change. 

To give professional look to the chart, titles can also be added as well as axes. Titles can also be 

formatted by different styles of fonts, sizes etc. The macro is useful feature to automate common 

tasks. Once a macro has been created either by recording or writing, we can run it any number of 

times. To run a macro, we can press its shortcut keys or select its name from a list of macros. In 

the Tables grand totals can be known row wise or column wise very easily but, to know the totals 

of subfields we have to use Pivot tables. 

Short Answer Type Questions 

1. What is a spread sheet? 

2. What is a Ribbon? 

3. What is mini toolbar? 

4. How many rows and columns in excel 2007? 

5. What is the difference between workbook and worksheet? 

6. How the columns and rows are represented in a work sheet? 

7. What is a formula? 

8. What is undo and redo? 

9. What is auto fill ? 

10. What is find and replace? 

11. What is Go To command? 

12. What is spell check? 

13. What is split screen? 

14. What is the difference between copy and move? 

15. What are the six options in format cells ? 

16. What are the alignments? 

17. What are merge cells? 

18. What are the shortcut keys for bold, italic and underline? 

19. What is the importance of saving a worksheet? 

20. What is the difference between save and save as ? 

21. What is the importance of charts? 

22. What are the different types of charts? 

23. What is a macro? 

24. What is a table? 

25. What is a PivotTable? 
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Long Answer Type Questions 

1. Write the 7 tabs in excel and write the groups in each tab. 

2. Write and explain any six functions. 

3. Write and explain any five mathematical functions. 

4. Write and explain any five statistical functions. 

5. Explain copy and move the range of cells with an example. 

6. Write the procedure to open, save and print a worksheet. 

7. Write about charts. 

8. Write about macros. 

9. Write about tables in excel. 

10. Write about PivotTables in excel. 

5 MS-Excel 

5.1 Creating Presentations using AutoContent Wizard, Template and Blank 

Presentation 

5.1.1 Auto-content Wizard 

5.1.2 Template 

5.1.3 Creating Presentation using Blank Presentation 

5.2 working with Master’s Slide, title handout and Notes  

5.2.1 Hand-outs 

5.2.2 Speaker notes 

5.2.3 The Slide Master 

5.3 Viewing presentation 

5.3.1 slide views 

5.3.2 Slide Sorter view 

5.3.3 Slide Show view 

5.3.4 The slide show menu 

5.3.5 Menu icon 

5.3.6 Notes Page view 

5.4 Drawing Objects and Inserting OLE  

5.4.1 Drawing Objects 

5.4.2 Inserting OLE- Object Linking and Embedding 

5.5 Drawing Freeform Shapes 

5.5.1 draw a freeform shape 

5.5.2 Working with editing points 

5.5.3 Delete shapes 

5.5.4 Draw a Pentagon Shape 

5.6 Rotating Objects 

5.6.1 Aligning objects 

5.6.2 Ordering and rotating objects 

5.6.3 Grouping objects 
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5.7 Animation in Slides/Objects Create a Chart 

5.7.1 Animating text and objects 

5.7.2 Apply an animation to an object 

5.7.3 Effect options 

5.7.4 Working with Animations 

5.7.5 preview animations 

5.7.6 Animation pane 
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UNIT - V 

MS-Power Point 
Introduction 
 
In this era of competitive business environment, the companies will have minimum expectation 

of the professional skills of their employees which involves making a presentation to clients, 

colleagues, superiors that requires presentation skills, communication skills and knowledge of 

presentation software. The days where using whiteboard and marker pens or overhead projectors 

for giving presentations is over. Today, a number of software packages designed for the users to 

conceive, create and deliver visually stunning and dazzling presentations. These applications 

differs based on the the level of technical skills required to create a presentation. 
 
There are three main features that should be kept in mind while working with PowerPoint 2007: 

The Microsoft Office Button, The Quick Access Toolbar, and The Ribbon. The function of these 

features is clearly explored below. 
 
5.1 Creating Presentations using AutoContent Wizard, Template and Blank Presentation 
 
A presentation is a collection of data and information that is to be delivered to a specific group of 

people. A PowerPoint presentation is a collection of electronic slides which can have text, 

pictures, graphics, tables, sound and video. This collection can run automatically or can be 

(manual)controlled by a presenter. 
 
Microsoft Office Button 
 
The Microsoft Office Button performs many functions as that of File menu of older versions of 

PowerPoint. This button allows you to create a new presentation, Open an existing presentation, 

save and save as, print, send, or close.   
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Fig 5.1 Power point page 

 
 

Ribbon 
The ribbon is the panel located at the top  of the document. It has seven tabs: Home, Insert, 

Design, Animations, Slide Show, Review and View. Each tab is divided into groups which have 

their respective tasks.  
 
 
 
 
 
 
 
 
 
 
 

Fig 5.2 Microsoft office button  
 
 
 
 
 
 
 

Fig 5.3 Ribbon 

 
The groups are collections of features that are designed to perform functions that will allow you 

to develop or edit your PowerPoint slides. Only commonly utilized features are displayed on the 

Ribbon. To view additional features within each group, select the arrow at the bottom right 

corner of each group. 
 
Home: Clipboard, Slides, Font, Paragraph, Drawing, and Editing 
 
Insert: Tables, Illustrations, Links, Text, and Media Clips 
 
Design: Page Setup, Themes, Background 
 
Animations: Preview, Animations, Transition to this Slide 
 
Slide Show: Start Slide Show, Set Up, Monitors 
 
Review: Proofing, Comments, Protect 
 
View: Presentation Views, Show/Hide, Zoom, Window, Macros 
 
Quick Access Toolbar 
 
The quick access toolbar is a customizable toolbar that contains commands that may allow you 

to use. The quick access toolbar can be placed above or below the ribbon. To change the position 

of the quick access toolbar, click on the arrow at the end of the toolbar and click Show Below 

the Ribbon. 
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5.4 Quick Access Toolbar 
New items can also be added to the quick access toolbar. Right click on any item in the Office 

Button or the Ribbon and click Add to Quick Access Toolbar and a shortcut will be added.  
 
 
 
 
 
 
 

 

 

 

Fig 5.5 cutomize quick access toolbar 
Mini Toolbar 
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A new feature in Office 2007 is the Mini Toolbar. This is a floating toolbar that is displayed 

when you select text or right-click text. It displays basic formatting tools,  
such as Bold, Italics, Fonts, Font Size Color and Alignment. 
 
 

 

 

 

 

 

 

Fig 5.6 Mini Toolbar 
 

Navigation 

Navigation through the slides can be done through the Slide Navigation menu on the left side of 
the screen. Also,  an outline appears from materials that have been entered in the presentation. 
To access the outline, click on the outline tab. 
 

 

 

  

 

 
 
 
 
 
 
 
 
 

 

 

 

 

 

Fig 5.7 Navigation 
Slide Views 
 
Presentations can be viewed in different ways. On the View tab, the group Presentation Views 

allows you to view the slides as Normal, Slide Sorter, Notes Page, Slide Show, Slide Master, 

Handout Master, and Notes Master. 
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Fig 5.8 Slide Views 
 
5.1.1 Auto-content Wizard 

AutoContent Wizard to help you create a presentation. This wizard   provides several slides with 

different contents. Presentation guides are available in several fields, that includes general, 

corporate, and sales and marketing 

. 

Use Auto-content Wizard 

• In the task pane under New Presentation, choose From AutoContent Wizard. 

• Click Next to see the various  presentation options that are available. 

 

 

 

Choosing a presentation type 

                            As you continue working in the wizard, think about what you presentation  type 

suits your  need. If you're not sure with the type, try General - Generic. 

• Click Next after you have chosen a presentation type. 
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                 Making changes to content 

When you use the AutoContent Wizard, the slides that result are a guide for your actual content. 

Make the necessary changes that suits your presentation. 

For example, if you are working on a General - Generic presentation about your organization 

and how it helps the community, your first slide might look like this: 

 

You can add or delete some of the slides based on your content or add a different design or color 

scheme based on your choice. 

 

5.1.2 Template 

Template is a pattern or blueprint of a slide or group of slides. Templates can contain layouts, 

theme colors, theme fonts, theme effects, background styles, and even content. 
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Applying a design template 

 

PowerPoint offers design templates  readily to make it easy to create an attractive presentation. 

These templates are of  variouscolors and  styles. You can apply a design to existing slides or  a 

new presentation can be started with a template. 

              To begin a new presentation with a design template: 

• Open PowerPoint. 

• In the task pane under New, click From Design Template. 

 

 

• A list of templates appears. 

• Move your mouse pointer through the different designs, or use the                         

scroll bar. 

• Click the down-pointing arrow in the gray box next to the template you like. 

• Choose Apply to All Slides(based on your need). 

Adding a design to an existing presentation PowerPoint makes it easy to enhance your existing 

slides with a design template. 

To apply a design to an existing presentation: 

• Open PowerPoint. 

• In the Getting Started task pane, under Open, click the presentation you want or 

select More... to browse through the files. 
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• Click the down-pointing arrow in the Getting Started pane, and choose Slide Design - 

Design Templates. 

• A list of templates appears. 

 

• Move your mouse pointer through the different designs, or use the scroll bar. 

• Click the down-pointing arrow in the gray box next to the template you like. 

• Choose Apply to All Slides. 

5.1.3 Creating Presentation using Blank Presentation 
 
you would get to know creation ,saving and preview of presentation using blank. 
 
New Presentation 
 
A new presentation can be started from a blank slide, a template, existing presentations, or a 

Word outline. To create a new presentation from a blank slide:  
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Fig 5.9 New Presentation 

 

• Click on the Microsoft Office Button 
 

• Click on New 
 

• Click on Blank Presentation 
 
 
 
To create a new presentation from an existing presentation: 
 

• Click on the Microsoft Office Button 
 

• Click on New 
 

• Click on New from Existing 
 
Browse to and click the presentation  
 
 
 
 
 
 
 
 

 

 

 

 

 

Fig 5.11 Blank presentation 
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To create a new presentation from a Word outline: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig 5.1 

2 Slides from outline 

 

• Click on the slide where you would like the outline to begin 

• Click on New Slide on the Home tab 

• Click on Slides from Outline 

• Browse and select  the Word Document that contains the outline 
 
Save a Presentation 
 
When you save a presentation, you have two choices: Save or Save As. To save a document: 
 

• Click on  the Microsoft Office Button 
 

• Click on Save  
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Fig 5.13 Save a presentation 
 
You may need to use the Save As option when you need to save a presentation under 

a different name.  
 
To use the Save As feature: 

• Click on the Microsoft Office Button 

• Click on Save As 

• Type in the name for the Presentation 

• In the Save as Type box, choose Excel 97-2003 Presentation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig 5.14 Save As a presentation 
 
Add Slides 

 

Slides can be added to an existing presentation wherever necessary. There are several ways  to 
add a new slide to the presentation: Office Themes, Duplicate Selected Slide, or Reuse Slides.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig 5.15 Adding of slides 
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To create a new slide from Office Themes: 
 

• Select the slide immediately BEFORE where you want the new slide 

• Click on the New Slide button on the Home tab 

• Click on the slide choice that fits your material 
 
To create a slide as a duplicate of a slide in the presentation: 
 

• Select the slide to duplicate 
 

• Click on the New Slide button on the Home tab 
 

• Click on Duplicate Selected Slides  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig 5.16 Duplicate selected slides 
 
To create a new slide from another presentation: 
 

• Select the slide immediately BEFORE where you want the new slide. 

• Click on the New Slide button on the Home tab 
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• Click on Reuse Slides 
 

• Click on Browse 
 

• Click on Browse File 
 
Locate the slide show and click on the slide to import  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig 5.17 Reuse of slides 
 
Themes 
 
Themes are design templates that can be applied to an entire presentation that allows for 

consistency throughout the presentation. To add a theme to a presentation: 
 

• Click on the Design tab 

• Choose one of the displayed Themes or click the Galleries button  
 
 
 
 
 
 
 

Fig 5.18 Themes
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To apply new colours to a theme: 
 

• Click on  the Colours drop down arrow 
 

• select a colour set or click Create New Theme Colours  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig 5.19 Create new theme 
 
To change the background style of a theme 
 

• Click the Background Styles button on the Design tab  
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig 5.20 Background styles 

Working with Content 
 

Editing the presentation by means of entering text, copy and move a text, and also check the 

spellings by spell check. 
 
Enter Text 
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To enter text: 
 

� Select the slide where you want the text 
� Click in a Textbox to add text  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig 5.21 Content 
 

To add a text box: 
 

• Select the slide where you want to place the text box  

• On the Insert tab, click Text Box 

• Click on the slide and drag the cursor to expand the text box  

• Type in the text 
 
 
 
 
 
 
 
 
 
 

 

Fig 5.22 Text box 

Select Text  
To select the text: 
 

• Highlight the text 
 
 
 
 
Fig 5.23 Select Text 

Copy and Paste 
 

To copy and paste data: 
 

• Select the item(s) that you wish to copy 

• On the ClipboardGroup ofthe Home Tab, click Copy 

• Select the item(s) where you would like to copy the data 
• On the ClipboardGroup ofthe Home Tab, click Paste.  
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Fig 5.24 Copy and paste 
 

Cut and Paste 
 

To cut and paste data: 
 

• Select the item(s) that you wish to copy 

• On the Clipboard Group of the Home Tab, click Cut 

• Select the items(s) where you would like to copy the data 

• On the Clipboard Group of the Home Tab, click Paste  
 
 
 
 
 
 
 
 
 
 

 

Fig 5.25 Cut and paste 
 

Undo and Redo 
 

To undo or redo your most recent actions: 
 

• On the Quick Access Toolbar 

• Click Undo or Redo  
 
 
 
 
 
 
 
 
 

 

Fig 5.26 Undo and Redo 
 

Spell Check 
 

To check the spelling in a presentation: 
 

• Click the Review tab 
• Click the Spelling button. 
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5.2 working with Master’s Slide, title handout and Notes 

Introduction 

Away from slides, PowerPoint provides both Handouts and Notes that can be seen, edited or 
printed along with a presentation. For various PowerPoint users, both Handouts and Notes are 
unused features. That in itself is very unfortunate, for the reason that both these elements can 
make the entire presentation experience more complete and enriched.  

5.2.1 Handouts 

The Handout Master 

Masters are an assistant to create patterns. Everything is duplicated based on elements 
existing in the master. Unlike slides, Handouts are almost always proposed for print and 
title..etc. so it better to edit the Handout Master based on that assumption. You want to be 
sure of using content that prints well to both black and white and coloured output. 

To edit the Handout Master,  

• go to View 

• click on Master  

• Select Handout Master.  
Within the Handout edit area you'll find 4 editable regions on the four corners of the page. 
These are header, footer, number and date. All these four regions can be edited as mandatory 
and since all edits are being done on the Handout Master. 

 

 

many users are not awake of is that you can even edit the main handout page area - for 
example, you can insert the company logo as a watermark behind the slide thumbnails or 
even modify the background colour of the whole handout area. The screenshot above shows 
the Handout Master with a teal background to do that, follow these steps: 
1. While in Handout Master View  

• Click on view 
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• choose View  

• choose Master 

• choose Handout Master 

• choose Format  

• Handout Background. 
2. In the resultant Handout Background dialog box, choose any of the background 

options. 
Formatting Handout Pages 

Handout pages are smaller, printed versions of your slides. They can consist of two, three, 
four, six, or nine slides per page. Before printing, you may need to add titles, page numbers, 
or borders. You can do all of these tasks on the Handout Master. 
To format handout pages: 
1. Choose View -> Master -> Handout Master or hold down Shift as you click the Slide 

Sorter View button. 
2. The Handout Master appears  

 
 

 
 

Figure  To format and lay out your handout pages, edit the Handout Master. 
 
3. On the Handout Master View toolbar, choose the icon that represents the number of 

slides you want to appear on each handout page. 
4. Make any of the following changes: 

• To add text that you want to appear on each page (such as the presentation title 
or page number), choose the View > Header and Footer command. 

• Add any desired background graphics. 
5. When you are finished, click Close on the Handout Master View toolbar. 
5.2.2 Speaker notes 
 
By using two monitors, you can view your notes, or run other programs that your audience 

will not see while giving your presentation and you can do this by using Presenter view. 
 
Create Speaker Notes 
 
speaker Notes can be added to allow you to create notes for each slide. To add speaker notes: 

• Select the slide 
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• Click on View 
 

• Click on Note Pages 
 

• Click the Click to add Notes section of the screen 
 

• Type in the Notes for that slide.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig 5.63 Speaker Notes 
 
5.2.3 The Slide Master 

Master slide is the one where we can set the default “look” for each slide. Editing done in 
the slide master will affect every slide in the presentation. The slide master is used to add 
default content (which can include background pictures) to your presentation whereas theme 
is used to add a default art style to your presentation. 
•All objects that you place on the master slide will be placed on each and every slide. 
•The master slide contains placeholders that can be modified. 
•Attributes for the text (Size, Weight, Font), background images and background colour can 
be set. In order to access the slide master, go to the View tab and select “Slide Master”. 
Using Slide Master View 
             Some of the most common uses are : 

• Modify Backgrounds 

• Re-arrange place holders 

• Customize text formatting 

• Create unique slide layouts and many other 
All these changes will be affected to every slide in the presentation. 
 
 
 
 
 
5.3 Viewing a Presentat 

After finishing the creation of all slides, you may want to view your presentation to see that 
all of them appear as needed. PowerPoint gives you the ability to view the presentation in 4 
ways, depending on which task you are completing. For example, if you are using your 
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presentation to talk to an audience—which is how PowerPoint is often used—you may need 
to practice your presentation and view your slides in Slide Show view. 

5.3.1 Slide views 

It's important for you to be able to access the different PowerPoint slide views in order to 

use them for various tasks. In all the four views, three are visible from the Normal 

default view.  

The slide view commands are situated on the bottom-right side of the PowerPoint 

window in Normal view. Click a view command to switch to that view. 

 

Normal view: Creation and editing of slides is done in this view. You can also move 

slides in the Slides tab on the task pane on the left. 

 

5.3.2 Slide Sorter view: customized slides(miniature) are arranged on the screen in this 

view. You can drag and drop slides easily to rearrange them, and you can see more than 

one slides at one time. This view is useful to confirm that you have all the necessary 

slides and that none have been deleted. 
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5.3.3 Slide Show view: This view fills the entire screen with a slide and is what the 

audience will see when they view the presentation. The Slide Show view has an 

additional menu that allows you to navigate the slides, as well as other features you can 

use while giving a presentation. 

 

The additional menu includes the arrow keys, Page Up and Page Down keys, 

spacebar, and Enter key to move through the slides in Slide Show view. Press the Esc 

key to end a slide show. 

5.3.4 The slide show menu 

Arrows: The forward arrow takes you to the next slide, while the back arrow takes you 

to the previous slide. 

 

5.3.5 Menu icon: Click the menu icon, and a menu appears that gives you the option to 

move to the next or previous slide, jump to a specific slide, change your screen options, 

or end the show. 
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5.3.6 Notes Page view 

It is not one of the view commands included at the bottom of Normal view; however, it 

can be selected from the View tab. This view provides a space for presentation notes, 

which are often called speaker notes. The notes can be added to the presentation from 

this view. You can enter your speaker notes directly into the text placeholder in Notes 

Page view, or while in Normal view you can enter your notes in the area below the slide. 

 

To change to Notes Page view: 

• Select the View tab. 

• Locate the four view commands on the left side of the Presentation Views 

group. 

 

 
• Click Notes Page view. 
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5.4 Drawing Objects and Inserting OLE 

5.4.1 Drawing Objects: 

 Power point provides different shapes for various uses which allows you to enhance  your 
presentation. These objects can be accessed from the DRAWING subgroup in the ribbon 
present at the top of homepage.These objects are used for drawing flowcharts in your 
presentation and many other purposes. 
 

 
 
 
 
 
 

Fig object to draw flow chart 
Also these objects can be accessed from insert tab. 

• To access built-in shapes, go to the Insert tab and under the Illustrations group click 
on the Shapes button to see the list. 

• Click on your desired shape. 

• On the slide, click and drag your mouse to create your shape. 

• Once your shape is in place you can move it around, use the handles to adjust the size 
and rotation, and edit it as you would any other object. 

 
Several categories of shapes including lines, basic shapes, block arrows, flowchart elements 
etc are provided. 
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Fig objects to draw different shapes
 
5.4.2 Inserting OLE- Object Linking and
 
You can use hyperlinks to move from one slide to another, to a network or Internet location, or 

even to another file or program altogether.
 

• Select the text that you want to click to activate the hyperlink. Alternatively, you can 

select an object (a piece of clip art, for example, or a SmartArt graphic)

• On the Insert tab, in the Links
 

• In the Insert Hyperlink dialog box, click the appropriate button in the 

for the target of your link (that is, the place wher
 

• To go to another slide in your presentation, for example, click 

inThis Document. 
 

• Find and click the target location, make any changes that you want in the 

Text to display and Address 
 
Preview your presentation as a slide show
 
To view your presentation on your computer screen exactly the way that it will look to 

your audience when you are presenting, do the following:
 

1. On the Slide Show

one of the following:
 
To start with the first slide in the presentation, click
 
�To start with the slide that currently appears in the

Slide. The presentation opens in Slide Show view.
 
2. Click to advance to the next slide.
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Fig objects to draw different shapes 

Object Linking and Embedding 

You can use hyperlinks to move from one slide to another, to a network or Internet location, or 

even to another file or program altogether. 

Select the text that you want to click to activate the hyperlink. Alternatively, you can 

ct (a piece of clip art, for example, or a SmartArt graphic) 

Links group, click Hyperlink. 

dialog box, click the appropriate button in the My Places 

for the target of your link (that is, the place where the link takesyou). 

To go to another slide in your presentation, for example, click Place 

Find and click the target location, make any changes that you want in the 

Address boxes, and then click OK. 

sentation as a slide show 

To view your presentation on your computer screen exactly the way that it will look to 

your audience when you are presenting, do the following: 

Slide Show tab, in the Start Slide Show group, do 

one of the following: 

tart with the first slide in the presentation, click From Beginning. 

To start with the slide that currently appears in the Slide pane, click From Current 

. The presentation opens in Slide Show view. 

2. Click to advance to the next slide. 

You can use hyperlinks to move from one slide to another, to a network or Internet location, or 

Select the text that you want to click to activate the hyperlink. Alternatively, you can 

My Places box 

Find and click the target location, make any changes that you want in the 
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5.5 Drawing Freeform Shape
You can draw different shapes in 
Scribble tools. 
5.5.1 To draw a freeform shape:

1. Go to the Insert tab select the
2. To draw a shape that has 
3. To draw a shape that looks like it was drawn with a pen by hand, or to create smooth 

curves, click Scribble and click anywhere in the document, and then drag to draw.
4. To draw a straight segment with the 

pointer to a different location, and then click again; to draw a curved segment, keep 
your mouse button pressed as you drag to draw.

To finish drawing the shape, do one of the following

• To leave the shape open, 

• To close the shape, click near its starting point.
Edit points in a shape 

You can edit the points of most shapes. For example, you edit points when you need to lean a 
triangle over to the right. 

1. Select the shape that you want to e
and then select Edit Points

2. Drag one of the vertexes that outline the shape. A vertex is the point, indicated by a 
black dot, where a curve ends or the point where two line segments meet in a freeform 
shape. 

5.5.2 Working with editing points

1. To add a point, click the shape outline while pressing 
2. To delete a point, click the point while pressing 
3. To have the point treated as a smooth point, press 

handles attached to the point. Once you stop dragging, the point will be changed to a 
smooth point. A smooth point joins two line segments of equal length.

4. To have the point treated as a straight point, press 
handles attached to the poi
straight point. A straight point joins two line segments of different lengths.

5. To have the point treated as a corner point, press 
handles attached to the point. Once
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g Freeform Shape 
You can draw different shapes in PowerPoint 2010 by the help of freeform Shape

5.5.1 To draw a freeform shape: 

tab select the Illustrations group and click on the Shapes 

 both curved and straight segments, click Freeform

To draw a shape that looks like it was drawn with a pen by hand, or to create smooth 
and click anywhere in the document, and then drag to draw.

To draw a straight segment with the freeform tool, click one location, move your 
pointer to a different location, and then click again; to draw a curved segment, keep 
your mouse button pressed as you drag to draw. 

To finish drawing the shape, do one of the following 

To leave the shape open, double-click at any time. 

To close the shape, click near its starting point. 

You can edit the points of most shapes. For example, you edit points when you need to lean a 

Select the shape that you want to edit and go to the Format tab, click Edit Shape

Edit Points. 

 
Drag one of the vertexes that outline the shape. A vertex is the point, indicated by a 
black dot, where a curve ends or the point where two line segments meet in a freeform 

 
5.5.2 Working with editing points 

To add a point, click the shape outline while pressing Ctrl. 
To delete a point, click the point while pressing Ctrl. 
To have the point treated as a smooth point, press Shift while dragging either of the 

ed to the point. Once you stop dragging, the point will be changed to a 
smooth point. A smooth point joins two line segments of equal length. 
To have the point treated as a straight point, press Ctrl while dragging either of the 
handles attached to the point. Once you stop dragging the point will be changed to a 
straight point. A straight point joins two line segments of different lengths.
To have the point treated as a corner point, press Alt while dragging either of the 
handles attached to the point. Once you stop dragging the point will be changed to a 

freeform Shape and 

Shapes option. 
Freeform. 

To draw a shape that looks like it was drawn with a pen by hand, or to create smooth 
and click anywhere in the document, and then drag to draw.  

tool, click one location, move your 
pointer to a different location, and then click again; to draw a curved segment, keep 

You can edit the points of most shapes. For example, you edit points when you need to lean a 

Edit Shape, 

Drag one of the vertexes that outline the shape. A vertex is the point, indicated by a 
black dot, where a curve ends or the point where two line segments meet in a freeform 

while dragging either of the 
ed to the point. Once you stop dragging, the point will be changed to a 

while dragging either of the 
nt. Once you stop dragging the point will be changed to a 

straight point. A straight point joins two line segments of different lengths. 
while dragging either of the 

you stop dragging the point will be changed to a 
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corner point. A corner point joins two line segments with one segment going off in a 
different direction. 

6. To cancel the change to the point and line segments, press Esc before releasing the 
mouse button. 

7. To open Edit Points mode with keyboard shortcuts, select the shape and then press 
Alt + JD, E, E. 

5.5.3 Delete shapes 

1. Select the shape that you want to delete, and then press Delete. 
2. If you want to delete multiple shapes, select the first shape, press and hold Ctrl while 

you select the other shapes, and then press Delete. 
5.5.4 How to Draw a Pentagon Shape 

A pentagon may be simple or self-intersecting. The sum of the internal angles in a simple 
pentagon is 540°. In PowerPoint 2010 you can easily draw a simple pentagon shape using the 
shape tool.  
Here follow the following example to know how to draw a pentagon in PowerPoint 2010. 
To insert a pentagon in PowerPoint slide, go to Insert menu and then select on Shapes to 
open the collection of shapes. Then look under Basic Shapes to find the Regular Pentagon 
shape as shown below: 

 
Fig drawing pentagon shape using freeform 

You can easily insert this pentagon into the current slide. You can use this pentagon shape 
to prepare to make concept slides for your presentations, since you can use this kind of 
shapes or other shapes to embed pictures inside the shape. Also you can edit the text inside 
the pentagon by right clicking over the shape. 
 
5.6 Rotating Objects 
In PowerPoint, every slide may have different items, such as pictures, shapes, and text boxes. 
PowerPoint lets you arrange the objects the way you want by aligning, grouping, rotating, 
and ordering them in multiple ways. Here, you will learn how to align objects across the 
slide, group multiple objects into one object and order objects from front to back.After adding 
objects to a slide, it is necessary to arrange them so the objects appear the way you want. You 
can align, group, rotate, and order objects to create the desired arrangement. 
5.6.1 Aligning objects 

You can select and drag objects to align them manually, but guesswork will never give you 
the best result. And also, aligning objects in this way can take a great deal of time. Luckily, 
PowerPoint provides you with various commands that allow you to arrange and position 
objects easily. 
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To align two or more objects: 

1. Click and drag the mouse to form a selection box around the objects you want to 
align. All of the objects will now have sizing handles to show that they are selected. 

 
2. From the Format tab, select the Align command, and then select Align Selected 

Objects. 

 
3. Click on the Align command again, and select one of the six alignment options. 

 
4. The objects will align to each other based on the selected option. 
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To align objects to the slide: 

Sometimes you may want to align one or more objects to a specific location within the slide, 
such as the top or bottom. In such cases you can select the Align to Slide option before you 
align the objects. 

1. Click and drag the mouse to form a selection box around the objects you want to 
align. All of the objects will now have sizing handles to show that they are selected. 

2. Go to the Format tab, select the Align command, and then select Align to Slide 

option. 

 
3. Select the Align command again, and then select one from the six alignment options. 

 
4. The objects will align to the slide based on the option you have selected. 
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To distribute objects evenly: 

If you have arranged objects in a row or column, you may want them to be in an equal 

distance from one another for a well-organized appearance. You can do this by distributing 

the objects horizontally or vertically. 
1. Click and drag the mouse to form a selection box around the objects you want to 

align. All of the objects will now have sizing handles to show that they are selected. 

 
2. Go to the Format tab, click on the Align command. 
3. From the menu, select Distribute Horizontally or Distribute Vertically option. 

 
4. The objects will be distributed evenly. 

 
5.6.2 Ordering and rotating objects 

In addition to aligning and grouping objects, PowerPoint gives you the ability to arrange 

objects in a specific order. In case when two or more objects overlap ordering is important 
because it will determine which objects are in the front or back. 
To change the ordering by one level: 

1. Select an object. The Format tab will appear. 
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2. From the Format tab, select the Bring Forward or Send Backward command to 

change the object's ordering by one level. If the object overlaps with more than one 
other object, you need to select the command several times to achieve the desired 
ordering. 

 
3. The objects will reorder. 

 
To bring an object to the front or back: 

If you want to send an object behind or in front of several objects, it's usually faster to bring 

it to front or send it to back rather than clicking the ordering commands several times. 
1. Select an object. The Format tab will appear. 
2. From the Format tab, select the Bring Forward or Send Backward drop-down box. 
3. From the drop-down list, select Bring to Front or Send to Backoption. 

 
4. The objects will reorder. 
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To rotate an object: 

1. Select an object. The Format tab will appear. 
2. From the Format tab, select the Rotate command. A drop-down list will appear. 
3. Click on the desired rotation option. 

 
4. The object in the slide will rotate. 

 
5.6.3 Grouping objects 

Sometimes you may need to group multiple objects into one object so that they will stay 
together if they are moved. Often, this is easier than selecting all the objects every time you 
want to move them. 
Pictures, shapes, clip art, and text boxes can be grouped together, but placeholders cannot be 
grouped. Therefore, make sure not to insert the pictures into placeholders if you will be 
grouping the pictures. 
To group objects: 

1. Click and drag your mouse to form a selection box around the objects you want to 
align. All of the objects will now have sizing handles to show that they are selected. 
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2. Go to the Formattab, Select the Group command, then select Group. 

 
3. The selected objects will now be grouped. There will be a single box with sizing 

handles around the entire group to show they all are one object. 

 
If you select the objects and if the Group command is disabled, it may be because one of the 
objects is inside a placeholder. If this happens, try to reinserting the images or cutting and 
pasting them into the same slide outside of any placeholders. 
To ungroup objects: 

1. Select the grouped object you want to ungroup. 
2. Go to the Formattab, select the Group command, then select Ungroup. 

 
3. The objects will be ungrouped. 
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5.7 Animation in Slides/Objects 
In PowerPoint you have an option called animate which is used to animate the text and 
objects such as clip art, shapes, and pictures. Animation or movement of text or an object  on 
the slide can be used to draw the viewer’s attention to that particular  content.  
 
5.7.1 Animating text and objects 
In PowerPoint we have variety of animations which are used to enhance your presentation. 
In order to create customized animation you can use motion paths. 
The four types of animations 

We have different animation effects and they are organized into four types: 
• Entrance: By this Entrance you can control how the object enters the slide. For 

example, if you want the text to enter into the slide with the Bounce animation, then 
the object will drop onto the slide and then bounce many times. 

 
• Emphasis: These animations occur while the object is on the slide and are often 

clicked by the mouse. For example, you can set an object to Spin by the mouse click. 

 
• Exit: This exit option controls how the object exits the slide. For example, with the 

Fade animation, the object will simply fade away. 

 
• Motion Paths: This Motion Path option is similar to Emphasis effects, except the 

object moves within the slide along a predetermined path, like a circle. 

 
5.7.2 To apply an animation to an object: 

1. Select an object. 
2. Select the Animations tab. 
3. In the Animation group, press the More drop-down arrow to view all the available 

animations. 
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4. Select the desired animation effect. 

 
5. The object will now have a small number next to it which indicates that the object is 

animated. Also, in the Slide pane, the slide will now have a star below the number of 
that slide.. 

 
At the bottom of the menu, you can also access more effects. 

 
5.7.3 Effect options 

Some effects will have options which you can change. For example, with the Fly In effect, 
you can control from which direction the object or text have to  comes from. You can use 
these options from the Effect Options command in the Animation group. 
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5.7.4 Working with animations 

To add multiple animations to an object: 

If you select a new animation for an object from the menu in the Animation group, it will 
replace the object's current animation. However, if you want to place more than one 
animation on an object,  you have to use the command Add Animation, which will allow you 
to keep your current animations while adding new ones. 

1. Select the object. 
2. Press the Animations tab. 
3. In the Advanced Animation group, select the Add Animation command to view the 

available animations. 
4. Choose the desired animation effect. 

 
5. If an object has more than one effect on it then it will have a different number for 

each and every effect. The numbers indicate the order in which the effects have to 
occur on the slide. 

 
It's important to consider how you want your animations to appear in your slide show.  
To copy animations with the Animation Painter: 

Sometimes if you want to apply the same effect to more than one object then you can do this 
by copying the effects from one object to another by using the Animation Painter. 

1. Select the object that has the effects you want to copy. 
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2. From the Animations tab, Select the Animation Painter command. 

 
3. Click the object to which you want to copy the effects. The effects will be applied to 

the object. 

 
To reorder the animations: 

1. Choose the number of the effect you want to change. 

 
2. From the Animations tab, choose the Move Earlier or Move Later commands to 

change the order of occurance. 

 
5.7.5 To preview animations: 

All the animation effects you have applied to the presentation will be shown up when you 
play the slide show. However, you can also quickly preview the animations of a particular 
slide without viewing the slide show. 

1. Navigate to the slide you want to preview the animation effects. 
2. From the Animations tab, select the Preview command. Then the animation effects 

for the current slide will play. 
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5.7.6 The Animation pane 

The Animation pane allows you to view and manage all  the effects that are on the current 
slide. You can modify and reorder them directly from the Animation pane, which is mainly 
useful when you have several effects. 
Procedure to open the Animation pane: 

1. FromtheAnimations tab, choose the Animation Pane command. 

 
2. You will have the animation pane window open on the right side of the main window. 

It will show all of the effects of the current slide in the order . 

 
To reorder effects from the Animation pane: 

1. On the Animation pane, select and drag an effect up or down. 

 
2. The effects will reorder. 

To preview effects from the Animation pane: 

1. From the Animation pane, select the Play button. 

 
2. The effects for the current slide will play. On the right side of the Animation pane, 

you can see a timeline that shows the progress of each effect. 
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If the timeline is not visible, press the drop-down arrow for an effect, then select Show 

Advanced Timeline. 
To change an effect's start option: 

By default, an effect begins by a mouse click during the slide show. If you have multiple 
effects, you have to click the mouse multiple times to start each effect individually.  By 
changing the start option for each effect, you will have effects that automatically play one 

after the other or at the same time. 
1. From the Animation pane, choose an effect. A drop-down arrow will appear next to 

the effect. 

 
2. Select the drop-down arrow. You will have three start options: 

o Start on Click: By this option you can start the effect when the mouse is 
clicked. 

o Start With Previous: This option is used to start the effect at the same time as 
the previous effect. 

o Start After Previous: This option will start the effect after completing the 
previous effect. 

 
3. Choose the desired start option. 
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When you preview the animations, all of the effects will play automatically. To test effects 
that are set to Start on Click, you will need to play the slide show. 
 
 
Summary 

The Ribbon and remaining groups are not same as we used in word or excel. So you must 

observe the differences in the ribbons and groups of particular component such as word or 

excel of ms office. One more thing to remember that PowerPoint 2007 has many similar 

features to previous versions. You will also notice that there are many new features that 

you’ll be able to utilize. 

The difference between themes and PowerPoint design templates 

Beginning with Office PowerPoint 2007, templates are “starter” documents, just like those in 

Office Word 2007 and Office Excel 2007, and can contain starting content or boilerplate text. 

Themes replace the PowerPoint slide designs and contain one or more slide masters. 

A slide master isn’t actually a slide and it doesn’t store theme information. The slide master 

is a separate layer that only looks like a slide. It is where you can set the master layout and 

design elements, such as slide background appearance and graphics that all slide layouts 

follow by default. For example, you can specify a slide background, the layout of content 

placeholders, and add your company logo on a slide master to have all of those elements 

apply by default to all slide layouts that are attached to that slide master. 

You can undo and redo up to 100 actions in Microsoft Office programs, such as Microsoft 

Office Word 2007, Microsoft Office PowerPoint 2007, Microsoft Office Excel 2007, and 

Microsoft Office Access 2007. You can repeat actions as many times as you want. 

We can also make tighten or lose the text , that is the required space can be provided between 

the characters . Strike through and shadow facilities can also be applied to the text. 

When you insert a sound on a slide, an icon  that represents the sound file appears. To play 

the sound while you give your presentation, you can set the sound to start automatically when 

the slide is displayed, start on a mouse-click, start automatically but with a time delay, or play 

as part of an animation sequence. You can also play music from a CD or add narration to 

your presentation. You can add sounds from files on your computer, a network, or Microsoft 

Clip Organizer. You can also record your own sounds to add to a presentation or use music 

from a CD. 

Movies are desktop video files with formats such as AVI (Audio Video Interleave)or 

MPEG(Moving Picture Experts Group) and file extensions such as .avi, .mpg, and .mpeg. A 

typical movie can include a speaker talking, such as an executive who cannot attend the 

actual presentation. You can use a movie to train others or to perform a demonstration. 
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You can add one shape to your presentation or combine multiple shapes to make a drawing or 

a more complex shape. Available shapes include lines, basic geometric shapes, arrows, 

equation shapes, flowchart shapes, stars, banners, and callouts. 

Slide transitions are the animation-like effects that occur in Slide Show view when you move 

from one slide to the next during an on-screen presentation. You can control the speed of 

each slide transition effect, and you can also add sound. 

Animate: To add a special visual or sound effect to text or an object. For example, you can 

have your text bullet points fly in from the left, one word at a time, or hear the sound of 

applause when a picture is uncovered.) the text or objects (object: Atable, chart, graphic, 

equation, or other form of information. Objects created in one application, for example 

spreadsheets, and linked or embedded in another application are OLE objects.) in your 

presentation to give them sound effects or visual effects, including movement. You can use 

animation to focus on important points, to control the flow of information, and to increase 

viewer interest in your presentation. 

You can print your entire presentation — the slides, outline, notes pages, and audience 

handouts — in color, grayscale (grayscale: A series of shades from white to black used in 

displaying or printing text and graphics.), or pure black and white. Most often, however, you 

will probably choose to print in either black and white or grayscale. 

Before printing handouts or slides, consider placing the presentation in a shared location. Just 

prior to the delivery time, advice viewers of the location and those who require hard copies, 

can print and bring them to the presentation delivery meeting. This can help to conserve 

paper and printer ink. 

Model Question 

Short Answer Type Question 

1. What is power point presentation? 

2. What is Microsoft office button? 

3. What are the seven tabs in Ribbon in power point? 

4. What is quick access toolbar? 

5. What is mini toolbar? 

6. What are the seven slide views in presentation views group in view tab? 

7. What are the themes? 

8. What is a template? 

9. Expand and write the concept of OLE. 

10. What is meant by copy and move a text? 

11. What is meant by undo and redo? 

12. What is spell check? 

13. What is word art? 

14. What are the four alignments? 

15. What is indentation? 
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16. What are text directions 

17. Expand AVI AND MPEG 

18. What is clip art? 

19. What is Smart Art? 

20. What is Photo album? 

21. What is a slide transition? 

22. What is a slide animation? 

23. What is speaker’s note? 

 

Long Answer Type Question 

1. Write the groups in each tab of a ribbon in power point. 

2. Write the steps to create, save and preview a presentation. 

3. Write about formatting a text in power point. 

4. What are the steps to add video and audio to the presentation? 

5. Write about graphics in power point. 

6. Write the steps for animation of slides. 

7. What are handout and notes page? 

8. Write about the printing of a presentation. 

9. Discuss about animation of objects. 

10. Discuss the concept of drawing freeform shapes 

11. Explain the concept of OLE 

12. Write the steps for rotating objects. 
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INTRODUCTION 

 
 

“I hear, I forget” 
“I  see, I remember” 

“I do, I understand” 
 
 
You can solve different types of problems on a computer. Problem can be 
a business problem or a scientific problem. All you have to do is to 
analyse the problem and  Write a step by step solution and translate it in 
a language understandable by a computer. 
 
Problem Definition : 
 
   Suppose you want to reach college computer laboratory at 8 A.M. You 
would lay out a plan to get ready by 7 A.m. then take a bus/ rikshaw and 
reach at the gate of our college. Then climb up the stairs to arrive in the 
lab. For all this movements, you will note the time taken for each activity, 
due to some reason, you are unable to get ready by 7 A.M. and you know 
that it takes one hour to reach from house to school lab by bus/ rikshaw, 
so you will take some faster means of transport. You may take an auto 
rikshaw or taxi. Thus, a very simple problem of reaching to the computer 
lab by 8 A.M. will need several steps for solution. Each step needs to be 
accurately defined so that guessing the next activity to be done. You can 
thus represent the solution of this problem in three steps shown in Fig. 
1.0 
 
   In Fig 1.0, steps 1,2 and 3 appear to be very simple. In actual practice 
when you have to give instruction to a student, who is going for the first 
time, it may not be so easy. For example, you have to define the word 
“READY” precisely so that he knows   

  
 
 
     

 
Take a bus for  

        college 

 

 

Get  ready 
By 7 a.m.   

Step 1  

Step  2 
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Reach by computer  

Lab by 8a.m. 

 

Feg 1.0 

 

 

Exactly what he has to do by 7 A.M. to get1 READY in step 1, Similarly in 
step 2, you may have to clearly specify the bus route number, the bus 
stop to board the bus, the place to get down from the bus etc. you may 
also like to tell that a bus, is not to be boarded. if it is over crowded. the 
word “overcrowded” needs to be properly defined. Finally, step 3 needs 
further elaborations about the room number and floor number where the 
computer lab is located and how to reach there. 
 
 You can explain all this to a person who does not know anything 
about the computer lab, provided you know it correctly. In the same way, 
you can solve a problem on a computer, if you know exactly what it is and 
how you can solve it manually. 
 
1.1 PROCEDURE : 
  
A fixed, step by step sequence of activities are course of action (with 
definite start and end points) that must be followed in the same order to 
correctly perform a task.  
 
1.2  PROBLEM SOLVING AND TECHNIQUES : 
Problems that can be solved through the computer may range in size and 
complexity. Since the computer does not possess any commonsense and 
cannot make any unplanned decisions, the problem, whether it is simple 
or compile, has to be broken into a well-defined set of solution step. It 
should be remembered that computers do not solve problems; rather they 
are used to implement the solutions to problems.  
 
In an attempt to solve problems on a computer, one has to the steps for 
the solutions in terms of simple conceptual instruction and operations and 
then obtain the result. They may be number of ways to solve a given 
problem and the solution methods may have from person to person, 
depending on one’s logic. But the basic steps would be: 
 
(i) Formulating the problem and deciding the input data if any 
(ii) Identifying the various steps of computation that are must for the 
solution. 

Step  3  
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(iii) Identifying the points of decision i.e. under what circumstances a 
particular  
     operation is to performed and when it is not be performed. 
(iv) Knowing the expected result and when to obtain the output. 
 
Besides these, the programmer has to various types of variables that 
should be used to solve the problem.    

 
The basic elements of problem solving are as follows: 
 
1. Understanding the problem in terms of input data available and output 
results required 
2. Analysing the problem in terms of known and unknown parameters and 
constants. 
3. Computing the various methods of solutions possible and  
    selecting the best one. 
4. Preparing a logical and concise list of procedures required for the  
    selected method of solution. 
5. Solving the problem and examining the results. 
 
 
 
 
 
1.3.0  ALGORITHM 
 
In programming algorithms are the set of well defined instruction in a 
sequence to solve a program. An algorithm should always have a clear 
stopping point.  
  
1.3.1 Qualities of a good algorithms: 
 
1. Input and output should be defined precisely. 
2. Each steps in algorithm should be clear and unambiguous.  
3. Algorithm should be most effective among many different ways to  
solve a problem  
4. An algorithm should be most effective among many different ways to 
solve a   
    problem. 
5. An algorithm shouldn’t have computer code. Instead, the algorithm 
should be  
    written in such a way that, it can be used in similar  programming 
languages.  
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1.3.2 Algorithm - Definition: 
 
 The sequence of instructions for solving a particular problem is 
known as algorithm. 
1. A sequential solution of any program that written in human language, 
called   
    algorithm. 
2. Algorithm is first step of the solution process, after the analysis of 
problem,  
   programmer write the algorithm of that problem. 
 

1.3.3 Example of Algorithms: 

Q1. Write a algorithm to find out number is odd or even? 
Ans. step 1 : start 
       step 2 : input number 
       step 3 : rem=number mod 2 
       step 4 : if (rem=0) then  
                   print “number even” 
    else  
    print ”number odd” 
    endif 
      step 5 : stop 
 
 
Q2.Wite an algorithm to add two given numbers. 
Ans.  step 1 : start 
 step 2 : declare variables num1, num2 and sum 
 step 3 : read values num1 and num2 
 step 4 : add num1 and num2 and assign the add value to sum 
   sum   =      num1 + num2 
 step 5 : display sum 
 step 6 : stop. 
 
 
Q3. Write an algorithm to find the largest among three different  
numbers. 
Ans.  step 1 : start 
 step 2 : declare variables a,b and c 
 step 3 : read variables a,b and c 
 step 4 : if (a>b) 
   if (a>c) 
   display a is the largest number 
   else 
   display c is the largest number 
   else if (b>c)  
   display b is the largest number 
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   else 
   display c is the largest number 
 
 
Q4.Write an algorithm to find all roots of a quadratic equation  

     ax2 + bx+c= 0 
Ans.  step 1 : start 
 step 2 : declare variables a, b, c, D, R1, R2, rp and ip; 
 step 3 : calculate discriminate 
 step 4 : if D>=0 
   r1-(-b+ D)/2a 
   r2-(-b+ D)/2a 
   display r1 and r2 as roots 
     else 

calculate real part and imaginary part 
    rp - b/2a 
    ip -   (-D) / 2a 
   display rp+j (ip) and rp - j (ip) as roots 
 step 5 : stop 
 

 
Q5. Write an algorithm to find the factorial of a number entered by user. 
Ans.   step 1 : start 
  step 2 : declare variables n, factorial and i. 
  step 3 : initialize variables  
    factorial - 1 
    f - 1 
  step 4 : read value of n 
  step 5 : repeat the steps until i =n 
   5.1 : factorial - factorial *i  
   5.2 : i-i+1 
  step 6 : display factorial  
  step 7 : stop 
 
 
Q6. Write an algorithm to check whether a number entered by user is 
prime or not.   
Ans.   step 1 : start 
  step 2 : declare the variables n, i, flag 
  step 3 : initialize variables 
        flag - 1 
        i - 2 
  step 4 : read n from user 
  step 5 : repeat the steps until  i <(n/2) 
    5.1 : if remainder of n / i equals to 0 
     flag - 0 
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     go to step 6 
    5.2 : i-i+1 
  step 6 : if flag =0 
     display n is not prime 
     else 
     display n is prime 
  step 7 : stop 
 
Q7. Write an algorithm to find the Fibonacci series till <= 1000 
Ans.  step 1 : start 
 step 2 : declare the variables first_term, second_term and temp 
 step 3 : initialize variables first_term-0 second-term-1 
 step 4 : display first_term and second_term 
 step 5 : repeat the steps until second_term<=1000 
   5.1 : temp - second_term 
   5.2 : second_term-second_term+first_term 
   5.3 : first_term-temp 
   5.4 : display second_term 
 step 6 : stop 

Q8. Write an algorithm to find out the greater of given two numbers. 
Ans. Step 1 : read the values of A and B 
 Step 2 :  compare the values to determine if A is greater or B 
 Step 3 : if A is greater than B then 
    Out put value of A 
   else (Otherwise) 
 
 Step 4 : output value of B 
 Step 5 : stop 
 
Q9. Write an algorithm to find the sum of 1 to n positive numbers. 
Ans. Step 1 : start 
 Step 2 : input the value of ‘N’ 
 Step 3 : assign 1 to I 
 Step 4 : print I 
 Step 5 : Ist the value of ‘I’ equal to the value of N 
 Step 6 : (a) yes ---- goto step 6 
   (b) No ----- Increase I by 1 
 `    goto step 4 
 Step 7 : stop 
 
 
 
Q10. Write an algorithm to calculate the simple interest using where P is 
the principle  
        amount, N is the number of years and R is the rate of interest. 
Ans.  Step 1 :  start 
 Step 2 :  input the values for P,N,R; 
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 Step 3 : calculate the simple interest with the principle  
    SI = P *N*R/100; 
 Step 4 : print the simple interest (SI) 
 Step 5 : stop 
 
1.4 FLOW – CHART : 

The flowchart is a means to visually present the flow of data through an 
information processing systems, the operations performed within the 
system and the sequence in which they are performed. In this lesson, we 
shall concern ourselves with the program flowchart, which describes what 
operations (and in what sequence) are required to solve a given problem. 
The program flowchart can be likened to the blueprint of a building. As we 
know, a designer draws a blueprint before starting to construct a building. 
Similarly, a programmer prefers to draw a flowchart prior to writing a 
computer program. As in the case of the drawing of a blueprint, the 
flowchart is drawn according to defined rules and using standard flowchart 
symbols prescribed by the American National Standard Institute. 

Meaning of a Flow Chart : 

 

A flowchart is a diagrammatic representation that illustrates the sequence 

of operations to be performed to get the solution of a problem. Flowcharts 

are generally drawn in the early stages of formulating computer solutions. 

Flowcharts facilitate communication between programmers and business 

people. These flowcharts play a vital role in the programming of a 

problem and are quite helpful in understanding the logic of complicated 

and lengthy problems. Once the flowchart is drawn, it becomes easy to 

write the program in any high level language. Often we see how 

flowcharts are helpful in explaining the program to others. Hence, it is 

correct to say that a flowchart is a must for the better documentation of a 

complex program. 

Flow is a representation of a series of logic operations to satisfy specific 
requirements. A flow exists naturally. It can be irregular, unfixed or full of 
problems. For this reason, it may apparently be absent in some 
situations. Lately, members of a team were assigned to investigate the 
flow of a business process, and I was told that there were some 
deficiencies in the flow. The reply from the person who was in charge of 
the team was that no flow was shown in part of the business process. As 
a matter of fact, it is impossible for a business carried out without a flow. 
It may be a flow in an unfixed form, or, may be the person himself whom 
you investigated does not have a clear sense about the flow. 

Chart, or diagram, is a presentation or a written description of some 
regular and common parts of the flow. A chart is conducive to 
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communication and concentration and offers references for process 
reengineering. 

 

Flow chart can be seen from the definition that a flow accompanies always 
with business or transaction. Not all of the flows, however, are 
appropriate to be expressed by flowcharts. Flows that can be expressed 
by charts follow some fixed routines, and the key links of flows won't be 
changed constantly. 

1.4.1 When to Use Flow Chart : 

A flowchart helps to clarify how things are currently working and how they 
could be improved. It also assists in finding the key elements of a 
process, while drawing clear lines between where one process ends and 
the next one starts. Developing a flowchart stimulates communication 
among participants and establishes a common understanding about the 
process. 

Flowcharts also uncover steps that are redundant or misplaced. In 
addition, flowcharts are used to identify appropriate team members, to 
identify who provides inputs or resources to whom, to establish important 
areas for monitoring or data collection, to identify areas for improvement 
or increased efficiency, and to generate hypotheses about causes. 
Flowcharts can be used to examine processes for the flow of patients, 
information, materials, clinical care, or combinations of these processes. 
It is recommended that flowcharts be created through group discussion, 
as individuals rarely know the entire process and the communication 
contributes to improvement. 

The computer world is nothing, but a reflection of the real world. That's 

why in most programming languages we use different data types to 

represent the information. 

1.4.2 What is a Process Flowchart? 

Also called: process flowchart, process flow diagram.  

Variations: macro flowchart, top-down flowchart, detailed flowchart (also 
called process map, micro map, service map, or symbolic flowchart), 
deployment flowchart (also called down-across or cross-functional 
flowchart), several-leveled flowchart.  

A flowchart is a picture of the separate steps of a process in sequential 
order.  
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Elements that may be included are: sequence of actions, materials or 
services entering or leaving the process (inputs and outputs), decisions 
that must be made, people who become involved, time involved at each 
step and/or process measurements.  

The process described can be anything: a manufacturing process, an 
administrative or service process, a project plan. This is a generic tool 
that can be adapted for a wide variety of purposes.  

1.4.3 Advantages of Flow charts : 
 
The basic concepts associated with flowcharting has been presented in 
this chapter. Though the following have been mostly used to help the 
programmer develop the programs logic and to serve as documentation 
for a completed program, but its advantages are many, which may be 
summarized as follows. 
 
 
 

• It convenient method of communication 
• It indicates very clearly just what is being done, where as a 

program has logically complexities. 
• It is a key correct programming. 
• It is an important tool for planning and designing a new system. 
• It clearly indicates the role played at each level. 
• It saves the conveniences in further and serves the purpose of 

documentation for a system. 
• It provides an over- view of the system and also demonstrates the 

relationship between various steps.  
• It facilitates trouble shooting  
• It promotes logical accuracy. 
• It makes sure that sure no logical path is left in complete without 

any action being taken.     
 

1.4.4 Flowchart Basic Procedure : 

Materials needed: sticky notes or cards, a large piece of flipchart paper or 
newsprint, marking pens. 

1. Define the process to be diagrammed. Write its title at the top of 
the work surface. 

2. Discuss and decide on the boundaries of your process: Where or 
when does the process start? Where or when does it end? Discuss 
and decide on the level of detail to be included in the diagram. 

3. Brainstorm the activities that take place. Write each on a card or 
sticky note. Sequence is not important at this point, although 
thinking in sequence may help people remember all the steps. 
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4. Arrange the activities in proper sequence. 
5. When all activities are included and everyone agrees that the 

sequence is correct, draw arrows to show the flow of the process. 
6. Review the flowchart with others involved in the process (workers, 

supervisors, suppliers, customers) to see if they agree that the 
process is drawn accurately. 

 

1.4.5 Commonly Used Symbols in Detailed Flowcharts: 

One step in the process; the step is written inside the box. Usually, only one arrow 

goes out of the box. 
 

 
 

 

 

                                                 Direction of flow from one step or decision to 

another. 

 

 

 

 

 

 

      This diamond shap is used to decision based on a question. 

The question is    

written in the diamond.  More than one arrow goes out 

of the diamond,    

each one showing the direction the process takes for a 

given answer to   

 the question. (Often the  answers are “ yes” and “ no.”)   
 

 

               

                 Link to another page or another flowchart. 
The same  

        symbol on the other page indicates that the 
flow   

continues there. 

 
                         
 

                                           The parallelogram box is used to read input / 
output the values 
 

The rectangle box is used to assume the values and calculate 

procedure  
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                                    This symbol is used to print the document.           
 

 

 
 
 

The oval shaped symbol represents the 
START operation. This symbol is also used 
for start and end points  

 
 
1.4.5 Difference between flow – chart and algorithm : 
  

Algorithm Flow – chart 
A method of representing the step 
by step logical procedure for 
solving of problem  
 

A flow – chart is diagrammatic 
representation of an algorithm. It is 
constructed  using different types of 
boxes and symbols. 
 

It contain step by step description 
in English, each step representing a 
particular operation leading to 
solution of problem 
 

The flow – chart has series of blocks 
and arrows, each of which 
represents a particular step in an 
algorithm   

These are particularly useful for 
small problems  

These are useful for detailed 
representations of complicated 
programs. 
 

For example programs algorithms 
prove to be inadequate  

For complex programming flow-
charts prove to be adequate. 
 

These are particularly useful for 
small problems 

These are useful for detailed 
represented of complicated 
programs  

It is written in user friendly 
language like English 

It drawn according to international 
standard organization (ISO) 
symbols.   
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1.4.6 Flow Chart Example 1: 

1) Draw a flow – chart to print first  N positive integers  

                             

                                                       

                                                                               Start  

                                         

                                     Input 

            N 

 

                                                I = 0 

 

     Yes        If              No  

                                                      I=N 

 

                Stop         Print 

 

 

             I = I+1 

 

Fig. 1.4.1 
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2) Draw a flowchart to adding 1 to n  natural numbers. 

Answer:  

 

            Start 

 

 

            Input N 

 

      Sum =0,I=0 

      

          

     Yes       No 
     If I=N 

 

    Print sum     sum=sum+I 

 

 

    Stop     I=I+1 

 

 

Fig 1.4.2 
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3) Draw a flow-chart for the sum of the first 50 natural numbers  

 

 

 

          Start 

 

 

            S=0     

 

       I = 0 

 

      No   Yes 

          I = 50  

 

    S = S+I         Print S 

 

                                                   I=I+1   

                                                                 Stop 

 

Fig 1.4.3 
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4) Draw a flowchart to find the largest of three numbers A, B, and C. 

                 

 

Fig 1.4.4 

5) Draw a flowchart for computing factorial N (N!)  Where N! = 1?2?3?....N .    
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Fig 1.4.5 

 
1.5 PSEUDO CODE : Pseudo code  is a detailed  yet readable description 
of  what a computer program or algorithm must do, expressed in a 
formally - styled   natural languages like English, rather than in a  
programming language. 
 
 Pseudo code is sometimes used as a detailed step in the process of 
developing a program. It allows designers or lead programs to express 
the design in detailed and provides programmers a detailed template  for 
the next step writing code in a specific programming language.  
 
Ex;  Read  A,B ; 
 sum = A+B; 
 mult = A*B; 
 div = A/B; 
 diff = A-B; 
        Print sum, mult, div, diff 
         End .   
 

----------------------------------------------------------------------------------

----------- 
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Review Questions and Answers. 

Short Answer type Question       --- 2 marks. 

1. What is procedure? 

2. Define an algorithm? 

3. Write an algorithm to print the biggest of given two integer number? 

4. Define flow – chart? 

5. What are the flow – chart symbols? 

6. Draw a flow – chart to calculate the simple interest using (SI = P* N* 

R /100)? 

7. Draw a flow – chart to find the remainder value of given two 

numbers? 

8. Draw a flow – chart to find the biggest value of given two integer 

numbers? 

9. Draw a flow – chart to calculate product of given two numbers? 

10. What is pseudo code? 

 

Long Questions   --- 6 marks. 

  

1. What are the advantages of flow - chart? 

2. What are the differences between algorithm and flow – chart? 

3. Write an algorithm to find smallest value in given three integer 

numbers? 

4. Write an algorithm to find the whether the given number in prime or 

not? 

5. Write an algorithm to find the reverser value of given 4 digit number? 

6. Draw a flow – chart to find the biggest value of a given three number? 

7. Draw a flow – chart o find pass or failed of a student of a given 5 

subject marks each subject maximum marks are 50. If total mark ≥ 

180 result is pass or fail? 

8. Draw a flow - chart to find the average of 5 given numbers? 

9. Draw a flow – chart to find the sum of 1 to natural numbers? 

10. Draw a flow – chart to find sum o 1 to n even numbers? 

 2 . marks  

1. Define algorithm 
2. What is flow-chart? 
3. What is pseudo code?  
4. What are the symbols of flow-chart? 
5. Write an algorithm to print biggest of given two numbers? 
6. Write flow- chart to print sum of two given numbers?  
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6 MARKS QUESTIONS : 

1. Draw a flow – chart to find the biggest / greatest of given three 
numbers. 
2. Draw a flow – chart to find the whether the given number is even or 
odd. 
3. Write an algorithm to check whether the given number palindrome or 
not. 
4. Differentiate between algorithm and flow – chart. 
 
 
More practice on related flow – charts 
1) Conversion of temperature in Celsius to Fahrenheit  
2) Factorial of a number 
3) Fibonacci sequence 
4) Area of a triangle, given its sides. 
5) Finding GCD, HCF of two numbers  

6) Addicting N terms of the series S = 
�

�!
+

�

�!
+

�

�!
+⋯�		    

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

PAPER II  PROGRAMMING IN ‘C’  
   

241 

 

UNIT -2 

 

   Features of “C” 

______________________________________________________
____ 

Features 

______________________________________________________
____ 
 

Introduction to C language. 
2.1.     Character  set of C language.  
2.2.  Structure of ‘C’ program. 
2.3.  Constant variable and keywords identifiers 
2.4. Data types in ‘C’.  
2.5. Operators in ‘C’. 
2.6. Input and output statements  
   Scanf ( ) 
        get ( ) 
  getchar ( ) 
    printf ( ) 
        put ( ) 

putchar ( ) 
2.7. Control statements 
 Simple if statement 
  If - else statement 

nested if statement 
else if ladder statement 

 
2.8. Loops  in ‘C’ 
 While loop 
 For loop 
 Do – while loop 
 
2.9. Branching statements 
 Switch statement 
 Break statement 
     Continue statement 

Unconditional branching statements 
Goto statement 

 
2.10. programs covering this unit. 
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2.0 Introduction to ‘C’  : 

 In any programming languages, experienced programmers often 

simplify a difficult task by breaking the problems into several smaller, 

more  manageable ones. This process is often refer to as “divide  and 

Conquer”. 

 In “C” we call smaller tasks functions. By combining functions, we 

create problems. A  major benefit of separating a large program with 

functions in that several programmers can work on different aspects of 

the problem at the same time, later combining their functions to complete 

the final program. In addition once you have created a function, you can 

use the routine in other programs without having to               lode for 

example, break a big problem in to several smaller tasks and the 

implement these tasks as functions in ”C”. This chapter introduces you to 

the structural organization of “C” program. Upon completion of this 

chapter, you should understand the frame work of a C program and also 

recognize how comments are represented within the programs. 

“C” language is one of the high level languages and it is a general 

purpose computer language. It supports mathematical, scientific, 

engineering and commercial applications. ‘C’ language was developed at 

Bell laboratories in the early 1970’s by “Dennis Ritchie”. The UNIX 

operating system was written in ‘C’ language. 

2.1Features of C language : 

1) It is structured language 

2) It is simple, versatile, high level language. 

3) It has very big and rich operators. 

4) The execution of programs in ‘C’ is very fast and efficient. 

5) In C language very efficiency data types. 

6) It is supported a separate compilation of function and such function 

can  

    be called by value and called by reference. 

7) ‘C’ language can be used in developing operating system, design of 

compiler and         

  Interpreters, network design, text – editors, develop to data base design 

languages. 
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2.2 STRUCTURE OF C PROGRAM: 

C program have the following structure  

(1) Documentation section 
(2) Linkage section 
(3) Define section 
(4) Global declaration section 
(5) main() 
 (a) declaration part 
 (b) executable part 
(6) Sub programming section 
 

1.DOCUMENTATION SECTION: 
 All user comments and documentation names user name, program 
name are written in this section. All are enclosed or written in /*-------*/. 
We write comments, name of the program or any comments. 
 
2.LINKAGE SYSTEM:  
 
 It is used for C supplied reader files and user created file in this 
section begin with # symbol and without space write ‘include’ (include is a 
reserve word) and then write name of the header enclose within the less 
than  (<) symbol and greater then (>) symbol. We do not put any special 
character  at the end of the linkage section.  
       Ex:   #include <stdio.h> 
               #include <math.h> 
 
3. DEFENITION SECTION: 
  
It is pre processor  statements. It defines all symbolic constants. They are 
called preprocessor directives. 
 
       Ex :  #define max-marks 100. 
 For defining symbolic constant maximum marks =100. 
It is begin with # symbol and without spaces and write define (define is a 
reserve word) don’t put any special character  at the end of the sections. 
 
4. GLOBAL DECLARATION SECTION: 
  
There are some  variables and are declared in the” global declaration 
section”, that is outside of all the functions. This section also declares all 
the user defined section. Variables or functions whose. 
      Ex: since it known in the main () function and other user defined 
functions are called global variables or functions and their  declarations. 
Their declaration should be made before main (). 
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5. MAIN () FUNCTION SECTION: 
 
 Every C program must have one main () function section. This 
section contains two parts 1) declaration part and 2) Executable part. The 
declarations part declares all the variables used in the executable part. 
There is at least one statement in the executable part. These two parts 
must appear   between the opening ({) and closing braces(}). The 
program execution begins at the opening brace ({) and ends (}),the 
closing brace  of the main functions section in the logical end of the 
program. All statements in the declaration and executive parts end with a 
semicolon (;). No C program is executed without main () function. It 
should be written in lowercase letters and should not be terminated by a 
semicolon.  It calls other library functions and user defined functions. 
There must be one and only on main () function in every C program. 
 
 

(a) Declaration:-  It is part of  C program. When all the 
variables, arrays, functions etc. used in the C program are declared  
and may be initialized with their basic data types. 
 

(b) Executive statements:-  these are instruction to the specific 
operators. They may be input, output statements asthmatic 
statements control statements and other statements. They are also 
including comments. 
 

(c) Sub-programming section:- The sub-programming  sections 
contains all the user defined functions that are called in the main 
function. User defined functions are generally placed immediately 
after main function, although they may appear in any order. These 
are subprograms. Generally a subprogram is a function and then 
contain a set statements to perform a specific task. These are 
written by the user, hence name in user_ defined it define after the 
main () function. 

 
                  

   Documentation section. 

                  Link section. 

                  Definition section. 

                  Global Declaration Section. 

                 main () 

                              { 

                                         Declaration Part. 

                                     Executable Part.                                                           

                                } 

  Sub program section. 

   Function -1. 
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   Function -2. 

   ------ 

                          ------ 

                          ------ 

                          ------                   

                          Function – n. 

 

    Fig - Structure Of C Program. 2.0 
 
2.3 Constant  and types of constants & variable and types of 
variable: 
 
 A programming language designed to help process certain kinds of 
data consisting of numbers, characters and string and to provide useful 
output known as information. 
 

The task of processing of data is accomplished  by executing a 
sequence of precise instruction called a program. This instructions are 
formed using certain symbols and words according to some reside rules 
as syntax rules. Every program instruction must confirm precisely to the 
syntax rules of the language. C has its own vocabulary and syntax rules. 
In this chapter, we will discuss the concept of constants and variables and 
other types as they related to C programs. 
 
2.3.0. CHARACTER SET: 
 The characters set  can be used to form words, numbers and 
expressions depend up on the computers on which the program is run. 
However, a subset of characters is available that they can be used on 
most of the computers. The characters in C are grouped in to the 
following types. 
1. Alphabets A to Z  (or) a to z 
2. Digits (numbers 0 to 9 ) 
3. Special characters , ; : . > < ! = # * etc. 
4. White spaces. 
 
 The compiler ignores white spaces they are a part of string 
constant. White spaces may be used to separate the words, but are  
prohibited between the characters of keywords and identifiers. 
 
 
 
 
 
 
2.3.1 Tokens in C: 
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In C some words are used as reserved to do specific tasks intended for 
them and called keywords or reserve words. The list reserve words are  
 
 

C Tokens 

 
 
 

Key words 
 

 

 

 

   
 
 
 

Fig : 2.3.1 
2.3.1.0  KEY WORDS: 

In ‘C’ words is a combination alphabets and digits. The words in C are 

classified in to  

(a) Key word 

(b) Identifier  

All key words have fixed meaning these meanings cannot be changed. 

Key words serve as buildings of blocks for program statements. The list of 

all keywords in ANSIC are listed the table. All key words are written in 

lower case. 

Here in C some words are used as reserved to do specific tasks intended 

for them and called key words or reserve words. The list reserve words 

are  

auto    if   void 
break    int   while 
case    long    
char    register 
continue   return 
default   short size of 
do    static 

Constants Strings Operators 

Identifier 
Special symbols 

Ex:int 
     Float 
     Char 
     If 
     Else 

Ex:Name 

Number 

No 

Nov 

Ex:PI=22/7 

Max mark=100 
Ex:”GJC” 

“College” 

Ex :  ( )    { }  

Ex:+ - * / % 
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double   struct  
else enum   switch 
exter    typedif 
float    union 
for     unsigned 
goto 
 

2.3.1.1  IDENTIFIERS : 

Identifiers are the names of the objects, whose values can be changed 

during the execution of the program. The identifiers are named with 

description that transmits the value it holds. Identifiers refers name of the 

variables, functions and arrays. These are user-defined names and consist 

of a  sequence of letters and digits with a letter as a first character. Both 

upper_ case and lower _ case letters are permitted. Although lower_ case 

letters are preferable. 

2.3.1.2 CONSTANTS: 

A constant contains a value that cannot be changed during execution of a 

program. If you are writing a program that uses a value that never varies. 

It is wise define it as a constant. Constants increase the readability of 

code and in addition cannot be effected by program errors. C supports 

several types of constants. 

CONSTANTS 

 

 

NUMERICAL      CHARACTER 

   CONSTANT      CONSTANT 

 

                   INTEGER               REAL    SINGLE CHARACTER  STRING        

BACK SLASH 

      CONSTANT                       CONSTANT  CONSTANT                  CONSTANT        

CONSTANT   

DECIMAL         OCTAL      HEXA 

   DECIMAL  

Fig 2.3.2 Constant types 
 
(a) NUMERICAL CONSTANT  : 
 It can be any of decimal integers (base 10) consists one or more digits 0-
9  

 
 

(b)INTEGER CONSTANTS : 
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An integer constants refers to a sequence of digits. These are three types, 
namely    (i) decimal (ii) octal (iii) hexa decimal 
 
(i) Decimal integer : The decimal integer constants  consists of a set of 
digits 0 (zero) to 9, preceded by an optional + or - sign 
 
Example :   521 
  -521 
       64537 
    +72 
In the formation of integer constants do not maintain spaces between 
digits don’t put an special character between digits like comma (,) 
Semicolon(;) and non_ digits characters are not permitted between digits. 
 
Example to invalid integer constant:   
23,265 ( not valued) commas are not allowed between integer constant 
23  265  (not valued) blank spaces are not allowed between integer 
constant 
Rs. 500 (not valued) special symbols are not allowed between integer 
constant 
 
The above examples are illegal numbers. 
 
(ii) Octal: 
 
An octal integer constant consists of any combination of digits from 0 
(zero) to 7 with a leading 0 (zero). 
 
Example :  0212 
  0393 
  0123 
  0 
The + or – sign may have optional. In the absence  of  sign, the constant 
is assumed to be positive. Special characters  like  , (commas) and blank 
spaces are not permitted do not put the period (.) in between digits. 
 
 The in valued octal integers are  
   05.56   decimal point is not permitted 
   07,89  commas are not permitted 
   X023   X is a special symbol is not permitted 
   523   5 is not a permissible symbol as first 
character. 
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(iii) Hexadecimal integer : 
 
A sequence of digits preceded by OX. The letters  A,B,C,D,E,F (lower case 
or upper case ) represent A or a is equal to 10, B or b is equal to 11, C or 
c is equal to 12 and D or d is equal to 13, E or e equal to 14 an F or f 
equal to 15. 
 
Example :  0X2  0X2 
   0X8C  0X8C 
   0Xabc 0Xabc 
   0X24  0XEF 
     0X24 
 
We rarely use hexadecimal numbers in C programming. The following 
rules are required to form a hexadecimal number. 

� It is a sequence of one or more symbols. (0 to 9 and A to F) 
the symbols of Hexadecimal number system 

� It may have an optional  + or – sign in the absence  of sign, 
the constant is assumed be positive. 

� It should start with the symbols OX or ox 
� Commas and blanks spaces are not permitted. 
� It should not have  a period (.) as a part of it. 

 
 

Some examples for invalid hexadecimal integer constants. 
 

� OX.421 (.) Dot is not permitted. 
� -0X512  - sign is not permitted. 
� -056.A . the symbols in between the digits. 

 
(c) REAL CONSTANTS : 
 
Integers, numbers containing fraction parts, some numbers are called real 
(or) floating point. 
 
Example :   0.0282 
   -2.321 
   +523.12 
   5.2351 
These numbers are shown in decimal notation having a whole number 
followed by a decimal point and the fractions part. It is possible to omit 
digits before the decimal point, digits after the decimal point that is  
         315 . 6 
        . 62 

    - . 71 
     + .5 
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The above are all valid real numbers. A real numbers may also be 
expressed in exponential notation. For example, the value 315.25 may be 
written 3.1525e2 in exponential notation e2 means multiply by 102. The 
general form is 
 
Montissa e exponent: 
The mantissa is either a real number expressed in decimal notation or an 
integer. The exponent is an integer number with an optional plus or minus 
sign. The letter  ‘e’ separating the mantissa  and exponent can be written 
in either lower_ case(e) or upper case(E). 
 
(d)CHARACTER  CONSTANTS : 
 (a) A single character constants : 
A single character constant contains a single character enclosed with in 
pair of single quotation mark. 
 
Example :  ‘A’, ‘5’, ‘,’ ‘*’ 
Note that the character constants 5 is not same as integer value of ‘5’. ‘5’ 
is the value ASCII is a ‘blank space’. 
 
(b) String constant :  
A string constant is a sequence of character enclosed in double quotes 
(“”). The characters may be letters, numbers, special characters and 
blank space.. 
 Examples :  “GJC” 
   “college” 
   “5+6” 
   “xyz” 
   “A” 
In the above examples “A” is not equal to ‘A’. ”A” is a double string 
constants, ‘A’ is a single string constant. Further a single string constant 
does not have an equivalent integer while a character constant has 
integer value. i.e. (ASCII value ), character strings are often used in 
programs to build meaningful programs. 
 
(c). BACK SLASH CHARACTERS : 
‘C’ supports some special characters constants that are used in output 
function. For example, the symbol ‘\n’ stands for new line character. 
Some backslash character constants are shows in Fig 2.2.3.0. 
 
 
 
 
 
 

TABLE 
Back slash Constant  Meaning 
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“\a” Bell 
“\b” Back space 
“\f” Form feed 
“\n” New line 
“\r” Carriage return 
“\t” Horizontal tab 
“\v” Vertical tab 
“\0” Null 

 Fig 2.2.3.0 
 
2.3.2 Delimiters : 
 
These symbols have syntactic meaning and has not significance. These 
will not specify any operated to result in a value. The following shows 
delimiters list . 
 
 # Hash 
 , Comma 
 ; Colon 
 : Semi colon 
 () Parenthesis 
 {} Curly braces  
 [] Square braces 
 
2.3.3  VARIABLES: 
 
A variable is a data name that may be used to store a data value. During 
execution of a program the values are change is called variable. The 
variable may take different values at different times during execution. 
 
For instance, we used the variable Total as Tot is 40 to store the value of 
total marks. A variable name can be chosen by the programmer in a 
meaningful way so as to reflect its function or nature in the program. 
 
Example :  Avg (Average) 
  Ht (height) 
  Tot((Total) 
  Tot _ stu(Total students) 
 

� If you want write to compound words as variable name. You can put 
the underscore (_) character only.  

� The length of variable not exceed 31 characters. 
� The variable name should not be a keyword. 
� White spaces are not allowed. 
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Invalid variable names : 
 
Example: 521, 4abc, / ram, 26th etc. 
 

Table – Invalid and valued Examples of variables names 

Variable name  Valid / not valid Remarks 
First name  Valid   

Int Not valid  Int is a key word 
Rs. Rate  Not valid  Rs sign is illegal 

Average marks  Not valid  Blank space is not allowed 
Type def  Not valid  It is a reserve word. 

No  Valued  - 
Na Valued - 

Name  Valued  - 
Number  Valued - 

My_name  Valued  - 
Fig 2.3.3 

 
After assigning  variable names we must declare to the compiler. The 
variable does two things. 

(i)It specifies the compiler what the variable name is  
(ii) It specifies what type of data the variable will hold. 

   The declaration of variables must be done before. They are used in 
program. 
 
Variable declaration :  
 
A variable can be used to store a value of any data type. This is the name 
has nothing to do with its types. 
 
 Syntax : Data type var1, var2, var3……………….var n; 
Var1, var2, var3……..var n are the name of variable. Variables are 
separated by commas. Variable declaration statement must end with a 
semicolon(;). 
 
  

Examples:  int a; 
  Int no; marks  
  Float avg – marks; 
  Char name[20]; 
  Double ratio; 
In the above example int, float, char, double are data types, a, no, 

avg marks are numbers. Name or ratio are variable names with character 
data value and double data value respectively. 

 
 
 



 

 

PAPER II  PROGRAMMING IN ‘C’  
   

253 

 

 
Assign the values to variable: 
Variable are declared for use in programming statements such as 

Interest = PXNXR/100; 
Values can be assigned to variable using the assignment operator “=” as 
follows. 
Variable – name = constant or variable or expression 
An assignment implies that the value of the variable on the left of the 
equal sign (“=”)right side of equal sign”=”. 
 
2.3.4 Identifier : 
 
An identifier is a string of alpha numeric characters that begins with 
alphabetic character or an underscore character that are used in 
represent various programming elements such as variables, functions, 
arrays, structures, unions and soon. Actually an identifier is a user – 
defined word. Identifier or symbols are the names user supply for 
variables, types, functions and labels in your program. Identifier names 
must differ in spelling and case from any keyword. You cannot use 
keywords as identifiers, they are reserved for special use. 
 
2.3.5 Expression: 
In programming, an expression in any legal combination of symbol that 
represents a value. Each programming language and application has its 
own rules for what is legal and illegal. For example in the ‘C’ language  
a+5 is an expression, as is the character string “girl”. An expression is a 
combination of variables, constants and operators written according to the 
syntax of C language. In every ‘C’ expression evaluate a value, i.e. every 
expression results in some value of a certain type that can be assigned to 
a variable. Some expressions of C are shown below. 
 
  A= a+b; 
  A=bXc/2; 
  (ab/c) 
  aXb/c  etc.. 
 
2.3.6 Declaration of storage class : 
 
Variables in C can have not only data type but also storage class that 
provides information about their location and visibility in memory. The 
storage class decides the part of a program with in which the variables 
are recognized. The storage classes are classified into auto, static, 
extern,register. 
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2.4 DATA TYPES IN ‘C’  : 

2.4.0.  Data types characteristics: 

    Each data has its own specifics. While a type can be very good for a 
given situation it could not work well in another. So it is good to know the 
different options that we have - their characteristics, advantages and 
disadvantages. Before looking deeper into each of them we will see their 
parameters: purpose, size, range, signed, precision. 

Purpose 

    Obviously the numeric types are there to represent numbers. 
Depending on the size they may vary from vary small to very big range. 
There are also types to represent only integer numbers and others – for 
real numbers. Other data types represent a single character, a sequence 
of characters, a boolean(truth) value. 

Size 

    Varying on the application different data requires different size to be 
stored on. Usually we measure it in bytes or shortly “B”. Note that this is 
a capital B. The lowercase abbreviation “b” means “bits”. One bit is the 
smallest portion of information that a computer can handle. 8 bits form 
one byte and this is the measure that we use – byte (B).  

Range 

    (Only for numeric types) Depending on the size the types could work 
with numbers from different ranges. If you try to store number, which is 
out of the range, an overflow will occur and data will be lost. It is good to 
optimize your programs. If you don’t need to use a big size(range) type, 
you should use the smaller(shorter) version. Of course if you are unsure if 
the type is big enough – take the bigger range. It is better to take several 
bytes more than lose information, because of an overflow. 

Signed or Unsigned 

    When signed, the type can represent both positive and negative 
numbers. Unsigned types work only with positive numbers and they can 
hold numbers twice bigger than signed. This applies to numeric types and 
could depend on the programming language. Some languages (like Java) 
don’t support unsigned numbers. Other languages (like C) have both 
signed and unsigned types. This allows better optimization. 
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    From computer side the difference is in the meaning of the most 
significant bit(MSB). With signed numbers it is the sign. MSB=1 means a 
negative number (- minus sign) and MSB=0 means a positive(+ plus 
sign). If the type is unsigned the sign is fixed to plus and the MSB is just 
a part of the saved value. 

Precision 

    The precision applies only to real numeric types. This is the number of 
digits after the decimal sign that could be remembered. 

    What is a literal? - It is a source code, representing a given value. It 
sounds more complicated than it is ;). In the blocks below you will see 
different examples of literals for each type. 
*The blocks for array, pointer and user defined are not clearly literals, 

they are just examples. 

Some of the most used data types are: 

- Integer – contains integer numbers. There are 
several integer types with different size and 
range. By default they are signed. We use them 
to store information like quantities, sizes, period 
of time etc. 

 

- Real – Also called "floating point numbers", 
contain real numbers with some precision. It 
depends on the type we use. By default is 
signed. You can use these to save price, 
salaries and others. 

 

 

- Character – Saves a single symbol. It is represented with a code. 
Languages like C, C++ use one byte code, and others like Java, C# use 
two bytes code. 

    Character values are enclosed by apostrophes - 'character'. A character 
type can be used when reading the input from the keyboard symbol by 
symbol. 

    There are special characters called escape sequences. They begin with 
a backslash '\'. Such symbols are new line('\n'), null('\0') and others. 
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- String – It represents a sequence of characters. It does not have a 
fixed range. Usually it takes as many bytes as needed to save the 
information. 

    String values are enclosed by quotation marks - "string". Use this to 
store names, words or any other sequence of characters. It can also 
contain escape sequences (see character data type above). 

 
- Boolean – Stores a truth value. It can 
contain only “true” or “false”. It is in use when 
we want to save the result of a logical(Boolean) 
calculation.  

 

 

- Array- An array is not really a new type. It is a sequence of many 
values of the same type. They are called elements. Each element has an 
unique index number. The first element has index=0, the second 1... 

    To access an element from the array use the name of the array and 
the element index(the third element of array “my Array” is : my 
Array[2]). Arrays are useful when dealing with many records of similar 
information. For instance it is convenient if you want to save the names 
for a given number of people. 

 
- Pointers – This also is not really a type, but 
instead a data pointing where a certain 
information is stored. Pointers are extremely 
powerful, but it can be very hard to master 
them. If you plan learning C, you will work with 
pointers very often. 
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- User defined – When solving a complex task it is often useful to define 
our own data type. For instance : you want to save information about 
students. It will be much more convenient if there is a “student” type and 
all information for one student is kept in one place and accessed with one 
variable. For this reason most of the computer languages offer this 
functionality. In C these are structures and unions. In object oriented 
languages this is done with classes. 

 - Void - "void" means “no data type”. Usually this is used with sub-
programs(methods) that don’t return a result. Other usage are void 
pointers. 

 
2.4.1. Data types : 
 
C  language is very big in its data types. Storage representation and 
machine instructions to handle constants differ from computer to 
computer. The variety of data types available allow the programmer 
select the type appropriate to the needs to the application as well as 
the computer. 
 
 Type  Size in bits Range  
Char  8 -128 to 127 
Signed char  8 -128 to 127 
Unsigned char  8 0 to 255 
int  16 -32, 768 to 32767 
Unsigned int  16 0 to 65.535 
Short int  8 -128 to 127 
Signed short int  8 - 128 to 127 
Unsigned short int  8 0 – 255 
Long int  32 -2,147,483,648 to 

2,147,483,647 
Signed longint  32  -2,147,483,648 to 

2,147,483,647 
Unsigned long int 32 0 to 4,294,967,295 
Unsigned long int 32 0 to 4,294,967,295 
Float  32 3.4 E.38 to 3.4 E + 38 
Double  64 1.7E – 308 to 1.7E + 308  
Long double  80 3.4E – 4932 to 1.1E + 4932. 

Fig 2.5 
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In C the data types mainly are  : 
1. Primary ( Fundamental data types) 
2. User defined data types 
3. Derived data types 
4. Empty data set.data type. 
 
1.Primary data types :  
Actually, C support 4 fundamental (or) primary data types. Namely  
(a) Int 
(b) Char 
(c) Float 
(d) Double 
 
Size and range of Basic Data types of Primary data types : 
 
  Int    -32768 to 32.767 
  Char    - 128  to 127  
  Float    3.4e 38 to 3.4e + 38 
  Double   1.7e – 308 to 1.7e +308 
 
 

Primary / fundamental data types 
 
 

 
    Integer type            character type      
Floating type 
 
Signed           unsigned          Signed           unsigned         float   
double    long 
 Integer   integer      character        character                                
double 
 
1.Integer types : 
 
Integers are which numbers with a range of values supported by a 
computer. Integer occupy one word of storage, and since the word 
sizes of computer vary 16 or 32 bits the size of an integer that can be 
stored depends on the computer. If you use a 16 bit word length. The 
size of the integer value is limited to the range  - 32768 to +32767 
 
A signed integer uses one bit for sign and 15 bits for the number. 
Similarly a 32 bit word length can store an integer ranging from -
2.147,483, 648 to 2.47,483,647 
C has three classes of integer storage namely short int, int and long int  
in both signed and unsigned forms  
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For example :  
• Short int represents small integer values 
• The sign and unsigned integers use all the bits, these are always 

positive numbers. 
• A 16 bit machine, the range of unsigned integer number will 

form from 0 to 65.535. 
  We declare long and unsigned integers to increase the range of values. 
The use of qualifier signed an integer is optional, because the default 
declaration assumes a signed number.  
 
(2)Float data type: 
 
The float data types are classified to as (a) float (b) double (c) long 
double. 
 
(a) Float:   
The real numbers or float numbers are stored in 32 bits, with 6 digits of 
precision. Float numbers are defined by “float”. When the accuracy 
provided by a float numbers is not sufficient, the type double can be 
used. 
 
(b) Double: 
 A double data type number used 64 bits giving a precision of 14 digits. 
(c)Long double:  
The precision requires with greater precision, to extend the precision may 
be long double which uses 80 bits. 
(3) Character data type : A single character can be defined as a character 
data type(char) data type. Characters are usually stored in 8 bits (one 
byte) of integer storage. The character data type is also using signed and 
unsigned. While unsigned characters have values from -128 to 127. 
 
3.    USER DEFINED DATA TYPES:  
User defined data types are defined by users programs. They may be 
typedif, sizeif, enim, empty or null data types are used function. Enum is 
a another used defined data types in enumerated data types 
 
 Syntax : enum identifier  { value 1, value2, value 3…………..value n} 
 
Example : enum months { jan =1, feb=2,  march =3………………….dec = 
12} 
 
4. Derived or secondary data types: 
 Derived data types are defined by the primary data types. They are 
array, pointers, functions, structures and files. 
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5. Empty data types: 
 Void is an empty data type normally used as a return type in C. the 
another use of void to declare the pointer in C. When it is not sure that 
what data type will be addressed by the pointer. 
 

2.5 OPERATORS 

 An operator is a symbol that tells the computer to perform certain 

mathematical or logical manipulations. Operators are used in program to 

manipulate data and variables. The data items that operators act upon 

are called “Operators”. 

C operators can be classified into a number of categories. They include. 

1. Arithmetic operators 

2. Relational operators 

3. Logical operators 

4. Assignment operators 

5. Increment and decrement operators 

6. Conditional operators 

7. Bitwise operators 

8. Special operators 

2.5.1.Arithmetic Operators: 

  C provided all arithmetic operators. The operators are +, -, *, / 

and %. These can operate a any built-in data type allowed in C. 

Operator Meaning of operator 

   + 

   - 

     \ 

     % 

Addition of  two values. 

Subtraction of  two values 

Division  of  two values. 

Modular division. 

    

  Integer Arithmetic : 

 When both operands in single addition expression  such as a + b 

one integer the expression is called an integer addition expression,  and 

the operation is called integer arithmetic.  Integer arithmetic  always 

yields as integer value. 
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Example:-  if A and B are integers, and A=25 B= 15 the result is : 

               A+B = 40 
                A-B  = 10 
         A * B = 375 
           A / B  = 1(decimal part truncated) 
           A % B = 10 ( remainder value) 
 
Integer division truncates any fractional part.  The modulo division. 

During integer division,  if  both the operands are of the produce the 

remain of an, integer division. Same sign, the result is truncated towards 

zero. That is 5/2=0 

         -5/-7=0 

    But -5/7 may be zero or -1. 

During modulo division to sign of the result is always the sign of the first 

operand that is  -15%4 = -3 

   -15%-4  -3 

   .15% -4 =3 

The following program shown the use of integer to convert given number 

of days into months and days it is only 30 days months only. 

   Month = days / 30 

Assign to the remainder part of division the days. Thus to given number of 

days is converted into an equivalent number of months and days and the result 

is printed. 

 

 

 

Program:- 

  main ( ) 

   {  

   int  M, D; 

   \ * M means month and D means days */ 

   printf (“ enter any 3 digit number \n “); 

   scanf (“%d”,& D); 

   M = d/30; 

   D= d % 30; 

   printf (“ month = %d days -- %d , M , D ); 

  } 

  enter any 3 digit number. 

  325 

  Months =  10       days = 25 

  enter any 3 digit number 
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  125 

  Months = 4        days = 5. 

2.5.2.Relational operators : 

 

Operator Meaning 
> 

>= 
                          < 

<= 
== 
\= 

 

Is greater than 
Is greater than or equal to 
Is less than 
Is less than or equal to 
Is equal to 
Is not equal to 

 

The relation expression used as the operand1 and operand2 may be 

variable or constant. 

Example:- 

 125 > 120   TRUE 

 12.5 ≥ -12.5 TRUE 

 -125 > 120    FALSE 

 10 < 6 + 5 FALSE 

 

If A = 25 

 A > 10 TRUE 

 100 < A   FALSE 

When Arithmetic expressions are used on either side of a relational 

operator, to arithmetic expression will be evaluated first and then the 

result compared. The relational expression are used in decision 

statements such as if, while, do etc, to decide to course of action of a 

running program. 

 

 

 

 

2.5.3. LOGICAL OPERATORS: 

 

C has the following three logical operators. 

1. && (logical AND) 

2. ¦¦   (logical OR) 

3.  !  (logical NOT) 

These logical operator are used where result more than one condition Fr 

NOT it requires one expression only. 
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Example:- 1. If  (A > B) && (A >C) 

   Big = A 

  2. If (A > B)¦¦ (B<A) 

In the above example the first expression A>B is true and second 

expressive is also true. An expression of this kind which combines two or 

more relational expression is termed as logical expression or a compound 

relatives expression. The result of logical operator yields the result value 

either one (1) or zero (0) if the result is 1, it is True.   

Logical AND:- 

 Syntax : 

if (Expression1) && (Expression 2) 

The expression1  and expression 2 are true only reset I true. 

Example;-  If (Expression-1) && (expression 2) 

   True                   True               result is 1 or True                

 

Truth table for logical AND 

(Expression 1 && Expression-2) Result 
True 
True 
False 
False 

&& 
&& 
&& 
&& 

True 
False 
True 
False 

True 
False 
False 
False 

  

If a= 20, b=5, c=15 

1. If (A>B) && (A>C) = True 

2. If (A>B) && (A<C) = False 

3. If (A<B) && (A>C) = False 

4. If  (A<B) && (A<C)= False 
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Logical OR ( ¦¦):- 

 The logical OR Operator is ( ¦¦ ). It is used where the expression -1 

or expression -2 is true result is true. It mean either expression is true 

result will be true. 

Truth  Table 

(Expression 1 Operator Expression-2) Result 
True 
True 
False 
False 

|| 
|| 
|| 
|| 

True 
False 
True 
False 

False 
True 
True 
False 

 
 

Example:-  

 A=25,  b=50,  C=30 

1. If (A<B) ¦¦ (A<C) = False 

2. If (A<B) ¦¦ (A>C) = True 

3. If (A>B) ¦¦ (A<C) = True 

4. If (A>B) ¦¦ (A>C)= False 

Program 

To print given character in consonant or vowel using logical operator OR. 

A.  main() 

     { 

          char alpha; 

          clrscr(); 

          printf(“Enter any alpha \n:”); 

  scanf(“%c”,&alpha)                                               

           

if(alpha==’a’||alpha==’e’||alpha==’I’||alpha==’o’||alpha==’u’) 

          printf(“%c is vowel” ,alpha); 

          else 

          printf(“%c is consonant”, alpha); 

} 

Input:-Enter an alpha: a 

Output:-a is vowel 
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Input:- Enter an alpha: z 

Output:-z is consonant  

 

 

Logical NOT ! 

 The logical NOT operator is !. in logical NOT we are using one on 

expression. If the expression is true result is false and if the expression is 

false the result is true is called negative. 

(Expression  Operator Result 
True 
False 

! 
! 
 

False 
True 

 
Example : 

  if A=10, B=25, C=50. 
(A>B)  ! False               Result is True here 10>25 is false but negative 
result is True         
 (A<B)  !  True             Result is false here 10 <25 is True but negative 
result is False 
(A<C)  ! True              Result is false here 10 <50 is True but negative 
result is False 
(A>C)  !  False            Result is True here 10>50 is false but negative 
result is True         
 
2.5.4. Assignment operators: 

  An assignment operator is used to assign a value to a variable the 

assignment operator is “=”. 

Syntax:-  Identified = Expression / variable / Constant 

 Where the value of expression, variable and constant is assign 

identify, the operator is “=”. 

 

Ex:-  A  =  B; 
 A = 10 + 5;   
 A = (10+5 ) * B 
 A = 100; 
If two operands in an assignment expression one of different data type, 

then the value of the expression on the right will automatically be 



 

 

PAPER II  PROGRAMMING IN ‘C’  
   

266 

 

converted to the type of the identifier on the left side. ‘C’ is also support 

short hand operator like + = , - = *=, /=, etc. 

The shorthand operator + means add the value of left to right side of “=” 

assignment operators. 

 

 

Examples:- 

Assignment operator Use short and  
operator 

          a=a+1 
          a=a -1  
          a = a * (K+1) 
          a= a/ (K+1) 
          a =  a%b 

         a+=1 
         a - =1 
         a * = K+1 
         a/ = K+1 
         a%=b 
 

 
 
The use of shorthand assignment operators has three advantages. 
What appears on the left hand side need not be repeated and therefore it 
becomes easier to write. 
The statement is more concise and easier to read. The statement is more 

efficient. 

Program an assignment operator: 

 main ( ) 

  {  

 int i, n;  

          i = 0; s = 0; 

      printf (“ enter any two digit value “\n”); 

      scanf (“ %d”, n); 

               while ( i < n) 

        { 

    printf (“%d \n”,i); 

    i + = i; 

               } 

  } 

Output:   enter any two digit value  10 
     1 
   2 

3 
4 
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5 
6 
7 
8 
9 
 
 
 

 
2.5.5. Increment and decrement operators: 

The increment / decrement operators act upon a single operand and 

produce a new value is also called as “ unary operator”.  The increment 

operator  + + adds 1 to operand and decrement operator - - subtract 1 

from operand. 

Syntax: unary operator operand 

Ex: + + i  is equal to i = i + 1 

- - i  is equal to i = i -1  

Mostly we use the increment and decrement operator in loops. 

While + + i  and i++ mean the same thing when they form 

statement independently, they behave differently when there are used in 

expression on the right hand side of an assignment statement consider 

the following: 

   i = 5; 

   s = + + i; 

 in this case, the value of S and I would be 6. Suppose, if we rewrite the 

above statement as  

   i= 5;  

   s = i+ +; 

 

Then the value of S would be 5 and i would be 6. A prefix operator first 

adds 1 to the operand and then the result is assigned to the variable on 

left. 

On the other hand, a postfix operator first assigns the value to the 

variable on left side then increments the operand.  

 

2.5.6.Conditional operators : 

The conditional operator is also called ternary operator, the conditional 

operators are “( ?) (:)”. The Ternary operator works like if else 

statement. 
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Syntax:  (Expression 1 ? Expression 2 : Expression 3); 

Where  – expression1 is evaluated first. If it true, then the expression2 is 

evaluated and becomes the value of expression. If expression1 is false 

the expression3 is evaluated and its value becomes the value of the 

expression. Note that only one of the expression2 either expression2 or 

expression3 is evaluated. 

Ex:- X = 100;  

 X = 150; 

 A = (X > Y) ? X: Y;   

In the above example A will be assigned the value of Y. This can be 

achieved  using to if else statements as follows. 

 if ( X > Y) 

 A = X; 

 else 

 A = X; 

Program:  

Write a C program to find smallest of given two integer using conditional 

operators. 

A.   #include<stdio.h> 

     #include<conio.h> 

      void main() 

       { 

          int a,b,t; 

          clrscr(); 

          printf(“Enter the values for a,b); 

          scanf(“%d,%d”,&a,&b); 

          t=(a<b)?a:b; 

          printf(“Smallest value is %d”,t); 

         getch(); 

  } 

Input:-Enter the values for a,b:  456  876 

Output: Smallest value is 456  

 

 

2.5.7. BITWISE OPERATORS:- 

 A bitwise operator operators on each bit  ( bit means binary digit) of 

data it may 0 or 1 only. The bit wise operator. 

 

Bitwise operator Meaning 
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& 
| 
^ 

<< 
>> 
˜ 

Bitwise AND 
Bitwise OR 

Bitwise exclusive OR 
Shift left 

Shift right 
One’s complement 

The operations are carried out independently on each pair of 

corresponding bits within the operands thus the LSB (Least Significant bit) 

i.e right most side bits within the two operands will be compared until all 

bits have been compared. The result  of these comparisons are: 

Bitwise AND:- This expression will be returns 1, if both bits have a value 

of 1. Otherwise, it will return a value  of 0. 

Truth Table 

  A   B Result 
0 
0 
1 
1 

0 
1 
0 
1 

0 
0 
0 
1 

Truth table of Bitwise AND 

Bitwise OR:- This expression will be returns 1, if one or more of the  bits 
have a value of 1. Otherwise, it will return a value  of 0. 
 

Truth Table 
 

  A   B Result 
0 
0 
1 
1 

0 
1 
0 
1 

0 
1 
1 
1 

 

Bitwise  Exclusive OR:- This expression will be returns a1, if one  of the  

bits have a value of 1 and  Otherwise, it will return a value  of 0. 

Truth Table 

  A   B Result 
0 
0 
1 
1 

0 
1 
0 
1 

0 
1 
1 

  0   
Truth table of Bitwise OR 
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Bitwise left shift operator(<<):- 

It  work as the represent the bit pattern to be shifted. Bitwise right 

operator (>>). It is an unsigned integer that indicates the number of 

displacements. 

 

 

One’s complement ( ˜):-  

Bitwise complement operator “˜” switches all to bits binary pattern, that 
is all the  
“0” s (zeros) becomes all 1 (ones) becomes 0 s ( zeros). 
 
8.Special operators:- 

C support some special operators of such as comma operator, size of 

operator, pointer operators * and member selection operators. (dot) and 

—>. 

The comma  operator:- 

 The comma operator can be used to link related together. A coma 

operator link list of expression is evaluated left to right and the value of 

right – most expression is the value the combined expression. 

Example:- int a,b,c,d; 

  a=5, b=10, c=20; 

First assigns the value 5 to a, then 10 assign to b, and 20 assign to c. 

The comma operator has the lowest precedence of all operators. 

The size of operator:- 

 The size of is a complie time operator. When used with an operand, 

it returns the number of bytes the operand occupies. The operand may be 

a variable, or a constant or a data type qualifier. 

Example:- m = sizeof (S) 

  n = sizeof (int) 

  k = sizeof (325L); 
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The size operator is normally used to determine the length of arrays and 

structures. When sizes are not known to the programmer. It is also used 

to allocate memory space dynamically to variable during execution of 

program. 

2.6. INPUT – OUT PUT STATEMENTS : 
In computer programs, reading, processing and writing of data are 
essential. This is simply doing by programs takes some data as input and 
output / display and then processing data. The input data given to the 
program by two ways. One method is the assign values to variable 
through the assignment statements such as A=10, B=A, X=0 and so on. 
Another method is to use the input function scanf() which can read data 
from a input device. We have used both the methods is most of our 
earlier programs. 
All input/output operations are carried out through function calls such as 
printf()and scanf(). These functions are collectively known as the 
standard input or output library. It may be recalled that included a 
statement. 
# include <stdio.h> 
This is to instruct the compiler to fetch the function scanf() and 
printf()from stdio.h library. Stdio.h is an abbreviation for standard input – 
output header file. The instruction # include <stdio.h> tells the compiler 
to search for a file named stdio.h and place  its contents at this point  in 
to program. The contents of the header file become part of source code 
when it is compiled. 
 
 Input – output statements another way of giving values to variables. 

Is to input data though key board using scanf( ) function. And get the 

result through VDU using printf( ) function. 

 In a they are two types of input/output statements. 

1. Formatted input statements. 

2. Unformatted  input stated. 

3. Formatted output statements 

4. Unformatted output statement 

An input / output function can be accessed from where within a program  

simply by writing the function name followed by a list of    arguments 

enclosed  in parentheses“( )”. The arguments represent data item. They 

are sent tot the function .  Some input/output function do not require 

arguments through the empty parentheses. 

 scanf ( ): function is a example for formatted input statement, is the 

unformatted input functions are getchar( ),gets(). 
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printf(): printf() function is a example for formatted output function. The 

unformatted output functions are putchar(),puts() 

Input statements are 

Formatted 
 

Input Statement 

Formatted Input statement 
Unformatted Input Statements 

scanf ( ) 
getchar(), gets()  

Output statements 

Formatted Output statement 
 

printf ( ) 

Unformatted Output statements 
 

putchar ( ), puts. 

2.6.0.Conservation Characters 

Character Meaning 
%c 

 
%d 

 
%f 

 
 

%e 
 

%g 
 
 

%i 
 

%o 
 

%s 
 

%x 
 

%n 
 

%l 
 

%L 
 

Data value is a single character 
 
Data value is a signed decimal integer 
 
Data value is a signal floating point 
value with E not him. 
 
Data value is a signal floating point 
value. 
 
Data value signed value in %e or %f 
format  
whichever is shorten. 
 
Signed decimal integer 
 
Unsigned octal ( base 8) integer 
 
String of text. 
 
Unsigned hexadecimal base (10) 
integer 
 
For short integer 
 
For long integer 
 
For long double. 

Fig : 2.6.0 
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2.6.1.scanf ( ):- scanf ( ) is a input function. It can be used to send data 

into the memory from standered  input devices. This function can be used 

to enter any combination of numerical values, character values and string 

values. The function retires number of data items. 

Syntax:-scanf ( “ control strings”, & var1, &var2, & var); 

Where control string refers to string containing certain required 

formatting information and var1, var2, var3,…, var n are variables that 

represent the individual input data value. 

Use of scanf()  function: 

Field specification consisting of the conversion character % a data type 

character and an optional number for specifying the and blanks, tabs, and 

new lines. The blank spaces, tabs and newlines the optional the data 

types character indicates the types of data that is to be assigned to the 

variable associated with the corresponding variables. The field width 

specifies is optional 

The ampersand symbol (&) before each variables. Science the control 

string  %d. Specifies that an integer value is to be read from to input 

device, we have to type in the value in integer form. Since the number is 

typed in the “enter key” is pressed, the computer then proceeds to the 

next statement. 

The control string is a sequence one or more groups, Each character 

group is combination of % symbol and one o the conversion character. 

The control string specific variable. The control string specific variables. 

The control string specifies the field format in which direct the 

interpretation of input data. It may include: 

Input- Integer numbers: 

The field specification for reading an integer number is %d. The percent 

sign(%) indicates that a conversion specification an integer that is also 

specifies that field with of the number to be input and “d” known as data 

type character, indicates that the number to be read in integer mode. 

The value 100 assigned to n and the value 2561 assigned to n1. 

When the scanf( ) reads a particular value, reading of the value will 

terminate as soon as the number of characters specified by the field  

reached or until a character  

The following examples refers to various input formatting options. 
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The scanf( ) request input data for 3 integer values a ,b, c and 

accordingly 3 values 5,10,15 are given. The specification %*d the value 5 

has been skipped and 10 is assigned to the value b, c contains 15. 

The second scanf( ) function specifies the formed %2d and %4d for M,N 

respectively. Whenever we specify field width for reading integer 

numbers, the input numbers should not contain more digits than the 

specified size. The extra digits on the right hand side will be truncated 

and assigned to the next variable in the list. Suppose we declare x as 

6785 and y as 6542 it assigned 87 to m and 85 to N. The value 6542 has 

assigned to the next first variables in the immediately sacnf( )  

statement p. 

main( ) 

 { 

  int a,b,c, M,N,P; 

  int p,q,r; 

  printf (“enter 3 integer value”,\n”); 

scanf (“%d %d %d”,&a, &b, &c); 

printf (“%d %d  \n”a,b,c); 

printf (“enter two 4 digit numbers”,\n”); 

scanf (“%2d,%4d”,&M, &n); 

printf (“%d %d,\n,\n” M,N); 

printf (“enter a two digit  integer,\n”); 

scanf (“%d %d”,&a, &M); 

printf (“%d, %d”,&a,&M); 

printf (“enter a 9 digit number”,\n); 

scanf (“%3d,%4d%3d”,&p,q,r); 

printf (“%d%d%d\n\n\n”,p,q,r); 

printf (“enter two 3 digit number \n”); 

scanf (“%d%d”,&m,n); 
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}Output:- 

   Enter three integer number. 

   5 10 15 

Output:- 5,10 – 3657   ( C contains  garbage). 

   Enter two 4 digit numbers. 

   8765,   6542. 

Output:- 87 65 

    Enter two digit integerr 

Output:- 6542, 44 

    Enter a nine  digit number 

Output:- 651234567 

    Enter two  3 digit number 

    523 657 

    523 523 

Output:- 89 523. 

 

Inputing Real Numbers:- 

 

 scanf reads real values using to simple specification %f for both the 

contains namely, decimal point notation and exponential notions. 

 

Example:- Scanf (“%f %f %f”, &A,&B,&C); 

  With values 123.45 , 67.85, 900 

Values will assign with 123.45 to A 67.85 to B, and 900.00 to C. 

If the number to be read f double type, than the specifications should be 

%if instead of simple if. 

 

Example:- 

 main( ) 

 { 

  float A,B; 

  double C,D; 

  printf (“values of A,B”); 

scanf (“%f%e”,&A, &B); 

printf (“ \n”); 

printf (“A=%f/n Y=%f\n”,A,B); 

printf (“values for C,D”); 

scanf (“%f %f,&C,&D”); 
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printf (“\nC=%f\n D= %e,”C,D); 

printf (“\n\n A=%12 \f \n B=%123”, C,D); 

} 

Output:- 

  Values of A B  

  12.3456, 12.5e-2 

  A= 12.345600 

  B= 0.125000 

  Values for C and D 

  1.2345678987654321, 56789123567890 

  C= 1.2345676543, 

  D= 5.678912356789 e+001. 

Character Reading:- 

 A single character can be read from  terminal using to getchar ( ) 

function. 

 A scanf ( ) function can input strings containing more than one 

character. The following to specification for reading character strings. 

   %Wc   or     %WS. 

The corresponding argument should be a pointer to a character array. 

However, %C may be used to read  singe character when the argument 

in a pointer to a char variable. 

Getchar( ):- Single character can be entered into the computer using 

in C library function getchar ( ). It return a  single character from a 

slandered input  device. The function. 

Syntax:- Character variable = getchar ( ); 

Example Reading of string using %WC and %WS: 

The use of various field specification for reading string1. When we use 

%d WC for reading a string to system will wait until W to character is 

keys. The specification %S terminates reading as the encounter of blank 

space. Reference name has read only to first part Andhra and the 

second part Pradesh is assigned to named during the second run the 

string Andhra is correctly to name%. 
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 %C[ character] and % [character] 

The specification %c [character] means that only characters specified 

within the brackets are permissible in to input string.  

Gets ( ):-  The function gets ( ) receives the string from the standard 

input device. 

Syntax:- gets (< string _type variable). 
 

2.6.2.Output functions : 

The printf  statement provide certain features that can be use effectively 

to control the assignment and spaces of print-outs on the terminals. The 

printf( ) is used  to print the data from memory onto a output devices. 

This function can be used to output any combination of values like 

integer, float, single character and string. 

Syntax;- printf (“Control String”, var1, var2, var3,…, var n); 

In the above syntax the control string consists of three types of items.  

• Character that will be printed on the screen as they appear. 

• Format specification that define the output format for display of 

each item. 

• Escape sequence characters such \n,\t and \b. 

 

The control string indicates how many arguments follow and what their 

data types. The variables var1, var2, var3,… var n are the variables 

whose values are formatted and printed according to the specifications of 

the control string. The variables should match in number, order and type 

with the format specifications. 

 Example:- 

  printf (“ c programs”); 

  printf (“/n”); 

  printf (“%d”,A); 

  printf (“ ”); 

  printf (“ A=%f \n b=%f ”, A,B); 

   printf (“\n \n \n”); 

printf never supplies a new line automatically and therefore  printf 

statement may be used to build one line of output. A new line can be 

introduced by to help of  a character “\n”, printf ( ) of integer 
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numbers. The  format specification for printing an integer number is 

%Wd. 

Where W indicate field width for output. Where d specifies that the 

value to be printed is an integer. The number is written right – justified 

in the given field width heading blanks will appear as necessary. 

Examples:-                                             

printf ( ) format Output 

 

printf (“%d”, 1234) 

 

printf (“%5d”, 1234) 

 

printf (“%5d”, 1234) 

 

 printf (“%-5d”, 1234) 

 

  printf (“%05d”, 1234) 

 

 

1 2 3 4 

 

 1 2 3 4 

 

1 2 3 4 5 

 

1 2 3 4  

 

0 1 2 3 4 
 

  

It is also possible to force printing the text to left justified by placing a 

minus (-) sign directly after the % character as shown in the forth 

example above. It is also possible to put with zeros in leading blanks by 

placing 0 (zero) before field width specifier as shown in the 5th example. 

The long integers may be printed by specifying “ld” in place of “d” in the 

format specification.  

The program for various formats of integer value.  

main( ) 
 

 { int A=12345; 

  long N=567890; 

  printf (“%d  \n”, A); 

printf (“10d \n”,A); 

printf (“ %010d\n”,A); 

printf (“%-10d\n”,A); 

printf (“%10ld \n”, N); 

printf (“%10ld \n”/-N”); 
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} 

Output:- 

  12345 

        1 2 3 4 5 

       0 0 0 1 2 3 4 5 

       1 2 3 4 5 

      567890 

            -567890 

Output real or floating numbers:The output of a real number by 

displaying decimal notation  using the following format specification. 

    %W.P.f 

The ‘W’ indicates the number of position that are to be used for display of 

the value and the ‘P’ indicates number digits to be displayed after the 

decimal point (Precision). The value, when displayed is rounded to ‘P’ 

decimal places and printed right-justified in the field of ‘W’ columns. The 

negative numbers will be printed with the minus sign specification (-

).The following example to output of the A=12.3456 under different 

format specification. 

Printf real numbers format  Output 

Printf (“%7.4, A”);                      

Printf (“ %7.2,A”);      

Printf (“%-7.2f”A); 

printf (“%f”,A);                                       

printf (“/0.2e”,A);   

  The program for printing real numbers: 

 main( ) 

 { floa t A=12.3456; 

  printf (“%7.4f”, A); 

printf (“%f \n”,A); 

1 2 . 3 4 5 6 

  1 2 . 3 4 

1 2 . 3 4   

1 2 . 3 4 5 6 

  1

  

\ 2 2 e + 0 1 
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printf (“ %7.2f\n”,A); 

printf (“%-7.2f\n”,A); 

printf (“07.2f \n”, A); 

printf (“10.2e \n”/A”); 

  printf (“12.4e \n”,- A); 

printf (“0.-10.2e \n”,y); 

printf (“ %e\n”,y); 

 } 

 Output:- 

     12.3456   1.22e + 001 

             12.345606  1.2345e + 001 

     12.34   1.23e + 001 

     12.34   123456.e + 001 

Printing a Single Character: 

A single character can be displayed in a desired position using the 

format. 

    % WC 

The character will be displayed right justified in the field of a columns we 

can make the display left  by placing a minus (-) sign before ‘W’. The 

default value for W is 1. 

Putchar ( ):-   

Single characters can be displayed using function putchar ( ). It returns a 

single character to a standard output device. It must be expressed as an 

argument to the function. 

Syntax:- putchar (< character _ variable>); 
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Printing Strings : 

The format specification for out putting string is similar to that real 

numbers. 

    % W P S. 

Where W specified to field width for display and P instruct that the first P 

character of the string one to be displayed. The display is right – 

justified. 

Example:- S= ANDHRA PRADESH 

 1 2 3 4 5 6 7 8 9 1

0 

1

1 

1

2 

1

3 

1

4 

1

5 

1

6 

1

7 

1

8 

1

9 

2

0 

%S A N D H R A  P R A D E S H \0     A 

%20

S 

N D H R A  P R A D E S H \0       

%6S      A N D H R A  P R A D E S H \0 

                     

%5S     A N D H R A  P R A D E S H \0  

   

Printf Format Codes : 

Code Meaning 

%c 
 

%d 
 

%e 
 

%f 
 

%g 
 

%i 
 

%o 
 

%S 
 

%u 
 

%x 

Print a single character 
 
Print a decimal integer 
 
Print floating point value with 
exponent 
 
Print floating  point without exponent 
 
Print floats point either e-type or 
float  
 
Print signed decimal integer 
 
Print octal integer 
 
Print string 
 
Unsigned decimal integer 
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Hexa decimal integer without leading 
o 

Puts ( ):- The function puts ( ) outputs the sing to the standard ouput 

device 

  Syntax:- puts (s); 

Where S is a string that was real with gets ( ) 

Expression:-  

An Arithmetic expression is a combination of variables, constants and 

operators arranged. Expressions are evaluated using an assignment 

statement of the form.  

Syntax : variable = expression 

Variable is any valid C variable name, when the statement is 

encountered , the expressions is evaluated first and the result the 

replaces the previous value of the variable on left hand side.  All 

variables used in the expression must be assigned values before 

evaluation is attempted. 

Example:- A = B+ C 

   I = I +1 

   I≤ 20. 

2.7 CONTROL STATEMENTS: 

 When the execute a program, the instruction can be performed 

sequentially, respectively or selectively based on a condition. The if and  

if_ else statement provide a means of performing a series of instruction 

based on a condition. Flow of control specifies the sequences in which the 

instruction are executed. 

Decision making with if statement: 

The if statement is a powerful decision making statement and is used to 

control the flow of execution of statements. It is basically two ways 

decision statements and is used in conjunction with an expression. 

It allows the computer to evaluate the expression first and then, 

depending upon whether the value of the expression is True or False, it 

transfers the control to a particular statement. The point of program has 
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two parts to follows one for the true condition and the other for the false 

condition. 

 

                                                                   

    

   False  True 

 

Example:-  

  if total marks ≥ 75 
  You are select 
  else 
   You are not select. 
 
C support 4 types of conditional statement 

1. Simple if statement 

2. If--- else statement 

3. Nested if --- else statement 

4. Else – if ladder 

 

2.7.0.Simple if statement:- 

Syntax:- if (test _ condition) 

  { 

   statement_ block; 

  } 

   statement _ X; 

In the above simple if syntax, the statement - block may be a single or 

group of statements. If the test _ condition is true. The statement – block 

will be executed, otherwise the statement will be skipped and execution 

will jump to the statement _ X. Remember, When the condition is true, 

both the statement_ block and statement _ X will be executed. 
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Flow-chart of simple if:- 

     

   

   False                                 True 

 

 

 

 

 

 

 

                                  Fig : Flow chart of simple if 

Example:- if ( total marks >= 400) 
  { 
   total_ marks + bonus _ marks; 
  } 
   printf (“%d”, total marks); 
In the above example the total marks of the student is >=400, then 
additional  
Bonus marks are added to his marks before they are printed total _ 
marks. Otherwise if total marks < 400 the bonus- marks are not added. 
The actual given total_marks only printed. 
Program:- 

 main ( ) 

 {  

int TM, Sno; 

  printf (“enter the student number \n”); 

  scanf (“%d”, &sno); 

  printf (“enter the student total marks \n”); 

  scanf (“%d”, & TM); 

  if (TM ≥ 400) 

  {   

TM  = TM + 10; 

  } 

Test 

expression 

Statement block 

Next Statement 

Statement _X 
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  printf (“student No is %d\n”, sno); 

  printf (“Total marks %d\n”, TM); 

   } 

Program to simple if statement 

    

2.7.1.If ------ else statement:  

The if – else statement is used to execute true or false. 

Syntax:- 

    if (test _ expression) 

   { 

      true _ block statements; 

   } 

       else 

   {   

false_ block statement; 

   } 

  

statement _ X; 

 

If the test_expression is true , then the true_block    statements   are   

executed   true_ block may have one or more statements if the 

test_expression is false (else) the false_block statements are executed.  

In either case, either true_block or false_block will be executed, not both.  

 

flow chart : 

      

   False                                  True 

 

 

 

 

 

 

Test 

Expression 

False -  block 

statement 

True -  block 

statement 

Statement - X 
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Example:-  

In a class we want count the student of boys and girls. We use code for 
‘B’ for boys and ‘G’ for girls. 
  if( student _ code == B) 

  {  

Boys = boys + 1; 

  } 

  else 

  {    

Girls = girls + 1; 

} 

In the above example the first test_condition is true. The number of boys 
is incremented by one. If the test_ condition false the girls are increment  
by one. Then the control reaches the statement _X. 
Program:- 
  main ( )  

  {  

int a,b, big = 0; 

  printf );(“enter the value for a\n”); 

  scanf (“%d”, &a); 

  printf (“enter the value for b\n”); 

  scanf (“ %d”, &b); 

  if (a > b) 

  {  

big =a; 

  } 

  else 

  {   

big = b; 

  } 

  printf (“the big value is %d”, big) 

  } 

 

Program to if-else statement 

2.7.2.Nested if statement:- 
 When a series of decision are involved, we may have to use more 
than one if else statement in nested form. 
Syntax:- if ( test _ condition _ 1) 
  { 
   if (test _condition _2) 
       { 
    statement _ 1; 
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   } 
  else 
   { 
    statement _2; 
   } 
  else 
   { 
    statement _ 3; 
   } 
    statement _ n; 
 
The execution of nested if is, if the condition _1 is, false statement _3 will be 

executed, otherwise it continued and perform the test condition _ 2 if it also true 

the statement will be executed. If means to the statement _1 will be executed 

only when condition _1 and condition _2 is not true i.e false, it mean the 1
st
 

condition _1 is true but test_ condition _2 is false. Then the statement _2 will be 

executed, and then the control is transferred to the statement _ X. 

 

               

                             False                                           True 

                                              

 

 

                                                                   False                         

True 

 

 

 

 

 

Fig : Flow chart of Nested – if Statement 

 

If 

condition - 1 

Test 

condition - 2 

Statement -1 

Statement – 2 

Statement – 3 

Statement - X 
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Example:-  

A bank has introduced an in continue  interest to give giving bonus interest  all 

senior citizen holders who deposit more than 50,000. The bonus interest is 3%. 

If the deposit holder is not to senior citizen. 

 if ( customer _ code = senior citizen ) 

 { 

  if ( deposit _ amount > 50000) 

 {   interest = interest rate  + 0.05 

 } 

  else 

  interest = interest  + 0.02; 

 } 

  else 

  interest = interest + 0.00; 

 } 

  amount = interest + bonus interest. 

In the above example, if the condition _code == Senior citizen and the deposit 

amount is >= 50,000 the interest is calculated as actual interest plus 0.05 Bonus 

interest. i.e. interest = interest rate + 0.05. 

If the customer code = senior citizen and the deposit amount is < 50,000 the 

interest is calculated as actual interest plus 0.02 Bonus interest. i.e. interest = 

interest rate + 0.02 

If the customer code is not = senior citizen and the actual interest is paid only. 

There is no Bonus interest. i.e.  interest = interest rate + 0.00 
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2.Write a C program to find the biggest value of given three integer numbers 

using nested if statements 

#include<stdio.h> 

#include<conio.h> 

void main() 

{ 

    int a,b,c ; 

   clrscr(); 

   printf(“Enter the values a,b,c:”); 

   scanf(“%d,%d,%d”,&a,&b,&c); 

   if(a>b) 

    { 

      if(a>c) 

     { 

         printf(“%d is biggest”,a); 

     } 

else 

    { 

      printf(“%d is biggest”,c); 

     } 

   } 

  else 

   { 

     if(b>c) 

{ 

    printf(“%d is biggest”,b); 

} 

else 

{ 

      printf(“%d is biggest “,c); 

} 

       } 

       getch(); 

  } 

Input:- 

Enter the values a,b,c:  567  764   345 

Output:- 

345 is biggest 
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2.7.3.The else - if  ladder: 

 Another way of using if’s together when multipath are involved. A 

multipath decision is a chain of ifs in which the statement associated with 

each else is an if. 

Syntax:-  

if (condition_1) 

       statement _1; 

  else if ( condition _2) 

       statement _ 2; 

  else if ( condition _3) 

       statement _ 3; 

   ----- 

   ------ 

  else 

   default _statement; 

   statement_ X; 

 

This construction is known as else if ladder. The conditions are  evaluated  

from top to bottom. As soon as a true condition is found the statement 

associated with it executed the control is transferred to statement _ X. It 

is simple skipped the rest of the statement when all conditions becomes 

false, then the final else containing the default – statement will be 

executed. 
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Flow – chart  – to else if ladder statement: 

 

            True   False 

 

             True                False 

   

 

         True                   False 

 

   

      

                                True  False 

     

       

 

 

Shfs     

 

 

 

 

Fig : 2.7.0.Flowchart - Else if ladder Statement 

Condition - 4 

 

Statement -1 Statement -2 Statement -3 Statement -4 default 

Syntax - X 

Condition - 3 

 

Condition - 2 

 

Condition - 1 
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Example:- If you give grading the students in your college. The grading 

is done according to the following marks out of 100. 

Marks Grade 
80 – 100 
60 – 79 
50 – 59 
40 – 49 

Below -  40 

A 
B 
C 
D 

Fail 
 

If ( marks > 79 ) 

 Grade = “A” 

elseif (marks > 59) 

 Grade  = ”B” 

elseif ( marks = 49) 

 Grade = “C” 

else 

 Grade = “Fail” 

printf(“%S”, grade); 

 

Program: 

Write a C program to find the grade of the student to following condition using 

else if statement. 

Avg marks Grade 

>=80 distinction 

<=80 and >=60 1
st

 division 

<60 and >=50 2
nd

 division 

<50 and >=40 3
rd

 division 

<40 Fail. 

                           

 
 
 
 
 



 

 

PAPER II  PROGRAMMING IN ‘C’  
   

293 

 

 
A.  void main() 
  { 
       int m1,m2,m3,m4,m5,avg; 
       clrscr(); 
       printf(“Enter the values for m1,m2,m3,m4,m5:”); 
      scanf(“%d,%d,%d,%d,%d”,&m1,&m2,&m3,&m4,&m5); 
       avg=(m1+m2+m3+m4+m5)/5; 
       if(avg>=80) 
       { 
          printf(“Distinction”); 
       } 
     else  
      if(avg>=60) 
      { 
         printf(“1st grade”); 
      } 
     else     
      if(avg>=50) 
     { 
          printf(“2nd grade”); 
     } 
   else 
    if(avg>=40) 
    { 
      printf(“3rd grade”); 
     } 
    else 
     { 
       printf(“fail”); 
      } 
     getch(); 

}  
Input:- 
Enter  the values for m1,m2,m3,m4,m5: 87 
         54 
         65 
         98 
         87 
Output:- 1st grade 
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2.8. LOOPS: 

We have seen in the previous chapter that is possible to execute a 

segment of a program repeatedly by introducing a counter and later 

testing it using the if statement. While this method is quietly satisfactory 

for all practical purpose we need to initialize and increment and test its 

value at an appreciate place in the program for the completion of the 

loop.  

 Loop statements are used to execute the statements p repeatedly 

as long as an expression is true. When the expression becomes false 

then the control transferred out of the loop. 

 In looping a sequence of statements are executed until the 

condition is true, A looping process consists two segments, one is known 

as body of the loop the other known as the control statements. The 

control statement tests certain conditions and then directs the repeated 

execution of the statement contained in the body of the loop. 

Depending upon the position of the control statements in the loop, a 

control structure may be, classified either the “entry_ controlled loop” 

or as the “exit controlled loop”.   

 In entry controlled loop, the conditions one tested before to start of 

the loop execution. If the conditions are not true, then the body of the 

loop will not be executed. 

In exit- controlled loop to test condition is performed at the end of the 

body of the loop and therefore the body is executed at least one time 

without condition for the first time. 
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a).Flow chart to entry: 

     

                 False    True 

 

 

 

 

 

 

 

Fig : 2.8.0.Flowchart to entry loop 

b) Flow chart to exit loop:- 

 

 

 

 

   False    True 

 

 

 

 

Fig : Flowchart to exit loop 

The test condition should be carefully stated in order to perform the 

desired of loop executions. It assumed that the test_ condition will 

Condition 

Body of 

the loop 

Out of the loop 

Body o the loop 

Condition 

Out of the loop 
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eventually transfer the control out of the loop. In case, due to some 

reason it does not do so, the control setup an infinite loop and the body is 

executed over again the looping process would include the following 

steps. 

1. Setting and initialization of a counter. 

2. Execution of the statements in the loop. 

3. Test for a specified condition for execution of the loop. 

4. Incrementing the counter. 

The test may be either to determine whether the loop has been repeated 

the specified number of times or to determine whether a particular 

condition has been met. 

C language provided for three loop constructs for performing loop 

operations. They are. 

1. The while statement 

2. The for statement 

3. Do statement 

2.7.1 THE WHILE STATEMENT: 

Syntax:- while (condition) 

  { 

  Body of the loop; 

  } 

The while statement in an entry controlled loop statement . The condition 

is evaluated first and if condition is true, then the body of the loop is 

executed. After execution of the body the test condition is once again 

tested. Evaluated and I it is true, the body is executed once again. 

Evaluated once again. This process of repeated execution of the body 

continues until the condition finally becomes false and control is 

transferred out of the loop. One on exit, the program continues until the 

with the statement immediately after the body of the loop. The body of 

the loop may have one or more statements. The braces ( { } )  are 

needed only if the body  contains to or more statements. However it is a 

good practice to use the braces even if the body has only one has only 

one statement. 

Example:-  

  s = 0; 
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  i = 0; 

  while (i ≤ 10) 

  { 

  s = s+i; 

  i= i+1; 

  } 

 printf (“sum = 5d \n”, s); 

 

The body of the loop is executed 10 times from 1 to 10 each time 

increment by 1 value of i in inside loop. The condition may also be written 

I <11, the result would be the same. 

Program:- To calculate sum of 1 to n natural numbers. 

 main ( ) 

  { int i, n, s; 

   printf (“enter the value to n \n”); 

   scanf (“%d”, &n); 

   s=0; 

   i=1; 

   while (i ≤ n) 

   { 
    s= s+i; 
    i=i+1; 
   } 
   printf (“\n the sum value of 1 to n natural no’ s is %d 

\n”, s); 

  } 
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Programme for while statement 

Program 2  

. Write a C program to print first ‘n’ odd numbers series. 

A.  #include<stdio.h> 

      #include<conio.h> 

       void main() 

        { 

             int n,c; 

            clrscr(); 

           printf(“Enter values for n:”); 

           scanf(“%d”,&n); 

           c=1; 

          printf(“odd numbers series n:”); 

          while(c<=n) 

          {  

             printf(“%d \n”,c); 

             c=c+2; 

         } 

         getch(); 

     } 

Input:- Enter values for n:10 

Output:- odd numbers series n: 1     3      5     7     9  
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2.8.2.for statement: 

The for is another entry controlled loop statement that provides a more 
concise loop control structure.  

The syntax of the for loop is: 

 for (initial – value; final value; increment  value ) 

  { body of the loop; 

  } 

Example:- 

  s=0; 

  printf (“enter the value to N \n”); 

  scanf (“%d”, &n); 

  for (i=1; i≤n; i++) 

  {  s= s+i;  

  }   

  printf (“the sum is %d ”, s); 

 

The execution of the control variables is done first in the above example I 

is the control variable. The value of control variable is tested using the 

condition ( final, value). The condition is a relational expression such as 

<,  >, ≤, ≥, !, etc. i≤ 10 that determines when the loop will exit. If the 

condition is true, the  body of the loop is executed, otherwise, the loop is 

terminated from body of the loop will exit and execution continue with the 

statement that immediately follows the loop. 

When the body of the loop is executed, the control is transferred back to 

the for  statement after evaluated the last statement in the loop. Now, 

the control variable in incremented using an assignment statement. Such 

as i=i+1 and the new value of the control variable is again tested to see 

whether it satisfies the loop condition. If condition is satisfied the body of 
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the loop is again executed. This process continues till the value of the 

control fails to satisfy the condition. 

Example:- for (i=0, i<=10, i++) 

  { 

  Printf(“%d\n”,i); 

  } 

The for loop is executed 10 times and print 10 digits 0 to 9. The three 

sections enclosed within the parenthesis must be separated  by 

semicolons. Note that there is no semicolon at the end of the loop. 

The for statement allow for negative increments i.e decrement the control 

variable. 

Example:- for (i = 9; i>=0;i--) 

  Printf (“%d”, i); 

This loop is also executed 10 times, but the output would be from 9 to 0 

instead of 0 to 9. Science the conditional test is always performed at the 

beginning of the loop the body of the loop may not be executed at all. If 

the condition fails at the start. 

Program: 

 Write a C program to find sum of 1 to n odd numbers using ‘for’ loop. 

 A. #include<stdio.h> 

      #include<conio.h> 

      void main() 

      { 

        int n,i; 

       clrscr(); 

       printf(“Enter the value for n:”); 

       scanf(“%d”,&n); 

       printf(“Odd numbers series in \n”); 

       for(i=1;i<=n;i++) 

        {    

                printf(“%d”,i); 

        } 

       getch(); 

  } 

Input:- 
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Enter the values for n:8 

Output:- 

  Odd numbers series in 1 

 3  

 5 

 7 

 9 

11 

13 

15 

  

Program : 2.8.2. to for statement 

2.8.3. do STATEMENT:- 

The do statement is an exit controlled  loop statement. The do 

statement the program proceeds to evaluate the body of loop first. At the 

end of the loop, the condition is in the while statement if the condition is 

true the program continues to evaluate the body of the loop once again. 

This process continues as long as the condition is true. When the 

condition becomes false, the loop will be terminated and the control goes 

to the statement that appears immediately after the while statement. 

Syntax:- do 

 { 

Body of the loop; 

  } 

  While (condition); 

Example:- 

  i=0 

  s=0 

  do 

  { s=s+i; 

    i=i+1; 

  } 

While (I ≤ 10); 
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In the above example it reads the 1 to 10 natural numbers the loop to be 

executed as long as the number keyboard is lies between 0 to 10.  

 

Nesting of loops:-  

Nesting of loop, that is one for statement within another for statement , is 

allowed in C. For example. 

 for (i=0; i≤m; i++) 

 { 

 for (j=0; i≤n; i++) 

 { 

 body of loop; 

 } 

 Statement – n; 

The loops should be properly indented so as to enable the reader to easily 

determine which statements are contained within each for statement. 

Nested for statement as follows. 

  for (i=0; i≤m; i++)s 

  {   

    for (j=0; j≤m; j++) 

   { 

scanf (“%d”, a(i) (j)); 

   } 

  } 

Nesting can be defined as the method  emending one control structure 

with in another control structure. 

While making control structure to be reside one with in another, the inner 

loop and  outer loop control structures may be of the same type or may 

not be of same type. But it is essential for us to unsure that one control 

structure completely embedded with another. 

Program: 

Write a C program to print the following format using nested for loop. 

                                                1 

                                                2    2 

                                                3     3    3 

                                                4     4     4    4 

                                                5     5     5    5    5 
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#include<stdio.h> 

#include<conio.h 

                main( ) 

              { 

                     int i,j,n; 

                    clrscr( ); 

                    printf(“Enter the value for n:”); 

                    scanf(“%d”,&n); 

                    printf(“format is\n “); 

                   for(i=1;i<=n;i++) 

                    { 

                       for(j=1;j<=i;j++) 

                        { 

                           printf(“%d”,i); 

                         } 

                        printf(“\n”); 

                    } 

                  getch(); 

            } 

Input:-Enter the values for n:2 

Output:-  1 

                  2       2   

  3 3 3 

   

2.9.BRANCHING: 
 
THE  SWITCH STATEMENT:- 

    
  C has a built - in – multiway decisions statement known as a 
switch. The switch statement tests to value of value of a given variable 
against a list of case values and when a match is found, a block of 
statements associated with that case is executed. 
 

Syntax: 
   switch (Expression) 
   {  

Case Constant-value _1: 
    Statement  -  block _1; 

  Break; 
  
 Case Constant-value _2: 

  Statement  block _2; 
  Break; 
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Case Constant-value _3: 
    Statement  block _3; 

Break; 
 

Case Constant-value _4: 
  Statement  block _4; 
  Break; 
 

 Case Constant-value _5; 
  Statement  block _5; 
  Break;  

Default: 
 default – statements block; 
 break;                            

                              } 
                                            Statements – X; 
 
The above syntax the expression is an integer expression or character. 
Constant – values are constants  or constants expressions and are known 
as case labels. Each of these values should be unique within the switch 
statement.   The statement blocks may contains zero or more statements. 
There no need to put braces around these statement blocks. Note that 
case label end with : colon. When switch is executed, the value of the 
expression is successively compared against the constant value 1, 
constant value 2. ……. Constant value_n. If a case found whose value 
matches with the value of the expression, then the block of statements 
that follows the case are executed. The break statement  at the end of 
each block signals  the end of a particular case and causes an exit from 
the switch statement, transferring the control to the statement  - x 
following the switch . The default is an optional case, When present, it will 
be executed if the value of the expression does not match with any of the 
case values. If not present, no action takes place if all matches fail and 
the control goes to the statement – x. 
 
 
Example:-     
If you want declare a grade to the student in class see maximum total 
marks is 100. With the following conditions. 
   Total marks    80 to 100    grade    =   A+  

Total marks    70   -    60   grade    =   A  
Total marks     >50  -  <59   grade    =   B 

         Total marks      >40  -  <49   grade    =   C 
 Total marks     <40               grade    =  “Fail”. 
 
switch (Total marks) 
{ 
  Case 100: 
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  Case   90: 
  Case   80: 
 Grade = “A+”; 
 Break; 
 
  Case   70: 
  Case   60: 
 Grade = “A”; 
 Break; 
  Case   50: 
   Grade = “B”; 
 Break; 
  Case   40:  
   Grade = “C”; 
 Break; 
Default: 
 Grade = “Fail”; 

   } 
             Printf (“%s”, grade) ; 

 

2. Write a C program to find the given alphabet in vowel or consonant using in switch 

case. 

A. main() 

    { 

       char alp; 

       clrscr(); 

       printf(“Enter the value alp:”); 

       scanf(“%c”,&alp); 

      switch(alp) 

      { 

       case’a’: 

       case’e’: 

       case’I’: 

       case’o’: 

       case’u’: 

       printf(“%c is vowel”,alp); 

       break; 

      default: 
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      printf(“%c is consonant”,alp); 

    } 

   getch(); 

 } 

Input:-Enter the value alph: i 

Output:-  i is vowel 

Input:- Enter the value alph:t 

Output:- t is consonant 

Program : 2.9. to switch statement 
 
2.9.2.Break – Statement: 
When the break statement is encountered inside a loop, the loop is 
immediately exited and the program continues with the statement 
immediately following the loop. When the loops are nested, the break 
would only exit from the loop containing it. That is, the break will exit 
only a single loop. 
 Syntax:- 
   Break; 
Example: 
   main () 
   { 
 
     int I,N,S; 
      printf (“enter value for n/n”); 
      scanf (“%d”, &N); 
      S=0; 

    for (i=1; i≤N; ;++) 
{ 

 if (N<0) 
 break; 
 S=S+I; 

} 
printf (“she sum f 1 to n numbers is %d \n”,S); 

} 
Program : 2.9.2 to using break statement 

 
2.9.3.continue – Statement: 
 
C  support another similar statement called continue statement . However 
, the break which causes the loop to be  terminated, the continue as the 
name implies. Causes the loop to be continued with the next iteration 
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after skipping any statement in between . The continue statement tell to 
complier “SKIP THE FOLLOWING STATEMENTS AND CONTINUE WITH THE 
NEXT ITERATION”. 
 
Syntax:-  continue; 
  
 The use of continue statements in loops causes to continue the 
iteration process. Into case of ‘for’ loop the increment part of the loop is 
executed the text-condition is evaluated. 
 
2.9.4.Unconditional Branching Statements:- 
 
goto statement 
C supports the ‘goto’ statement to branch unconditionally from one place 
to another in the program. Although it may be essential to use to ‘goto’ 
statement in a highly structured languages. 
 The goto requires a Lablename in order to identify the place where 
the branch is to be made. A ‘lable’ is any valid variable name, and must 
be followed by a colon (:). The label name is placed immediately before 
the statement where the control is to be transferred. There are two types 
of  ‘goto’ statements used as forward JUMP. forward jump and 
backward jump. The forward jump is as goto…… lable name:. The 
backward jump is as label name: 
 
Syntax forward jump : 

goto lable_name; 
  statement -1;  

statement -2; 
               statement -3; 
     ------ 
     ------ 

    ------ 
    ------   

label name: 
             statement -X; 
 
Syntax:- (backward jump) 
  
  label- name: 
  statement -1; 

statement -2; 
statement -3; 
   ------- 
   ------- 
goto label-name; 
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The lable-name any ware in the program either before or after to goto if 
we use the lablename after ‘goto’ statement is called forward jump. If you 
use the lablename before goto is called backward jump. 
 
The lablename can be anywhere inthe program either before after the 
goto labelname; is met in a program, to flow of control will jump to the 
immediately following labelname begin. This happens unconditionally. 
 
If the label-name in before the statement goto, a loop will be formed and 
some statements will be executed repeatedly. Such as jump is called 
backward jump. Due to unconditional goto statement at his end. to 
control is always transferred back to the input statement. In fact, the 
program puts to computer is a permanent loop known as an infinite loop. 
The computer goes round and round until we take some special steps to 
terminate to loop. So infinite loops should be avoided. 
 
Example:- 
 main() 
 { 
  int A,B,I; 
           I=1; 
 printf (“enter any 5 values \n”); 
 Next_ value; 
 scanf(“%d”,&A); 
 if (n<0) 
 printf (“given number in negative \n”, I); 
 else 
 { 
 printf (“the given values %d”, A); 
 } 
 I=I+1; 
 if (I<=5) 
 goto Next_ value; 
 printf (“stop”); 
 } 
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Output : 

Enter any 5 values 

 15 

 23 

 29 

 16 

 25 

 

Program : 2.9.4. goto – statement – program. 
 

UNIT – 1 

• Practice more problem solved by algorithm 

• Practice more problems solved by draw a flowcharts.2 marks questions. 

1. Define algorithm. 

2. What is a flow chart. 

3. What is meaning of pseudo code 

4. What are the standard symbols using to draw a flow chart 

5. Write an algorithm calculate the simple internet using (PNR/100) 

6. Draw a flow chart to find the biggest of given two numbers 

7. Draw a flow chart to find the sum of given two numbers 

8. Draw a flow chart to find the remainder of given two numbers 

Long answers questions – 6 marks. 

1. Write an algorithm to find to smallest given three numbers. 

2. Write an algorithm to print the whenever given numbers is even odd. 

3. Draw a flow chart to find small less value of given three numbers 

4. Draw flow chart to find the sum of 4 given numbers 

5. What are the difference between algorithm a flowchart. 

UNIT-2 

Review Questions:2 marks: 

1.Who develop C program. 

2.Write the structure of C program 

3.What is a Constant 

4. What is a numeric constant 

5. What is a string constant 

6. What is a single string constant  

7.What is a Variable 

8. What is a String variable 

9. What is a numeric Variable 

10.Fundamental data types 

11. Logical operators 

12. Conditional operators 

13. Bil-mix operators 

14.Get char () 

15. Putchar () 

16.Gets () 
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17. Puts () 

18. Simple if statement 

19. What is a break statement 

20. What is a continue statement 

21. Goto statement 

22. Nested loop statement 

6 marks: 

1. What are input and output statement 

2. What are the control statement in ‘C’,  

3. Explain if else, nested  if attents in C 

4. Explain  if else statement with example 

5. What are loops in C explain them 

6. What are the difference between while and do while statement 

7. Explain the nested loop with example 

8. Write a problem  to find factories of given numbers 

9. Write a C program to find Fibonacci series up to given numbers 

10. Write a C program whenever  

11. Given numbers in plain done or not  

12. Write a C program to find the sum of 4 digits number 

13. Write a C program biggest value of given three numbers 

14. Write a C program to find smallest of given three numbers 

 

 

Short Questions covered in this Unit         2 marks 

1. Who invented the ‘C’ language. 

2. Write structure of  ‘C’ program. 

3. What is character set write the character which used in ‘C’ language . 

4. What is a constant. 

5. What an types of constants. 

6. What is numeric constant 

7. What is sting constant. 

8. What is variable. 

9. What are the string variable. 

10. What is a single string constant.  

11. What are the fundamental data type in C. 

12. What are the arithmetical operators. 

13. What are the bit wise operators. 

14. What are the conditional operators. 

15. What are input and output statements. 

16. What is syntax of pritnf ( ) statement. 

17. What is a getchar ( ) function in C. 

18. Write about simpleif statement. 

19. Write a syntax for if – else statement. 

20. How many types of loops available in C. 

21. What is use of break statement. 
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22. What is use of continue statement. 

23. What is syntax of switch ( ) statement. 

24. What is goto statement. 

Long Question    --- 6 marks. 

1. What are constant in C? Explain  with examples. 

2. What is variable? Explain the types of variable in C with example. 

3. What are the data types in ‘C’.  Explain  them? 

4. What are the operators in C? explain them. 

5. What  are the relational operators in ‘C’ explain with suitable 

examples. 

6. What are the logical operators in C explain with examples. 

7. What are input and output statements in explain them. 

8. What are the conditional statements in C? explain them. 

9. What  are the differences between break – statement and conditional 

statement. What  are the loops in C explain with suitable examples. 

10. Write C program  to find the biggest value of a given 3 integer 

numbers. 

11. Write C program to fin the given in vowel or alphabet character 

using switch statement. 

12. What are the loops in ‘C’ explain them. 

13. Write a C program sum of 1 to n natural number. Using while loop. 

14. Write C program to find the sum of 4 digit number using do… while 

loop. 

15. Write C program to find the given number palindrome or not. 

16. Write a C program to find the factorial of given number using 

recursion method. 
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UNIT – 3 

ARRAYS IN ‘C’ 

3.0 Introduction  to Array. 

      3.1.     Define an  Array. 

           Types of Arrays. 

   

   Sing dimensional Arrays 

Double dimensional Arrays 

Multi dimensional Arrays 

 

    3.3.  Program on Arrays.  

3.0.ARRAYS in ‘C’ : 

The ability to use a single name to represent a collection of items and the 

refer to an item by specifying in the item number enables us to develop 

concise and efficient programs. For example a loop with the subscript as 

the control variable can be used the entire data through ‘Array’ perform 

calculation and print out the result. 

An array is a group of related data items that share a common name; the 

individual values are called items. Arrays can be of any variable type. For 

instance we can define an array name student to represent a set of 

marks of a group of students. A particular value in indicated by writing a 

number called index number of subscript  in brackets after array name. 

Ex:- student [10]; 

It represents the marks of 10 students. While complete set values is 

referred to as an Array. 

Few key notes on Array 

� Array have 0 as the first index not 1. In the above example 

start with student [0] 

� If the size of an array is n to access the last element i.e.(n-1) 

index is used, in the above example student [9]. 

� Suppose the starting address of student [0] is 1004 (address 

allocated by computer), then the next address of student [1] 
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will be 1008(allocated by computer), address of student[2] 

will be 1012(allocate by computer)and so on. It’s because the 

size of float is 4 bits. 

3.1  DEFINITION OF ARRAY:- 

Array can be defined as a collection of data items which are stored in 

consecutive memory locations with a common array name. The individual  

data values present in an array called elements or subscripted -variable of 

array. The array elements can be values or variables also. 

The array can divide into 3 types. 

1. One dimensional Arrays. 

2. Two dimensional Arrays 

3. Multi dimensional Arrays 

3.1.0 Declaration of arrays:- 

Like any other variable array must be declared before they are used. 

We can initialize the elements of arrays in the same way as ordinary 

form of utilization of array is : 

Data_type  array_name[size]; 

 

Syntax to one dimensional array: 

  Data _type  Array _ name [size]; 

Ex:- int   A  [10]; 

Syntax  to two- dimensional array: 

Data-type  Array-name  [row-size] [column-size]; 

    Ex:-  int     A  [10]  [10]; 

  Syntax  to  Multi dimensional Array: 

  Data-type   Array-name  [size] [row-size] [column size] 

    Ex:-  int    A    [10]       [10]      [10]; 

The above syntax the data type specifies to type of elements that will be 

contained in an Array such as int, float, char. The size indicates the 

maximum number of elements that can be stored inside Arrays. The size 

must be enclosed in square brackets ([ ]). Only the two dimensional Array 
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declare row-size and column size, the multidimensional arrays declared 

with number of arrays (size) and row size and column size. 

3.1.1.One Dimensional Array:- 

A list of items can be given one variable name using only one subscripted 

variable is called one dimensional array. For example if we want to 

represent a set of five numbers, say (10, 17, 22, -3 . 19) by an array 

variable ‘A’, then we may declare the variable ‘A’ as follows. 

       A 

A[0]  

A[1] 

A[2] 

A[3]    

A[4]     

The values to the array elements can be assigned as follows. 

  A[0] = 10  

A[1] = 17 

A[2] = 22 

A[3] = -3  

A[4] = 19 

The array ‘A’ to store the value as. 

  A[0]  

A[1] 

A[2] 

A[3]    

A[4] 

The subscript of an array can be integer constants integer variables or 

expressions that yield integer. C performs no bounds checking and 

 

 

 

 

 

 10 

17 

22 

-3 

19 
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therefore care should be exercised to ensure that array indicates are 

within the declared limits. 

Example to one dimensional arrays: 

 main(  ) 

   { 

  int  I, a[10], N, sum; 

  printf (“enter size of array\n”); 

  scanf (“%d”, &N); 

  printf (“enter the values for array\n”); 

   for (i=0, i≤ N; i++); 

   { 

    scanf (“d”,& a (i)); 

   } 

   for (i=0; i< N; i++); 

   {  

sum=sum +a(i); 

   } 

   for (i=0; i<N; i++) 

 

   {  

printf (“sum value is %d\n”, sum); 

   } 

} 

Output:- 

 Enter any n integer value 

 5  

20 

  35 

  50 

  30 

  20  

sum value is 155. 

 

Program : Read and print an array of n elements 

main() 
{ 

int a[20],i,n; 
clrscr(); 
printf(“enter the size of array\n”); 
scanf(“%d”,&n); 
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printf(“enter the values in array\n”); 
 for (i=0; i<n;i++) 
      { 
  scanf(“%d”,&a[i]); 
       } 
printf(“the given values of an array\n”); 

 for (i=0; i<n;i++) 
      { 
  printf(“%d\n”,a[i]); 
       } 
getch(); 

  } 
Output: 

enter the size of array       
5 
enter the values in array 
45 
67 
23 
89 
34 
the given values of an array 
45 
67 
23 
89 
34 
 

3.1.2.Two dimensional arrays: 

The two dimensional array has a list of variable-name using two 

subscripts, we know already that a one-dimensional array can store rows 

of elements only, but in two dimensional array rows of values and 

columns of values. 

Syntax:- data_type  Array_name  [row-size] [columns-size]; 

Where data type refers to any valid data_type, and array_name refers to 

any valid C identifier, row_size indicates  the number of rows and 

column_size indicates the number of elements in each column. The 

row_size and column_size should be integer constants. The maximum 

values are stored in matrices is equal (row-size * column size). Each 

element in a two dimensional array is identified by the array name 

followed  by a pair square brackets enclosing its row number and  column 

number. 
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Example:-   int a  [5] [5]; 

In the above syntax is declared to be array have of two dimensions and of 

data type integer (int), row-size and column size. It stores 25 values will 

be store. 

The two dimensional arrays are stored in memory. 

 

Each dimension array is indeed from zero.  The first index selects the row 

and second index selects the column within that row. 

Two – dimensional array:- 

Where a table of values will have to be student show to value of the 

marks of 3 statements. 

Student no         Subject marks          Subject 2 marks                 Subject 3 

marks 

1                                  25                            21                                     35 

2                                  40                            32                                     38 

3                                  25                            43                                     39 

 

The above table contains 12 values there in each time. We can think of 

this table as matrix consisting of 3 rows and 3 columns. Each row 

represents the values of marks obtained by a each student and each 

column represent the value of marks in different subjects. 

 

 

 

  Coloumn0  Coloumn1  Coloumn2 

 Coloumn3 

Row0           5         15             25       14 

Row1           8         12             05       12 

Row2         3          -5      12               17 

Row3       4         14             19        25 
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Example the two dimensional arrays:- 

main ( )  

 {  

int  i,j a[10] [10],b[10][10],m,n; 

  printf (“enter the row size of array \n”); 

  scanf(“%d”,&m); 

  printf(“enter the column size of array \n”); 

  scanf (“%d”, &n); 

  printf (“enter the values of A matrices \n”); 

   for (i=0; i<m; i++); 

   {  

for (j=0; j<n; j++); 

    { 

     scanf(“%d”,& a[i] [j]); 

    } 

   }  

printf(“enter the value for B matrices  \n”); 

   for (i=0; i<m; i++); 

    {  

     for (j=0; j<n; j++); 

          { 

          scanf(“%d”,&b[i][j]); 

           } 

    } 

  printf  (“the values to A matrices are ”\n); 

   for (i=0; i<m; i++); 

    {  

  for (j=0; j<n; j++); 

           {   

     printf (“%5d”, a[i] [j]); 

     } 

      printf (“\n”); 

    } 

printf  (“the values to B matrices are”\n); 

   for (i=0; i<m; i++); 

    {  

  for (j=0; j<n; j++); 

           {   

     printf (“%5d”, b[i] [j]); 
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     } 

      printf (“\n”); 

    } 

  

} 

 

Output :  enter the row size of array 

  3 

  enter the column size of array 

  3 

  enter the values of A matrices 

  2 

4 

6 

7 

4 

9 

1 

3 

8 

  enter the value for B matrices   

4 

6 

7 

8 

9 

4 

5 

6 

3 

  the values to A matrices are 

2     4     6 

7     4     9 

1     3     8   

the values to B matrices are 

4      6     7 

8      9     4 

5      6     3 
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3.1.3.Multi dimensional arrays:- 

C allows arrays of three or more dimensions. The exact limit is 

determined by the compiler. 

Syntax:- data-type  array-name [size] [row size] [col size]; 

Exam:-     int              A  [5] [5]  [5]; 

In the first index refers to number matrices, the second  index refers to 

row size and the third index refers to columns size of given matrices. 

String handling in array:- 

A string is an array of  characters, any set of characters defined between 

double quotation marks is a constant string. 

Example:- “ My College name is GJC”. 

  “My name is MURTHY”. 

Character strings are after used to build  meaningful and readable 

programs. The common operations performed on character strings are 

also called string. 

DECLARATION AND INITILIZING STRING VARIABLES. 

 A string variables is any valued variable and is always declared as 

an array. The syntax of declaration of a string variable is. 

 char string – variable- name [size]; 

The size determines the number of character in the string- name. Some 

examples are. 

  char Town [10]; 

  char stu-name [10]; 

  char father-name [20]; 

When complier assigns a character string a character array automatically 

supplies a null character (\0) at the end of string. Therefore, the size 

should be equal to the maximum of character in the string plus one. 

Character arrays may be initialized when they are declared. ‘C’ permits a 

character array to be initialized in either of the following examples. 

  static char town [10] = “CHIRALA”; 
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  static char town [10] = { ‘C’,’H’,’I’,’R’,’A’,’L’,’A’, \O’}; 

  static char town [    ] = 

{‘R’,’A’,’J’,’Y’,’A’,’L’,’A’,’K’,’S’,’H’,’M’,’I’’,\0}; 

Actually, the town variable has to be eight (80 elements long i.e is s that 

the string “CHIRALA” contains 7 characters and one element space is 

provided for the null terminator. The name variable has not indicate the 

size, C permits us to initialize a character array without specifying the 

number of elements. In such cases, the size of the array will be 

determined automatically. 

Reading  words:-   

The input function  scanf  can be used with% s format specification to 

read in a string of character  

Example:- char student – name [20]; 

  scanf (“%s”, student-name); 

The problem with the scanf  function is that it terminates its input on the 

first white space it finds. (while space, include blanks, tabs, carriage 

return, has line). Therefore if the following line of text in the terminal. 

Read a line of text:-  In many processing application  we need to read 

an entire line text from to terminal. It is not possible to use scanf function 

to read a line containing more one word. This is because the scanf 

terminates reading as soon as space is encountered in input. To read a 

single character from the terminal, using function  

getchar():  We can use this function repeatedly, to read successive 

single characters from the input and place then into a character array. 

Thus, an entire line of  text can be read and stored in an array, reading is  

terminated when the newline character (“\n”) is entered and the null 

character is then inserted at the end of the string. 

 

Example:- 

 # include <stdio.h> 

 main ( ) 

 { char  L (50), ch; 

          int I; 

          I = 0; 
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          printf (“enter text \n”); 

          do 

          { ch= getchar ( ); 

            L[i] = ch; 

                I++; 

           } 

           c= c – 1; L (c) =’\0’; 

           printf (“\n %s \n “,L); 

             } 

Output:- 

Enter text: 

 Govt jr.college  

 Govt jr.college 

enter the text:  

GJC chirala 

GJC chirala 

 
Writing  strings to screen:- 
 
We have used extensively the printf function with %s specification to print 
strings to the string. The specification %s can be used to display an array 
of character that is terminate by the null character(\0). 
 
Example:-  printf (“%S”, student_ name”); 
 
*Can be used to display the entire contents of the array student-name. 
*We can also specify the precision with which the array is displayed. 
 
Example:-   A string program  using for loop to the following output. 
                                C 
               CO 
                  COL 
      COLL 
       COLLE 
       COLLEG 
       COLLEGE 
       COLLEGE 
                 COLLEG 
       COLLE 
               COLL 
       COL 
       CO 
       C 
main ( ) 

{ 
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1 int  i, d; 

   char string [ ] = “COLLEGE”; 

   printf (“\n \n”); 

  for (i=0; i≤ 8; i++) 

 {  

d=i+1; 

  printf  (“% -8 *s \n “,d, string); 

}  

printf ( “  \n”); 

    for (i=8; i>=0; i--) 

{ 

   d=c+1; 

   printf(“%-8 *s \n”, d, string); 

  } 

} 

Output:-                     C 

                CO 

                  COL 

       COLL 

        COLLE 

        COLLEG 

        COLLEGE 

        COLLEGE 

                 COLLEG 

        COLLE 

                COLL 

        COL 

       CO 

        C 

In the above program the variable specification %8.*s, *%, *S are the 

variable field width and precision specification.  

 

***** 
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PROGRAMS AN ARRAY 

 

1. Write a C program to read and print an array of elements 

 

A.   main() 

       { 

           int a[20],i,n; 

           clrscr(); 

           printf(“Enter the value for n:”); 

           scanf(“%d”,&n); 

           printf(“Enter the element of array \n:”); 

           for(i=0;i<n;i++) 

            { 

              scanf(“%d”,&a[i]); 

            } 

             

printf(“Element of an array:”); 

           for(i=0;i<n;i++) 

           printf(“%d \n”,a[i]); 

           getch(); 

       } 

Input:-   

Enter the values for n:   5 

              Enter the elements of array:  7    3    8    3    6 

 

Output:-   

   

           Elements of array:       7       

      3 

      8 

      3 

      6 

 

2. Write a C program to read and print the reverse of an array 

element 
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A.  main() 

       { 

           int a[20],i,n; 

           clrscr(); 

           printf(“Enter the value for n:”); 

           scanf(“%d”,&n); 

          printf(“Enter the element of array \n:”); 

           for(i=0;i<n;i++) 

           { 

             scanf(“%d”,&a[i]); 

           } 

           printf(“Element of an array:”); 

           for(i=n-1;i>=0;i--) 

           printf(“%d \n”,a[i]); 

           getch(); 

       } 

Input:-  Enter the values for n: 5 

               Enter the elements of array:  7    13    8    3    6 

 

Output:- Elements of array:  6       

       3 

       8 

       13 

       7 

3.Write a C program to find the sum and average given array of 

elements 

A.  main() 

      {  

         int i,n,s=0,avg,a[10]; 

          clrscr(); 

        printf(“Enter the elements of n:”); 

        scanf(“%d”,&n); 

        printf(“Enter the elements of array:”); 

         for(i=0;i<=n;i++) 

         scanf(“%d”,&a[i]); 

         printf(“Elements of an array:”); 

         for(i=0;i<n;i++) 

          { 

            s=s+a[i]; 

         } 

         avg=s/n; 
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        printf(“Sum of an array is %d”,s); 

         printf(“Average of an array is %d”,avg); 

         getch(); 

     }   

Input:-  

  Enter the elements of n: 5 

              Enter the elements of array:  8 

              4 

             8 

                    2 

              4 

Output:-  

Sum of an array is     24 

             Average of an array is   5 

4.  Write a C program to search an element in the given list of 

given array of elements 

A.  main() 

     { 

         int n,i,f,sr,a[10]; 

        clrscr(); 

         printf(“Enter the values for n:”); 

          scanf(“%d”,&n); 

         printf(“Enter the elements of an array:”); 

          for(i=0;i<=n;i++) 

        scanf(“%d”,&a[i]); 

          printf(“Enter the search element \n:”); 

          scanf(“%d”,&sr); 

           for(i=0i<n;i++) 

           if(a[i]==sr) 

           { 

             printf(“Elements %d is found in place of %d \n 

:”); 

             f=1; 

         } 

          if(f!=1) 

         printf(“Elements are not found”); 

        getch(); 

     } 

Input:- 

   Enter the values for n:   3 

    Enter the elements of an array:   1 
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                    9 

       7 

    Enter the search element: 9 

Output:-  

    Elements 9 is found in place of 2 

 

5. Write a C program to arrange given array of elements in sorted 

order 

A.    main() 

         { 

            int a[20],i,n,j,t; 

           clrscr(); 

            printf(“Enter the values for n:”); 

            sacnf(“%d”,&n); 

            printf(“Enter the elements of array \n:”); 

            { 

                 for(i=0i<n;i++) 

    sacnf(“%d”,&a[i]); 

    for(i=0;i<n;i++) 

    for(j=0;j<n;j++) 

    { 

        if(a[i]>a[j]) 

        { 

             t=a[i]; 

            a[i]=a[j]; 

             a[j]=t; 

         } 

    } 

    printf(“The sorted order \n :”); 

    for(i=0;i<n;i++) 

    printf(“%d”,a[i]); 

    getch(); 

           }  

  } 

 

 

Input:- 

 Enter the value for n:    51 

          Enter the elements of array :  4 

                5 

               18 
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                3 

                71 

Output:-  

The sorted order :   3 

                 4 

                18 

                 51 

                71 

 

6. Write a C program to  find smallest elements of given array of 

elements 

A.  main() 

       { 

           int a[20],i,n,sm; 

           clrscr(); 

           printf(“Enter the values of n:”); 

           scanf(“%d”,&n); 

          printf(“Enter the elements of array: \n”); 

            { 

               for(i=0;i<n;i++) 

               scanf(“%d”,&a[i]); 

               sm=a[0]; 

               for(i=1;i<n;i++) 

               if(sm>a[i]) 

              { 

                    sm=a[i]; 

               } 

               printf(“The smallest element is %d”,sm); 

               getch(); 

         } 

     } 

 

 

 

 

 

Input:-  

Enter the values for n:   31 

  Enter the elements of array:   2 

               52 

              84 
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Output:-  

The smallest elements is        2 

 

7. Write a C program to the greatest elements of given array of 

elements 

   A.   main() 

          { 

             int i,n,big,a[20]; 

             clrscr(); 

             printf(“Enter values for n:”); 

             scanf(“%d”,&n); 

             printf(“Enter the elements of an array: \n”); 

            for(i=0;i<n;i++) 

             scanf(“%d”,&a[i]); 

              big=a[0]; 

              for(i=1;i<n;i++) 

             if(big<a[i]) 

             { 

     big=a[i]; 

             } 

            printf(“The biggest element is %d “,big); 

            getch(); 

       } 

 

Input:-  

Enter values for n:        4 

Enter the elements of an array:  66 

       87    

       41 

Output:-  

The biggest elements is    87 

 

8. Write a C program read and a Matrix 

A.    main() 

        { 

           int m,n,i,j,a[10][10]; 

          clrscr(); 
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           printf(“Enter the values for n:”); 

           scanf(“%d %d”,&m,&n); 

           for(i=0;i<m;i++) 

           for(j=0;j<n;j++) 

          printf(“Enter the elements of matrix:”); 

           scanf(“%d”,&a[i][j]); 

           printf(“Matrix is  \n:”); 

           for(i=0;i<m;i++) 

            { 

                for(j=0;j<n;j++) 

                { 

       printf(“%5d”,a[i][j]); 

               } 

               printf(“\n\n ”); 

            } 

           getch(); 

      } 

Input: - 

Enter  the values for n:   2 

                      2 

 Enter the elements of matrix:        1 

        2 

        3 

       4 

Output:-  Matrix is:      1 2 

                 

               3 4 
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9. Write a C program to find the number of characters in length of 

string 

 A.    #include<string.h> 

         main() 

          { 

             char str[20]; 

             int l; 

           clrscr(); 

            printf(“Enter the string:\n”); 

           scanf(“%s”,str); 

           l=str len(str); 

           printf(“Size of string is%d:”,l); 

           getch(); 

         } 

Input:- 

Enter the string: Tejaswini 

Output:- 

 Size of string is 9 

10. Write a C program to convert string from upper case and lower 

case and vice versa 

A.  

#include<stdio.h> 

        #include<string.h> 

      void main() 

       { 

           char a[20]; 

           printf(“Enter lower case string to convert \n :”); 

           scanf(“%s”,a); 

          printf(“lower case string= %s”,a); 

           printf(“upper case string =%s”,strupr(a)); 

          getch(); 

         printf(“Enter upper case string to convert \n:”); 

         scanf(“%s”,a); 

           printf(“upper case string= %s”,a);  

           printf(“lower case string= %s”,strlwr(a)); 

           getch(); 

       } 

Input:- 

 Enter lower case string to convert: pavani 
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Output:-  

lower case string= pavani 

  upper case string= PAVANI 

 

Input:-  

Enter upper case string to convert: SASI 

  

Output:-  

upper case string= SASI 

 lower case string = sasi 

11. Write a C program to find string is Palindrome or not 

A. #include<string.h> 

      main() 

       { 

           char str[20],str1[20]; 

            int L=0,i,c=0; 

           clrscr(); 

           printf(“Enter the values in text:”); 

           gets(Line); 

           scanf(“%s”,str); 

           while(str[L]!=’/0’) 

            { 

               L++; 

            } 

           for(i=L-1;i>=0;i++) 

          { 

            str1[c]=str[i]; 

            c++; 

           } 

          str1[c]=’/0’; 

         if(stremp(str,str1)==0) 

         printf(“String is Palindrome”); 

         else 

          printf(“String is not Palindrome”); 

         getch(); 

     }    

 

Input:- 

Enter the values in text:  madam 
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Output:-  

String is Palindrome 

 

Input:- 

Enter the values in text: teja 

 

Output:- 

String is not Palindrome   

12. Write a C program to find the Adding of two matrix 

     A. #include<stdio.h> 

         void main() 

      { 

              int a[10][10],b[10][10],c[10][10],i,j,n,m,; 

         clrscr(); 

         printf(“Enter the values of m,n”); 

         scanf(“%d %d”,&m,&n); 

         printf(“Enter the elements of the matrix a :\n”); 

          for(i=0;i<m;i++) 

         for(j=0;j<n;j++) 

         scanf(“%d”,&a[i][j]); 

         printf(“Enter an elements of  the matrix b : \n”); 

         for(i=0;i<m;i++) 

        for(j=0;j<n;j++) 

         scanf(“%d”,&b[i][j]); 

         printf(“ Addition of two matrix is \n: ”); 

         for(i=0;i<m;i++) 

         for(j=0;j<n;j++) 

        c[i][j]=a[i][j]+b[i][j]; 

          { 

            printf(“%d”,c[i][j]); 

            printf(“\n”); 

          } 

         getch(); 

     } 

 

 

 

 

      Input:- Enter the values of m,n: 2 

                                       2 

              Enter the elements of the matrix a:  1 
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                                2 

                                3 

                                 4              

              Enter the elements of the matrix b:    3 

             4 

              1 

             2 

      Output:- Adding of two matrix is:   4 6 

          4 6                     

 

    

13. Write a C program to find Subtration of given two matrix 

     A.  #include<stdio.h> 

         void main() 

    { 

     int i,j,,m,n,a[10][10],b[10][10],c[10][10]; 

      clrscr(); 

      printf(“Enter values for m ,n \n:”); 

      scanf(“%d %d”,&m,&m); 

      printf(“Enter the elements of the matrix a:”); 

      for(i=0;i<m;i++) 

      for(j=0;j<n;j++)  

      scanf(“%d”,&a[i][j]); 

      printf(“Enter the elements of the matrix b:”); 

      for(i=0;i<m;i++) 

      for(j=0;j<n;j++) 

      scanf(“%d”,&b[i][j]); 

      printf(“Subtraction of two matrix is \n:”); 

      for(i=0;i<m;i++) 

      { 

         for(j=0;j<n;j++) 

         { 

            c[i][j]=a[i][j]-b[i][j]; 

            printf(“%d”,c[i][j]); 

        } 

        printf(“\n”); 

      } 

    getch(); 

 } 

Input:- Enter the values of m,n: 2,2 

            Enter the elements of the matrix a:      4 
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            3 

             7 

             5 

             Enter the elements of the matrix b:     1 

                                              2 

                                      5 

                                       1 

Output:- Subtraction of two matrix is:     3 1 

                  2 4             

    

                            

14. Write a C program to find the Multiplication of two matrix 

A. #include<stdio.h> 

      void main() 

      { 

         int a[10][10],b[10][10],c[10][10],i,j,k,m1,m,n,n1; 

        clrscr(); 

        printf(“Enter the size of matrix a:”); 

        scanf(“%d %d”,&n,&m); 

        printf(“Enter the size of matrix b:”); 

       scanf(“%d %d”,&n1,&m1); 

        printf(“Enter the values of matrix a:”); 

        for(i=0;i<n;i++) 

       { 

           for(j=0;j<m;j++) 

           { 

               scanf(“%d”,&a[i][j]);’ 

           } 

        } 

       printf(“Enter the values for matrix b:”); 

       for(i=0;i<n1;i++) 

        { 

           for(j=0;j<m1;j++) 

           { 

               scanf(“%d”,&b[i][j]); 

           } 

        } 

       if(n==m1) 

       { 

          for(i=0;i<n;i++) 

          for(j=0;j<m1;j++) 
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           { 

               c[i][j]=0; 

               for(k=0;k<n;k++) 

               c[i][j]=a[i][k]*b[k][j]+c[i][j]; 

             } 

             printf(“Result an c matrix is:”); 

             for(i=0;i<n;i++) 

             for(j=0;j<m1;j++) 

             printf(“%5d”,c[i][j]); 

             printf(“\n”); 

         } 

         else 

         printf(“Multiplication is not possible”); 

         getch(); 

      

} 

Input:-  Enter the size of  a: 2 

          2 

              Enter the values of matrix a: 4 

              6 

              2 

              8 

  Enter the values of matrix b:  3 

               2 

               1 

                 4 

Output:- Result an c matrix is:  18 32 

                14 36 
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UNIT – 4 

FUNCTIONS 

 
4.0. What is a function. 

4.1. Differences between function and procedure. 

4.2. Advantages of Functions 

4.3. User defined and library functions 

        Main ( ) function 

        Return 

    4.4.  Concepts of associated with functions – Recursion of scope of 

function. 

     Definition of function  

      Recursion. 

      Scope of a function. 

4.3.   Extent of variable. 

     Global and local variable. 

 

   4.4.   Explain the factorial and GCD using recursion functions. 

 

   4.5.   Use  of various categories of  built in function. 

   Arithmetical functions 

   Mathematical function. 

   String handling functions. 
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4. FUNCTIONS  

  

4.0.INTRODUCTION: 

  C language is that C functions are easy to define and use we have used 

functions in every program. Those are main ( ), scanf ( ), printf( ) etc. In this 

unit we will consider in detail now a function is designed, how two or more 

functions are put together and how communicate with one another. C functions 

can be classified into two catageries, namely, library functions and user-

defined functions main is an example of user-defined functions. Printf ( ) and 

scanf ( ) belong to the category of birary functions we have also used other 

library functions such as sin, cos, strcat, strlen, squrt etc. the main difference 

between these two types is that the library functions are not require to be 

written by us where as user-defined function has to be developed by the user at 

the time of writing a program. The use defined function can become a part of 

the program. 

Function Definition: 

A function is a self-contained block of code that perform a particular task. 

Once a function has been  designed and placed, it can be treated as a 

“Function Box” that tasks some data from the main program and return 

value. The inner details of operations are invisible to the rest of the 

program. All that the program knows about a function is: What goes in 

and what comes out. Every C program can be designed using a collection 

of these “Function Box”. 

Example:-    line() 

                { 

                        int i; 

                 for(i=0;i<=20;i++) 

                 { 

    printf(“-“); 

                           printf(“\n”); 

    } 

   } 

The  above set of statements defined a function is called line() which 

could print line of 20  “-“characters length if you used in a program. 
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Program: 

main() 
   { 
 line() 
 printf(“It is for function”); 
 line() 
   } 
     line() 
   { 
      int i; 
      for(i=1;i<=20;i++) 
   } 
   printf(“-“); 
   printf(“\n”); 
} 
 
Output:-                   

-------------------- 
It  is for function 
-------------------- 
 
The above program contains two users defined functions. 

1. main() 

2.  line() 

We know the program execution always being with the main function, 

during the execution of the main the first statement encountered is 

function line(); which indicates that the function line() is to be executed 

at this point the program control transferred to the function line() after 

executing the line() function which output’s a line of 20 characters 

length, the  control is transferred back to the main. Now, the execution 

continues at the print where the function call was executed. After 

executing the printf() statement, the control is again transferred to the 

line() function for printing  the line once again. Three main function calls 

the user defined line() function two times and the library function printf() 

once. We may understand that the line() function itself calls the library 

function printf() repeatedly. Any function can call any other function. In 

fact  it can call itself. A ”Call function” can also called another function , A 

function can be called more than once. In fact this is one of main feature 

of using functions, the flow of control in multifunction program 
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Need for user-defined functions:- 

Every C program must have a main ( ) function to indicate where the program 

has to begin its execution. While it is possible to code any program utilizing 

only main( ) function. It leads to a number of problems. The problem may 

become too large and complex and as a result the task debugging, testing and 

maintaining becomes difficult. If a program is dividing into functional parts, 

then each part may be independently coded and later combined into a single 

part. These subprograms called functions are much easier to understand, debug 

and test. They are some type of operation is repeated at many times throughout 

a program. For instance we must use the factorial of a number at several times 

in the program. In such situations we may repeat the program statements. 

Where they are needed. Another approach is to design a function. We may 

repeat the program statements whenever they are needed. Another approach is 

to design a function that can be called and used whenever required. This saves 

both time and space. 

 

4.1 Differences between the a function and a Procedure. 

Procedure Function 

 

Procedure can have bots  input / 

 output  parameters.  

Functions can have only Input 

functions. 

We cannot stored procedure in select 

statement.   

In functions we can use in select  

statement. 

Stored procedures can return zero 

(0) or  n values maximum (1024) 

The function can return only 1 

value 

which is mandatory. 

We can use transaction in stored           

procedure. 

Function can returns values. 

 

Procedure are collection of  statements  

that defines  Parameterized 

computation (parameterized)  

Functions are structurally resemble 

procedure but are semantically  

moldered on mathematical 

function. 

Procedure  cannot return value Function can returns value. 

Procedure cannot be called from 

Function.   

Function can be called  from 

Procedure. 

Procedure is a subprogram which Is 

included with in main program 

Functions is sub program which is 

Intended for specific taste. 
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Procedure cannot be called again  and 

again.  

Functions once defined can be 

called anywhere and any number of 

times. 

Global variables cannot be used In 

procedure.  

In function both local and global 

Variables can be used. 

Procedure can be written only in 

Procedure programming such  as 

Pascal, dbase etc. 

Function can be written in  

Sub programming such as C, C++. 

 

 

4.2.This sub programming function approach clearly result in a 

number of advantages of the function. 

1. It facilitates top- down modular programming. In this programming 

style the high level logic of the overall problem is solved first while 

the details of each lower level function are addressed later.    

 

          

    Main- program 
 

 

 

fun-1              fun-2                  fun-3             fun-4                fun-5 

2.The length of a source program can be reduce by using function at 
appropriate places. 

3.The function is easy to locate and isolate, function release the function 
for further development of programs. 

4.A function can be used by many programs. 

5.A function can be easy to read and debugging a function. 

6.A function can be to maintain of modify easily. 
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7.The function can be called any number of times in any place with 
different parameters. 

 

PARAMETERS OR ARGUMENTS: 

Function parameters are the means of communication between the calling 

and the called function. A parameter is a place holder. When a function is 

invoked, you pass a value to the parameters this value is returned to as 

actual parameters or arguments. The parameter list return to the type, 

order, a number of the parameters and number of the parameters of a 

function parameters are optional, that is a function may contain no 

parameters. 

4.3.USER DEFINED AND LIBRARY FUNCTIONS, MAIN 

FUNCTION, RETURN() 

C functions can be classified in to two types namely library functions 

and user defined functions. 

Library functions:-These functions are not required to be written by 

programs where as users defined function has to be developed by the 

programmer at the timer writing  in a program. The printf(), scanf(), 

squrt(),cos(),strcmp(),strcat(),strlen() etc..,belong to category of library 

functions. 

Userdefined functions:-The user defined functions are written by 

programmer has to be developed by the user at the time of writing a 

program. main is a specially recognized as user defined functions. Every 

”C” program must have a main function to  indicate where the program 

has to begin is execution. While it as possible to code any program 

utilizing only main function; it leads to a number of problems. The 

problem may become too large and complex and as a result to task of 

debugging, testing and maintaining becomes difficult. If a program is 

divided into functional parts, then each part may be independently coded 

and later combined into a single program. These sub programs called 

functions. These are much easier to understand, debug, and test .In sum 

situation, when some type of operation or calculation is repeated at many 

points throughout a program .For example we might use the factorial of a 

number at several points in the program. In such situation, we may 

repeated the program statement whenever there are needed. Another 

approach is to design a function that can be called and used whenever 

required. The saves both time and space. 
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MAIN () FUNCTION SECTION: 
 
 Every C program must have one main () function section. This 

section contains two parts 1) declaration part and 2) Executable part. The 

declarations part declares all the variables used in the executable part. 

There is at least one statement in the executable part. These two parts 

must appear   between the opening ({) and closing braces(}). The 

program execution begins at the opening brace ({) and ends (}),the 

closing brace  of the main functions section in the logical end of the 

program. All statements in the declaration and executive parts end with a 

semicolon (;). No C program is executed without main () function. It 

should be written in lowercase letters and should not be terminated by a 

semicolon.  It calls others library functions user defined functions. These 

must be one and only on main () function in every C program. 

return : A function may return a value the “return type” in the data type 

of the value the function returns some functions perform to desired 

operations without returning a value. In the case, the return type is the 

keyword void 

4.4. Concepts associated with functions – Recursion, Scope of 

Function 

4.4.0.Definding a function:-The general form of a function definition in 

C programming language is as follows: 

Syntax:- 

return type function name(parameters list) 

argument declaration 

{ 

    local variable declaration 

    execute statement1 

    execute statement2 

    execute statement3 

     …………………………………… 

  } 

A function definition in C program consist of a function header and a  

function body. Here all are the part of a function. 
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• Return type:- A function may return a value the “return type” in 

the data type of the value the function returns some functions 

perform to desired operations without returning a value. In the 

case, the return type is the keyword void. 

• Function -name:-This is the actual name of the function. The 

function name and parameter list  together constitute the function 

signature. 

• Parameters:-A parameter is a place holder. When a function is 

invoked, you pass a value to the parameters this value is returned 

to as actual parameters or arguments. The parameter list return to 

the type, order, a number of the parameters and number of the 

parameters of a function parameters are optional, that is a function 

may contain no parameters. 

• Function Body:-The function body contain a collection of 

statements that define the function does: 

Example:  

Given below is the source code for a function called max m().This function 

takes two parameters N1,N2 and return the maximum value between the 

two parameters. 

   int max m(int N1,int N2) 

{ 

   int max; 

   if(N1>N2) 

   max=N1; 

 else 

 max=N2; 

 return(max); 

} 

Program :  to find the sum of given two integer numbers using 

functions 

main() 
{ 

int a,b; 
clrscr(); 
printf(“value for A\n”); 
scanf(“%d”,&a); 
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printf(“value for B\n”); 
scanf(“%d”,&b); 
sum(a,b); 
getch(); 

} 
 sum(int x, int y); 
 { 

printf(“sum is  %d”, x+y); 
} 

 
Output : value for A 
10 
value for B 
15 

  sum is  25 

 

4.4.1.Recursion:- One of the special  features of C language is its support to 

recursion. Very few computer languages will support this feature. The recursion 

can be defines as the process of a function by which it can calls itself. The 

function which calls itself again and again either directly or indirectly is called 

“recursion”. In this technique is repeatedly executed unit the condition is 

satisfied. The normal function called by “main ( )” function by means of its 

name. But, the recursive function will be called by itself depending on the 

condition satisfaction. When function is called within the same function is 

known as recursion. In C the function which cause the same function is known 

as recursive function. A function calls itself  and does not perform any task after 

function call is known as tail recursion. In tail recursion we generally call the 

same function with return statement 

When called function in turn calls another function is process of changing 

occurs. Recursion is a special case of this process, when a function calls itself. 

Example:- 

Example of recursion is the evaluation of given number. The factories of 

a number it is expressed as a series of respective multiplications shown below. 

 Factorial of n = n(n-1) (n-2) ---------- 1. 

 Factorial of 5 = 5* 4* 3 *2 *1 = 120. 

A function to evaluate factorial of “n” is as 
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  fact ( n) 

       int n; 

{ 

    int f; 

     if (n = =1) 

     return (1) 

  else 

      f = n* fact (n-1); 

     return (f); 

  } 

Let us use how the recursion works= 5* fact (4) Assume n= 5, since the value 

of n is not 1 will be executed with n=5. That is  

  F = 5 * fact ( 4) 

Will be executed. The expression on the  right hand side includes a call a fact 

with n=4. The all will return the following value. 

  4*fact (1). 

Once again fact is called up to 1. This time function return 1. The sequence of 

operations can be summarized we can understand the above program of 

recursive method call by the given below as follows: 

  Return  5* fact (4) = 120 

       return  4  * fact (3)= 24  
 
            return 3 * fact (2) = 6 
 
      return2 * fact (1)= 2 
 
       return 1*fact(0) = 1 
 

1 * 2* 3 * 4 * 5 = 120 
  Recursive function can be effectively used to solve problems w here the 

solution is expressed  in terms of successively applying the same solution to 

subsets of the problem. When we write recursive  call being executed. 

Otherwise, the function will never return program. To  find factorial of given 

number using recursion. 
 # include <stdio.h> 
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 main () 
 { 
 int  n, f; 
 printf(“ \n enter any value \n”); 
 sacnf(“%d”, &n); 
 f= fact (n); 
 printf(“ factorial of %d is”, n, f); 
 getch ( ); 
 } 
 fact (int n) 
  { 
       if  (n==1) 
              return (1) 
  else 
     return (n* fact (n-1)); 
  } 
 
4.4.2.RETURN VALUES AND THEIR TYPES:- 

A function may or may not send back any value to the calling function. If 

it does, it is done through the “return” statement. While is possible to 

pass to the called function any number of values the called function can 

only return value per call. The “return” statement can take one of the 

following forms. 

 

    return(); 

    or 

        return(expression); 

The first return statement without expression means it does not return 

value ,it acts as the calling function. An example of the use of a “return” 

is  : 

    if(total marks=90) 

    return(); 

The second type of “return” with an expression return the value of the 

expression. 

Example:-  add(a,b) 

    int x,y; 

    { 
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    int s; 

    s=a+b; 

    return(s); 

    } 

It returns the ‘s’ which is the sum of values of A and B. The last two 

statements can be combined into one statements as follows. 

  return(a+b); 

A function may have more than one “return” statements. This can be 

happen when the value is returned is based on the condition only. 

Example:- if(a >=b) 

   return(0); 

   else 

   return(1); 

All functions by default to int data type. But what happens if a function 

must return some other type? We can force a function to return a 

particular type of data by using a type specified in the function leader. 

Example:-  float sum(a,b); 

   float sqrt(N); 

When a value is return it is automatically cast to the function data type if 

function that do computation using float, yet return int, the returned 

value will be truncated to an integer. 

 

 

Calling a function:- 

A function can be called by simply using the function name in a 

statement.  

Example:-   main() 

    { 

               int S; 

      S=(a+25.5) 
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     printf(“%d”,S);  

  } 

When the complier encounters a function call, the control is transferred 

the function s(a,b), this function then executed line by line as described  

and a value is returned when a return statements is encountered. The 

value of “s” is assigned. 

A function which return a value can be used in exception like any other 

variable. Each of the following statement is valued. 

 printf(“%d”, add(a,b)); 

 A=sum(a,b)/(c+d); 

 if add(a,b>sum); 

 printf(“Big”); 

However, a function cannot be used on the right side of an assignment for 

example Add(a,b)=50; in valid. 

A function that does not return any value may not be used in exception, 

but can be called to perform certain task specified in the function. The 

function line() discussed above belongs to this category such functions 

may be called in by simply their names as independent statement. 

Example:-  main() 

   { 

     line(); 

   } 

4.4.3.Category of functions:-A function depending on whether 

arguments are present or not and whether a value is returned or not, 

may belong to one of the following types. 

• Functions with no arguments and no returns value. 

• Functions with arguments and no return value. 

• Function with argument and return value. 

Function with no arguments and no return value 
 
When a function has no argument, it does not receive any data from the 
calling function. Similarly when it does not return a value, the calling 
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function does not receive any data from the called- function. It means 
there is no data transfer between the calling function and the called 
function. A function does not return any value cannot be used in 
expression. It can only be used as an independent statement. The nature 
of data communication between calling function and the called function 
with example to using  no arguments and no return values. 
 
# include <stdio.h> 
main ( ) 
{  int a,b; 
   printf (“enter two values”); 
   scanf (“%d %d”, &a, &b); 
 add (a,b); 
 getch ( ); 
} 

add (int a , int b); 
  {   

int c; 
  c=a+b;  

  printf(“addition of  %d,%d is %d”, a,b,c); 
 } 
 

Functions with arguments and no return value. This type of functions 

passes some formal arguments to a function but the function does not 

return back any value to the calling function. It is one way data 

communication between a calling portion of the program and the function 

part. 

 

    Value of  

arguments 

    

              No return 

                  value lling function  

 

Fig : One way data communication 

In the above program A, B, C are called the formed arguments. The calling 

function can now send values to these arguments using function calls containing 

appreciate arguments. Example, The function call. 

Function ( ) 

{ 

  

Function2 (a) 

{   

  

} 

Function 2(d ) 

{ 

 

 

} 
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Program : 

 # include <stdio.h> 

  Main() 

 { 

  Int a,b; 

  Printf(“Enter any two values”); 

  Scanf(“%d%d”, &a,&b); 

  Add(a,b); 

  Getch(); 

 } 

  Add (int a, int b) 

 { 

  Int c; 

  C = a + b; 

  Printf(“Addition of %d + %d is %d\n”, a,b,c); 

 } 

 

Output: 

If you  want addition of  given values   :   Add ( 20, 30)  

 

Would send the values 20 and 30 to the function. Add  ( a,b) assign 20 to ‘a’ 

and 30 to b. The sum 20, 30 are the actual arguments which become the values 

formed arguments inside the called function. The actual and formal arguments 

should match in number, type, and order. The values of actual arguments are 

assigned to the formal arguments on one to one basis. A example for arguments 

matching between the function call and the called function. 
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main ( )                        actual arguments  

{ 

 function1 (arg1,         arg2,            arg3,…….         argn); 

} 

function1( formal 1,  formal 2,   formal 3,…….. formal  n) 

{   

 

   Formal arguments 

          Fig : Arguments matching between the function call and called 

function 

We should ensure that the function call has matching arguments, in case, the 

actual arguments are more than the formal arguments, the extra actual 

arguments are discarded. On the other hand, if the actual arguments are less than 

formed arguments, the unmatched formed arguments are initialized to some 

“garbage values”. Any mismatch in data type may also result in passing of 

garbage value. Remember, no error message will be generated. While the 

formal arguments must be variable names, the actual arguments may be variable 

names, expression or constants. The variables used in actual arguments must be 

assigned values before the function call is made. Remember that, when a 

function call is made, only a copy of the values of actual arguments is passed 

into the called function. When occurs inside the function will have no effect on 

the variables used in the arguments list. 
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The variables declared inside a function are known as local variables and 

therefore their values are local to the function and cannot be accessed by any 

other function. 

In above program the function “add” addition of ‘a’ and ‘b’ the sum value for 

given period and prints the result as before, control is transferred  back or 

reaching the closing brace ( }) of the function. Note that the function (add) does 

not return any value. 

Arguments with return values:- 

The third type of function passes some formal arguments to a function 

from a calling portion of the program and computer value is transfer back 

to the calling function. Data are communicated between the calling 

portion and the function black. 

 

 

                                    Values of arguments 

 

 

                                   Function result 

 

 

Fig : Two – way data communication between functions. 

Program:-  Function  with arguments 

 #include <stdio.h> 

 main( ) 

    {  

 int a,b,c; 

       printf (“enter any two values”); 

      scanf (“%d %d”, &a,&b); 

     c= add (a,b); 

      printf (“addition of two values is %d” C); 

      getch( ); 

 } 

function ( ) 

{ 

  

function2 (a) 

{   

  

} 

function 2(d ) 

{ 

 

 

}   return  

 

 



 

 

PAPER II  PROGRAMMING IN ‘C’  
   

354 

 

     add (int a, int b); 

       { 

      return (a+b); 

      } 

Program to arguments with return value 

4.4.4. VOID : 

The keyword “VOID” can be used as a type specifies when defining a 

function that does not return anything or when defining a function that 

does not return anything or when to function definition does not include 

any arguments. The presence of this keyword is not mandatory but it is 

good programming practice to make use of this feature. 

4.4.5.Scope of Functions : 

Variables in c different behavior from those in most other languages. It all 

depends on “storage” classes a variable may assume. C can have any one 

of the four storage classes  

1. Automatic Variable 

2. External variable 

3. Static variable 

4. Register Variable 

The scope of variable determine over what parts of the program a 

variable is actually for use (active) and alive, so long has a direct 

effect on the utility of a given variable. The variables may also be 

broadly categorized depending on the place of declaration. Internal 

(local) or External (global). The internal variable are more declared 

within the particular function. The external variables are declared 

outside the function. 

1. Automatic Variable :  These variables are declared inside the 

function in which they are to be utilized. They are created when 

function is called and destroyed automatically. When the function 

is existed. 

Ex : auto int no; 

2. External Variables : These variables that are both alive and 

active through out the entire program. There also know as global 

variables. Unlike the local variables, global variables can be 

accessed by any function in the program. These variables are 

declared outside of the function. 

Ex : extern int a; 

                     main() 
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       { 
                       ……. 
                       …….. 
                    } 
                        fuction1() 
                         { 
                           int a = 10 
                             ---------; 
 
                         } 
 
                       function2() 
                        { 
                        int a = 15 
                           ------------; 
                           ------------; 
                         } 
 
 
Example : Program 
 
 int x; 

main () 
 { 
  x = 10;  
  printf (“ x = “%d\n”, x); 
  printf (“ x = “%d\n”, fun1()); 
  printf (“ x = “%d\n”, fun2()); 
  printf (“ x = “%d\n”, fun3()); 
 } 
  fun1() 
  { 
   x = x + 10; 
   return (x); 
  } 
  fun2() 
  { 
   int x; 
   x = 1; 
   return (x); 
  } 
  fun3() 
  { 
   x = x + 10; 
   return (x); 
  } 
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 Output : 
  X = 10 
  X = 20 
  X = 1 
  X = 30 
 

Program to External variable 
 
 
 
Static Variable :  

As the name suggests, the value of static variable persists until the end of 
the program. A variable can be declared static using the keyword static 
like. 
 
                File1.c     file2.c   
 

 

 

 

 

 

 

 

 

 

  

 

Fig. Another version of a multifile  program 
static int x; 

static float y; 
A static variable may be either an internal type or an external type, 
depending on the place of declaration. 
 Internal static variables are those which are declared inside a 
function. The scope of internal static variables extend up to the end of the 
function in which they are defined. Therefore, internal static variables are 
similar to auto variables, except that they remain in existence(alive) 
throughout the remainder of the program. Therefore, internal static 
variables can be used to retain values between function calls. For 
example, it can be used to count the number of calls made to a function. 
Example:  
 Write a program to illustrate the properties of a static variable. 

 int m;\*global variable*\ 
 main() 
 { 
  int i; 
  …….. 
  …….. 
 } 
 function1() 
 { 
  int j; 
  ……… 
  ……… 
 } 

 extern int m; 
 
 function2() 
 { 
  int i; 
  …….. 
  …….. 
 } 
 Function3() 
 { 
  Int count; 
  ……… 
  ……… 
 } 
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The program in fig. explains the behaviour of a static variable.  
 
 
 
 
 
   

 

 

 

 

 

 

 

 

 

 Fig: Illustration of static variable 

A static variable is initialized only once. When the program is 
compiled. It is never initialized again. During the first call to stat, x is 
incremented to 1. Because x is static, this value persists and therefore, 
the next call adds another 1 to x giving it a value of 2. The value of x 
becomes three when the third call is made. 
 
Had we declared x as an auto variable, the output would have been: 
 

x=1 
x=1 
x=1 

 
This is because each time stat is called, the auto variable x is 

initialized to zero. When the function terminates, its value of 1 is lost. 
An external static variable is declared outside of all functions and is 

available to all the functions in that program. The difference between a 
static external variable and a simple external variable is that the static 
external variable is available only within the file where it is defined while 
the simple external variable can be accessed by other files. 

Program  
/***********************************************/ 
/*   ILLUSTRATION OF STATIC VARIABLE             */ 
/**********************************************/ 

main() 
{ 
int I; 
for(i=1;i<=3;i++) 

  stat(); 
 } 
 stat() 
 { 
  static int x =0; 
  x=x+1; 
  printf(“x=%d\n”,x); 
 } 
 Output: 
 x=1 
 x=2 

x=3 
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It is also possible to control the scope of a function. For example, 
we would like a particular function accessible only to the functions in the 
file in which it is defined, and not to any function in other files. This can e 
accomplished by defining ‘that’ function with the storage class static. 
Register Variables: 
 
 We can tell the compiler that a variable should be kept in one of the 
machine’s registers, instead of keeping in the memory (where normal 
variable are stored). Since a register access is much faster than a 
memory access, keeping the frequently accessed variable (e.g. loop 
control variables) in the register will lead to faster execution of programs. 
This is done as follows: 
 

register int count; 
Although, ANSI standard does not restrict its application to any 

particular data type, most compilers allow only int or char variables to be 
placed in the register. 
     Since only a few variables can be placed in the register, it is 
important to carefully select the variables for this purpose. However, C 
will automatically convert register variables into non register variables 
once the limit is reached. 
 
Table summarizes the information on the visibility and lifetime of 
variables in functions and files. 

Scope and Life time of Declarations 
 

Storage 
class 

Where declared Visibility 
(Active) 

Life time 
(Active) 

None Before all functions 
in a file (may be 
initialized) 

Entire file plus 
other files where 
variable is declared 
with extern. 
 

Entire program 
(Global) 

extern Before all functions 
in a file (can not be 
initialized) 

Entire file plus 
other files where 
variable is declared 
extern and the file 
where originally 
declared as global. 
 

 
 
Global 

static Before all functions 
in a file. 
 

Only in that file Global 

None or 
auto 

Inside a function( or 
a block)  
 

Only in that 
function or block 

Until end of 
function or block 

register Inside a function or Only in that Until end of 
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block 
 

function or block function or block 

static Inside a function 
 

Only in that 
function 

Global  

 
 

  

4.5. Extent of variable (Global and local) 

Actual and formal parameters or arguments 

The parameters maybe classified two types:- 

1. formal parameters 

2. Actual parameters 

1.Formal parameters: The formal parameters are the parameters given 

in function declaration and function definition. When the function is 

invoked, the formal parameters are replaced by the actual parameters. 

 

2. Actual parameters:-The parameters appearing in the function call are 

referred to as actual parameters. The actual arguments may be expressed 

as constants, single variable or more complex expression. Each actual 

parameters must be of the same data type as its corresponding formal 

parameters. 

 

Local and Global variables: 

The variable may be classified local or global variables. 

Local variables : 

The variables defined can be accessed by only within the block of function 

in which they are declared. These variables are called local variables. All 

the variables are used within the function block must be either defined at 

the beginning of the block or before using the statement. Local variables 

are referred only the particular part of a block of a function. 

Global variables: 

Global variables are defined outside of main  function block. Global 

variables are not contained to a single function. Global variable that are 
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recognized in two or more functions. Their scope from the point of the 

definition through the reminder of the program.  

*The main differences b/w Global and Local variables are: 

1.The global variables are defined outside of the function, where as  the 

local variables are defined inside the function. 

2. Global variables are created at the time of program beginning and 

reside until the end of the program. The local variables are created at the 

time of function called and destroyed when the function execution is over. 

3.The global variables are accessible in entire program. These are alive, 

active and destroyed. The local variables are accessible only to the 

particular function. 

 

4.6.Explain Factorial and GCD using recursion. 

When called function in turn calls another function is process of changing 

occurs. Recursion is a special case of this process, when a function calls itself. 

Example:- 

Example of recursion is the evaluation of given number. The factories of 

a number it is expressed as a series of respective multiplications shown below. 

 Factorial of n = n(n-1) (n-2) ---------- 1. 

 Factorial of 5 = 5* 4* 3 *2 *1 = 120. 

A function to evaluate factorial of “n” is as 

  fact ( n) 

       int n; 

{ 

    int f; 

     if (n = =1) 

     return (1) 

  else 

      f = n* fact (n-1); 

     return (f); 
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  } 

Let us use how the recursion works= 5* fact (4) Assume n= 5, since the value 

of n is not 1 will be executed with n=5. That is  

  F = 5 * fact ( 4) 

Will be executed. The expression on the  right hand side includes a call a fact 

with n=4. The all will return the following value. 

  4*fact (1). 

Once again ‘fact’ is called up to 1. This time function return 1. The sequence of 

operations can be summarized we can understand the above program of 

recursive method call by the given below as follows: 

  Return  5* fact (4) = 120 

       return  4  * fact (3)= 24  
 
            return 3 * fact (2) = 6 
 
      return2 * fact (1)= 2 
 
       return 1*fact(0) = 1 
 

1 * 2* 3 * 4 * 5 = 120 
  Recursive function can be effectively used to solve problems w here the 

solution is expressed  in terms of successively applying the same solution to 

subsets of the problem. When we write recursive  call being executed. 

Otherwise, the function will never return program.  

To  find factorial of given number using recursion. 
 # include <stdio.h> 
 main () 
 { 
 int  n, f; 
 printf(“ \n enter any value \n”); 
 sacnf(“%d”, &n); 
 f= fact (n); 
 printf(“ factorial of %d is”, n, f); 
 getch ( ); 
 } 
 fact (int n) 
  { 
       if  (n==1) 
              return (1) 
  else 
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     return (n* fact (n-1)); 
  } 
Another example to recursion:- 
To find the GCD / +/CF of two positive integers using recursion. 
The GCD or HCF of two integers is the largest integer that can exactly 
divide both numbers (without remainder). The program takes two positive 
integers as input from the user and calculate GCD using recursion.  
 #include <stdio.h> 
 int gcd (int A, int B); 

 main ( ) 

 {  

int A,B; 

  printf(“enter two positive integers”); 

  scanf(“%d%d”,&A,&B); 

  printf(“G.C.D. of %d and %d is %d”,A,B, Gcd(A,B)); 

  return 0; 

 } 

  int ged  (int A, int B); 

  { 

   if(b!=0) 

   return Gcd (b,a%b); 

  else 

   return a; 

  } 

Output :  

enter two positive integers 

  366 

    60 

G.C.D. of 366 and 60 is 6 

 

4.7. CALL BY VALUE AND CALL BY REFERENCE WITH EXAMPLES: 

 Call by Value and Call by reference: 

The arguments are send to the functions and their values are copied is 
the corresponding  function. This is a sort of  information inter change 
 between the calling  function and called function. This is known as 
parameter passing it is a mechanism through which arguments are 
passed to the called function for the required processing. These are two 
methods of parameter passing. 

1. Call by value. 
2. Call by reference 

Call – by – value :- 
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 When the values of arguments   are passed from calling function 

to a called function, these values one copied into the called function. If 

any changes are made to these values in the called function, there are no 

effect the original values within calling function. 

 In this case, By default, C programming uses call–by- value to pass 

arguments. In general, it means the code with in a function cannot  after 

the arguments used to call the function consider thee function swap ( ) 

definition as follows. 

A program the call – by – value :- 

#include <stdio.h> 

 main ( )  

    { 

  int A, B,C; 

  int call val ( ); 

   A= 10; 

   B= 20; 

  printf(“before call by value A is %d”, A); 

  printf(“\n before call by value B is %d”, B); 

  C= Callval (A,B); 

  printf(“After call by value A is %d”, A); 

  printf(“Afetr call by value B is %d”, B); 

  printf(“\n C= %d” \n”,C); 

 } 

  Calval ( X.Y); 

  int X, Y; 

  { 

   int sum; 

   sum = (X + Y); 

   X= X + 5; 

       Y = X*Y; 

   printf(“ X= %d and Y= %d \n “, X, Y); 

   return (sum) 

  } 

 

 

 

When the program is executed to output will be displays as 

 A = 10; 

 B = 20; 

 X = 15; 

 Y = 400; 
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Example 2 

 #include<stdio.h> 

 void  call by ref(int N1, int N2) 

 { 

  int Temp; 

  temp=N1; 

  N1 = N2; 

  N2 = Temp; 

 } 

  main() 

  { 

   int A=50, B= 30; 

   printf(“\n number: %d \n”,A); 

   printf(“\n number: %d \n”,B); 

   return(0); 

  } 

Output :- 

 N1 = 50 

 N2 = 30 

 

Call – by -  reference with example:- 

Call – by – reference :- In this method, the actual values are not passed, 

instead their addresses are passed. There is no copying of values since 

their memory location are referenced. If any modification is made to the 

values in the called function, then the original values, get changed with 

in the calling function. Passing  of address requires the knowledge of 

painters. To pass a value by reference, arguments pointers are passed to 

the function just like any other value. So accordingly you need to declare 

the function parameters as printer types as in the values of two integer 

variables pointed to, by their arguments. 
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# include <stdio.h> 

 /* function declaration */ 

 valid callref (int **, *y); 

  

 int main ( ) 

  { 

    int a= 100; 

     int b= 200; 

  printf(“before call the call ref  function A value is %d \n”, a); 

  printf(“before call  the call ref function B value  is %d \n”, b); 

  call ref (&a, &b); 

  printf(“after call callref function  A value is %d \n”, a); 

  printf(“after call  callref function B value  is %d \n”, b); 

   Return 0; 

  } 

 

Let us  put the above code is a single C file compile and execute it, to 

produce the following result. 

Output:- 

 before call callref function a value is 100. 

 before call callref function b value is 200. 

 

  after call callref function a value is 200. 

  after call callref function b value is 100.     

It shows that the change has reflected. Outside the function as well, 

unlike call by value where the changes do not reflect outside the 

function. 

1) While passing parameters using call by reference (address)scheme. We 
are passing  
    actual address of the variable to be called function. 
2) Any address made inside the called function will modify the original 
copy, since we are directly modifying the content of the exact memory 
location. 

 A      
                                               

                                       Address of variable “A” is passed the  function. 

 

    

100 
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  Operations done on by taking value from address i.e. original 

copy. 

 

     

    Thus original value also gets updated. 

 

Differences between call by value and call by reference in ‘C’ 

Call by value Call by reference 
 

A copy of value is passed to the 
function. 
 

An address of value passed to 
the function 

Changes made inside the function 
is not reflected on other function. 
 

Change made inside the function 
is reflected outside the function 
also 

Actual and formed arguments will 
be created in different memory 
location. 

Actual and formed arguments 
will be created in same memory 
location. 
 

 

4.8.Use of various categories of builtin functions like 

mathematical and string functions : 

use of various categories of built in functions:- 

 

4.8.1.‘C’ – mathematical function. 
The built in function in C. which are in  math.h header file is also given 

below for your reference. *”math.h” header file supports all the 

mathematical related function in C language. All the arithmetic functions 

used in ‘C’ language are given below. 

 

Floor ()    :- This function returns the nearest integer which is less than 

or equal to                          

                  the arguments passed to their function. 

    Ex : floor (9.2) is 9.0 

          Floor((-9.2) is  - 10.0 

round  () :- This function returns the nearest integer value of the float / 

double                                  

  /long double argument passed to”1 to 5”, it returns integer 

value less       

  Integer value greater the integer. 

   Ex : round(2.325) is 2.0 
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Ceil ()    :-  This function returns nearest integer value which is greater 

than or 

  Equal argument passed to this function. 

   Ex : ceil (9.2) is 10.0 

    Ceil(-9.2) is -9.0 

 

sin  ()    :- This function is used to calculate sine value. 

   Ex : sin(0.0) is 0.0,1  

 

cos ()    :- This function is used to calculate cosine. 

   Ex : cos(0.0) is 1.0 

 

cosh  ()  :- This function is used to calculate hyperbolic cosine. 

    

exp  ()   :- This function is used to calculate the exponential “e” to the X 

th power. 

   Ex : exp(1.0) is 2.718282, exp(4.0) is 54 

 

tan  ()  :- This function is used to calculate tangent. 

   Ex : tan(0.0) is 0.0 

 

tan h( )  :- This function is used to calculate hyperbolic tangent. 

 

log ( )   :- This function is used to calculate natural logarithm. 

   Ex : log(2.0) is 0.693147 

squrt ( ) :- This function is used to find square root of the argument 

passed to this  

          Function. 

 

pow ( )  :- This function is used to find the power of the given numbers. 

   Ex : pow(2,2) is 4.0 

trunc( ) :- This function truncates the decimal value from floating point 

value and  

  Return integer value. 

 

atof ( )  This function converts a floating point value found in 

string                    

    Into a floating paint number which can be stored in a 

variable. 

   Ex:- [N=] a to f  (string). 
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atoi ( )  It converts an integer value found in string into an 

integer  

   which can be stored in a variable. 

      Syntax  :-  X =  atoi (string) 

           Ex :- Number = “1234”; 

            No = atoi(Number); 

4.8.2.Text I/O Function:- 

 

  1.getchar ( )  

Syntax:-  ch = getchar ( ) 

   It reads a single character from the keyboard. The 

character is  

   Displayed and optionally, stored in the char variable ch. 

 

2.gets ( )   

Syntax :- gets (string type _ variable Array of 

char) 

   It   reads a string of text from the keyboard terminated 

by the                      

   Enter key the text is stored in the variable string. 

 

3. printf ( )   

 Syntax :- printf(“Data specification”, var1, var2,var3--

-----var n); 

   Ex : printf(“%s”, Name); 

It displays formatted text according to the format string 

optional  

    values or variables can be specified to match place 

holders or   

   conversion character in the format string. 

 

4. putchar ( )  

 

Syntax:-         putchar ( character 

variables) 

                       It displays the character ‘ch’ on the screen, where ‘ch’ is a 

single  

          character or a escape code in single quotes or the name 

of a char  

         variable. 
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5.  puts ( )  It displays the text string on the screen where string is 

a literal  

   String of text enclosed in double quotes or the name of 

the            string variable.  

 

6. scanf( )   

Syntax : scanf (“Data specification”, &var1, &var2,&var3-----

--var n);  

Read the information from the keyboard according to 

the conversion  

character in the format string. The information is then 

stored in the variable van, which must match the type 

of conversion character that‘s used (int, float, or char). 

 

4.8.3.STRING HANDLEING FUNCTIONS: 

The ‘C’ library supports a large number of string- handling functions that 

can be used to carry out many of the string manipulation functions.  

The string handling functions are: 

Function     Action 

1. strcat    ( )   Concatenates ( add) two strings 

2. strcmp  ( )   Compares two strings 

3. strcpy   ( )   one string over another assign 

4. strlen    ( )   the length of  string 

5. struppr ( )   Convert lower case to uppercase 

6. strlowr  ( )   Convert uppercase to lower case 

 

strcat function ():- 

Syntax :  

strcat (string1, string2); 

strcat () function joins are character arrays, when the function “strcat” is 

executed string2 is appended to string1. It does so by removing the null 

character at the end of string1 and placing string2 from there. The string 

at string2 remains unchanged. 
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Example:- 

string1 

 

string2  

Execute of the statement  

 strcat (string1, string2); 

 Will result in : 

 String1 `2          

 

Program: 

#include<string.h> 
main() 
{ 
 char str1[40],str2[20]; 
 clrscr(); 
 printf(“enter the first string \n”); 
 scanf(“%s”,str1); 
 printf(“enter the second string \n”); 
 scanf(“%s”,str2); 
 strcat(str1,str2); 
 srintf(“ after the merged the two strings are %s”,str1); 
 getch(); 
} 
 
Output :  

enter the first string 
Kanaka 
enter the second string 
Durga 

 after the merged the two strings are 
 KanakaDurga 
 
 

 

 

J I NU O \0  R 

C L LO E \0 E G 

J I NU O C R O E LL G \0 E 
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Strcmp ( ) function:- 

The strcmp ( ) function  compares ASCII value of character with string2 

first character ASCCI value of character. 

The strcmp ( ) function compares the ASCII code of sting1 first character 

with the ASCII code of strinng2 first character and the value 0 (zero), if 

there are equal. If there are not equal it has the numeric difference 

between the nonmatching characters in the strings. 

Syntax:- strcmp (string1, string 2); 

Example:- the string1 = “their” 

  The string2 = “there” 

  strcmp (string1, string2); 

The output will return of -9, which is the numeric difference between 

ASCII “I” and “r” and ASCII “I” value is 105 and ASCII of r is 114 (105 – 

114)= -9. So, the value is negative, string1 is alphabetically above 

string2. 

• Note we can see ASCII codes in ASCII table 

Program: 

#include<string.h> 
main() 
{ 

 char str1[40],str2[20]; 
 clrscr(); 
 printf(“enter the first string \n”); 
 scanf(“%s”,str1); 
 printf(“enter the second string \n”); 
 scanf(“%s”,str2); 
  if (strcmp(str1,str2==0)) 
   { 

    printf(“the given two strings are equal \n”); 
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   } 

    else 

   { 

    printf(“the  given two strings are not equal\n”); 

   } 

  getch(); 

  } 

 

 

Output:  

enter the first string 

Kusuma 

enter the second string 

Kusuma 

the given two strings are equal 

enter the first string 

their 

enter the second string 

there 

the  given two strings are not equal 

strcpy ( ) function:- 

The strcpy() function works likes a string assignment operator. 

Syntax:- strcpy (string, string 2); 

The contents of string2 will assign to string1. 

Example:- strcpy ( “TOWN”, “CHIRALA”); 

It will assign the CHIRALA to the variable “TOWN”. 
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Strlen ( ) function:-This function count and returns the number the 

number of characters in a string. 

Syntax:- N= strlen (string) 

Where ‘N’ is an integer variable which receives the value of the length of 

the string. The argument may be a string constant. It count the 

characters up to find the ‘\0’ of given string. 

Example:- 

 Int N; char S1= [“COLLEGE”]; 

   N= strlen (S1); 

 

 

The output is 8. the number  of characters in “COLLEGE” is + , plus one 

character to null (‘\0’). 

    Type 

   Programs   on 

1. Strcat 

2. Strcmp 

3. Strcpy 

4. Strlen 

Etc. 

Program: 

#include<string.h> 
main() 
{ 

 char str1[40],str2[20]; 
 clrscr(); 
 printf(“enter the first string \n”); 
 scanf(“%s”,str1); 
 printf(“enter the second string \n”); 
 scanf(“%s”,str2); 
  strcpy(str1,str2); 

  printf(“string1 = %s,string2  %s”,str1,str2); 

 getch(); 
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 } 

Output: 

enter the first string 

NAME 

enter the second string 

KUSUMA 

NAME  = KUSUMA 

strupper() Function :  

 

    The is upper function checks whether the character is an upper 

alphabetic (A to Z). 

Char isupper (string variable); 

 The function isupper() takes as an argument character is passed to 

the function. Internally the character is converted in to is ASCII for the 

check. 

 

 

Example : 

 Char a[20] = (“kusuma”); 

 strupper(a); 

 output : KUSUMA 

strlower() Function :  

 the is lower function checks the whether the character is lower case 

alphabetic (a to z) or not. Function is lower takes () a single argument 

character is passed the function. 

 

Example : 

 Char a[20] = (“KUSUMA”); 

 strupper(a); 

 output : kusuma 
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1. Write a C program to convert string from upper case and lower 

case and vice versa 

A.  

#include<stdio.h> 

        #include<string.h> 

      void main() 

       { 

           char a[20]; 

           printf(“Enter lower case string to convert \n :”); 

           scanf(“%s”,a); 

          printf(“lower case string= %s”,a); 

           printf(“upper case string =%s”,strupr(a)); 

          getch(); 

         printf(“Enter upper case string to convert \n:”); 

         scanf(“%s”,a); 

           printf(“upper case string= %s”,a);  

           printf(“lower case string= %s”,strlwr(a)); 

           getch(); 

       } 

 

 

Input:- 

 Enter lower case string to convert: nagarajarao 

 

Output:-  

lower case string= nagarajarao 

  upper case string= NAGARAJARAO 

 

Input:- Enter upper case string to convert: NAGARAJARAO 

  

Output:-  

upper case string= NAGARAJARAO 

 lower case string = nagarajarao 
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 2 marks questions 

1. What is a procedure. 

2. Define a function. 

3. What are the types of function. 

4. What is the syntax of function? Give on example. 

5. What are the advantages of function. 

6. What is a global variable. 

7. What is a local variable. 

8. What are the parameters. 

9. What is a main ( ) function. 

10. What any 4 mathematical function with example. 

11. What any 4 arithmetical function give example. 

12. What is a global string. 

13. What is a recursion. 

14. What is use of return statement. 

15. What is use of void function. 

16. What are the string handling function in ‘C’ explain them. 

 

Long Question  6 marks. 

 

1. What are the differences between procedure and function. 

2. What are library function ? explain with suitable examples. 

3. What are the mathematical function explain with suitable example. 

4. What are the differences between global variable and local variable. 

5. Explain GCD procedure using recursion method. 

6. What a program to find factorial of given number. 

7. Explain call by value with suitable example. 

8. Explain the call-by-reference with suitable example. 

9. Explain the category of function in ‘C’. 

10. What are the differences between call- by- value and call by reference. 
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UNIT -5 

 

   Structures in “C” 

______________________________________________________
____ 

structures 

______________________________________________________

____ 
 

5.1.  Structure definition. 

  Structure declaration. 

  Structure creation. 

  Access Structure members. 

 

5.2. Operation on Structure . 

 Structure initialization. 

 Array of Structure. 

 Array within Structure. 

Nested structure. 

 

 5.3. Unions. 

  Definition of Union.  

  Union declaration. 

  Union creation. 

5.4. Operation on union. 

5.6. Difference between union and structure. 
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STRUCTURES IN C : 

Structure is a user- defined data-type in C  language which allows us to combine 

data of different types together. Structure helps to construct a complex data- 

type which is more meaningful. It is somewhat similar to an array. But an array 

holds data of similar type only. But structure on the other hand, can store data 

only. Any type, which practical more useful. 

For example: If I have write a program to store student information, which will 

have students name, age, branch permanent address, father’s name etc. which 

include string values, integer values etc; how can I use arrays for this values, I 

will require something which can hold data of different types together. In 

structure data stored in form of records. 

Defining structure:-  A structure can be defined to be a group of logically 

related data items. Which may out of different types stored in contiguous 

memory locations, sharing a common name but distinguished by its members. 

Hence a structure can be viewed as a heterogeneous user- defined to data type. 

It can used to create variable. Which can be manipulated in the same way as a 

variable of built in data types. Struct is used to define a structure. Struct 

defines a new data type which is a collection of primary and derived data types. 

Syntax:- 

  Struct  structure_ name 

   { Datatype  member 1; 

    Datatype  member 2; 

    Datatype  member 3; 

 

    Datatype  member n; 

   }  

    var1, var2, var3 ------ var n;  

As you can see in the syntax above, we start with the struct  keyword, then it’s 

optional to provide your structure a name, we suggest you to give it a name, 

then inside the curly braces ({}), we have mention all the member variables, 



 

 

PAPER II  PROGRAMMING IN ‘C’  
   

379 

 

which are nothing but normal C language variables of different types like  int, 

float, char, array etc. 

After the closing curly brace, we can specify one or more structure variables 

again this is optional. The closing curly brace in the structure type declaration 

must be followed by a semicolon (;). 

 

Example:-   

   Struct student 

   { 

    char name [20]; 

         int age; 

    char class [20]; 

     int marks; 

   }; 

Here struct student declares a structure to hold the details of a student which 

consists of 4 data fields, namely name, age, class, marks. These fields are 

called structure elements or member. 

Each member can have different data types like in this case name is an array of 

char type and age is of int type etc. student and is called as the structure – 

name. 

Declaring structure variable:- 

It is possible to declare variable of a structure either along with structure 

definition or after the structure is defined. Structure variable declaration is 

similar to the declaration of any normal variable of any data type. Structure 

variables can declared in following two ways. 

1. Declaring structure variable separately. 

 Struct student 

  { char name [20]; 

             int age; 
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   char class [10]; 

   int marks; 

  }; 

  struct student s1, s2; 

 

2.  Declaring structure variables with structure definition. 

  struct student 

   { char name [20]; 

    Int age; 

    char class [10]; 

     int marks; 

   }; 

    s1, s2; 

Here s1 and s2 are variables of structure of student. However this approach is 

not much recommended. 

Access structure members:- 

Structure members can be accessed and assigned values in a number of ways 

structure members have no meaning individually without the structure. In 

order to assign a value to any structure member. The member name must be 

linked with the structure variable using a dot (.). Operator also called period or 

member access operator. 

Example;- 

  # include <stdio.h> 

  # include <string.h> 

  struct student 

  { char  name [20]; 

   int age; 

   char class [10]; 

   char marks; 

  }; 

  int main ( ) 

   { struct student s1; 

           s1. Age =18; 
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            strcpy ( s1.name, “murthy”); 

  printf(“Name of the student 1 is %s \n”, s1.name); 

  printf (“Age of the student %d \n”, s1.age); 

  return 0; 

  } 

output 

 name of student 1     : Murthy 

 A age of the student : 18. 

 

 

We can also use scanf ( )  to give values to structure members 

through terminal. 

  Scanf (“%s”, s1.name); 

  Scanf (“%d”, s1 . age ); 

 

 

Structure inlialization:- 

Like a variable of any other data types structure variables can also be initialized 

at compile time. 

 Struct student 

  { float height; 

          Int age; 

             Int weight; 

  }; 

  Struct student s1={ 178.26, 20, 48}; 

  Or 

   Struct student s1; 

       S1 . height = 178.26 
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        S1 . age     = 20 

        S1 . weight = 48 

Array of structure:- 

We can also declare an array of  structure variable in which each element of 

the array will represent a  structure  variable. 

Example :- 

  Struct student [5]; 

The below program define an array of student of size 5. Each element of the 

array stu is of type. 

Student:- 

 # include <stdio.h> 

   Struct student 

  { char name [20]; 

                   Int marks; 

  }; 

  Struct student stu [5]; 

  Int i,j; 

  Valid st ( ) 

   {  for ( i=0; i<2; i++) 

   {  

     Printf (“\n enter %d
st
 student   Information \n” student 

i++); 

     Printf (“\n name \n”); 

     scanf (“ %s, stu[i]. name); 

     Printf (“\n enter age \n”); 
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    scanf (“%d”, & stu.age \n”); 

  } 

Array with in Structure :-  

Struct data type can be hold an array type variable as its members. We can 

declare the member of a structure as array data type similar to int, float, char 

etc. 

Ex:- struct student 

  { char stu- name [20]; 

    int sno; 

  int marks; 

 }; 

In the above, the structure variable student contains character array type 

stuname as its member. The initialization of this can be done as usually. 

  

struct stuname  =  { “ Rajaya lakshmi”, 900}; 

Structure of function arguments 

We can pass a structure as a function arguments just like we pass any other 

variable or an array as a function arguments. 

Ex:- # include <stdio.h> 

 struct student 

 { char name [20]; 

  int     no  ; 

 }; 

 valid output (struct student st); 

 void main ( ) 

 { struct student. Stu; 

    printf (“\n enter student   Information \n” ); 

    printf (“\n student name \n”); 



 

 

PAPER II  PROGRAMMING IN ‘C’  
   

384 

 

            scanf (“ % S”,st.name); 

    printf (“\n enter student  . no); 

    output (stu); 

 } 

  valid output (struct student st); 

  { 

    printf (“\n  student name is %s” stu.name); 

    printf (“\n no is %d”, stu.no); 

  } 

   printf (“\n print  student information”); 

  for (i=0; i<2’ i++) 

  { 

    printf (“\n student name is %S”, stu [i]. name); 

     printf (“\n Aage is %d stud [i].age”); 

  } 

 } 

 valid main ( ) 

  {  

   st ( ): 

  } 

Program for structure with array 

Nested structure 

Nesting of structures, is also permitted in C language. Nested structure means 

that one structure has another as member variable. 

Example:- 

  Struct student 

  { char name [10]; 

   Int age; 

   Struct address 

   { 
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    Char  area [10]; 

    Char town [10]; 

    Int pincode; 

   }  add; 

  }; 

UNION:-  

A union is a special data type available in ‘C’ that allows to store different data 

types in the some  memory location. You can define a union with may 

members, but only one members can contain a value at any given time. unions 

provide an efficiency way using the same memory location for multiple – 

purpose. 

Defining a union   

To define a union you  union  you must use the union  statement in the same 

way as you did while defining a structure. The union statement define a new 

data type with more than one member for your program. The format union 

statement is as follows. 

 Union – name 
 { data – type   member1; 
  data – type   member2; 
  data – type   member3; 
   ------ 
   ------ 
  data – type   membern; 
 } 
 

 

The union_ name  is optional and each member definition is a normal variable 

definition, such as int, float, char, array or any other valid variable definition. 

At the end of the union’s definition before the final semicolon; you can specify 

or more union variables but it is optional. Here is the way you would define a 

union type named date having three members i, f , str. 

 Union data 
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 { int i; 

  float a; 

  char st [30]; 

 } info;  

Now a variable data type can store integer a floating point number or a string of 

characters. It means a single variable i.e same memory location, can be used to 

store multiple types of data. You can used any built – in or user defined data 

types inside a union based on your requirement. The memory occupied by a 

union will be large enough to hold the largest member of the union. For 

example in the above example data type will occupy 30 bytes of memory space 

which can be occupied by character string. The following example displays the 

total memory size occupied by the above union. 

# include<stdio.h> 

# include <string.h> 

Union data 

   { int i; 

 float a; 

 Char st [30]; 

 } 

 int main  ( ) 

  Union date st; 

 printf (“memory size occupied data :%d \n”, size of (data)); 

  Return 0; 

 } 

When the above code is compiled and executed it produce the following result. 

Memory size occupied by data : 30. 
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Accessing union members 

 To access any member of a union, we use the member access operator (.). 

the member access variable is coded as a period between the union variable 

name and union member that  we     wish   to  access. You would use the 

keyword union to define variable of   union_ type. The following example 

shows how to use union in a program. 

 # include <stdio.h> 

 # include <string.h> 

 Union data 

 { int i; 

  Float a; 

  Char str [30]; 

 }; 

 int main ( ) 

    { union data st; 

  Data.i = 10;  

  Data.f = 322.7; 

  Strcpy (data .st,” the union”); 

  Printf (“data.i %d \n”, data.i); 

  Printf (“data.a %f \n”, data.f); 

  Printf (“data.str: %S \n”, data.str); 

  Return 0; 

  } 

When the above code is  compiled and executed it produce the following result 

 Data.i : 2352612. 

 Data.f  : 625232542567892257625.00000 
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 Data.str: the union. 

Here we can see that the values of  i and f members of union got corrupted 

because the final value assigned to the variable has occupied the memory 

location and this is the reason the value of str member is getting printed very 

well. Now let’s look in to the same example once again where we will use one 

variable at a time. Which is the main purpose of having unions? 

  # include <stdio.h> 

  # include <string.h> 

  Union data 

  { int i; 

   Float a; 

    Char str [20]; 

  } 

  Main ( ) 

  { union data data 

    Data.i = 10 

 

 Printf (“data .i : %d \n”, data . i); 

 Data . a = 325.62 

 Printf (“data.a : %f  \n”); 

 Strcpy (data.str,” the union, data.a ); 

 Printf (“data . str :%s \n”, data . str); 

 Return 0 

When the above  code is complied and executed it produce the following result 

 Data. i = 10 

 Data. F= 325.62 
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 Data . str : the union 

Here all the members are getting printed very well because one number is 

being used at a time. 

 

Differences between structure and union. 

 

Structure Union 
 

The keyword struct is used to 
define a structure. 
 
When a variable is associated with 
a union, the complier allocate the 
memory for each member. The size 
of structure is greater than or equal 
to the a sum of size of its 
members. 
 
 
Altering the value of a member will 
not affect other member of the 
structure 

 
Individual member can be accessed 
at a time. 
 
Several members of a structure can 
initialize at once. 

The keyword union is used the 
define union. 
 
When a variable associated with a 
union, the compiler allocate the 
memory by considering the size of 
the largest memory. So size of 
union is equal to the size of largest 
member. 
 
Altering the value of any of the 
member with alter other member 
values. 
 
Only one member can be accessed 
at a time. 
 
Several member of a structure can 
initialize at once. 
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Short answer type Question. 

1. What is structure. 

2. What is syntax of struct. 

3. What are advantages of structure. 

4. What is nested structure. 

5. What is a advantages over an array. 

6. What is a union. 

7. What is the syntax of union. 

 Long Answer Questions..  6 marks. 

1. What is structure? Explain in detail. 

2. How to access structure members? Explain with example. 

3. Explain  the array of structures. 

 
 
 
 
 
 
 
 
 
 
 
 

“HARD HARD HARD HARD WORK IS SECRET OF SUCCESSWORK IS SECRET OF SUCCESSWORK IS SECRET OF SUCCESSWORK IS SECRET OF SUCCESS” 
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UNIT - 1 

INTRODUCTION 

 

1.1 Book –keeping 

1.2 Accountancy 

1.3 Uses of accountancy 

1.4 Accounting concepts 

1.5 Accounting conventions 

1.6 Accounting terminology 

INTRODUCTION  

A systematic record of the daily events of a business leading to presentation of a 

complete financial picture is known as accounting or, in its elementary stages as book – keeping.  

Every business necessarily keeps a systematic record of what happens from day – to – day.  

Every business constantly enters into transactions with outsiders.  A transaction may be 

defined as the actions and reactions having monetary implications of one person or firm in 

relation to another person or firm. A transaction involves transfer of money or money’s worth 

from one to another.  

1.1  Book - Keeping 

Book-keeping is the branch of knowledge that reveals how to keep a record of business 

transactions. Book - keeping is constructed to provide the preliminary information needed to 

create accounting records. Each transaction must be recorded in the books, and any and all 

changes must be updated on a continuous basis.  Book - keeping involves the recording of 

financial transactions and other information related to the business on a day-to-day basis. It 

records and organises the financial transactions in a company.   

 Accourdingto R.N.Carter “Book – keeping is the science and art of correctly recording 

in the books of account, all the business transactions that result in the transfer of money or 

money’s worth”. 

1.2 Accountancy 

In India it has its origin as early as CHANAKYA’S (KOUTILYA) dynasty which was in 

around Third Centaury B.C.  This can be identified from his famous book on ECONOMICS 

where in he emphasized the book keeping and maintenance of Accounting Records. 



Paper III Accountancy & Tally Finalised 

392 

 

The modern system of Accounting owes its origin to Pacioli who lived in “Italy” in 15
th

 

century. In the late thirties only the study of theory of accounting has been taken up seriously 

even though it is practiced for a long.  

A important part was played by “American Institute of Certified Public Accountants” in 

this task and it is defined the accounting as “The art of recording , classifying and 

summarizing in a significant manner and in terms of money transactions and events which 

are, in part at least, of a financial character and interpreting the results thereof ”. 

 As per the definition of American Accounting Association (A.A.A.) “Accounting is the 

process of identifying, measuring and communicating economic information to permit 

informed judgments and  decisions by users of the information”. 

 Accountancy refers to systematic knowledge of accounting which covers rules, 

regulations, principles, concepts and conventions and standards that govern the accounting 

process. Accounting refers to the actual process of preparing and presenting the accounting 

information.  Book – keeping is a part of accounting and is concerned with record keeping or 

maintenance of books of accounts. It is routine and clerical in nature. 

Objectives Of Accounting 

1. To maintain full and systematic records of business transactions. 

2. To determine profit or loss of the business. 

3. To show financial position of the business.  

4. To provide accounting information to the interested parties. 

 

1.3 Uses of Accountancy 

1. To identify the Profit or Loss of a business for an accounting period. 

2. To know the financial position of a business. 

3. It maintains all the financial transactions of a business . 
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4. By maintaining the proper books of accounts, it supports the business to follow the legal 

Accounting rules and regulations. 

5. It supports the business persons to take the proper decisions for future. 

6. It identifies the expenditure incurred on the Goods and Services . 

7. It helps to compare the efficiency of the firm with competitors and also with previous results. 

8. It helps to calculate the taxes like Income Tax, G.S.T etc., 

9. It helps to utilize the business assets in efficient and effective manner. 

 

1.4 Accounting Concepts 

 Accounting is the language of business. To make the language convey the same meaning 

to all people, as far as practicable, and to make it full of meaning, accountants have agreed on a 

number of concepts which they try to follow. These are given below: 

1. Business Entity Concept 

2. Money Measurement Concept 

3. Cost Concept 

4. Going Concern Concept 

5. Dual – Aspect Concept 

6. Realisation concept 

7. Accural Concept 

8. Matching Concept 

9. Accounting Period Concept 

 

1. Business Entity Concept: Accountants treat  business as separate from the owner; then it 

becomes possible to record transactions of the business with the owner also.  Without such 

differentiation, the affairs of the firm will all be mixed up with the private affairs of the 

owner and the true picture of the business will not be available. 

2. Money Measurement Concept: Accounting records only those transactions which are 

expressed in terms of money, though inventory rerecords are also kept in some cases. It 

should be remembered that money allows various things of different nature to be added up 

together and dealt with.  The use of a building and the use of clerical services can be added 

up only through money values and not otherwise.  

3. Cost Concept: Transactions are entered in the books of account at the amounts actually 

involved. It prevents random values being put on transactions. This concept is used mainly in 

acquisition of assets.  In other words, the amount to be recorded is objectively arrived at as a 

result of the mutual agreement of two parties involved. 

4. Going Concern Concept: It is assumed that the business will exist for a long time and 

transactions are recorded from this point of view.  This concept requires difference between 

expenditure as long term benefitting expenditure (Ex: pre paid insurance) and short term 

benefitting expenditure (Ex: Salaries). 

5. Dual – Aspect Concept: Dual Aspect Concept is the core of the double-entry bookkeeping. 

It provides the very basis of recording business transactions in the books of accounts. Dual 

Aspect Concept assumes that every transaction has two-sided effects, i.e. it affects two 
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accounts in their respective opposite sides. Therefore, the transaction should be recorded at 

two places. It means, both the aspects of the transaction must be recorded in the books of 

accounts. 

 

The concept of duality is commonly expressed in terms of fundamental accounting equation: 

Assets = Liabilities + Capital 

 

The above accounting equation states that the assets of a business are always equal to 

the claims of owner/owners and the outsiders this claim is also termed as capital or owner’s 

equity and that of outsiders, as liabilities or creditors’ equity. According to this concept for 

every debit, there is a correspondence credit and vice versa. Every transaction has two 

aspects. These two aspects may be: 

 

1. An increase in asset and decrease in other assets 

2. An increase in asset and simultaneously increase in liability 

3. A decrease in asset and increase in another asset 

4. A decrease in asset and decrease in liability 

 

6. Realisation concept: Revenue should be accounted for only when it is actually realized or it 

has become certain that the revenue will be realized.  This signifies that revenue should be 

recognized only when the services are rendered or the sale is affected.  However, in order to 

recognize revenue, actual receipt of cash is not necessary, but the organization should be 

legally entitled to receive the amount for the services rendered or the sale affected.  

7. Accrual Concept: The accrual concept in accounting means that expenses and revenues are 

recorded in the period they occur, whether or not cash is involved. The benefit of the accrual 

approach is that financial statements reflect all the expenses associated with the reported 

revenues for an accounting period. 

8. Matching Concept: The matching concept is an accounting practice whereby firms 

recognize revenues and their related expenses in the same accounting period. Firms report 

revenues, that is, along with the expenses that brought them. The purpose of the matching 

concept is to avoid misstating earnings for a period. 

9. Accounting Period Concept: An accounting period is the span of time covered by a set of 

financial statements. This period defines the time range over which business transactions are 

accumulated into financial statements, and is needed by investors so that they can compare 

the results of consecutive time periods. 

 

1.5 Accounting Conventions 
Accounting Conventions help in comparing accounting data of different business units or of the same unit 

for different periods. These have been developed over the years. The most important conventions which 

have been used for a long period are : 

1. Convention of consistency 

2. Convention of full disclosure.  
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3. Convention of materiality.  

4. Convention of conservatism. 

1. Convention of consistency: The convention of consistency means that same accounting principles 

should be used for preparing financial statements year after year. A meaningful conclusion can be 

drawn from financial statements of the same enterprise when there is comparison between them over 

a period of time. But this can be possible only when accounting policies and practices followed by the 

enterprise are uniform and consistent over a period of time. 

 

2. Convention of full disclosure: The convention of full disclosure suggests that every financial 

statement should fully disclose all relevant information.  Full disclosure means that there should be 

full, fair and adequate disclosure of accounting information. Adequate means sufficient set of 

information to be disclosed. Fair indicates an reasonable treatment of users. Full refers to complete 

and detailed presentation of information. 

 

3. Convention of materiality: The convention of materiality states that, to make financial statement to 

be meaningful by reflecting the material fact. Material fact means the information of which will 

influence the decision of its user. 

 

4. Convention of conservatism: This convention is based on the principle that “Anticipate no profit, 

but provide for all known losses”. It provides guidance for recording transactions in the books of 

accounts. It is based on the policy of playing safe in regard to showing profit. The main objective of 

this convention is Profit should not be overstated.  

1.6 Accounting Terminology 

1. Account: An account is a summary of relevant business transactions at one place relating 

to a particular head. 

2. Transaction: The accounting transaction is an activity of a business, which involves 

transfer of money or goods or services between two persons or two accounts. 

3. Entry: Recording a financial transaction in the books of accounts. 

4. Accounting Period: The period of time, for which the books of account maintained by a 

business. 

5. Entrepreneur / Proprietor: The person who contributed capital to maintain a business 

to earn the profit. 

6. Capital:  The Amount of Money, Assets, Goods or Money’s worth introduced by the 

owner to start or to maintain the business. 

7. Assets: An asset is a property of every description belonging to the business. Assets can 

be classified into two types: 

a) Tangible Assets: The assets having physical existence, which we can touch and see. 

Ex: Buildings, Furniture, Plant and Machinery 

b) Intangible Assets: The assets does not having any physical existence, but their 

possession gives rise to some rights and benefits to the proprietor or owner. 

Ex: Royalty, Copy rights, Goodwill, Trademarks.   
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8. Debtors: A Person, Individual or Firm, who received a benefit without giving money or 

money’s worth immediately, but liable to pay in future or in due course. 

9. Liabilities: The financial obligations of the  business are called liabilities.  Ex: Loans, 

Bank Over Draft, Bills Payable. 

10. Creditors: A person who provided benefit or service without receiving money or 

money’s worth immediately, but eligible to receive money in future or in due course. 

11. Drawings: The amount of Money, Goods or money’s worth used by the proprietor or 

owner of the business for his personal purpose.  

12. Revenue: The amount of money received or realised from the sale of good, provision of 

services and earnings from Interest, Dividend,  Commission etc., 

13. Income: Income is money or money’s worth that an individual or business receives in 

exchange of providing a Goods or Service or through Investment. 

14. Expenses: The amount spent on production and sale of goods and services. 

15. Voucher: A written document that supports a transaction has taken place for the value 

stated in the voucher on a particular date. Ex: Cash Receipt, Cash Memo, Invoice,  Bank 

pay – in – slip etc., 

16. Receipt: It is an acknowledgement for monies in the form of cash or through bank. Ex: 

Cash Received, Cheques Received, D.D. Received. 

17. Stock: Goods held with the firm as on specified date. They may include Raw Material, 

Finished Goods, Traded Goods or Work in progress.  

18. Purchases: The amount of goods bought by a business for resale or for use in the 

production. Purchases are two types 1) Cash Purchases 2) Credit Purchases 

19. Sales: The amount of goods sold that are already bought or manufactured. Sales are two 

types 1) Cash Sales 2) Credit Sales 

20. Debit: A debit is an accounting entry that either increases an asset or expense account or 

decreases a liability or equity account. 

21. Credit: A credit is an accounting entry that either increase a liability or equity account, or 

decreases an asset or expense account. 

 

Short Answer type Questions 

1. What is Book – Keeping? 

2. What is Accountancy? 

3. Define Debit and Credit. 

4. Define Debtors and Creditors. 

5. Define Capital. 

6. What is Drawings? 

7. What is Asset? Describe  classification of Assets. 

Long Answer Type Questions 
 

1. Explain different Accounting Concepts in detail. 

2. What are the Accounting Conventions and explain them. 
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UNIT - 2 

DOUBLE ENTRY SYSTEM 
 

2.1 Meaning and Theory of Double Entry System 

2.2 Classification of Accounts 

2.3 Advantages of Double Entry System 

 

2.1 Meaning and Theory of Double Entry System 
 

The fundamental rule under Double Entry system of Accounting is that, “ for every debit 

there must be corresponding value of credit”. 

Due to numerous transactions which are to be recorded in a business concern,  each 

transaction, reveals two important aspects: One aspect is Debit Aspect and another aspect is 

Credit Aspect. “Receiving aspect” or “incoming aspect” or “expenses / loss aspect” is termed as 

the “Debit Aspect” and on the other hand “giving aspect” or “outgoing aspect” or “income / 

profit aspect” is termed as the “Credit Aspect”.  These two aspects namely “Debit Aspect” and 

“Credit Aspect”, forms the basis of Double Entry System.   

According to J.R.Batliboi “Every business transaction has two – fold effect and it affects 

two accounts in opposite directions and if a complete record were to be made of each such 

transaction, it would be necessary to debit one account and credit another account”.  This 

recording of the two fold effect of every transaction has given rise to the term Double Entry 

System.  

 

FEATURES OF DOUBLE ENTRY SYSTEM: 

1. Every business transaction affects two accounts. 

2. Each transaction has two aspects those are debit and credit. 

3. It is based upon accounting assumptions, concepts and principles. 

4. It helps in preparing trial balance which is a test of arithmetical accuracy in accounting. 

5. Finally it helps in preparation of final accounts with the help of trial balance. 

 

2.2 Classification of Accounts 
 

 Account: 

Account is a summary of relevant transactions at one place relating to a particular head.  

An account will be represented in the form of  “ T “.  Debit and Credit refer to left side and right 

side of the account respectively.  To debit an account is to enter an amount on the left side of an 

account, and to credit an account is to enter an amount on the right side of an account. 
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Dr                                                    Title of the account                                                      Cr 

Debit Credit 

 

The accounts in double entry system are classified into three categories: 

1. Personal accounts 

2. Real accounts 

a) Tangible accounts 

b) Intangible accounts 

3. Nominal accounts 

 

1. Personal Accounts: Personal accounts may be further classified into two categories: 

a) Natural Personal Accounts: An account related to any individual like Bheemesh, 

Sitharam, Prasad, or Suresh is called as a Natural Personal Account. 

b) Artificial Personal Accounts: An account related to any artificial person like M/s 

Siri Motors LLP, M/s TATA MOTORS Ltd, M/s Reliance Industries, etc., is called 

as an Artificial Personal Account. 

Rule:   Debit the Receiver   

  Credit the Giver 

 

2. Real Accounts: Every Business has some assets and every asset has an account. Thus,      

         asset account is called a real account. There are two type of assets: 

a) Tangible Assets are having physical existence, which we can touch and see. Ex: 

Buildings, Furniture, Plant and Machinery. 

b) Intangible assets does not have any physical existence, but their possession gives 

rise to some rights and benefits to the proprietor or owner. 

Ex: Royalty, Copy rights, Goodwill, Trademarks. 

Accounting treatment for both type of assets is same. 

Rule: Debit what comes in 

  Credit what goes out 

 

3. Nominal Accounts: These accounts are related to incomes and expenses or profits and losses of 

business concern. Ex: Salary Account, Rent Account, Electricity Account, Discount Account, 

Commission Account, Interest Account 

        Rule: Debit all Expenses and Losses 

  Credit all Incomes and Gains 

 

2.3 Advantages of Double Entry System 

Double entry system is acknowledged as the best method of accounting in the modern world. 

Following are the main advantages of double entry system: 
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1. Complete Record of Transactions: Under this method both the aspects of each and 

every transaction are recorded. So it is possible to keep complete account. 

2. Scientific System: This is the only scientific system of recording business transactions. It 

helps to attain the  objectives of accounting. 

3. Accuracy of Accounts: It is possible to verify the arithmetical accuracy of the books of 

accounts by ascertaining whether the two sides (Dr. and Cr.) become equal or not through 

a process known as trial balance. 

4. Ascertainment of Profit or Loss: Under this system profit and loss account can be 

prepared easily by taking together all the accounts relating to income or revenue and 

expenses or losses and thereby the result of the business can be ascertained. 

5. Ascertainment of the Financial Position: A Balance Sheet can be prepared by taking 

together all the accounts relating to assets and liabilities and thereby the financial position 

of the business can be assessed. 

6. Prevents Errors and Frauds: Under this system mistakes and defects can be detected by 

internal check, so that accurate information regarding business can be ascertained. 

7. Full Details of Control: This system permits accounts to be kept in a very detailed form, 

and thereby provides sufficient information for the  purpose of control. 

8. Helps in decision making: Under this system necessary statistics are easily available so 

that the management can take appropriate decision and run the business efficiently. 

9. Comparative Study: Profit and Loss accounts and Balance Sheets of different years as 

well as of different firms can be compared and the success or failure of the business can 

be measured.  

Short Answer type Questions 
 
1. Define Double Entry System of Account.  

2. What is an Account? 

Long Answer Type Questions 
 
1. Define Double Entry System and Explain with it’s  features. 

2. Explain the advantages of Double Entry System. 

3. What is an Account? Explain different types of accounts with their rules. 
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UNIT – III 

JOURNAL 

3.1   Introduction 

3.2   Journalizing of different concepts 

 

3.1 Introduction 

Meaning: Journal is called as book of Primary Entry or Book of Original Entry. Because, All 

business transactions are first entered in this book in chronological order. A journal is a book in 

which all the day to day accounting transactions were written in accounting terms in 

chronological order. 

 

 The process of recording the transactions in the journal is called Journalizing and the 

entry made in the journal is called Journal Entry. 

 

Proforma: 

Date Particulars L/F 
Debit 

Amount Rs. 

Credit 

Amount Rs. 

     

 
Date Column: The date on which the transaction is taking place is written in this column.  

Particulars Column: The name of the account to be debited is written in the first line Suffixed 

with Dr and the name of the account to be credited is written in the second line prefixed with   ‘ 

To’ and the brief explanation of the transaction for the which the entry is recorded is written in a 

pair of braces as narration in this column. 

L.F. Column: L.F. indicates Ledger Folio number in which page, the entry is posted in the 

Ledger. 

Debit Amount Column: The amount to be debited is written against the debit entry in this 

column. 

Credit Amount Column: The amount to be credited is written against the credit entry in this 

column. 

 

According to the principle of Double Entry System, the two aspects i.e. Debit as well as 

Credit of the transaction are recorded in the Journal. 

 

3.2  Journalizing of different concepts 

Illustration 1: 

Jounalise the following transactions in the books of Mr. Venkat  

Date 

2017 June           

 1
st
  Mr. Venkat started business with cash Rs. 1,00,000. 
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 2
nd

 Bought furniture for cash Rs. 5,000 

 3
rd

 Purchased goods for Rs. 20,000 

 4
th

  Sold goods worth Rs.15,000 

 5
th

 Purchased computer for Rs. 30,000 

 10
th

  Sold goods to Siva worth Rs. 5,000 for credit 

 11
th

  Bought goods from Ganesh Rs.10,000 

 15
th

  Paid Internet charges Rs. 500 

 18
th

 Cash deposited into State Bank  Rs. 10,000 

 20
th

 Received Cheque from Siva Rs. 5,000 

 22
nd

  Goods withdrawn for personal use worth Rs. 2,000 

 28
th

 Issued cheque to Ganesh Rs. 10,000 

30
th

  Paid Rent  Rs. 2,000 

30
th

 Paid Salaries Rs. 5,000 

30
th

 Withdrew from bank for personal use 5,000 

 
     

Journal Entries in the books of   Mr. Venkat as on 30-07-2017 

Date Particulars L/F 
Debit 

Amount Rs. 

Credit 

Amount Rs. 
June, 2017 

1
st 

 

 

 

2 
 

 

  
3 

 

 

 

4 
 

 

 

5 
 

  
 

10 
 

 

 

11 
 

 

 

 

15 

Cash A/c                                                    Dr 
                To Capital A/c 
(Being Cash Brought in to start the 

business) 
 

Furniture A/c                                            Dr 
                To Cash A/c 
(Being Furniture purchased for cash) 
 

Purchase A/c                                            Dr 
                To Cash A/c 
( Being Goods purchased for cash  ) 
 

Cash  A/c                                                  Dr 
                To Sales  A/c 
(Being Goods  sold for cash) 
 

Computer A/c                                            Dr 
                To Cash  A/c 
(  Being Computer purchased for cash ) 
 

Siva   A/c                                                   Dr 
                To   Sales A/c 
( Being sold goods to siva for credit ) 
 

Purchase A/c                                            Dr 
                To Ganesh  A/c 
(Being Goods purchased from Ganesh for 

credit ) 
 

Internet Charges A/c                                Dr 

 1,00,000 
 

 

 

 

5,000 
 

 

 

20,000 
 

 

 

15,000 
 

 

 

30,000 
 

 

 

5,000 
 

 

 

10,000 
 

 

 

 

500 

 

1,00,000 
 

 

 

 

5,000 
 

 

 

20,000 
 

 

 

15,000 
 

 

 

30,000 
 

 

 

5,000 
 

 

 

10,000 
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18 
 

 

 

20 
 

 

 

22 
 

 

  
28 

 

 

  
30 

 

 

 

30 
 

 

 

30 

                To   Cash  A/c 
(  Being Internet Charges paid ) 
 

State Bank A/c                                          Dr                                      

                 To   Cash  A/c 
( Being Cash Deposited at bank ) 
 

Bank A/c                                                   Dr 
                To Siva  A/c 
(  Being cheque received from siva ) 
 

Drawings A/c                                            Dr 
                To Purchase  A/c  (or) Goods A/c 
( Being Goods withdrawn for personal use ) 
 

Ganesh   A/c                                             Dr 
                To Bank  A/c 
( Being paid to Ganesh through cheque ) 
 

Rent      A/c                                               Dr 
                To  Cash A/c 
( Being Rent paid  ) 
 

Salaries   A/c                                             Dr 
                To Cash  A/c 
( Being salaries paid ) 
 

Drawings A/c                                            Dr 
                To  Bank A/c 
(Being cash withdrawn from bank  for 

personal use ) 
 

 

 

 

10,000 
 

 

 

5,000 
 

 

 

2,000 
 

 

 

10,000 
 

 

 

2,000 
 

 

 

5,000 
 

 

 

5,000 

500 
 

 

 

10,000 
 

 

 

5,000 
 

 

 

2,000 
 

 

 

10,000 
 

 

 

2,000 
 

 

 

5,000 
 

 

 

5,000 

 

Note: The purchases and Sales against persons will be treated as credit if the transaction is not mentioned as cash. 
 

Illustration 2: 

Jounalise the following transactions in the books of Mr. Ganesh 

2017 Dec 

1  Started business with cash Rs. 80,000 and Furniture Rs. 10,000 

3 Goods purchased from Syamala 10,000 

8 Goods purchased from Hasini for cash 3,000 

10 Goods Sold to Mukharji 2,000 for cash 

12 Cash deposited in to bank 40,000 

15 Cash with drawn from bank for personal use 5,000 

18 Cheque collected from mukharji worth Rs. 10,000 

19 Commission paid by cheque Rs. 500 

22 Cash with drawn from bank for office use Rs. 1,500 

24 Commission received Rs. 1,000 

30 Rent paid by cheque Rs. 1,000 
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Journal Entries in the books of  Ganesh  as on 31-12-2017 

Date Particulars L/F 
Debit 

Amount Rs. 

Credit 

Amount Rs. 
Dec, 2017 

1
st 

 

 

 

 

3 
 

 

  
 

8 
 

 

 

10 
 

 

 

12 
 

 

 

15 
 

 

 

 

18 
 

 

 

19 
 

 

 

22 
 

 

 

24 
 

 

Cash  A/c                                                   Dr 
Furniture A/c                                            Dr 
                To Capital A/c 
(Being Cash and Furniture Brought in to 

start the business) 
 

Purchases  A/c                                           Dr 
                To Syamala A/c 
(Being goods purchased from syamala for 

credit) 
 

Purchase A/c                                             Dr 
                To Cash A/c 
( Being Goods purchased for cash  ) 
 

Cash  A/c                                                   Dr 
                To Sales  A/c 
(Being Goods  sold for cash) 
 

Bank  A/c                                                  Dr 
                To Cash  A/c 
(  Being cash deposited at bank) 
 

Drawings  A/c                                          Dr 
                To   Bank A/c 
( Being cash withdrawn from bank for 

personal use) 
 

Bank A/c                                                 Dr 
                To Mukharji  A/c 
( Being Cheque collected from mukharji) 
 

Commission  A/c                                     Dr 
                To   Bank  A/c 
(  Being commission paid paid by cheque) 
 

Cash A/c                                                 Dr 
                To   Bank  A/c 
(Being Cash Withdrawn from bank ) 
 

Cash  A/c                                                Dr 
                To Commission Received  A/c 
( Being commission received ) 

 80,000 
10,000   

 

 

 

 

10,000 
 

 

 

 

3,000 
 

 

 

2,000 
 

 

 

40,000 
 

 

 

5,000 
 

 

 

 

10,000 
 

 

 

 500 
 

 

 

1,500 
 

 

 

1,000 
 

 

 

 

90,000 

 

 

 

10,000 

 

 

 

3,000 

 

 

 

2,000 

 

 

40,000 

 

 

5,000 

 

 

 

 

10,000 

 

 

500 

 

 

 

1,500 

 

 

1,000 
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30 
 

Rent   A/c                                               Dr 
                To Bank  A/c 
( Being  rent paid to through cheque ) 

 

1,000 
 

1,000 

 

 

 

Illustration 3: 

Jounalise the following transactions in the books of Pallavi 

2016 August 

 1 Pallavi started business with cash 30,000 

 2 Purchases Rs. 2,000 

 3 Goods purchased from Pavani Rs. 4,000 

 5 Cheque received from Manikanta Rs. 10,000 

 8 Machinery purchased and payment made by cheque Rs. 6,000 

 10 Internet bill paid Rs. 500 

 12 Fuel charges paid Rs. 200 

 15 Sales Rs. 5,000 

 16  Received Dividend through cheque Rs. 500 

 17 Commission received Rs. 1,000 

 22 Sold goods to Manikanta Rs. 4,000 

 25 Additional Capital Introduced Rs. 10,000 

 30 Salaries paid Rs. 8,000 

  Rent paid Rs. 1,000 

 

Journal Entries in the books of  Pallavi  as on 31-08-2016 

Date Particulars L/F 
Debit 

Amount Rs. 

Credit 

Amount Rs. 
Aug, 2016 

1
st 

 

 

3 
 

 

  
5 
 

 

 

8 
 

 

 

 

10 
 

Cash  A/c                                                   Dr 
                To Capital A/c 
(Being Cash Brought to start the business) 
 

Purchases  A/c                                           Dr 
                To Cash A/c 
(Being goods purchased for cash) 
 

Bank A/c                                                   Dr 
                To Manikanta A/c 
( Being Cheque received from Manikanta) 
 

Machinery   A/c                                        Dr 
                To Bank  A/c 
(Being Machinery purchased and  payment 

made through cheque) 
 

Internet Bill A/c                                        Dr 
                To Cash  A/c 

 30,000 
   

 

 

30,000 
 

 

 

10,000 
 

 

 

6,000 
 

 

 

 

500 
 

 

 

30,000 

 

 

30,000 

 

 

10,000 

 

 

6,000 

 

 

 

 

500 
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12 
 

 

 

15 
 

 

 

 

16 
 

 

 

17 
 

 

 

22 
 

 

 

25 
 

 

 

 

30 
 

 

 

30 

(  Being Internet bill  paid) 
 

Fuel  A/c                                                   Dr 
                To   Cash  A/c 
( Being Fuel charges paid) 
 

Cash A/c                                                Dr 
                To Sales  A/c 
( Being sold goods for cash) 
 

 

Dividend  A/c                                         Dr 
                To   Bank  A/c 
(  Being dividend received through cheque) 
 

Cash A/c                                                Dr 
                To   Commission  A/c 
(Being commission received) 
 

Manikanta  A/c                                      Dr 
                To Sales  A/c 
(Being sold goods to  manikanata for credit) 
 

Cash   A/c                                              Dr 
                To Capital  A/c 
( Being Additional Capital introduced by  

the proprietor) 
 

Salaries  A/c                                           Dr 
                   To Cash A/c 
(Being Salaries paid) 
 

Rent   A/c                                               Dr 
                To Cash  A/c 
( Being  rent paid ) 

 

 

200 
 

 

 

5,000 
 

 

 

  

500 
 

 

 

1,000 
 

 

 

4,000 
 

 

 

10,000 
 

 

 

 

8,000 
 

 

 

1,000 

 

 

200 

 

 

5,000 

 

 

 

 

500 

 

 

1,000 

 

 

 

4,000 

 

 

10,000 

 

 

 

 

8,000 

 

 

1,000 

 

Short Answer type Questions 

1. Define Journal.  

2. Define Journal Entry? 

Exercises 

1. Jounalise the following transactions in the books of Chandra Sekhar 

2015  June 

 1 Started business with capital Rs. 1,00,000 

 2 Goods purchased for cash Rs. 10,000 

 5 Sold goods to Venu Rs. 8,000 

 6 Cash deposited at bank Rs. 40,000 

 7 Machinery purchased worth Rs. 10,000 
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 9 Purchased goods from Harish  Rs. 5,000 

 10 Sold goods to Devi  Rs. 8,000 

 15 Cartage paid Rs. 200 

 25 Postal Charges paid 20 

 30 Paid rent by cheque 1,000 

 

 

 

 

2. Jounalise the following transactions in the books of Prajapathi 

2014, December 

 1 Started business with cash Rs. 50,000 

 2 Opened bank account with Rs. 20,000 

 4 Purchased goods worth Rs. 5,000 

 8 Sold goods Rs. 3,000 

 10 Travelling expenses paid Rs. 200 

 11 Goods sold to Nagalakshmi Rs. 2,000 

 15 Cartage paid Rs. 200 

 16 Goods Returned by Nagalakshmi Rs. 500 

 18 Commission paid Rs. 1,500 

 20 Rent received Rs. 800 

 24 Cash deposited at bank Rs. 5,000 

 30 Rent paid Rs.750 

 

3. Jounalise the following transactions in the books of Shanmukh 

2015, January 

 1 Started business with  cash Rs. 10,000, Furniture  Rs. 3,000 and  Goods  Rs. 1,000 

 2 Sold goods to Dhanalakshmi Enterprises  Rs. 1,000 

 4 Purchased goods from Sindhu Rs. 5,000 

 5 Sold goods to Pavithra  Rs. 2,000 

 6  Cheque issued to Sindhu Rs. 4,500 

 8 Cash received from pavithra Rs. 2,000 

 10 Goods returned to Sindhu Rs. 500 

 12 Cartage paid Rs. 150 

 15 Telephone bill paid Rs. 800 

 20 Stationery purchased Rs. 250 

 23 Freights paid Rs. 100 

 25 Commission received Rs. 200 
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 28 Electricity charges paid Rs. 1,000 

 31 Salaries paid by cheque Rs. 5,000 

 

4. Jounalise the following transactions in the books of Pathanjali 

2018, March 

 1 Started business with Rs. 1,00,000 

 2 Purchased goods Rs. 15,000 

 4 Sold goods to Asha Rs. 10,000 

 6 Purchased goods from Ravi  Rs. 15,000 

 8 Cheque received from Asha Rs. 9,500 and allowed a discount of Rs.500 

 15 Computer purchased worth Rs. 35,000 and payment made by cheque. 

 18 Cheque issued to Ravi 13,000 and received a discount of Rs. 1,000 

 20  Goods returned to Ravi Rs. 1,000 

 21 Goods taken for domestic use Rs. 2,000 

 22 Cash withdrawn for personal use 2,000 

 23 Rent paid 2,000 

 30 Telephone bill paid 1,000 

 

5. Jounalise the following transactions in the books of Shankar 

2014, July 

 1 Commenced business with cash Rs. 2,00,000 

 2 Bought goods from Sulochana Rs. 25,000 

 3 Sold goods to Sudha Rs. 10,000 

 4 Cash deposited with Andhra Bank Rs. 50,000 

 6 Sold goods to Hasini 10,000  

 8 Goods returned to Sulochana Rs. 1,000 

 10 Sale of old news papers Rs. 200 

 12 Heating expenses paid Rs. 300 

 15 Commission Paid Rs. 450 

 17 Advertisement Expenses Rs. 1,000 

 18 Furniture purchased Rs. 2,000 

 19 Sold Plant  & Machinery 10,000 

 20 Paid for sundry expenses Rs.500 

 21  Goods taken by Shankar domestic use Rs. 2,000 

 25 Commission received through cheque Rs. 1,000 

 31 Tea & Tiffin expenses paid Rs. 500 

 31 Rent paid by cheque Rs. 1,200 

 31 Machinery purchases Rs. 25,000 
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UNIT - IV 

LEDGER 

4.1 Meaning 

4.2 Ledger Posting 

4.3 Ledger of Balancing 

4.4 Advantages of Ledger 

 

4.1 Meaning 
Ledger is a main book which contains all  the accounts in which the transactions recorded in 

the books of original entry are transferred. Ledger is also called the “Book of Secondary Entry”, 

because the transactions are finally incorporated in the ledger. 

 

Ledger is a book with various accounts like Real , Personal and Nominal Accounts and each 

account is shown on a separate page, that gives the details of the different transactions and its 

summary.  Ledger is a book of account containing a classified summary of every transaction 

recorded in journal. 

 

According to L.C. CROPPER, the book which contains a classified and permanent record of all 

the transactions of a business is called Ledger. 
 

 

4.2 Ledger Posting 
 

The process of grouping of all the transactions relating to a particular account at one place is 

called posting.  Posting helps us to know the net effect of various transactions during a given 

period on a particular account.  It is necessary to post all the journal entries into various accounts 

in the ledger. 

 

Format 

Dr     Name of the account             Cr 

Date Particulars J.F. Amount 

Rs. 

Date Particulars J.F. Amount 

Rs. 
Year 
Mont

h 
Date 

To  Name of credit 

Account in journal 
 xxxxx  By Name of debit Account 

in journal 
 xxxxx 

 

Note: 

1. The words Dr. and Cr. are used to denote Debit and Credit. 

2. Name of the account is mentioned between Dr. and Cr. on the top middle portion of the 

account. 

3. Each account is divided into two parts. Left hand side part of the account is called as “Debit 

Side” and Right hand side of the account is called as “Credit Side”. 

4. Date of the transaction is recorded in the “Date” column. 
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5. The word ‘To’ is used before the account which appear on the debit side of an account and 

the word ‘By ‘ is used before the account which appear on the credit side of an account in the 

particulars column. 

6. The name of the other account which is affected by the transaction is written either on the 

debit side or credit side in the particulars column. 

7. The page number of the corresponding journal or subsidiary book from where that particular 

entry is transferred is entered in the Journal Folio (J.F.) column. 

8. The amount pertaining to this account is entered in the amount  column. 

 

4.3 Balancing of Ledger 
Balancing is the process of finding the difference between total debits and the total credits of 

an account. The net result of such debits and credits in an account is called balance.   

 

The writing of the difference between the amount columns of the two sides in the ledger is 

called “out standing balance “ or “Balance carry forward”. This amount will be carry forwarded 

to the statement of next period. The excess of debit total over credit total is called the debit 

balance where as, the excess of credit total over debit total is called the credit balance. 

 

Procedure for Balancing: 

While balancing the accounts the following steps are involved 

 

To find the balance of an account, the amount columns of both Debit side and credit side total 

separately and then calculate the difference of both columns.  

 

We insert it in the lesser side of the account, with the words ‘Balance carried down’ in the 

corresponding particulars column prefixed with ‘ To ‘ or ‘ By ‘. 

 

Total again both the amount columns  put the  total on both sides and draw a line above and a 

line below the totals. 

 

Enter the  date of  the beginning of  the next period in  the date column and bring down the 

balance on the corresponding side along with the words “ To Balance b/d” or “By Balance b/d” 

in the  particulars column. 

 

4.4 Advantages of Ledger 
 

1. It provides the complete accounting information regarding all the transactions of the  

business at a glace. 

2. The amount has to be paid by us to the suppliers and also the amount has to be received 

from the customers was easily identified. 

3. With the help of Nominal Accounts in the ledger we can easily calculate the main 

incomes and expenditures of the business. 

4.  With the help of Real Accounts in the ledger we can easily calculate the  net worth of the 

business. 
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5. Easy to prepare Trial Balance, Profit & Loss Account and Balance Sheet with the help of 

ledger balances of the business. 

Short Answer type Questions 

1. What is Ledger? 

2. What do you mean by posting? 

Long Answer Type Questions 

1. Write the procedure of ledger posting. 

2. Explain different types of ledgers in details.  

3. Write the advantages of Ledger in detail. 

4. Explain the procedure of balancing the ledger. 

 

Illustration 1: 

From the following transactions, prepare ledger accounts in the books of Bhavya. 

2016 April 

 1  Started business with Rs. 1,00,000 

 2  Sold goods to Rani for credit Rs. 40,000 

 4  Sold goods to Mukhesh for cash Rs. 20,000 

 6  Purchased goods from Anand Rs. 25,000 and received discount Rs. 2,000 

 7  Cash  received  from Rani Rs.10,000 

 8  Commission received  Rs. 1,000  

 9  Received cheque from Rani Rs. 17,000 and allowed a discount of Rs. 3,000 

 10  Purchased Machinery worth Rs. 25,000 

 15  Purchased goods worth Rs. 15,000 

 16  Purchased stationery Rs. 250 

 18  Received interest Rs. 1,000 

 20  Received dividend through cheque Rs.  500  

 25  Wages Rs. 4,000 

 28  Electricity Expenses  Rs. 1,500 

 30  Paid salaries  Rs. 2,000 

Journal Entries in the books of Bhavya as on 30
th

 April, 2016. 

Date Particulars L/F 
Debit 

Amount Rs. 

Credit 

Amount Rs. 
April, 2016 

1
st 

 

 

 

2 
 

Cash A/c                                                    Dr 
                To Capital A/c 
(Being Cash Brought in to start the 

business) 
 

Rani   A/c                                                  Dr 
                To Sales A/c 

 1,00,000 
 

 

 

 

40,000 
 

 
1,00,000 

 

 

 

 

40,000 
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4 

 

 

 

6 
 

 

 

 

 

7 
 

  
 

8 
 

 

 

9 
 

 

 

 

 

10 
 

 

 

15 
 

 

 

16 
 

 

 

18 
 

 

  
20 

 

 

  
25 

 

 

 

28 
 

 

 

(Being sold goods to rani for credit) 
 

Cash   A/c                                                 Dr 
                To Sales A/c 
( Being Goods sold for cash  ) 
 

Puchases A/c                                             Dr 
Discount A/c                                             Dr 
                To Anand  A/c 
(Being Goods  sold for cash and allowed 

discount) 
 

Cash   A/c                                                  Dr 
                To Rani  A/c 
(  Being Cash received from rani ) 
 

Cash   A/c                                                  Dr 
                To   Commission A/c 
( Being Commission received) 
 

Bank A/c                                                   Dr 
Discount A/c                                             Dr 
                To Rani  A/c 
(Being cheque received and discount 

allowed to rani ) 
 

Machinery  A/c                                         Dr 
                To   Cash  A/c 
(  Being Machinery purchased) 
 

Purchases  A/c                                           Dr 
                To   Cash  A/c 
( Being goods purchased for cash) 
 

Stationery    A/c                                        Dr 
                To Cash  A/c 
(  Being stationery purchased ) 
 

Cash    A/c                                                 Dr 
                To Interest  A/c 
( Being Interest received) 
 

Dividend   A/c                                           Dr 
                To Bank  A/c 
( Being dividend received) 
 

Wages      A/c                                            Dr 
                To  Cash A/c 
( Being wages paid  ) 
 

Electricity Expenses A/c                           Dr 
                To Cash  A/c 
( Being Electricity expenses paid ) 
 

 

 

20,000 
 

 

 

25,000 
2,000 

 

 

 

10,000 
 

 

 

1,000 
 

 

 

 

17,000 
3,000 

 

 

 

 

25,000 
 

 

 

15,000 
 

 

 

250 
 

 

 

1,000 
 

 

 

500 
 

 

 

4,000 
 

 

 

1,500 
 

 

 

 

 

 

20,000 
 

 

 

 

27,000 
 

 

 

10,000 
 

 

 

1,000 
 

 

 

 

 

20,000 
 

 

 

 

25,000 
 

 

 

15,000 
 

 

 

250 
 

 

 

1,000 
 

 

 

500 
 

 

 

4,000 
 

 

 

1,500 
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30 Salaries A/c                                               Dr 
                To  Cash A/c 
(Being salaries paid ) 
 

2,000  

2,000 

 

Dr.      Cash Account           Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2016, 

APRIL 
1 To Capital A/c   1,00,000 

2016, 

APRIL 

10 By Machinery Account   25,000 

4 To Sales A/c   20,000 15 By Purchases A/c   15,000 

7 To Rani A/c   10,000 16 By Stationery A/c   250 

8 To Commission A/c   1,000 25 By Wages A/c   4,000 

18 To Interest A/c   1,000 28 By Electricity Expeses A/c   1,500 

        30 By Salaries A/c   2,000 

                

        30 By Balance c / d   84,250 

                

      1,32,000       1,32,000 

1st 

May To Balance b/d   84,250         

                

 

 

 

Dr.      Sales Account                        Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2016, 

APRIL       

2016, 

APRIL 

2 By Rani A/c   40,000 

        4 By Cash A/c   20,000 

 

30 To Balance c / d   60,000       

                

      60,000       60000 

1st 

May By Balance b/d   60,000 
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Dr.      Purchases Account                        Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2016, 

APRIL 

6 To Anand A/c   25,000 

2016, 

APRIL       

15 To Cash A/c   15,000         

    30 By Balance c / d   40,000 

                

      40,000       40,000 

1st May To Balance b/d   40,000         

                

 

Dr.      Rani Account                         Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2016, 

APRIL 

2 To Sales A/c   40,000 

2016, 

APRIL 

7 By Cash A/c   10,000 

        9 By Bank A/c   17,000 

        9 By Discount A/c   3,000 

                

    30 By Balance c / d   10,000 

                

      40,000       40,000 

1st May To Balance b/d   10,000         

                

Dr.      Commission Account                       Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2016, 

APRIL       

2016, 

APRIL 

8 By Cash A/c   1,000 

                

                

30 To Balance c / d   1,000         

                

      1,000       1000 

1st May By Balance b/d   1,000 
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Dr.      Capital Account                       Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2016, 

APRIL        

2016, 

APRIL 

1 By Cash A/c   1,00,000 

                

                

30 To Balance c / d   1,00,000         

                

      1,00,000       1,00,000 

1st May By Balance b/d   1,00,000 

                

 

Dr.      Stationery Account                                  Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2016, 

APRIL        

2016, 

APRIL 

1 By Cash A/c   250 

                

                

30 To Balance c / d   250         

                

      250       250 

1st May By Balance b/d   250 

                

 

Dr.      Interest Account                       Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2016, 

APRIL       

2016, 

APRIL 
18 By Cash A/c   1,000 

                

                

30 To Balance c / d   1,000         

                

      1,000       1000 

1st May By Balance b/d   1,000 
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Dr.      Wages Account                       Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2016, 

APRIL 

25  To Cash A/c   4,000 

2016, 

APRIL  

                

                

30 By Balance c / d   4,000 

                

      4,000       4,000 

1st May To Balance b/d   4,000 

                

 

Dr.      Electricity Expenses Account                           Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2016, 

APRIL 

28  To Cash A/c   1,500 

2016, 

APRIL  

                

                

30 By Balance c / d   1,500 

                

      1,500       1,500 

1st May To Balance b/d   1,500 

                

 

Dr.      Salaries Account                            Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2016, 

APRIL 

30  To Cash A/c   2,000 

2016, 

APRIL  

                

                

30 By Balance c / d   2,000 

                

      2,000       2,000 

1st May To Balance b/d   2,000 
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Illustration 2: 

From the following transactions, prepare ledger accounts in the books of Vaaraahi 

2015 September 

 1  Started business with cash      Rs. 1,00,000   

   Furniture         Rs. 10,000 

 2  Cash deposited at bank      Rs. 40,000 

 3  Goods purchased from Sindhu     Rs.20,000 

 5  Goods sold to Ram       Rs. 5,000 

 7  Goods returned to Sindhu      Rs. 1,000 

 8  Cheque issued to Sindhu      Rs. 17,800   

   and received a discount of      Rs. 1,200 

 10  Goods sold to Anil for cash      Rs. 10,000 

 11  Cheque received from Ram worth     Rs. 4,000   

   and allowed a discount of      Rs. 500 

 12  Ram returned goods worth      Rs. 500 

 15  Purchased machinery and payment made by cheque Rs. 5,000  

 20  Cash with drawn from bank personal use    Rs. 1,000 

 30  Salaries paid        Rs. 3,000  

 

 

 

 

 

 

 

Journal Entries in the books of Vaaraahi as on 30
th

 September, 2015 

Date Particulars L/F 
Debit 

Amount Rs. 

Credit 

Amount Rs. 

Sept, 2015 

1
st 

 

 

 

 

2 

 

 

  

3 

 

CashA/c                                        Dr 

Furniture A/c 

                To Capital A/c 

(Being Cash and Furniture Brought 

in to start the business) 

 

Bank  A/c                                      Dr 

                To Cash  A/c 

(Being Cash deposited at bank) 

 

Purchases A/c                               Dr 

                To Sindhu A/c 

 1,00,000 

10,000 

 

 

 

 

40,000 

 

 

 

20,000 

 

 

 

1,10,000 

 

 

 

 

40,000 

 

 

 

20,000 
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5 

 

 

 

7 

 

  

 

8 

 

 

 

 

 

10 

 

 

 

11 

 

 

 

 

 

12 

 

 

 

15 

 

 

 

 

20 

 

 

  

 

30 

( Being Goods purchased from 

sindhu for credit) 

 

Ram  A/c                                       Dr 

                To Sales A/c 

(Being goods sold to ram for credit) 

 

Sindhu   A/c                                  Dr 

                To Purchase returns  A/c 

(  Being goods returned to sindhu) 

 

Sindhu   A/c                                   Dr 

                To   Bank A/c 

                To Discount Received A/c 

( Being payment made by cheque 

and discount  received from sindhu) 

 

Cash A/c                                       Dr 

                To Sales  A/c 

(Being sold goods for cash ) 

 

Bank  A/c                                       Dr 

Discount Allowed A/c 

                To   Ram  A/c 

(  Being Cheque received and 

Discount allowed to ram) 

 

Sales Returns A/c                         Dr 

                To   Ram  A/c 

( Being goods goods returned by 

ram) 

 

Machinery    A/c                           Dr 

                To Bank  A/c 

(  Being Machinery purchased and 

payment made by cheque) 

 

Drawings A/c                                 Dr 

                To Bank  A/c 

( Being Cash with drawn from bank 

for proprietor personal use) 

 

Salaries A/c                                  Dr 

                To  Cash A/c 

(Being salaries paid ) 

 

 

 

5,000 

 

 

 

1,000 

 

 

 

 

 

19,000 

 

 

 

 

 

10,000 

 

 

 

4,000 

500 

 

 

 

 

500 

 

 

 

5,000 

 

 

 

 

1,000 

 

 

 

 

3,000 

 

 

 

 

5,000 

 

 

 

1,000 

 

 

 

 

 

17,800 

1,200 

 

 

 

 

10,000 

 

 

 

 

4,500 

 

 

 

 

500 

 

 

 

5,000 

 

 

 

 

1,000 

 

 

 

 

3,000 
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Dr.      Cash Account           Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2015, 

Sept 1 To Capital A/c   1,00,000 

2016, 

Sept 2 By Bank A/c   40,000 

10 To sales A/c 10,000 30 By Salaries A/c   3,000 

  

        30 By Balance c / d   67,000 

                

      1,10,000       1,10,000 

1st 

Oct To Balance b/d   67,000         

                

 

Dr.      Capital Account           Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2015, 

Sept    

2016, 

Sept 1 By Cash A/c   1,000,000 

1 By Furniture A/c 10,000 

        

30 By Balance c / d   1,10,000         

      1,10,000       1,10,000 

1st Oct By  Balance b/d   1,10,000 

 

 

Dr.      Purchases Account           Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2015, 

Sept 3 To Sindhu A/c   20,000 

2016, 

Sept    

        30 By Balance c / d   20,000 

        

      20,000       20,000 

1st Oct To Balance b/d   20,000 
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Dr.      Sales Account           Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2015, 

Sept    

2016, 

Sept 5 By Ram A/c   5,000 

10 By Cash A/c 10,000 

  

30 To Balance c / d   15,000         

      15,000       15,000 

1st Oct By  Balance b/d   15,000 

Dr.      Purchase Returns Account          Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2015, 

Sept    

2016, 

Sept 7 By Sindhu A/c   1,000 

30 To Balance c / d   1,000         

      1,000       1,000 

1st Oct By  Balance b/d   1,000 

 

Dr.      Sales Returns Account          Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2015, 

Sept  To Ram A/c   500 

2016, 

Sept    

        30 By Balance c / d   500 

        

      500       500 

1st Oct To Balance b/d   500 

 

 

Dr.      Sindhu Account           Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2015, 

Sept 7 To Purchase Returns A/c   1,000 

2016, 

Sept 3 By Purchases A/c   20,000 

To Bank A/c 17,800 

   To Discount received A/c   1,200 

          

      20,000       20,000 
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Dr.      Drawings Account          Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2015, 

Sept 20 To Bank A/c   1,000 

2016, 

Sept  

30 By Balance c / d   1,000 

      1,000       1,000 

1st Oct By  Balance b/d   1,000 

 

 

 

Dr.      Machinery Account          Cr. 

Date Particulars J.F. 
AMOUNT 

RS. 
Date Particulars J.F. 

AMOUNT 

RS. 

2015, 

Sept 15 To Bank A/c   5,000 

2016, 

Sept  

30 By Balance c / d   5,000 

      5,000       5,000 

1st Oct To  Balance b/d   5,000 

 

Exercises 

1. Write the journal entries and prepare proper ledger accounts from the following 

transactions. 

2014 March 

 1 Goods sold to syamala       Rs. 14,000 

 2 Symala returned goods worth      Rs.       500 

 10 Received cash from Syamala      Rs. 10,000 

 14 Goods purchased from Ganesh & co     Rs. 16,000 

 16 Goods purchased for cash      Rs.   2,000 

 31 Cash paid to Ganesh & Co      Rs.   4,000 

 

2. Write the journal entries and prepare proper ledger accounts from the following 

transactions. 

2015 January 

 1 Ramarao started business with Cash      Rs. 40,000 

 5 Cash purchases from Amalesh      Rs. 10,000 

 6 Sold goods to Ramsingh       Rs.   5,000 

 8 Paid Wages         Rs.   1,000 

 16 Cash received from Ramsingh      Rs.   3,500 

 21 Furniture purchased and paid cash      Rs.   2,500 
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 30 Received Commission       Rs.      500 

 30 Sold goods for cash        Rs.   4,000 

 30 Rent          Rs.      300 

3. Prepare M/s Narasalakshmi account from the following 

2014 March 

 1  Goods purchased from Narasalakshmi   Rs. 28,000 

 6  Cash paid to Narasa lakshmi     Rs.   5,000 

 8  Goods returned to Narasa lakshmi    Rs.   1,000 

 15  Paid to Narasa Lakshmi by Cheque    Rs. 10,000 

 18  Discount allowed by Narasa Lakshmi   Rs.   5,000 

 22  Goods purchased from Narasa Lakshmi for cash  Rs. 10,000 

 25  Discount given by Narasa Lakshmi    Rs.   1,000 

 

4. Journalise the following transactions and post in the proper Ledger Accounts. 

2011 April 

 1 Suman Started business with capital      Rs. 65,000 

 4 Goods purchased for cash       Rs. 16,000 

 5 Goods purchased from Hanoku      Rs.   6,000 

 9 Cash deposited at bank       Rs.   5,000 

 11 Goods sold to Gangadhar       Rs.   9,000 

 19 Cash paid to Hanoku        Rs.   2,000 

 24 Cash received from Gangadhar      Rs.   1,000 

 30 Salaries Paid         Rs. 15,000 

5. Prepare Furniture account from the following Transactions 

2012 June 

 1 Furniture purchased from J & P       Rs. 40,000 

 10 Goods purchased from Amaravathi furniture for cash   Rs.   5,000 

 14 Cash  paid to J & P        Rs. 20,000 

 16 Sold old furniture worth Rs. 8,000  for Rs. 5,000 

 30  Depreciation on furniture       Rs.   6,000 

 30 Goods purchased from Rajesh      Rs.   4,000 
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UNIT - V 

SUBSIDIARY BOOKS 
5.1 Meaning and Significance 

5.2 Different types of Subsidiary Books 

5.3 Purchase Book 

5.4 Sales Book 

5.5 Purchase Return Book 

5.6 Sales Return Book 

5.7 Bills Receivable Book 

5.8 Bills Payable Book 

5.9 Treatment of Trade Discount 

 

5.1 Meaning and Significance 
 Due to the large number of transactions in big organizations it is difficult to maintain all 

transactions in  one book. Hence, there is a need to sub divide journal into special journals.  Each 

journal is meant for recording the transactions of separate category and of repetitive nature.  

These special journals are called ‘Subsidiary Books’. 
   

5.2 Different types of Subsidiary Books 
There are 8 types of subsidiary books used for different purposes. Those are: 

1. Purchase Book 

2. Purchase Returns Book 

3. Sales Book 

4. Sales Returns Book 

5. Cash  Book 

6. Bills Receivable Book 

7. Bills Payable Book 

8. Journal Proper 

 

5.3 Purchase Book 
 Goods purchased on credit are recorded in this book.  The cash purchases of goods and 

Purchase of Assets (Furniture, Machinery etc.) are not recorded.  The invoice or bills  received 

from the supplier by the firm are the source documents for recording entries in this book. 

 

Invoice: Invoice is a document received by  the trader from the supplier along with the goods by 

stating that, the goods are supplied as per the order along with the  price, discount offered, and 

other terms and conditions.  This document is called as “Inward Invoice”. 

 

Purchase Book contains five columns. Those are Date, Particulars, Invoice No. , L.F.No  and 

Amount. 

1. Transaction Date is to be recorded in the Date column. 

2. Name and address of the creditor is to be recorded in the particulars column. 

3. Serial Number of the Invoice is to be recorded in the Invoice column. 

4. Page Number of Creditor A/c is to be recorded in the L.F. Column. 
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5. Net Amount should be recorded in the Amount column. 

 

Purchase Book 

Date Particulars Inward 

Invoice 

No. 

L.F.No Amount 

Rs. 

     

 

5.4 Purchase Returns Book 
 

 The goods returned to the supplier purchased on credit are recorded in this book. As  the 

goods are going out from the firm, this book is also called as ‘Returns Outward Book”.  For 

every return a Debit Note is prepared and is sent to the supplier.  Each debit note is serially 

numbered and dated.  

 

Debit Note: Debit note is the document sent to the supplier while returning the goods purchased 

on credit from him, intimating that his account is debited to the extent of goods returned and the 

reasons for returning them. The debit note contains Name and Address of the supplier, the value 

of the goods returned, the value of the goods purchased, reasons for return of goods. 

 

Purchase Returns Book contains five columns. Those are Date, Particulars, Debit Note No., 

L.F.No  and Amount. 

1. Date of goods returned is to be recorded in the Date column. 

2. Name and address to whom the goods are returned is to be recorded in the particulars 

column. 

3. Debit Note Number is to be recorded in the Invoice column. 

4. Page Number of Creditor A/c is to be recorded in the L.F. Column. 

5. Net  value of the goods returned is recorded in the Amount column. 

 

Purchases Returns Book 

Date Particulars Debit Note 

No. 

L.F.No Amount 

Rs. 

     

 

5.5 Sales Book 
 The goods sold on credit are recorded in this book.  The cash sales of goods and Sale of 

Assets (Furniture, Machinery etc.) are not recorded.  The Outward invoice or bills  prepared by 

the trader are the source documents for recording entries in this book.  Sales book also called as 

‘Sales Day book or Sales Journal’.   
  

 If the trader sell goods on credit, an invoice is given to the buyer.  The proforma of this 

outward Invoice resembles the Proforma of Inward Invoice.  This is prepared with a duplicate 

copy, one copy is sent to the customer and the second copy is kept by trader.  In some cases it 

may be prepared in triplicate for giving a copy to the transporter.  Ex. In GST Outward supply 



Paper III Accountancy & Tally Finalised 

424 

 

(Sale) bills must be in triplicate. The credit sale transactions are recorded in sales book on the 

basis of duplicate invoice copy. 
  

 Sales Book contains five columns. Those are Date, Particulars, Invoice No. , L.F.No  and 

Amount. 

1. Transaction Date is to be recorded in the Date column. 

2. Name and address of the Debtor is to be recorded in the particulars column. 

3. Serial Number of the Invoice is to be recorded in the Invoice column. 

4. Page Number of Debtor A/c is to be recorded in the L.F. Column. 

5. Net Amount has to be recorded in the Amount column. 

 

Sales Book 

Date Particulars outward 

Invoice 

No. 

L.F.No Amount 

Rs. 

     

 

5.6 Sales Returns Book 
 

 The goods returned by the customers sold for credit are recorded in this book. As the goods 

are coming into the firm, this book is also called as “Returns Inward Book”.  On receipt of 

goods from the customer, credit note is prepared and serially numbered and dated. 

 

Credit Note: It is a document (note) prepared and sent to the customer to inform that his account 

is credited with the amount of goods returned by him.  It is a common practice to make it in red 

ink. 

 

Sales Returns Book contains five columns. Those are Date, Particulars, Credit Note No., L.F.No  

and Amount. 

1. Date of goods returned by the customer is to be recorded in the Date column. 

2. Name and address to whom the goods are returned is to be recorded in the particulars 

column. 

3. Credit Note Number is to be recorded in the Invoice column. 

4. Page Number of the Debtor A/c is to be recorded in the L.F. Column. 

5. Net value of the goods returned is recorded in the Amount column. 

 

Sales Returns Book 

Date Particulars Credit   Note 

No. 

L.F. No Amount 

Rs. 

     

 

5.7 Cash Book 
 In  this book, all the transactions relating to cash receipts and cash payments are recorded.  It 

starts with the cash or bank balance at the beginning of the period.  It gives the closing balance at 

the end of the period.  It is the only subsidiary book which acts as both Journal and Ledger. 
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5.8 Bills Receivable Book 
 A trader draws bills on the debtors for the  amount due from them,  such bills drawn by the 

traders and duly accepted by the debtors are called ‘Bills receivable’. The amount on bills to be 

received is entered in bill receivable book.  This book contains the details of the bill date, 

acceptor’s name, amount, term, place of payment etc. 

 

Bills Receivable Book 
No. 
Of  
Bill 

Date 

Receive

d 

Date 

of 

bill 

From 

whom 

received 

Drawer Acceptor Where  

payable 
Term Due 

date 
Ledger 

Folio 
Amount Cash  

book 

folio 

Remarks 

             

 

5.9 Bills Payable Book 
 Every business organisation accepts the bills to the creditors, like wholesalers or 

manufacturers for the purchase of goods on credit.  Such bills drawn by creditors and accepted 

by traders are called bills payable and they are recorded in a separate book called ‘Bills Payable 

Book’. 

 

Bills Payable Book 
No. of 

bill 
Date of 

bill 
To 

who

m 

given 

Drawer Payee Where 

payable 
Term Due 

date 
Ledger 

Folio 
Amount 

paid 
Date of 

Payment 
Cash 

Book 

Folio 

Remarks 

             

 

5.10 Journal Proper 
 This book is maintained to record transactions, which do not find place in other seven 

Subsidiary Books.  The Journal Proper also known as ‘Journal Residual ‘. The format of Journal 

Proper is similar to the ordinary journal.   

 

5.11 Treatment of Trade Discount 
 Trade Discount: The rebate offered by the supplier on the catalogue price is known as trade 

discount. After deducting the trade discount from the purchase price, the only net amount is to be 

recorded in the books, if the discount is given by the trader. 

 

Short Answer type Questions 

1. Define Invoice. 

2. What is Debit Note? 

3. What is Credit Note? 

4. Define Journal Proper . 

5. What is Trade Discount? 
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Long Answer Type Questions 

1. Explain different types of Subsidiary Books in detail. 

 

Illustration : 1 

Enter the following transactions in the proper subsidiary books 

2012 March 

1 Goods purchased from Kalyani    Rs. 14,000 

6 Goods sold to Jitendra     Rs.   9,000 

9 Goods purchased from Lakshmi    Rs.   7,000 

14 Goods purchased from Durga & Co    Rs.   6,000 

15 Jitendra returned goods worth    Rs.   2,000 

17 Goods returned to Lakshmi     Rs.      500 

Purchases Book 

Date Particulars Inward 

Invoice 

No. 

L.F.No Amount 

Rs. 

2012 March 

1 

9 

14 

 

Kalyani 

Lakshmi 

Durga & Co 

 

Debited to Purchase Account  

   

14,000 

7,000 

6,000 

28,000 

Sales Book 

Date Particulars outward 

Invoice 

No. 

L.F.No Amount 

Rs. 

2012 March 

6 

 

Jitendra 

 

Credited to Sales Account 

   

6,000 

6,000 

Sales Returns Book 

Date Particulars Credit   

 Note No. 

L.F. 

No 

Amount 

Rs. 

2012 March 

15 

 

Jitendra 

 

Debited to sales returns account 

   

2,000 

2,000 

 

Purchases Returns Book 

Date Particulars Debit Note L.F.No Amount 
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No. Rs. 

2012 March 

17 

 

Lakshmi 

 

Credited to Purchase Returns account 

   

500 

500 

Illustration 2 

2010 January  

 1 Goods purchased from Nagalakshmi & Co    Rs. 1,000 

 5 Goods sold by Varaprasad      Rs. 2,500 

 14 Goods purchased from Sridevi     Rs. 4,000 

 15 Goods returned to Varaprasad     Rs.    600 

 18 Goods sold to Hema       Rs. 5,000 

 20 Goods sold to Mahesh      Rs. 1,500 

 22 Goods sold to BVS &Co      Rs. 2,000 

 26 Goods returned to Sridevi      Rs.    700 

 28 Hema returned goods worth      Rs.    500 

 31 Goods returned by Mahesh      Rs.    400 

 

Purchases Book 

Date Particulars Inward 

Invoice 

No. 

L.F.No Amount 

Rs. 

2010, Jan 

1 

5 

14 

 

Naga Lakshmi & Co 

Varaprasad 

Sridevi 

 

Debited to Purchase Account 

   

1,000 

2,500 

4,000 

7,500 

Sales Book 

Date Particulars outward 

Invoice 

No. 

L.F.No Amount 

Rs. 

2010, Jan 

18 

20 

22 

 

 

 

Hema 

Mahesh 

BVS &Co 

 

Credited to Sales Account 

   

5,000 

1,500 

2,000 

8,500 

 

 

Sales Returns Book 

Date Particulars Credit   L.F. Amount 
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 Note No. No Rs. 

2010, Jan 

28 

31 

 

Hema 

Mahesh 

 

Debited to sales returns account 

   

500 

400 

900 

Purchases Returns Book 

Date Particulars Debit Note 

No. 

L.F.No Amount 

Rs. 

2010, Jan 

15 

26 

 

Varaprasad 

Sridevi 

 

Credited to Purchase Returns account 

   

600 

700 

1,300 

 

Illustration 3: 

Venusri started business on 1
st
 Jan, 2017 with assets: cash Rs. 18,000, Stock Rs. 10,000, 

Furniture Rs. 24,000, Machinery Rs.10,000 and Creditors Rs. 3,500 and Bank Over draft 

Rs.2,500 pass opening entry. 

Journal Proper 

Date Particulars L.F.No. Debit Rs. Credit 

Rs. 

2017 Jan 1
st
 Cash A/c                                 Dr 

Stock A/c                                Dr 

Furniture A/c                         Dr 

Machinery A/c                       Dr 

             To Creditors A/c 

To Bank Over Draft 

To Capital Account 

(Being the opening entry for the 

above assets and liabilities) 

 18,000 

10,000 

24,000 

10,000 

 

 

 

 

3,500 

2,500 

56,000 

 

 

Note : In the above entry, four assets are debited with their values and liabilities are credited with 

their values. The difference between the assets and liabilities is credited to capital account. 

Total Assets   18,000+10,000+24,000+10,000  = 62,000 

Total Liabilities 3,500+2,500    =   6,000 

   Capital     = 56,000 

 

 

Illustration 4: 

Write the opening entry as on 1-4-2016 from the following in the books of Mrudula 

Balance sheet of Mrudula on 31
st
 March 2016 
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Liabilities Amount 

Rs. 

Assets Amount 

Rs. 

Sundry Creditors 

Bills Payable 

Capital 

25,000 

10,000 

45,000 

 

 

80,000 

Cash 

Sundry Debtors 

Stock 

Machinery 

15,000 

20,000 

15,000 

30,000 

 

80,000 

Journal Proper 

Date Particulars L.F.No. Debit 

Rs. 

Credit 

Rs. 

2016, April 

1 

Cash A/c                                           Dr 

Stock   A/c                                        Dr 

Sundry Debitors  A/c                      Dr 

Stock  A/c                                         Dr 

Machinery  A/c                                Dr 

               To Sundry Creditors A/c 

               To Bills Payable A/c 

               To Capital  A/c 

(Being the balance of the previous year 

brought to the current year) 

 15,000 

15,000 

20,000 

30,000 

 

 

 

 

 

25,000 

10,000 

45,000 

 

Exercises 
1. Enter the following transactions in the proper subsidiary books 

2014 March 

 1 Goods purchased from Mounika    Rs. 14,000 

 2 Sold goods to Ramachandra     Rs.    9,000 

 9 Goods purchased from Santhi    Rs.    7,000 

 14 Goods purchased from Bhagyalakshmi & Co  Rs.    6,000 

 15 Goods returned by Ramachandra    Rs.    2,000 

 17 Goods returned to Santhi     Rs.       500 

 

2. Enter the following transactions in the proper subsidiary books 

2011 August 

 1 Goods sold to Asha      Rs. 40,000 

 7 Goods purchased from Balu     Rs. 16,000 

 9 Goods Purchased from Saikrishna    Rs.   5,000 

 14 Goods returned to Balu     Rs.   2,000 

 23 Asha returned goods      Rs.      250 

 29 Goods returned to Saikrishna     Rs.      100 

 

3. Prepare proper subsidiary books for the following transactions 

2012 December 

 1 Goods Sold to Prasad      Rs. 15,000 

 3 Goods Purchased from Kalyanai    Rs. 10,000 
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 5 Purchased goods from Hema     Rs.   5,000 

 10 Sold goods to Teja      Rs.   5,000 

 13 Sold goods to Sireesha Traders    Rs.   3,000 

 18 Goods returned by Prasad     Rs.   2,000 

 20 Goods returned to Kalyani     Rs.   1,000 

 22 Goods returned to Hema         Rs.      500 

 25 Goods returned by Teja     Rs.      200 

 
 

4. Enter the following transactions in the proper subsidiary books 

2013 July 

 1 Goods Purchased from Govind Rs. 20,000 

 3 Goods Sold by Vinay Rs. 10,000 

 5 Goods Purchased from Chaitanya Rs. 5,000 

 6  Goods sold to Vijaya for cash Rs. 11,500 

 8 Goods returned to Vinay Rs. 500 

 10 Goods Returned to Govind Rs. 2,000 

 14 Goods Purchased from Baby for cash Rs. 1,000 

 16 Sold goods to Vasantha Rs. 15,000 

 18 Sold goods to SRK Industries Rs. 7,000 

 22 SRK Industries returned goods Rs. 700 

   

5. Enter the following transactions in the proper subsidiary books 

2017 August 

 1 Goods purchased from Nageswari 10,000 

 3 Goods sold by KNLProjects Rs.5,000 

 7 Goods sold to Veera Industries Rs. 8,000 

 9 Goods sold to Phaneendra Rs. 2,000 

 12 Goods sold to Jagadeeswari Pharma Rs. 10,000 

 18 Returned goods to Nageswarri 1,000 

 20 Goods returned by Veera Industries Rs. 300 

 22 Goods returned to KNL Projects Rs. 250 

 23 Goods sold to Sudha Foods Rs. 2,000 

 24 Goods returned by Jagadeeswari Pharma Rs. 500  

 24 Goods returned by Sudha Foods Rs. 200 

  

6. Balasai & Associates started business with Cash Rs. 1,00,000, Furniture Rs. 20,000, 

Fixtures Rs. 2,000, Machinery Rs. 20,000 
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UNIT - VI 

CASH BOOK 

6.1 Meaning and Significance of Cash Book 

6.2 Features of Cash Book 

6.3 Kinds of Cash Books 

6.4 Single column Cash Book 

6.5 Two Column Cash Book 

6.5.1 Cash book with Cash and Discount Columns 

6.5.2 Cash book with Bank and Discount Columns 

6.6 Three Column Cash  Book 

6.7 Analytical Petty Cash Book 

 

6.1 Meaning and Significance of Cash Book 

Cash book is a very popular subsidiary book maintained by all business organizations 

irrespective of their nature, as big or small. All the cash transactions of a business are 

primarily recorded in cash book. Business transactions are mainly two types 1. Cash 

Transactions  2. Credit Transactions. Cash transactions involve cash receipts and cash 

payments. If the number of transactions related to cash is large, it is necessary to maintain a 

subsidiary (separate) book for recording cash receipts and cash payments.  Cash book records 

all the cash receipts and cash payments and gives the balance of cash in the business at any 

time. 

Cash receipts are recorded on the Debit side and cash payments are recorded on the 

Credit side of the Cash Book.  The principle of Real Account is applied to this. The 

difference between Debit total and Credit total reveals the balance of cash.  Cash book 

always shows Debit balance, because a business unit cannot pay more than  its receipts. 

 

6.2 Features of Cash Book 

1. Cash book is a subsidiary book. 

2. It records all cash transactions. 

3. Cash book acts as Cash Account, preparation of a separate  cash A/c in ledger is not 

required. 

4. It gives the Cash and Bank balance of a business at any given period. 

5. Mistakes or Frauds can be detected by verifying the closing balance of cash book with 

the actual amount of cash in hand. 

6. It records cash receipts on the debit side and cash payments on the credit side. 

Cash book will show Debit Balance only. 

 

6.3 Kinds of Cash Books 
There are different kinds of cash books maintained by the business organisation 

depending on the size of business. Those are  

1. Simple Cash Book (or) Single Column Cash Book 

2. Double Column Cash Book 

3. Triple Column Cash Book 
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4. Petty Cash Book 

 

6.4 Simple Cash Book (or) Single Column Cash Book 
Simple Cash Book (or) Single column cash book records all cash transactions of the 

business in a chronological order.  Cash receipts are to be debited and cash payments are to 

be credited. We can ascertain the balance like other accounts, after entering all the 

transactions. The format of single column cash book is as follows. 

 
Dr.     Simple Cash Book (or) Single Column Cash Book                  

 Cr. 
Date Particulars L.F. Amount 

Rs. 
Date Particulars L.F

. 
Amount 

Rs. 
        

 

 Simple Cash Book (or) Cash Book contains four columns in both Debit and Credit sides. 

Those are Date, Particulars, L.F.No  and Amount. 

1. Date on which cash received is to be recorded in the debit side Date column and Date on 

which cash payment is made is to be recorded in the credit side Date Column. 

2. Name of the account from whom cash received is to be recorded in the debit side 

particulars column and name of the account to whom cash  paid is to be recorded in the 

credit side particulars column. 

3. Page Number of the Ledger A/c is to be recorded in the L.F. Column. 

4. Amount of transaction is recorded in the Amount column. 

 

Illustration – 1 

2017 January 

 1 Samitha started business with cash     Rs.80,000 

 4 Purchases        Rs. 20,000 

 6 Cash deposited at Bank      Rs. 30,000 

 8 Sales         Rs. 14,000 

 10 Purchased goods from Harshitha for cash    Rs.   5,000 

 14 Manager salary       Rs. 12,500 

 16 Office expenses       Rs.   2,500 

 17 Stationery Purchses       Rs.      350 

 21 Sale of old newspapers      Rs.        90 

 23 Drawings        Rs.   5,000 

 25 Rent paid        Rs.   2,800 

 29 Interest Received       Rs.   1,250 

 31 Travelling expenses paid      Rs.   1,150 
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Dr. Simple Cash Book Cr. 

Date Particulars L.F. Amount Date Particulars L.F. Amount 

2017 

January 

1 

To Capital A/c   80,000 

2017 

January 

4 

By Purchases A/c   20,000 

8 To Sales A/c   14,000 6 By Bank A/c   30,000 

21 To Old News papers A/c   90 10 By Purchases A/c   5,000 

29 To Interest A/c   1,250 14 By Salaries A/c   12,500 

      16 By Office expenses A/c   2,500 

      17 By Stationery A/c   450 

      23 By Drawings A/c   5,000 

      25 By Rent A/c   2,800 

      31 By Travelling Expenses A/c   1,150 

              

      31 By Balance c/d   15,940 

    95,340       95,340 

              

Feb, 1 To Balance b/d   15,940         

 

Illustration – 2 

Enter the following transactions in single column cash book of Sri hitha 

2012 December, 

 1 Opening Balance       Rs. 20,000 

 4 Received from Sivanandam      Rs.   4,000 

 8 Paid to Krishna       Rs.   1,000 

 16 Goods sold for cash           Rs.   1,600 

 19 Received from Saroja for the full settlement of his account  Rs.   1,710 

 28 Goods purchased for cash      Rs.   1,600 

 31 Paid salaries        Rs.   1,140 

 31 Rent Paid        Rs.   1,000 

Dr. Simple Cash Book Cr 

Date Particulars L.F. Amount Date Particulars L.F. Amount 

2012 

Dec 1 
To Opening Balance   20,000 

2012 

Dec 8 
By Krishna A/c   1,000 

4 To Sivanandam A/c   4,000 28 By Purchases A/c   1,600 

16 To Sales A/c   1,600 31 By Salaries A/c   1,140 

19 To Saroja A/c   1,710 31 By Rent A/c   1,000 

            

      31 By Balance c/d   22,570 

    27,310       27,310 

2013 

Jan 1 To Balance b/d   22,570         
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6.4 Double column Cash Book (or) Two Column Cash Book 
This cash book is an extension of Single Column Cash Book. In double column cash 

book, an additional column is provided for the discount.  On the debit sided discount allowed 

column and on the credit side discount received column is provided along with cash column.  

There are two columns for amount on each side of the cash book. One is for cash or bank and 

the other is for Discount.  This cash book also called as Two Column Cash Book.   

 

Discount: Discount is an incentive given by the creditor to debtor for prompt payment.  

Discount is of two types. Those are 1) Trade Discount  2) Cash Discount 

 

Trade Discount: The discount given by the seller to buyer is known as “Trade Discount”.  

This discount is deducted from the Catalogue price in shown in the invoice and the account is 

prepared by taking net amount.  The  trade discount should not be recorded in the books of 

accounts. 

 

Cash Discount: The discount for prompt or early payment is called cash discount. There are 

two types in Cash Discount.  Those are  1)Discount Allowed    2) Discount Received. 

 

 The Double column Cash Book is again classified into Two types those are 

1. Cash book with Cash and Discount Columns 

2. Cash book with Bank and Discount Columns 

 

6.4.1 Cash book with Cash and Discount Columns 
If any business having only Cash Receipts and Cash Payments, the cash book 

with Cash and discount columns is used.  The cash receipts are entered on the debit side, 

where as cash payments are entered on the credit side.  In this book, cash columns are 

balanced like the  other ledger accounts but discount columns are not balanced. The 

proforma of Cash and discount column cash book is as follows. 

Dr    Cash and Discount column cash book   Cr 

Date Particulars 
L.F. 

No 

Discount  

Allowed 

Amount 

Rs. 
Date Particulars 

L.F. 

No 

Discount  

Received 

Amount 

Rs. 

           

6.4.2 Cash book with Bank and Discount Columns 
Many business organizations carry their transactions in the form of Cheques, 

NEFT, RTGS etc through banks.  The receipt of cheques, NEFT,  RTGS etc are 

mentioned in the bank column of cash book.  Instead of cash column, bank column is 

provided in this cash book in both debit and credit sides.  The bank columns are balanced 

to identify the  bank balance. The proforma of Bank and discount column cash book is as 

follows. 

Dr    Bank and Discount column cash book   Cr 

Date Particulars 
L.F. 

No 
Discount  

Allowed 
Bank 

Rs. 
Date Particulars 

L.F. 

No 

Discount  

Receive

d 

Bank 

Rs. 
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Illustration – 3 

Prepare two column cash book from the  following transactions 

2018 January 

 1 Opening Balance      Rs. 2,00,000 

 6 Payment made to Kameswari     Rs.      6,700  

  Discount received      Rs.         300 

 8 Goods purchased for cash     Rs.    10,000 

 10 Sales       Rs.    14,000 

 23 Cash received from Kella & co.,    Rs.    19,800 

  Discount allowed      Rs.         700 

 31  Salaries paid       Rs.      1,300 

 31  Cash received from SNL Pioneer Projects   Rs.      6,300 

  Discount allowed      Rs.         200 

 31  Paid Rent       Rs.      1,000 

Dr.                           Cash and Discount column Cash Book                                            Cr. 

Date Particulars 
L.F. 

No 

Discount  

Allowed 

Amount 

Rs. 
Date Particulars 

L.F. 

No 

Discount  

Received 

Amount 

Rs. 

2018  

Jan  1 To Balance b/d     200,000 

2018 

 Jan 6 By Kameswari A/c   300 6,700 

10 To Sales A/c     14,000 8 By Purchases A/c     10,000 

23 To Kella &Co A/c   700 19,800 31 By Salaries A/c     1,300 

31 To SNL Pioneer 

 Projects A/c   200 6,300 

31 By Rent A/c     1,000 

                

          31 By Balance c/d     221100 

      900 240100       300 240100 

                    

Feb-

01 By Balance b/d   221100             

Illustration – 4 

Prepare Bank and discount column cash book in the books of Sri Sivananda Enterprises 

2015 October 

 1 Bank Balance      Rs. 9,000 

 4 Cheque issued to Kotak Mahindra   Rs. 1,000 

 7 Cheque received from Sastry    Rs. 3,000 

 11 NEFT made to Adibabu    Rs. 1,300 

  Discount received     Rs.    200 

 14 Salaries paid by cheque    Rs. 1,200 

 19 RTGS made to Kumar traders   Rs.    750 

  Discount received     Rs.    250 

 24 Cheque received from Lakshman   Rs. 1,200 

  Discount allowed     Rs.    300 

 27 Office rent paid by cheque    Rs.    600 

 30 Cheque received from Sankar   Rs.    800 
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  Discount allowed     Rs.    200 

 

Dr.                    Bank and Discount column Cash Book of Sri Sivananda Enterprises                 Cr. 

Date Particulars 
L.F. 

No 
Discount  

Allowed 

Bank 

Rs. 
Date Particulars 

L.F. 

No 
Discount  

Received 

Bank 

Rs. 

2015 

Oct 1 

To Opening 

Balance     90,000 

2015 

Oct 4 By Kotak Mahindra A/c     10,000 

7 To Sastry A/c     30,000 11 By Adibabu A/c   200 10,300 

24 To Lakshman A/c   300 10,200 14 By Salaries A/c     12,000 

30 To Sankar A/c   200 8,000 19 

By Kumar Traders 

A/c   500 7,500 

          27 By Office Rent A/c     600 

                  

          31 By Balance c/d     97,800 

      500 1,38,200       700 1,38,200 

                    

Feb-

01 By Balance b/d   97,800             

 

6.5 Three Column Cash  Book 
In addition to the Date, Particulars, L.F. No., Discount and Amount columns in the double 

column cash book, the triple column cash book contains bank column.  It contains three columns 

for amount on both debit and credit sides. This book also called or known as Cash book with 

Cash, Bank and Discount columns. 

� It records both cash  and bank transactions. 

� It records the transactions which affects both cash and bank at a time with the help of 

contra entry. 

Contra Entry: An entry which appears on both sides of the Three column cash book i.e., Debit 

side as well as Credit side is called “Contra Entry”.  It affects both the bank and the cash 

columns at a time on both sides of the cash book. The contra entries represents by writing 

alphabet “C” in L.F. column on each side of the cash book. 

The contra entries are recorded in the following cases 

a) When cash is deposited into bank. 

b) When cash is withdrawn from bank for office use. 

c) When an account is opened with bank. 

d) When a cheque received from others on one day and deposited in the bank on another 

day. 

The proforma of Three column cash book is as follows. 

Dr.     Three column cash book      Cr. 

Date Particulars 
L.F. 

No 

Discount  

Allowed 

Amount 

Rs. 

Bank 

Rs. 
Date Particulars 

L.F. 

No 

Discount  

Received 

Amount 

Rs. 

Bank 

Rs. 
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Illustration – 5  

Prepare three column cash book for the following transaction in the books Vaarahi  

2018 January 

 1 Capital Introduced    Rs. 1,00,000 

 3 Deposited at bank     Rs.    45,000 

 4 Goods purchased for cash    Rs.      2,550 

 5 Cash received from Prasad    Rs.      6,700 

  Discount Allowed     Rs.         300 

 7 Cash paid to Devi    Rs.      6,800 

  Discount received     Rs.         200 

 11 Cheque issued to Sailaja    Rs.    10,000 

 19 Cheque received from Srinivas   Rs.    40,000 

 20 Srinivas cheque deposited at bank 

 26 Cash with drawn from bank for office use  Rs.    15,000 

 30 Sold goods for cash     Rs.    21,600 

 31 Salaries paid through cheque    Rs.    18,000 

 31 Deposited at bank     Rs.    12,000 

 31 Rent paid      Rs. 1,400
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     Dr.           Cash book with Discount, Cash and Bank Columns                                       Cr. 

 

 

Date Particulars 
L.F. 

No 

Discount  

Allowed 

Amount 

Rs. 

Bank 

Rs. 
Date Particulars 

L.F. 

No 

Discount  

Received 

Amount 

Rs. 

Bank 

Rs. 

2018 Jan 1 To Capital A/c     1,00,000   2018 Jan 3 By Bank A/c C   45,000   

3 To Cash A/c C     45,000 4 By Purchase A/c     2,550   

5 To Prasad A/c   300 6,700   7 By Devi A/c   200 6,800   

19 To Srinivas A/c     40,000   11 By Sailaja A/c       10,000 

20 To Cash A/c C     40,000 20 By Bank A/c C   40,000   

26 To Bank a/c C   15,000   26 By Cash A/c C     15,000 

30 To Sales A/c     21,600   31 By Salaries A/c       18,000 

31 To Cash A/c C     12,000 31 By Bank A/c C   12,000   

            31 By Rent A/c     1,400   

                        

            31 By Balance c/d     75,550 54,000 

      300 1,83,300 97,000       200 1,83,300 97,000 

                        

Feb-01 By Balance b/d     75,550 54,000             
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6.6 Analytical Petty Cash Book 
 

Due to a large number of Petty expenses or petty payments such as cartage, travelling, 

postage, refreshments, stationery and other expenses,  it is difficult to record all such payments in 

regular books of accounts.  To record all such payments of repetitive nature, a separate cash book 

is prepared which is called petty cash book. 

 

Generally petty cash book is prepared in column wise. It means details of expenses are 

shown in an analytical manner.  The amount of every expense is entered in total amount column 

and also in a separate column allotted to the respective expense.  This helps to know the total 

amount incurred for petty expenses and also the amount incurred on each head of expense. 

 

In this system the estimated petty amount for petty expenses is determined and handed over 

to the petty cashier in advance.  If, all petty expenses are paid and total of such expenses paid is 

re – advanced to petty cashier. It follows imprest system. 

 

Illustration 6 

Prepare analytical cash book for the following details 

2011  January 

 1 Advance received from head cashier   Rs. 500 

 2 Travellings      Rs. 15 

 8 Postal Stamps Puchased    Rs. 25 

 10 Stationary Purchased     Rs. 30 

 12 Carriage paid      Rs. 20 

 16 Courier Charges     Rs. 27 

 19 Tea & Tiffins      Rs. 15 

 23 Telegram Expenses     Rs. 22 

 24 Auto charges      Rs. 20 

 25 Paid to Sankar     Rs. 15 

 30 Pen purchased      Rs. 10  
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Dr.       Analytical Petty cash book       Cr. 

 

 

 

Cash 

Receive

d 

L.

F. 

N

O 

Date Particulars 

Vou

che

r 

No 

Total 

paymen

t 

Rs. 

Analysis of Payment   

Rem

arks 

Trave

llings 

Rs. 

Postage 

Rs. 

Telegra

m 

Rs. 

Printing 

& 

Stationer

y 

Rs. 

Carria

ge 

Rs. 

Refre 

Shmen

ts 

Rs. 

Sun

drie

s 

Rs. 

Misl

enio

us 

Rs. 

500   

2011  

JAN 

1 

To Cash                       

    2 By Travellings   15 15                 

    8 By Postal Stamps   25   25               

    10 By Stationery   30       30           

    12 By Carriage   20         20         

    16 By Courier Charges   27   27               

    19 By Tea & Tiffins   15           15       

    23 By Teligram   22   22               

    24 By Auto Charges   20 20                 

    25 By Sankar   15             15     

    30 By Pen   10       10           

          199                   

    31 By Balance c/d   301                   

500         500 35 74 0 40 20 15 15 0    

                              

    

Feb-

01 To Balance b/d   301                   
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Short Answer type Questions 

1. What is Cash book? Write different types of Cash books. 

2. Define Trade Discount and Trade Discount. 

3. Define Contra Entry. 

4. Define Analytical Petty cash book. 

Long Answer Type Questions 

1. Explain different types of cash books in detail. 

Abbreviations 

NEFT:  National Electronic Fund Transfer  

RTGS: Real Time Gross Settlement 

IMPS:  Immediate Payment System 

Exercises 

1. Prepare Simple cash book from the following transactions. 

2011 January 

 1 Opening balance    Rs. 20,000 

 2 Received from Badrinath   Rs.    5,000 

 4 Goods sold to Hari    Rs.    4,000 

 8 Purchased goods    Rs.   2,000 

 9 Cash paid to Havish    Rs.    4,000 

 14 Wages      Rs.    1,000 

 18 Sales      Rs.    2,000 

 22 Machinery Purchases   Rs   1,000 

 30 Salaries paid     Rs.    1,200 

Ans: Cash Balance – Rs. 21,800 

Hint: January 4
th

 goods sold to hari is a credit sale  

 

2. Prepare single column cash book from the below information. 

2015 March 

 1 Balance Brought Down   Rs.     10,000 

 4 Sales      Rs.  2,000 

 6 Purchases     Rs.  4,000 

 8 Travellings     Rs.     500 

 12 Received from Bhagmathi   Rs.  2,000 

 14 Cash paid to Victoria Nelson   Rs.  3,000 

 18 Wages paid     Rs.     500 

 22 Paid to Sumithra    Rs. 1,000 

 28 Electricity Bill paid    Rs.     800 

 31  Salaries paid      Rs.  1,500 

Ans: Cash Balance – Rs. 2,700 
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3. Prepare Simple cash book for the following transactions 

2016 March 

 1 Started Business with cash  Rs.  10,000 

 3 Purchase    Rs.   4,000 

 6 Goods sold for cash   Rs.    5,000 

 8 Paid to Ramesh   Rs.       600 

 10 Wages     Rs.       175 

 12 Telephone bill paid   Rs.      500 

 16 Carriage inwards   Rs.      150 

 19 Auto Charges paid   Rs.         200 

 24 Purchased goods for Cash  Rs.  2,000 

 26 Sales     Rs.  2,500 

 30 Salaries    Rs.     800 

Ans : Cash Balance – Rs. 9,075 

 

4. Prepare Single column cash book in the books of DS Food Plaza 

2017 December 

 1 Started business with Cash Rs. 10,000 

 2 Machinery purchased Rs. 2,000 

 3 Goods purchased for cash Rs. 500 

 4 Paid to Manikanta Rs. 1,500 

 6 Stationery Rs. 500 

 10 Sales Rs. 1,000 

 12 Paid to Sainath Rs. 2,000 

 14  Received from Nageswari Rs. 1,200 

 16  Sold goods for cash Rs. 2,000 

 22 Wages Rs. 500 

 25 Travelings Rs. 400 

 30 Salaries paid Rs. 1,000 

Ans: Cash Balance –Rs.  5,800 

  

5. Prepare Cash and Discount column from the following details 

2010 Octber 

 1 Opening Balance Rs. 15,000 

 2 Paid to Ramya Rs. 2,000 

 4 Received from Kalpana Rs. 3,800 

  Discount Allowed Rs. 200 

 8 Paid to Sudha Rs. 2,500 

  Discount Received Rs. 500 

 10 Received from Madhuri Rs. 1,900 

  Discount Allowed 100 

 18 Paid to Jayasri Rs. 500 

 21 Sales 4,000 
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 22 Purchased goods for cash Rs. 2,000 

 25 Purchased goods from Prasad for cash Rs. 1,500 

 30 Paid Salaries Rs. 2,000 

 

Cash Balance – Rs. 14,200, Discount Allowed – Rs. 300, Discount Received – Rs.500 

  

6. Prepare Cash and Discount Column Cash book for the following 

2013  September 

 1 Ravi Started business with Cash Rs. 40,000 

 3 Paid to Hrushikesav Rs. 18,500 and received discount of Rs. 500 

 5 Received from Arjun Rs. 19,000 and allowed a discount of Rs. 1,000 

 12 Goods sold to Arjun for cash Rs. 1,000 

 14 Purchases Rs. 2,900 

 16 Telephone bill paid Rs. 600 

 22 Cartage Rs. 250 

 28 Rent Paid Rs. 1,800 

 30 Salaries paid Rs. 1,600 

  

7. Prepare Bank and discount column cash book from the details 

2014 April 

 1 Over draft Rs. 2,500 

 3 Goods sold to Ganesh worth Rs. 4,500 payment received by cheque and allowed  

a discount of Rs.  500. 

 5 Purchased goods from Arjun Rs. 9,100 and received through NEFT and received a  

discount of Rs. 900 

 10 Received cheque from  Sankar Narayan Rs. 20,000 

 12 Cheque issued to Tanmayi Rs. 10,000 

 15 NEFT received from Devi Rs. 5,000 

 18 Electricity charges paid through NET Banking Rs. 800 

 22 Cash paid to Anitha  2,000 

 25 Withdrawn from bank for personal use Rs. 2,500 

 

 

8. Prepare two column cash book from the  following details 

2017 December 

 1 Bank Balance Rs. 20,000 

 2 Paid to Ramprasad through cheque Rs. 10,000 

  Discount Received Rs. 1,000 

 4 Received from Naidu through IMPS Rs. 19,800  

 allowed a discount of Rs. 200 

 10 Cheque received from Hari Rs. 1,000 

 12 Paid to Visali through cheque Rs. 4,000  

 16 NEFT received from Hari Rs. 1,000 

 22 Salaries paid by cheque Rs. 6,000 

 24 Purchased goods by cheque Rs. 11,800 

  Discount received Rs. 200 



Paper III Accountancy & Tally Finalised 

444 

 

 25  Purchased Machinery and payment made by cheque Rs. 8,000 

 31 Rent paid by cheque Rs. 1,000 

 

 

9. Prepare three column cash book for the following transactions in the books of 

Satwik 

2011 January 

 1 Satwik started business with cash Rs. 60,000 

 2 Cash deposited at bank Rs. 19,000 

 4 Goods purchased Rs. 12,000 

 6 Sales Rs. 600 

 8 Goods purchased from Aakash & Co Rs. 9,000 

 10 Cheque issued to Aakash & Co Rs. 8,900  

  Discount Received Rs. 100 

 12 Sold goods to Hasini Enterprises Rs. 7,000 

 14 Cash received from samitha Rs. 1,600 

 15 Goods purchased from Charan Rs. 2,500 

 17 Goods sold to Chandrasekhar Rs. 2,750 

 19 Receive cheque from Hasini Rs. 7,000 

 22 Hasini cheque deposited at bank. 

 24 Cheque issued to Charan Rs. 2,400 

  Discount received Rs. 100 

 25 Received cheque from Chandra sekhar Rs. 2,750 

  Cheque deposited in the bank on the same day. 

 27 Cash withdrawn from bank for office use Rs. 2,000 

 28 Cash withdrawn from bank for personal use Rs. 400 

 28 Cash withdrawn from bank for personal use Rs. 200 

 31 Salaries paid by cheque Rs. 3,000 

 

Cash Balance - Rs. 33,000   Bank Balance – Rs. 11,600  

Discount Received – Rs. 200  Discount allowed – Rs. – NIL -  

 

10. Prepare Three column cash book in the books of Jagadeeswari 

2010 July 

 1 Sridhar started business with cash Rs. 20,000 

 1 Cash deposited at bank Rs. 10,000 

 2 Goods purchased for cash Rs. 1,600 

 3 Goods sold to Sudheer Rs. 2,400 and received a cheque from him 

 4 Sudheer Cheque deposited at bank 

 5 Purchased furniture Rs. 800 and payment made by cheque 

 6 Invested in shares Rs. Rs. 6,000 

 8 Cheque received from Sekhar Rs. 4,600   

  Discount Allowed Rs. 250 

 10 Payment made to Devender by Cheque Rs. 3,000  

  Discount received Rs. 250 
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 15 Machinery purchased Rs. 6,000 and payment made by cheque 

 18 Paid to Kishore Rs. 2,800 and received a discount of Rs. 120 

 19 Cash sales Rs. 3,600 

 20 Withdrawn from bank for personal use Rs. 900 

 26 Cash withdrawn from bank for office use Rs. 4,500 

 29 Rent paid in advance Rs. 4,000 

 31 Rent paid by cheque Rs. 600 

 31 Salaries paid Rs. 700 

 31  Electricity charges paid by Cheque Rs. 130 

 

Cash Balance – Rs. 3,000  Bank Balance – Rs. 1,070 
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UNIT – VII 

Bank Reconciliation Statement 
7.1 Introduction 

7.2 Meaning and Advantages 

7.3 Preparation of Bank Reconciliation Statement 

7.4 Overdraft 

 

7.1 Introduction 

Bank maintains an account for each customer in its book.  All the deposits done by the 

customer are recorded on the credit side of customer account and all the withdrawals done by the 

customer are recorded on the debit side of the customer account.  A copy of this account is 

regularly sent to the customer by the bank.  This copy is called “Pass Book”. It is useful to tally 

the firm’s bank transactions as recorded by the bank with the cash book.  But, some times the 

bank balances shown by the cash book and that shown by the passbook may vary.  So it is 

necessary to reconcile the balance shown by the bank column of cash book and balance shown 

by the pass book for a specific period of time. 

 

7.2 Meaning and Advantages 

The statement prepared to reconcile the balances of cash book and pass book is called “Bank 

Reconciliation statement”.  i.e. The  Bank Reconciliation statement is a statement prepared to 

reconcile the difference between the balances as per the bank column of the cashbook and 

passbook  at any given date.  

 

Advantages 

� We can locate the mistakes or errors on either side. 

� Enables the business concern to get up – to – date record of transactions from the bank. 

� Ensure proper evidence of payment 

� Enable the business to identify the cheques deposited at bank by the business but not 

collected in time. 

� It prevents the frauds and misappropriations 

 

7.3 Preparation of Bank Reconciliation Statement 

The preparation of Bank Reconciliation Statement starts with making adjustments to one 

balance to reach the other balance, which ensures agreement between both the balances.  The 

Bank reconciliation statement usually prepared for a specific period means a month, a Quarter, 

half year or a year according to convenience of the firm. 

 

The Bank Reconciliation Statement can be prepared with the balances of Cash book and Pass 

book in the following types. 
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Nature of Balance Cash Book Shows Pass Book Shows 

Favorable Balance Debit Balance Credit Balance 

Unfavorable Balance 

(Over Draft) 

Credit Balance Debit Balance 

 

Illustration of Adjustments 

Particulars Amount 

Rs. 

Bank Balance as per cash book 

(or) 

Over Draft as per Pass Book 

 

Add: 
1. Cheques issued but not presented for payment 

2. Interest allowed by the bank 

3. Interest, Dividend, Bills or any others directly  

Collected by Bank on behalf of customer 

4. Customers paid amount in the bank directly 

5. Wrong entry on the credit side of the passbook 

 

 

Less: 
1. Cheques presented into the bank but not yet 

collected by Bank 

2. Interest, Bank Charges and other expenses 

charged by Bank 

3. Payments directly paid by the bank 

4. Dishonor of cheques, bills by the bank 

5. Cheques debited in cash book but forgot to send 

to bank  

6. Wrong entry on the debit side of the Pass Book 

 

 

 

Balance as per Pass Book (Credit Balance) 

(or) 

Over draft balance as per Pass Book (Credit 

Balance) 

 

 

 

 

 

 

XXX 

XXX 

 

XXX 

XXX 

XXX 

 

 

XXXXX 

 

 

 

 

 

 

 

 

XXXX 

 

 

 

 XXX 

 

XXX 

XXX 

XXX 

 

XXX 

XXX 

XXXXXX 

 

 

 

 

 

 

 

 

XXX 

  

 

XXXXX 
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Favourable Balance 

Illustration 1: 

Prepare Bank Reconciliation statement from the following information. 

 

1. Bank Balance as per cash book Rs. 14,000 

2. Cheques issued but not presented by the customers at bank Rs. 2,500 

3. Cheques submitted to the bank but not collected by bank Rs. 1,000 

4.  Cheque received and entered in the cash book but not presented to bank Rs. 200 

5. Payment directly paid by customer in our bank account Rs. 700 

6. Bank debited bank charges Rs. 14 and credited interest Rs. 25 in the pass book. 

 

Bank reconciliation statement 

Particulars Amount 

Rs. 

Bank Balance as per cash book 

Add: 
1. Cheques issued but not presented at bank 

2. Payment directly paid by the customer into our bank account 

3. Credited bank interest in bank account 

 

 

Less: 
1. Cheques submitted to bank but not collected by bank 

2. Cheques received but not submitted to bank 

3. Bank debited bank charges 

 

 

Bank Balance as per pass book 

 

 

2,500 

700 

25 

14,000 

 

 

 

3,225 

 

 

1,000 

200 

14 

17,225 

 

 

 

1,214 

 16,011 

 

Illustration 2: 

Prepare Bank Reconciliation statement as on 31
st
 December, 2016 from the following 

information. 

1. December 1, 2016  Cashbook showing balance  Rs. 14,000 

2. Cheques issued before the due date but not submitted to the bank by the customers Rs. 4,500 

3. A cheque worth Rs. 3,500 sent to the bank on 16
th

 December but not collected by bank as on 

due date. 

4. A cheque worth Rs. 280 received from the customer and entered in the cash book but not sent 

to the bank for collection. 

5. Interest credited Rs. 90 and debited bank charges Rs. 14 are not entered in the cash book. 
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Bank reconciliation statement as on 31
st
 December, 2016 

Particulars Amount  Rs. 

Bank Balance as per cash book 

Add: 
1. Cheques issued but submitted to bank for payment 

2. Interest credited in pass book 

 

 

Less: 

1. Cheques sent to bank but not collected 

2. Cheques entered in the cash book but not sent to bank 

3. Expenses debited in the pass book 

 

Bank Balance as per pass book 

 

 

4,500 

90 

 

 

 

3,500 

280 

14 

 

 

14,000 

 

 

 

4,590 

 

18,590 

 

 

3,794 

 

14,796 

 

Illustration 3: 

Identify the Bank balance in the cash book of Sitaram  as 31-12-2010 from the following details. 

1. Bank balance as per pass book as on 31-12-2010  Rs. 8,000 

2. Cheques worth Rs. 1,200 issued in the last week of December but those are submitted for 

payment on 2
nd

 January 2011. 

3. Cheques worth Rs. 2,500 deposited in on 26
th

 December are collected before the due date. 

4. Cheques deposited at bank for collection on 29
th

 December 2010 but are collected by bank on 

4
th

 January, 2011 worth Rs. 2,000 

5. Interest on bank balance Rs. 200 entered in the pass book  on 31
st
 December 2010. But it is 

identified by the Sitaram on 8
th

 January, 2011. 

6. Cheques issued on December 15
th

 worth Rs. 600 are presented at bank on December 29
th

. 

7. Salary for the month of December to Sitaram Rs. 1,500 is paid directly to his bank  account. 

8. Divedend on shares amount Rs. 800 is directly collected by bank on December 29
th 

 but it is 

intimated to sitaram on 2
nd

 January, 2011. 

Bank reconciliation statement of Sri Sitaram as on 31
st
 December, 2010 
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Particulars Amount Rs. 

Bank Balance as per pass book 

Add: 
1. Cheques deposited at bank and collected as on 31-12-2010 

 

 

Less: 

1. Cheques issued but submitted for payment as on 31-12-2010 

2. Interest posted in pass book 

3. Salary directly paid to bank account 

4. Dividend directly collected by bank  

 

Bank Balance as per Cash book 

 

 

2,000 

 

 

 

1,200 

200 

1,500 

800 

 

 

8,000 

 

 

2,000 

10,000 

 

 

 

 

3,700 

 

6,300 

 

Note:  

1) Cheque deposited at bank on 26
th

 December is collected by  bank on 31
st
 December, therefore,  

it is not required to adjust in the Bank Reconciliation Statement. 

2) Cheque issued on December 15
th

 is submitted for payment on December 29
th

 , therefore it is 

not required to adjust in the Bank Reconciliation Statement. 

 

7.4  Overdraft:  

 

The excess amount used by the business from its bank current account even though there is 

no balance in its bank current account is called “over draft”. This facility is given by the bank to 

the business persons subject to conditions. 

 

Unfavourable Balance or Overdraft Balance: 

Illustration 4: 

Prepare Bank Reconciliation Statement of Jacob from the following as on 30-06-2010 

a) Overdraft as per pass book as on 30-06-2010 Rs. 540 

b) Cheques issued before 30-06-2010 but not submitted to bank for payment Rs. 2,800 

c) Cheques submitted to bank for collection but not collected by bank as on 30-06-2010 Rs. 

3,900. 

d) Interest on over draft is not posted in cash book Rs. 20 

e) Insurance premium paid by bank is not posted in the cash book Rs. 400 

f) Bank directly collected Interest on investments and posted in the pass book Rs. 500 

Bank Reconciliation Statement of Jacob as on June 30, 2010 
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Particulars Amount 

Rs. 

Over draft as per pass book 

Add: 

1. Cheques issued but submitted to bank for Payment as on due 

date 

2. Interest on investments collected by bank and posted in pass 

book 

 

Less: 

1. Cheques submitted to bank for collection but not collected by 

bank as on due date 

2. Interest  on over draft 

3. Insurance premium paid by bank 

 

Bank balance as per cash book 

 

 

 

2,800 

 

 

500 

 

 

3,900 

20 

400 

 

 

540 

 

 

 

 

3,300 

3,840 

 

 

 

 

4,320 

 

480 

 

 

 

Illustration 5: 

 Raman pass book showing Rs. 20,600 over draft as on  31-12-2009  

1. Cheques issued before 31-12-2009 but not submitted to the bank for payment Rs. 1,600 

2. Cheques submitted to bank but not credited as on 31-12-2009 Rs. 4,500 

3. Bank debited interest on over draft Rs. 250 

4. Interest on Investments Rs. 1,400 collected by bank is credited in pass book only. 

5. Bank charges Rs. 24 not posted in the cash book. 

6. Cheque dishonored worth Rs. 1,500 is posted in pass book only.  

 

Bank Reconciliation Statement of Raman  as on 31
st
 December, 2009 

Particulars Amount 

Rs. 
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Over draft as per pass book 

Add: 
1. Cheques issued but submitted to bank for Payment as on due 

date 

2. Interest on investments collected by banker and credited in 

pass book 

 

Less: 

1. Cheques submitted to bank for collection but not collected by 

bank as on due date 

2. Interest  on over draft 

3. Bank charges posted in pass book 

4. Dishonored cheque 

 

Bank over draft balance as per cash book 

 

 

 

1,600 

 

1,400 

 

 

 

4,500 

250 

24 

1,500 

 

 

20,600 

 

 

 

 

3,000 

23,600 

 

 

 

 

 

6,274 

 

17,326 

 

Short Answer type Questions 

1. Define Pass Book. 

2. Define Bank Reconciliation Statement. 

3. Define Over draft. 

Long Answer Type Questions 

1. Explain the importance of Bank Reconciliation Statement. 

Exercises 

1. Prepare Bank Reconciliation Statement of Rayudu Prasad as on 31 March 2011 

a. Balance as per cash book Rs. 5,877. 

b. Cheques issued but submitted to bank for payment Rs. 2,013 

c. Cheques deposited but not collected by bank as on due date Rs. 1,419 

d. Banker wrongly debited Rs. 225 in the pass book. 

Ans: Bank balance as per cash book Rs. 6,246  

 

2. Prepare Bank Reconciliation Statement of Bhargav as on 31
st
 December, 2015 

a. Bank balance as per pass book Rs. 6,245 

b. Cheques issued but not submitted to bank for payment 

1. Mahitha & Co  Rs. 459 

2. Srikanth Enterprises Rs. 596 

3. Tanuja Jewellers    Rs. 957 

c. Cheques submitted to bank but not collected by bank 

1. Nagalakshmi Textiles Rs. 506 

2. Satyaveni Refreshments Rs. 913 

d. Banker wrongly debited Rs. 225 in the pass book and rectified on 4
th

 January, 2016 

Ans: Bank balance as per cash book Rs. 5,877 
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3. Bank balance as per pass book as on 31
st
 March, 2011 

I. Bank balance as per pass book as on 31-03-2011 Rs. 25,000 

II. Cheques sent to bank for collection worth Rs. 4,000 but bank collected cheques worth Rs. 

2,000 in the month of April. 

III. Cheques issued worth Rs. 2,500 as on 25
th

 March but cheques worth Rs. 1,500 only 

submitted to bank for payment. 

IV. Pass book was wrongly debited by Rs. 100 

V. Bank charges Rs. 25 posted in pass book only. 

VI. Bank directly collected interest on investments Rs. 400 and posted in pass book  but not 

shown in cash book. 

VII. Cheque received from customer worth Rs. 150 posted in cash book but not sent to bank 

for collection. 

Ans: Bank balance as per cash book Rs. 25,875 

 

4. Prepare Bank Reconciliation Statement and identify the pass book balance as on 31
st
 March, 

2013. 

a. Cheques worth Rs. 600 deposited in the current account in march 2013. But, bank 

credited in  April. 

b. Cheques issued worth Rs. 1,100 in the month of March but paid by bank in April. 

c. Bank charges Rs. 10 is appearing in the pass book twice. But it was not posted in the cash 

book atleast once. 

d. Cheque directly deposited in the bank account worth Rs. 500 is not shown in the cash 

book. 

e. A cheque worth Rs. 200 was dishonored and returned by the bank. 

f. Rs. 400 worth cheque posted in cash book twice but it is appearing in the pass book only 

once. 

g. Banlace as per cash book as on 31
st
 March, 2013 

 

Ans: Bank  balance as per pass book Rs. 3,580 

 

 

 

5. Find the correct bank balance of Stella Joseph on 31
st
 December, 2014 from the information 

gathered from Cash book as well as Pass book. 

i. Bank balance as per cash book Rs. 2,980 and Bank balance as per pass book Rs. 6,830. 

ii. Cheques worth Rs. 5,000 sent to bank for collection but collected Rs. 3,800 only. 

iii. Cheques issued worth Rs. 4,600 but submitted to bank for payment Rs. 3,900 only. 

iv. A customer of Stella Joseph directly deposited in the bank account Rs. 5,000. 

v. Interest on Bank Over Draft is recorded in the  pass book only Rs. 150. 

vi. A hudie worth Rs. 2,500 discounted earlier was dishonored by the bank. 

vii. Interest on fixed deposits Rs. 400 recorded in pass book. 

viii. Cash paid to a creditor Rs. 1,000 erroneously entered in the bank column of cash book. 

ix. Cheque issued but cancelled later worth Rs. 600 is recorded as issued but cancellation 

was not recorded. 
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Ans: Bank balance as per cash book Rs. 6,830.  

Note: Bank bank balance as per cash book was considered in the above problem. 

Note: If two balances i.e. cash book as well as pass book in the problem solve the problem by 

considering one balance to identify the another.  

 

6. Prepare Bank Reconciliation Statement of Razia Begum as on 31
st
 March, 2009 from the 

following information. 

a. Bank over draft as per cash book ason 31-03-2009 Rs. 2,000 

b. Cheques issued but not submitted to bank for payment Rs. 1,350 

c. Cheques deposited at but not collected by  banker Rs. 560 

d. Expenses recorded in the pass book only Rs. 80 

e. Interest on investments directly collected by Bank and posted in pass book Rs. 905 

Ans: Overdraft as per pass book 385 

 

7. Prepare Bank Reconciliation Statement of Hema as on 31-12-2011 from the following details 

A. Over draft as per  pass book as on 31-12-2011 Rs. 1,027 

B. Cheques issued on 31-12-2011 but paid by bank in month of January bank Rs. 1,244  

C. Interest on over draft Rs. 51 was not posted in cash book. 

D. Cheques received worth Rs. 5,340 on 30-12-2011 are posted in cash book but are sent to 

bank in the month of January,2012. 

E. Chechbook value Rs. 29 was reposted in the cash book in month of November. 

F. Bill receivable worth Rs. 250 was sent to bank on 28-12-2011  and posted in the cash 

book but collected by bank in the month of January,2012. 

G. Central Exise paid Rs. 10 paid by bank on 01-12-2011 but not posted in the cash  book. 

H. Bank charges Rs. 15 posted in the pass book twice. 

Ans: Bank balance as per cash book Rs. 3,345 

 

8. Prepare Bank Reconciliation statement to Identify the pass book balance of Pavithra as on 

31-12-20014. 

a. Over draft as per cash book as on 31-12-20014 Rs. 3,000. 

b. Interest on over draft for six months Rs. 100 was debited in pass book only. 

c. Bank debit bank charges in the pass book Rs. 25. 

d. Cheques issued but not submitted to bank for payment by the customers Rs. 750. 

e. Cheques submitted to bank for collection but not collected by bank Rs. 2,500. 

f. Interest on investments Rs. 900 collected by bank and posted in the pass book. 

Ans: Over draft as per pass book Rs. 3,975 
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UNIT – VIII 

TRIAL BALANCE AND RECTIFICATION 
 

8.1 Meaning and Significance 

8.2 Features and Objectives of Trial Balance 

8.3 Preparation of Trial Balance 

8.4 Errors disclosed and not disclosed by Trial Balance 

 

8.1 Meaning and Significance 

To verify the accuracy of the postings after completion of postings in the Journal or 

Subsidiary Books to the ledger it is needed to prepare a statement by the businessmen. The 

statement where in the balances of all the accounts in the ledger are incorporated is called as 

“trial balance”.  The totals of the debit side in the trial balance should be equal to the  totals of 

credit side. 

 

According to J.R.Batliboi Trial balance is a statement, prepared with the debit and credit 

balances of ledger to test the arithmetical accuracy of the books. 

According to Carter  “Trial balance is the list of debit and credit balances, taken out from 

ledger .  It also includes the balances of cash and bank taken from cash book”. 

According to Spicer and Peglar, “ A trial balance is a list of all the balances standing on the 

ledger accounts and cash book of a concern at any given date. 

 

8.2 Features and Objectives of Trial Balance 

1. It is a working statement and not an account. 

2. It is not an account, it is only a statement which is prepared to verify the arithmetical 

accuracy of ledger accounts. 

3. It is a list of balances of all ledger accounts and the cash book. 

4. It is always prepared on a particular date and not for a particular period. 

5. It is prepared at the end of accounting year before preparing the final accounts. 

 

8.3 Preparation of Trial Balance 

The following points are to be kept in mind while preparing the Trial Balance. 

1.  Not required to use “To” or “By” due to it is a statement. 

2. The debit column shows all the Purchases, Sales Returns, Assets, Expenses 

3. The credit column shows all the Sales, Purchase Returns, Liabilities, incomes. 

4. Show reserves and surpluses / reserve funds / provisions in credit columns, doubtful 

debts, General reserve, Reserve fund etc. 

5. Show intangible assets in debit column Ex: Goodwill, Patents, Royalties, Trademarks, 

Copyrights etc. 
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Illustration of transferring balances to Trial Balance 

 

S.L.No Nature of Accounts L.F. Balances shown 

Dr. / Cr. 

 

1. 

2. 

3. 

4. 

5. 

6. 

7. 

8. 

9. 

10. 

11. 

 

 

12. 

13. 

14. 

15. 

16.  

17. 

18. 

 

 

19. 

20. 

21. 

22. 

23.  

24. 

25. 

26. 

 

 

I. Personal Accounts  

Capital Account 

Drawings Account 

Sundry Debtors 

Sundry Creditors 

Bank balance 

Expenses to be paid 

Expenses paid in advance 

Incomes to be received 

Incomes received in advance 

Bills payable 

Bank Over draft 

 

II. Real Accounts 

Opening Stock 

Goodwill 

Trademarks, Copy rights 

Bills receivable  

Buildings and Lands 

Machinery and Furniture 

Investments 

 

III. Nominal Accounts 

Purchases (Goods) 

Purchase returns (Goods) 

Sales (Goods) 

Sales Returns (Goods) 

Expenditure accounts 

Losses accounts 

Income accounts 

Profit accounts 

 

All types of Reserves  

  

Credit 

Debit 

Debit 

Credit 

Debit 

Credit 

Debit 

Debit 

Credit 

Credit 

Credit 

 

 

Debit 

Debit 

Debit 

Debit 

Debit 

Debit 

Debit 

 

 

Debit 

Credit 

Credit 

Debit 

Debit 

Debit 

Credit 

Credit 

 

Credit 

Note: While transferring the balances in to the trial balance, all assets and expenses accounts are 

placed in the debit column and all liabilities and income are place in the credit column. 
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The format of Trial Balance is as follows. 

S.L.No Nature of Accounts L.F. Balances 

Dr. Rs. 

Balances 

Cr. Rs. 

     

 

 

Suspense Account:  

 Suspense Account is an account prepared to transfer the difference amount identified for 

time being, suspense account will be shown in the Trial Balance.  Suspense account gets closed 

automatically as and when all the errors which caused the disagreement in the trial balance are 

rectified.  Suspense account may be shown either side of the trial balance depending on net effect 

of the Trial Balance. 

 

Illustration 1: 

Prepare the trial balance from the following balances of different ledger accounts. 

       Rs.         Rs. 

Cash A/c   53,500   Sales A/c  2,000 

Capital A/c  60,000   Slaries A/c  1,000 

Purchases A/c    6,000   Commssion A/c 1,000 

Pinakapani  A/c   2,000   Sunitha A/c      500 

 

Trial Balance 

S.L.No Nature of Accounts L.F. Balances 

Dr. Rs. 

Balances 

Cr. Rs. 

1. 

2. 

3. 

4. 

5. 

6. 

7. 

8. 

 

Cash A/c 

Capital A/c 

Purchases A/c 

Pinakapani A/c 

Sales A/c 

Salaries A/c 

Commission A/c 

Sunitha A/c 

 

 

                                 Total 

 53,500 

 

 6,000 

 2,000 

 

1,000 

 

500 

 

 

63,000 

 

60,000 

 

 

2,000 

 

1,000 

 

 

 

63,000 

 

Illustration 2: 

Prepare the Trial balance from the following balances. 

       Rs.            Rs. 

Capital    19,000   Stationery        150 

Cash in bank   14,000   Unloading Charges         70 
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Cash in hand      1,430  Salaries        150 

Rent paid         300  Commission paid       100 

Sundry Creditors        150  Discount Received       400 

Purchases     3,570   Bills receivable       450 

Sales      4,630   Sundry Debtors       520 

Purchase Returns       400   Bills Payable     1,000 

Sales Returns         140   Goodwill     5,000 

Furniture        700   Andhra Bank over draft   1,000 

Trial Balance 

S.L.No Particulars 
Amount  

Dr. Rs. 

Amount 

Cr. Rs. 

1 Capital   19,000 

2 Cash in bank 14,000   

3 Cash in hand 1,430   

4 Rent 300   

5 Sundry Creditors   150 

6 Purchases 3,570   

7 Sales   4,630 

8 Purchase Returns   400 

9 Sales Returns 140   

10 Furniture 700   

11 Stationery 150   

12 Unloading charges 70   

13 Salaries 150   

14 Commission 100   

15 Discount   400 

16 Bills receivable 450   

17 Sundry Debtors 520   

18 Bills payable   1,000 

19 Good will 5,000   

20 Andhra bank  over draft   1,000 

        

   Total 26580 26580 

        

 

8.4 Errors disclosed and not disclosed by Trial Balance 

 

Errors not disclosed by Trial Balance 

 This type of errors can not be traced out in the preparation of trial balance, because these 

errors cannot affect the agreement of Trial Balance. 

 The main errors not disclosed by the trial balance are given below 

1. Errors of Principle 
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2. Errors of omission 

3. Errors of  Commission 

4. Compensating Errors 

5. Writing to wrong head of account 

 

1. Errors of Principle : Errors which are committed by violating the principles of (rules of) 

accounting.  These errors may arise, when the distinction is not made between the capital and 

revenue nature items.  

 

2. Errors of Omission: When a transaction is completely or partly omitted from the books of 

accounts such error is known as error of omission. 

 

1. When no entry is made for a transaction in Journal. 

Ex: Purchase of goods are not recorded in the books of original entry. 

2. If an entry is not made for a transaction in the subsidiary book. 

Ex: Paid cash to Arjun traders not entered in cash book. 

 

3. Error of Commission: The errors arise due to wrong recording, Wrong casting, Wrong entry 

forwarding, Wrong posting, Wrong Balancing are error of commission. 

1. Wrong Recording: If a transaction is incorrectly recorded in the books of original is 

called error of commission. 

Ex: Sales of Rs. 168 recorded as Rs. 861 

2. Wrong Casting: When the mistake is committed in totaling is called error of 

commission.  This error affects the agreement of trial balance.   

Ex: Purchase book under cash by 100. 

 

4. Compensating Errors: If two or more errors are committed and one error multi field the 

another error.  The net effect is unchanged.  Committing an error to compensate the previous 

or another error is known as compensating error. 
  

5. Writing to wrong head of account: Instead of recording one account, recording another 

account is known as writing to wrong head of account. 

 

Errors disclosed by Trial Balance 

 The errors which are revealed by the trial balance are known as errors disclosed by trial 

balance. 

 The following are the errors disclosed by trial balance: 

1. Posting of transactions to wrong side of an account 

Ex: Discount allowed posted to the credit side of discount account. 

2. Posting of wrong amount to an account 

Ex: Purchase of Rs. 50,000 posted as Rs. 5,000 to Purchase account. 
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3. Errors in totaling:  Wrong totaling made either in subsidiary books or in ledger affects 

the agreement of Trial Balance. 

4. Errors of Carrying forward: If a mistake is committed in carrying forward a total of 

one page to the next page.  This error affects the agreement of trial  balance. 

5. Posting of only one aspect of Journal Entry into ledger: Some times accountant may 

post only one aspect of the entry to the ledger account. 

6. Recording one aspect twice:  An account may be recorded twice in the journal.   

Ex: Paid salaries Rs. 1,000 debited twice to Salaries account. 

 

 

Short Answer type Questions 
1. Define Trial Balance. 

2. Define Suspence Account. 
 

Long Answer Type Questions 
1. Write the errors disclosed and not disclosed by  Trial Balance. 

 

Exercises 

1. Prepare Trial Balance from the following balances of Prabhakar. 

      Rs. 

Opening Balance          2,000 

Sales     21,000 

Purchases     15,600 

Sales Returns               900 

Commission Received in advance   2,500 

Depreciation      1,200 

Machinery     20,000 

Sundry Debtors      5,000 

Sundry Creditors      4,400 

Discount received from Creditors        300 

Capital     14,000 

Commission Received      3,500 

Ans:  Total Rs. 44,700 

 

2. Prepare Trial Balance from the following balances of Bhagya Lakshmi Enterprises 

Particulars Rs. Particulars Rs. 

Capital 3,100 Sales 4,000 

Cash in hand 250 Sundry Debtors 1,950 

Bills Receivable 3,275 Bills Payable 2,375 

Buildings 3,000 Bank Over Draft 2,000 

Purchases 3,000     

Ans Total Rs. 11,475 
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3. Prepare trial balance from the following balances of Mrudula Jiyyengar. 

Name of the account Rs. Name of the account Rs. 

Opening Stock 1,50,000 Machinery 1,16,000 

Purchases 1,50,000 Debtors 40,000 

Purchase Returns 20,000 Creditors 36,000 

Sales  3,00,000 Bills payable 13,600 

Sales Returns 28,200 Bills Receivable 12,500 

Rent 2,690 Cash in hand 14,800 

Salaries 14,200 Bank over draft 20,000 

Advertisements 2,100 Interest on over draft 2,400 

Commission Received 2,200 Capital 1,70,000 

Discount (Cr.) 1,290 Drawings 14,000 

Furniture 14,000     

Ans: Total Rs. 5,61,990 

 

 

 

4. Prepare the Trial Balance from the following balances of Chittiyar as on 31
st
 March, 2017. 

Name of the account Rs. Name of the account Rs. 

Stock on 1st April, 2017 120,000 Investments 125,000 

Purchases 250,000 Interest on Investments 20,800 

Sales 600,000 Cash balance 13,600 

Carriage Inwards 3,000 Premises 200,000 

Carriage Outwards 1,200 Fixtures 68,000 

Return Inwards 20,000 Miscellaneous Expenses 2,200 

Return Outwards 10,000 Miscellaneous Incomes 1,800 

Debtors 115,000 Loan from Canara Bank 115,000 

Creditors 110,000 Interest on canara bank loan 18,000 

Bad Debts 6,000 Capital 300,000 

Stationery 4,200 Drawings 30,000 

Insurance 3,400 Computers 28,000 

Wages and salaries 50,000 Goodwill 100,000 

Ans: Total Rs. 11,57,600 
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5. Prepare the Trial Balance of Sridhar  

Name of the account Rs. Name of the account Rs. 

Cash in hand  18,600 Return Outwards 3,610 

Machinery 40,000 Return Inwards 10,250 

Purchases 69,000 Capital 50,000 

Debtors 28,250 Drawings 10,000 

Carriage Inward 2,110 Bank Loan 25,000 

Carriage Outward 750 Interest on Loan 2,600 

Wages 18,600 Opening Stock 35,000 

Rent and Taxes 5,250 Sales 140,000 

Sundry Creditors 21,200 Discount Received 2,100 

Discount Allowed 1,500     

Ans: Total Rs. 2,41,910 

 

6. Prepare the Trial Balance of  S.N.L. Industries as on 31
st
 March, 2018. 

Name of the account Rs. Name of the account Rs. 

Cash In hand 8,200 Debtors 16,200 

Bank Over Draft 10,000 Creditors 4,000 

Opening Balance 35,000 Bills receivable 1,800 

Purchases 72,000 Bills Payable 4,100 

Purchase Returns 4,000 Capital 40,000 

Sales 125,500 Drawings 4,000 

Sales returns 4,000 Rent 1,700 

Travelling Expenses 2,100 Salaries 2,100 

Discount allowed 800 Loan (Cr) 15,000 

Discount received  2,500 Interest on loan 1,200 

Machinery 20,000     

Land and Buildings 36,000     

Ans: Total Rs. 2,05,100 

 

7. Prepare the  Trial Balance of Kasim & Co 

Particulars Rs. Particulars Rs. 

Opening Stock 20,000 Purhases 24,000 

Sales 29,000 Debtors 15,000 

Creditors 20,000 Salaries 2,000 

Cash 18,000 Capital 30,000 

Ans: Total Rs. 79,000 
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8. Prepare the  Trial Balance of Mr. Naresh from the following balances as  on 31-12-2010. 

Particulars Rs. Particulars Rs. 

Cash at Bank 30,000 Cash in Hand 14,000 

Salaries 2,500 Purchases 2,56,500 

Sales 3,00,000 Opening stock 25,000 

Buildings 30,000 Bills Payable 10,000 

Bills Receivable 10,000 Capital 58,000 

Ans: Total Rs. 3,68,000 

 

9. Prepare the  Trial Balance of Saraswathi as on 31-12-2017. 

Particulars Rs. Particulars Rs. 

Opening Stock 11,500 Sales 42,000 

Purchases 25,000 Salaries 3,500 

Carriage 1,000 Debtors 6,000 

Creditors 5,000 Cash in  Bank 10,000 

Capital 10,000     

Ans: Total Rs. 57,000 

 

10. Prepare the Trial Balance of Nasreen as on 31-12-2010. 

Particulars Rs. Particulars Rs. 

Cash in Hand 10,000 Buildings 12,000 

Debtors 16,000 Sales 45,000 

Opening Stock 12,000 Capital 25,000 

Purchases 22,000 Bills Payable 2,000 

Ans: Total Rs. 72,000 

 

11. Prepare Trial Balance of Visalakshi from the following balances. 

Particulars Rs. Particulars Rs. 

Carriage 600 Creditors 4,000 

Capital 15,000 Sales 31,000 

Salaries 4,000 Debtors 18,000 

Cash at bank 5,400 Purchases 22,000 

Ans: Total Rs. 50,000 
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12. Prepare Trial Balance of Jessi Rose from the following balances. 

Particulars Rs. Particulars Rs. 

Opening Stock 10,000 Sales 10,000 

Bills Payable 1,600 Returns outwards 2,400 

Bills Receivable 2,000 Salaries 600 

Purchases 6,000 Capital 5,000 

Returns Inwards 400     

Ans: Total Rs. 19,000 

 

13. Prepare Trial Balance of Sudha from the following balances. 

Particulars Rs. Particulars Rs. 

Capital 50,000 Buildings 20,000 

Furniture 10,000 Salaries 6,000 

Sundry Creditors 10,000 Drawings 2,000 

Cash 30,000 Purchases 10,000 

Sundry Debtors 10,000 Sales 28,000 

Ans: Total Rs. 88,000 

 

14. Prepare Trial Balance of Rani from the following balances. 

Particulars Rs. Particulars Rs. 

Bills Receivable 18,000 Furniture 33,000 

Capital 50,000 Capital 25,000 

Sales 40,000 Salaries 4,000 

Machinery 35,000 Drawings 5,000 

Bills Payable 11,600 Return Inwards 6,600 

Purchases 25,000     

Ans: Total Rs. 1,26,600 
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UNIT – IX 

FINAL ACCOUNTS 

 
9.1.1 Trading account 

9.1.1 Meaning and Significance 

9.1.2 Performance of Trading Account 

9.1.3 Adjustments 

9.1.4 Outstanding expenses, Prepaid expenses, Depreciation 

9.2 Profit and Loss Account 

9.2.1 Meaning and Significance 

9.2.2 Steps in preparation of Profit and Loss Account 

9.2.3 Performance of Profit and Loss Account 

9.2.4 Adjustments 

9.3 Balance Sheet 

9.3.1 Meaning and Significance 

9.3.2 Objectives 

9.3.3 Preparation of Balance Sheet 

9.3.4 Arrange of Assets and Liabilities 

9.3.5 Adjustments 

 

9.1 Trading account 
 

9.1.1 Meaning and Significance 

An account is to be prepared to know the results of trading activities carried during the 

accounting period is termed as “Trading account”. Preparation of Trading account is the 

primary stage of final accounts.  Purchasing of goods from others and selling them to others is 

called trading.  Trading account is a nominal account. The trading expenses should be debited 

and the trading incomes should be credited to this account. The outcome of the trading account is 

either gross profit or gross loss.  The trading account is to be prepared to find out the difference 

between actual cost of goods sold and sale proceeds. 

Cost of goods sold = Purchase price of the goods + Expenses incurred on purchases. 

 

If Opening stock and Closing stock of goods are given, 
Cost of Goods Sold = Opening Stock + Net Purchases (Cash + Credit – Returns) +Direct Expenses – 

Closing Stock of Goods 

 
Gross Profit / Loss = Net Sales – Cost of Goods Sold 
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 If the selling price of goods is more than cost price, it is known as gross profit.  If the 

selling price of goods is less than cost price, it is known as gross loss.  The gross profit or gross 

loss of trading account will be transferred to Profit & Loss Account. 

9.1.2 Performance of Trading Account 

� It reveals either Gross Profit or Gross Loss. 

� Gross Profit / Gross Loss Ratio can be calculated. 

� Trading expenses and incomes of the current year can be compared with  that of the 

previous year. 

� On the basis of the current year and previous years trading accounts, the trader can 

estimate his trade revenue for future years. 

 Preparation of Trading account 

 Trading Account can be prepared in one of the following two proformas. 

� Horizontal  

� Vertical 

Horizontal Proforma: 

Dr.   Trading Account for the year ending ______    Cr. 

Particulars Amount 

Rs. 

Amount 

Rs. 

Particulars Amount 

Rs. 

Amount 

Rs. 

To Opening Stock 

To Purchases 

Less Purchase Returns 

 

Purchase Expenses 

To Carriage 

To Cartage 

To Freights 

To Customs Duties 

To Import Duties 

To Clearing charges 

Direct Expenses 

To Wages 

To Factory Rent 

To Factory Insurance 

To Gas and Coal 

To Water Charges 

To Factory Manger’s 

Salary 

To Work Manager’s Salary 

To Oil & Fuel 

To Manufacturing 

Expenses 

To Heating and Lighting 

To Gross Profit 

 

XXXX 

(-)XXX 

XXXX 

 

XXXX 

 

 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

 

XXXX 

By Sales 

Less: Sales Returns 

 

By Closing Stock 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

By Gross Loss 

(Transferred to 

Profit & Loss 

Account) 

XXXX 

XXX 

 

XXXX 

 

XXXX 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

XXXX 
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(Transferred to Profit & 

Loss Account) 

XXXX XXXX 

  

Vertical Proforma: 

Trading Account for the year ending _________________ 

Particulars Amount 

Rs. 

Amount 

Rs. 

I. Net Sales 

      Sales 

      Less: Sales Returns 

 

II.  Less: Cost of Goods Sold: 

1. Opening Stock of Goods 

2. Purchases 

Less: Purchase Return 

 

3. Purchase Expenses 

Less: Closing Stock of Goods 

 

4. Direct Expenses 

 

 

Gross Profit / Gross Loss(I – II) 

 

XXX 

XXXX 

 

 

XXXX 

 

 

 

 

 

 

 

 

XXX 

 

 

 

XXXX 

 

XXXX 

(XXXX) 

XXXX 

XXXX 

(XXXX) 

XXX 

Illustration 1: 

Prepare Trading account of Seshu from the following information as on  31-12-2015 

        Rs.          Rs. 

Opening Stock of Goods  25,000  Wages      2,000 

Purchases    23,000  Carriage     1,000 

Sales     56,000  Coal & Gas        500 

Sales Returns      1,000  Factory Rent     1,000 

Purchase Returns     2,000  Closing Stock     2,000 

 

Dr.    Trading account of Seshu as on 31-12-2015   Cr. 

Particulars 
Amount 

Rs. 

Amount 

Rs. 
Particulars 

Amount 

Rs. 

Amount 

Rs. 

To Opening Stock of 

Goods   25,000 By Sales 56,000   

To Purchases 23,000   Less: Sales Returns 1,000 55,000 

Less: Purchase Returns 2,000 21,000 By Closing Stock   2,000 

To Wages   2,000       

To Carriage   1,000       

To Coal & Gas   500       
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To Factory Rent   1,000       

To Gross Profit 

(Transferred to Profit & 

Loss account)   6,500       

    57,000     57,000 

 

Illustration 2 

Prepare trading account of Bhargavi Sandhya  Enterprises for the year ending 31-03-2018 

     Rs.     Rs. 
 

 

 

 

 

 

 

 

 

 

 

 

Dr. Trading account of  Bhargavi Sandhya  Enterprises for the year ending 31-03-2018   Cr. 

 

Particulars 
Amount 

Rs. 

Amount 

Rs. 
Particulars 

Amount 

Rs. 

Amount 

Rs. 

To Opening Stock   15,000 By Sales 42,000   

To Purchases 21,000   Less: Sales Returns 800 41,200 

Less: Purchase Returns 1,500 19,500 By Closing Stock   3,200 

To Carriage   1,300       

To Factory Insurance   900       

To Gas and Water   1,400       

To Wages   2,500       

To Import Duties   500       

To Gross Profit (Transferred 

to Profit & Loss account)   3,300       

    44,400     44,400 

 

9.1.3 Adjustments 

One of the most important adjustment and its accounting treatment in trading account is  

“Adjustment relating to Closing Stock”. 

 

Closing stock is the stock of goods unsold at the end of the accounting year.  This does not 

appear in the trial balance. 

Accounting treatment in final accounts 

1. Shown on the credit side of the trading account. 

Opening Stock 15,000 Wages 2,500 

Purchases 21,000 Import Duties 500 

Purchase Returns 1,500 Sales 42,000 

Carriage 1,300 Sales Returns 800 

Factory Insurance 900 Closing Stock 3,200 

Gas and Water 1,400 
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2. Shown on the assets side of the balance sheet. 

 

9.1.4 Outstanding expenses, Prepaid expenses 

Out standing Expenses: Expenses relating to the current accounting period but not yet paid and 

are to be paid in the next year is known as outstanding expenses. 

Ex: Wages for the month of march is due but not paid. 

Accounting treatment of in final accounts 

1. Add  to the concerned expenditure item in Trading account. 

2. Show as liability on liabilities side of the balance sheet. 

 

Prepaid Expenses: Expenses relating to the next accounting year but paid in the current 

accounting period is called pre – paid expenses or expenses paid in advance. 

Ex: Wages or prepaid insurance paid in advance 

Accounting treatment in final accounts 

1. Deduct from the concerned expenditure in the trading account. 

2. Record in balance sheet on assets side. 

 

Manufacturing Account 

 The organizations which manufacture or produce goods will prepare manufacturing 

account.  Manufacturing account is a nominal account, hence all the expenses of goods, factory 

to be shown on debit side.  Balance of this account is known as cost of production (Debit 

Balance) and is to be transferred to the trading account. 

 

Dr.  Manufacturing account of _______  for the year ended _____    Cr. 

 

Particulars Amount 

Rs. 

Amount 

Rs. 

Particulars Amount 

Rs. 

Amount 

Rs. 
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To Opening Stock 

a) Raw Materials 

b) Partly finished goods 

c) Finished Goods 

 

To Purchases 

Less: Purchase Returns 

 

To Wages (Production) 

To Carriage 

To ClearingCharges 

To Gas & Coal 

To Oil & Fuel 

To Factory Rent, 

Insurance and Lighting 

To Motive Power 

 

 

 

 

 

XXXX 

XXXX 

XXXX 

 

XXXX 

XXXX 

 

 

 

XXXX 

 

 

XXXX 

 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

 

 

  

XXXX 

By Closing Stock 

a) Raw Materials 

b) Partly Finished 

Goods 

c) Finished Goods 

 

 

 

 

 

 

 

 

 

 

By Cost of Production 

( Transferred to Trading 

Account) 

 

XXXX 

XXXX 

 

XXXX 

 

 

 

 

XXXX 

 

 

 

 

 

 

 

 

 

 

XXXX 

 

 

 

XXXX 

 

9.2 Profit and Loss Account 

9.4.1 Meaning and Significance 

 After preparation of Trading Account, the Profit & Loss account is to be prepared to 

find out the net profit or net loss of the business.   

9.4.2 Steps in preparation of Profit and Loss Account 

 This is a nominal account, so all the expenses and losses should be debited and all the 

incomes and gains to be credited to Profit & Loss account.  The balance of Profit & Loss 

Account is either net profit or net loss and the same is to be added to / deducted from Capital 

Account in Balance Sheet. 

Proforma: 

Horizontal Form: 

Dr.   Profit & Loss A/c of _____ for the year ending ______  Cr. 

Particulars Amount 

Rs. 

Amount 

Rs. 

Particulars Amount 

Rs. 

Amount 

Rs. 

To Gross Loss b/d 

To Administrative Expenses 

To Salaries 

To Rent 

To Rates & Taxes 

To Insurance 

To  Printing & Stationery 

To Audit Expenses 

 XXXX 

 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

By Gross Profit b/d 

By Discount Received 

By Interest Received 

By Commission Received 

By Rent Received 

By Interest on Drawings 

By Apprentice Premium 

By Profit on sale of assets 

 XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 
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To Legal Expenses 

To General Expenses 

To Repairs 

To Selling & Distribution 

Expenses 

To Carriage Outwards 

To Advertisements 

To Bank Charges 

To Commission 

To Bad Debts 

To Travelling Expenses 

To Packing Expenses 

To Financial Expenses 

To Discount Allowed 

To Interest on Capital 

To Interest on Loans 

To Losses 

To Loss on sale of assets 

To Depreciation 

To Loss due to Fire Accident 

 

To Net Profit (Transferred to 

Capital Account) 

 

XXXX 

XXXX 

XXXX 

 

 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

 

XXXX 

XXXX 

XXXX 

 

XXXX 

XXXX 

XXXX 

 

XXXX 

 

XXXX 

By Bad Debt recovered 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

By Net Loss (Transferred to 

Capital Account 

XXXX 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

XXXX 

 

xxxxx 
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Vertical Form: 

Particulars Amount 

Rs. 

Amount 

Rs. 

1. Gross Profit / Gross Loss 

2. Add: Incomes 

d) Discount received 

e) Commission received 

f) Interest received 

g) Rent received 

h) Profit on sale of assets 

i) Interest on Drawings 

 

 

3. Less: Expenses 

a) Administrative Expenses 

b) Selling and Distribution expenses 

c) Financial Expenses 

d) Losses 

 

 

Net Profit / Net Loss 

 

 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

XXXX 

 

 

 

 

 

 

XXXX 

 

XXXX 

XXXX 

XXXX 

XXXX 

 

XXXX 

 

 

( -XXXX) 

  XXXX 

 

Illustration 1: 

Prepare the Profit and Loss Account from the following balances of Ravi Kumar as on 31-03-

2015 

              Rs.         Rs. 

Salaries 30,000 Discount Allowed 2,500 

Gross Profit 100,000 Loss incurred in fire accident 4,000 

Printing & Stationery 850 Rent, Insurance 5,000 

Courier Charges 750 Received Dividend 2,000 

Discount received 2,000 Misc. Expenses 4,000 

Cartage 2,000 Bad Debts 1,500 

Advertisements 2,500 Apprentice Premium 2,000 

Rent Received 1,500 Interest on Drawings 2,500 

Depreciation 3,000 Profit in sale off asset 2,000 

Repairs 2,000   
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Dr.   Profit & Loss Account of Ravi Kumar as on 31-03-2015  Cr. 
 

Particulars 
Amount 

Rs. 
Particulars 

Amount 

Rs. 

To Salaries 30,000 By Gross Profit 100,000 

To Rent, Insurance 5,000 By Discount received 2,000 

To Printing & Stationery 850 By Received Dividend 2,000 

To Courier Charges 750 By Rent Received 1,500 

To Mis. Expenses 4,000 By Apprentice Premium 2,000 

To Cartage 2,000 By Interest on Drawings 2,500 

To Advertisements 2,500 By Profit in sale off asset 2,000 

To Bad Debts 1,500     

To Depreciation 3,000     

To Rapares 2,000     

To Discount Allowed 2,500     

To Loss incurred in fire accident 4,000     

To Net Profit  

(Transferred to Capital Account) 53,900     

  112,000   112,000 

 

Illustration 2: 

Prepare Profit and Loss Account of Sri. Venkateswara Rao on 31-03-2015 from the following 

balances. 

Gross Profit 32,500 Mis. Expenses 1,000 

Rent 4,200 Office Expenses 1,200 

Salaries 5,000 Legal Expenses 1,000 

Bad Debts Recovered 2,000 Discount received 750 

Discount Allowed 500 Trade Expenses 2,000 

 

Dr.   Profit & Loss Account of Sri . Venkateswara Rao on 31-03-2015         Cr. 

Particulars 
Amount 

Rs. 
Particulars 

Amount 

Rs. 

To Rent 4,200 By Gross Profit 32,500 

To Salaries 5,000 By Bad Debts Recovered 2,000 

To Trade Expenses 2,000 By Discount received 750 

To Discount Allowed 500     

To Mis. Expenses 1,000     

To Office Expenses 1,200     

To Legal Expenses 1,000     

To Net Profit  

(Transferred to Capital Account) 20,350     
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  35,250   35,250 

 

 

9.4.3 Performance of Profit and Loss Account 
 

1. Reveals net profit or net loss. 

2. To find out net profit ratio. 

3. Current year’s administrative, selling and other expenses can be compared with the 

previous year’s amounts. 

4. Facilitates for the preparation of balance sheet. 

 

9.4.4 Adjustments 

Out Standing Expenses: Expenses relating to the current accounting period but not yet paid and 

are to be  paid in the next year is known as outstanding expenses. 

          Accounting treatment in Final Accounts 

1. Add to Concerned expenditure item in Profit and Loss Account. 

2. Show as a liability on liabilities side of the balance sheet. 

 

Pre – paid expenses: Expenses relating to the next accounting year but paid in the current 

accounting period is called pre – paid expenses or expenses paid in advance. 

          Accounting treatment in Final Accounts 

1. Deduct from the concerned expenditure item in Profit and Loss Account. 

2. Record in balance sheet on assets side. 

 

Income: The income relating to current year but to be received in the next year are called 

Accrued income or income receivable. 

          Accounting treatment in Final Accounts 

1. Add to the concerned income in Profit and Loss Account on credit side. 

2. Show as an asset in balance sheet on assets side. 

Note: If accrued income is given in trial balance, the amount is to be shown only in the 

balance sheet as an asset on assets side i.e., need not be shown in P & L Account. 

 

Income received in advance: The income pertaining to the next year but receiving in the current 

year called as income received in advance.  The income of next year received in the current year 

is not an income,  so it is deemed as liability for the accounting period. 

          Accounting treatment in Final Accounts 

1. Deduct from the concerned income in  Profit & Loss Account on credit side. 

2. In the balance sheet, record it as liability on the liabilities side. 

 

Depreciation: The value of fixed assets such as machinery, furniture etc., will decrease every 

year due to various reasons, such as wear and tear, obsolescence etc., Such decline in the value of 

fixed asset is called “Depreciation”.  It may be defined as decrease in the value of the asset. 

Depreciation should be considered as an expense in the final accounts and generally calculated as 

a percentage on the value of the given in trial balance. 

          Accounting treatment in Final Accounts 
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1. Charge it to the Profit & Loss Account (Appears on the debit side). 

2. Deduct it from the value of concerned asset in balance sheet on assets side. 

Bad Debts: The trader sells goods on credit to some of the customers.  The customers who have 

taken credit (Debtors) may not pay the amounts.  Thus the debts which are not collected and 

irrecoverable are known as bad debts. 

          Accounting treatment in Final Accounts 

1. Debit to Profit & Loss Account. 

2. Deduct from debtors in the balance sheet on assets side. 

Note:  If Bad debts are given in Trial Balance only, it should be shown in Profit & 

Loss Account as loss on debit side and need not be shown in Balance sheet. 

3.  In Profit & Loss Account, both the bad debts (Bad debts given in trial balance and  

given in adjustment) are to be shown on debit side. 

4. Bad debts given  only in the adjustments are to be deducted from debtors in the 

balance sheet on assets side. 

 

Provision for bad debts: Some debts of a particular year may or may not be recovered in the 

next year.  These debts are known as doubtful debts.  So the traders create some amount on 

current year debtors and keep the same to meet the doubtful bad debts of the next year, which is 

called as provision for bad and doubtful debts. 

          Accounting treatment in Final Accounts 

1. Record in  P & L Account on debit side. 

2. Deduct from Debtors in Balance Sheet on Assets side. 

 

Interest on Capital: It is the amount of the interest payable on owner’s capital by the business 

organisation.  The interest on capital is expenditure.  

          Accounting treatment in Final Accounts 

1. Calculate interest on capital at a given percentage and record  it in Profit & Loss 

account on debit side. 

2. Interest on capital should be added to the capital in Balance sheet on liabilities 

side. 

 

Interest on Drawings: The amount of cash or goods taken by the trader for personal use is 

known as drawings. 

          Accounting treatment in Final Accounts 

1. Interest on drawings amount to be recorded in profit & loss account on credit side. 

2. Interest on drawings should be deducted from capital in balance sheet (on 

liabilities side). 

Note: When the interest on drawings is given in trial balance, it should be recorded in 

Profit & Loss account on credit side.  No need to show it in the balance sheet. 
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9.3 Balance Sheet 
 

9.3.1 Meaning and Significance 
 

After Trading and Profit & Loss Account, Balance Sheet is the last financial statement to 

be prepared by the business organization. 

Balance Sheet may be defined as “an orderly statement representing assets, properties, 

capital and liabilities of the business on a particular date”. 

It is the statement prepared to find out financial position i.e., assets and liabilities of 

business on a given date.  The balance sheet explains that what a business owns (assets) and what 

the business owes to others (liabilities) on a given date. 

The balance sheet is prepared on the basis of trial balance.  Only real and personal 

accounts are taken into consideration in the preparation of balance sheet. 

 

9.3.2 Objectives 
1. Reveals true and fair financial position of the business. 

2. Traders can know about the business assets and liabilities i.e., what it owns and what it 

owes. 

3. Balance sheet is useful to the creditors and financial institutions to take decision to extend 

the credit. 

4. To know the financial solvency of the business. 
5.  

9.3.3 Preparation of Balance Sheet 
Arrangement of assets and liabilities is called marshalling.   

 Balance sheet should be divided into two parts as, left hand side and right hand side.  The 

left hand side is known as liabilities side and right hand side is called as assets side.  The capital 

and liabilities off business are shown on the liabilities side, and all assets shown on the assets 

side. 

 Balance sheet may be prepared in any one of the following order. 

1. Liquidity Order 

2. Permanency Order 

1. Liquidity Order: Liquidity means convertibility of assets into cash.  Assets of highest liquid 

is to be recorded first and next highest follows.  Liabilities will be shown inn the order of 

short term and long term. 

2. Permanency Order: The assets which are used permanently are recorded first and liquidity 

assets in the last.  On liabilities side, long term liabilities first and short term liabilities next. 
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Balance sheet on the basis of Liquidity Order 

Balance sheet of _______ as on ______ 
 

Capital & Liabilities Amount 

Rs. 

Amount 

Rs. 

Assets Amount 

Rs. 

Amount 

Rs. 

Bank Over draft 

Bills Payable 

Sundry Creditors 

Loans 

Capital 

Add: Net Profit 

 

 

Less: Drawings 

 

 

 

 

 

 

 

XXX 

XXX 

 

XXX 

(XXX) 

 

 

 

XXX 

XXX 

XXX 

XXX 

 

 

 

 

XXX 

 

 

XXX 

Cash 

Bank Balance 

Bills Receivable 

Debtors 

Closing Stock 

Furniture 

Machinery 

Buildings 

Good will 

 

 XXX 

XXX 

XXX 

XXX 

XXX 

XXX 

XXX 

XXX 

XXX 

 

 

XXX 

Balance sheet on the order of Permanency 

Balance sheet of _________ as on _________ 
 

Capital & Liabilities Amount 

Rs. 

Amount 

Rs. 

Assets Amount 

Rs. 

Amount 

Rs. 

Bank Over draft 

Bills Payable 

Sundry Creditors 

Loans 

Capital 

Add: Net Profit 

 

 

Less: Drawings 

 

 

 

 

XXX 

XXX 

XXX 

XXX 

XXX 

XXX 

 

 

 

 

XXX 

Cash 

Bank Balance 

Bills Receivable 

Debtors 

Closing Stock 

Furniture 

Machinery 

Buildings 

Good will 

 XXX 

XXX 

XXX 

XXX 

XXX 

XXX 

XXX 

XXX 

XXX 

XXX 

(XXX) 

 

 

 

 

XXX XXX 

 

Illustration 1: 

Prepare balance sheet from the following particulars. 
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Capital 44,000 Investments 12,000 

Debtors 12,000 Machinery 9,000 

Creditors 10,000 Cash 8,000 

Furniture 10,000 Closing Stock 7,500 

     

Balance sheet 

Capital & Liabilities 
Amount 

Rs. 

Amount 

Rs. 
Assets 

Amount 

Rs. 

Amount 

Rs. 

Capital 44,000   Debtors   12,000 

Add: Net Profit 4,500 48,500 Investments   12,000 

Creditors   10,000 Furniture   10,000 

      Machinery   9,000 

      Cash   8,000 

      

Closing 

Stock   7,500 

    58,500     58,500 

 

Illustration 2: 

Prepare balance sheet from the following particulars 

Capital 45,000 Loose Tools 3,500 

Add: Net Profit 6,000 Bills Receivable 12,000 

Debtors 4,800 Investments 16,000 

Less: Drawings 4,000 Machinery 12,000 

Creditors 8,000 Closing stock 9,200 

Bills Payable 2,500 

Balance Sheet 

Capital & 

Liabilities 

Amount 

Rs. 

Amount 

Rs. 
Assets 

Amount 

Rs. 

Amount 

Rs. 

Capital 45,000   Debtors   4,800 

Add: Net Profit 6,000 Machinery   12,000 

  51,000   Loose Tools   3,500 

Less: Drawings 4,000 47,000 

Bills 

Receivable   12,000 

Creditors   8,000 Investments   16,000 

Bills Payable   2,500 Closinng stock   9,200 

            

            

            

    57,500     57,500 

 

 

 



Paper III Accountancy & Tally Finalised 

479 

 

9.3.4 Arrange of Assets and Liabilities 
Capital and all liabilities to be recorded on left hand side (liabilities) and assets should be 

shown on right hand side (Assets). 

 

Short Answer type Questions 
1. Define Trading Account. 

2. Define Profit and Loss Account. 

3. Define Balance sheet. 

4. Define Adjustment. 

5. Define Depreciation. 

6. Define Bad Debts. 

Long Answer Type Questions 
1. Write the procedure to prepare final accounts. 

 

Exercises 

1. Prepare the trading account of Vasantha Enterprises as on 31-12-2013 from the following 

balances. 

Particlars           Rs. Particlars     Rs. 

Opening Stock 4,500 Sales Returns 1,000 

Purchases 10,600 Customs Duty 800 

Purchase Returns 1,000 Factory Supervisor salary 3,000 

Wages 800 Closing Stock 4,000 

Carriage 700 Factory Lighting 525 

Sales 16,000 Clearing Charges 1,000 

Ans: Gross Loss: Rs. 1,925 

 

 

 

2. Prepare Trading Account of Visweswar as on 31-03-20012 from the following balances 

Opening Stock 30,000 Manufacturing Expenses 8,000 

Purchases 65,000 Factory Rent 10,000 

Purchase Returns 4,000 Freights 3,000 

Sales 110,000 Wages 15,000 

Sales Returns 7,000 Closing Stock 30,000 

Ans: Gross Profit Rs.6,000 

3. Prepare the Trading Account of Nasreen as on 31-12-2016 from the following balances 

       Rs.             Rs. 

Opening Stock 100,000 Sales Returns 20,000 
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Purchases 55,000 Coal and Gas 2,500 

Sales 200,000 Purchase Returns 4,500 

Freights 1,000 Exicise Duty 2,500 

Wages 10,000 Closing Stock 30,000 

Ans: Gross Profit Rs.43,500 

4. Prepare Profit & Loss Account of Jessi Rose for the year ending 31-03-2010 from the 

following balances.  

Particulars Amount Particulars Amount 

Gross Profit 34,000 Discount(Dr) 250 

Cartage 1,000 Printing & Stationery 250 

Salaries 2,500 Rates & Taxes 300 

Rent 850 Travelling Expnses 250 

Insurance 1,000 Apprentice Premium 1,000 

Bad Debts 1,000 

    Ans: Net Profit Rs. 27,600 

5. Prepare Profit & Loss Account from the following balances of Satya Kumari for the year 

ending 31-12-2016. 

Particulars Amount 

Rs. 
Particulars Amount 

Rs. 

Salaries 4,000 Advertisements 1,200 

Freights 500 Audit Fee 1,500 

Discount Allowed 700 Mis. Expenses 1,350 

Commission Paid 1,000 Postage 850 

Bad Debts 2,000 Dividend Received 500 

Repares 500 Printing and Stationery 2,700 

Gross Profit 36,000 Insurance Premium 1,500 

Commission Received 800 Office Electricity Expenses 800 

Rent Received 1,200     

Net Profit: 19,900 

6. Prepare the Trading, Profit & Loss Accounts from the following balances of  Sri. Arun 

Kumar as on 31-03-2012. 

Particulars 
Amount 

Rs. 
Particulars 

Amount 

Rs. 

Opening Stock 8,000 Sales                      53,000 

Purchases                         43000 Sales Returns   2,000 

Purchase Returns         800 Closing Stock 22,000 

Discount Received 1,000 Wages 1500 

Commission 1,730 Manufacturing Expenses 800 

Trade Expenses 600 Salaries 15,000 
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Factory Rent 2600 Office Rent 1,800 

Interest on Dividend 1,690 Repares 650 

Profit on sale of old machinery 620 Mis. Expenses 1,200 

Rent Received 1,500 Bad Debts 860 

Depreciation 850     

Ans: Gross Profit Rs. 17,300  Net Profit Rs. 3,480 

 

7. Prepare balance sheet of Ekambareswar  from the following information as on 31.03.2012. 

Bank Over draft 20,000 Rent to be received 4,000 

Salaries to paid 10000 Net Loss 35,000 

Plant and Machinery 88,000 Furniture 40,000 

Lands and Buildings 120,000 Drawings 20,000 

Bills payable 20,000 Creditors 30,000 

Cash in hand 12,000 Interest received in advance 2,000 

Bank balance 18,000 Bank Debt 70,000 

Bills Receivable 35,000 Trade Marks 15,000 

Debt from  Kaamakshi 45,000 Patents 22,000 

Capital 250,000 Goodwill 35,000 

Rent paid in advance 3,000   

Ans: Balance sheet Total: Rs. 3,92,000 

8. Prepare the balance sheet of Sundareswar from the following details as on 31-03-2014. 

Particulars Rs. Particulars Rs. 

Opening stock 20,000 Debtors 15,000 

Creditors 50,000 Capital 100,000 

Machinery 40,000 Goodwill 45,000 

Motor Van 45,000 Closinng stock 25,000 

Other Debts 20,000   

Ans: Balance sheet Total: Rs. 1,70,000 
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9. Prepare the balance sheet of Natraj from the following as on 31-03-2016. 

Particualars 
Amount 

Rs. 
Particualars 

Amount 

Rs. 

Sundry Debtors 19,000 Motor Van 5,000 

Closing stock 18,000 Capital 56,000 

Bills payable 30,000 Net Loss 4,000 

Creditors 20,200 Drawings 3,000 

Debt from  sundari 10,000 Furniture 4,000 

Cash in hand 1,400 Buildings 10,200 

Bank balance 20,000 Goodwill 30,000 

Tools 1,600     

Balance sheet Total: Rs. 1,09,200 
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UNIT -X 

Tally 

 

10.a.1 Introduction to accounting packages 

10.a.2 Features, accounting, data migration capability, duties and taxes Advantages and 

disadvantages 

10.b.1 Financial functions of Tally 

10.b.2 Inventory and application  

10.b.3 Creation of company, alteration of company, master configuration, creation of groups, 

grouping of ledger accounts, voucher configuration, recording configuration of sample data 

10.c.1. Display and reports  

10.c.2 Accounting reports, Balance sheet, profit and loss account, printing reports 

10.d.1 Ratio Analysis 

10.d.2 Classification 

10.d.3 Financial Ratios, Profitability ratio, Activity ratio analysis 

10.e.1 Cash flow statement and funds flow statements 

10.e.2 Preparation of funds flow statement, Limitations of funds flow statement, Analysis of 

funds flow statement, Cash flow in tally. 

 

 

10.a.1 Introduction to accounting packages 

 

Accounting package allows us to monitor and manage the financial health of our 

business. Many different types of accounting packages are available on the market, with options 

to suit different business sizes, sectors, industries and even work processes. 

10.a.2 Features, accounting, data migration capability, duties and taxes 

Advantages and disadvantages 

Key features of accounting packages 

There are many types of accounting packages for business, with many different features and key 

functionalities. The package to be considered will depend on the type of business and the way of 

running it. 

• Basic bookkeeping - for example sales and purchase ledgers, nominal ledger and invoicing. 

• Duties and Taxes - Accounts system should be able to keep track of Duties and taxes and 

calculate your payments at the end of each Tax period. 

• Payroll processing – Regarding employees, consider a payroll function that calculates 

Salaries ,ESI ,PF etc., 

• Generation of reports –a system that gives regular management accounts will help improve 

business efficiency. 
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• Invoicing - any accounts package needs to be able to produce invoices in customized way  

and you may want to send them by email. 

• Credit control - an accounts package can help by highlighting where customers have 

exceeded their limits and provide statements to chase them. 

Advantages and disadvantages of accounting package 

Reliable accounting package is likely to benefit many businesses. However, such package 

sometimes comes with its share of problems, so it is important not to overlook the possible 

disadvantages. 

Advantages of accounting package 

Benefits of accounting package include: 

• simple data entry - it is typically fast, straightforward and only required once 

• fast processes - delays, for example between sale and invoicing, are minimal 

• automation of reports and analysis - eg on profit and loss, debtors and creditors, customer 

accounts, inventory counts, sales, forecasting, etc 

• automation of tasks - eg calculating pay, producing payslips, calculating taxes, etc 

• reduction of errors - eg transposition of figures, incorrect or incomplete recording of 

transactions, etc 

• integration with other systems, such as online banking and e-filing 

 

Using accounting package can help to save time and money, and offers valuable insight into 

business. If the package is chosen carefully, investing in a computerised accounting system can 

be one of the best decisions. 

 

Disadvantages of accounting package 

Certain problems and disadvantages are worth considering while using accounting packages. 

• Price - the package cost, although small in relation to other costs, is higher than a paper-

based system. 

• Implementation - manual accounts are generally easier to set up and can be more flexible 

than computerised accounting. 

• Support – It may need to purchase yearly maintenance and support for the package. 

• Specialised needs - an accounts package will typically suit most types of business. However, 

specialist businesses may need to refine the package or change their processes to use 

accounting package successfully. 

Accounting package may sometimes also have a steep learning curve, so if you are more 

comfortable writing up ledgers and books, keeping manual accounts may be a simpler option. 
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10.b.1 Introduction 

 
Tally is a Financial accounting Package that keeps pace with complex business demands 

and simplifies growth. This package was developed effectively to fulfill the needs and help to 

overcome the challenges of growing business. 

Tally’s Dynamic features and MIS capabilities are designed to simplify business 

operations, giving you complete control over accounting, inventory and statutory process. 

 

1. Simple : Tally is very simple and user friendly. 

2. Codeless System : It is Codeless enterprise system All jobs may be performed through the 

name Master. The name may be altered at any time without any effect. 

3. Quick Entry / Alteration of Masters : Master Creation is simple and fast . It provides 

special master entry / alteration module through several masters may be entered and altered 

in one screen.  

4. E-mail Capability : Any report can be sent using this software, without using any external e-

mail software.  

5. Web Publishing : User can publish any report at any Website or FTP site in HTML format to 

view from any place.  

6. Export of data : Any Report including masters and Vouchers may be exported in Any 

Format for import into another system( Tally / Non tally). 

7. Encrypted form : The data of any Company can be stored in highly secured encrypted form 

and is impossible to break open the data. 

8. Accounting period : You may extend the Accounting period to several Financial Years, and 

may keep the Accounts of a project for 5 years at one place. At any point of time one can 

split them to Financial years. 

9. Operations Audit : Tally keeps a record of user name for creation / alteration of all masters 

& voucher data. 

10. Group Companies : To get consolidate report of a Group of Companies, one can create a 

Group Company of several constituent companies. 

11. Printing : All Tally reports can be directed for printing and can be previewed before printing. 

12. Data connectivity : Tally data can provide ODBC connectivity to generate any report. 

13. Tally prepares final accounts from regular Voucher data. 

14. Single Mode Voucher Entry: Any lay man not knowing Debit and Credit can also use this 

package. Just enter the figures and tally does the rest. 

15. Day to day business transactions can be recorded using Ledgers, Journals etc. 

16. Ratio Analysis: Tally can be used for ratio Analysis for better financial management and 

interpretation of state of affairs of Company. 

17. Cash Flow and Funds Flow statements can be easily generated with working Capital figures 

for proper utilization & Control of liquid resources of the Company. 

18. Helps in maintaining Inventory 

 

10.b.2 Financial Functions of Tally 

Tally package is used for accounting system . The a/c package is used for maintaining the 

transactions of business on a daily basis by creating ledgers , journals, using reports we can view 
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Trial Balance, Profit and Loss A/Cs. Balance Sheet , To View Cash Flow and Finds flow 

statement. 

 

10.b.3 Creation of Company 

The new company can be created using the following steps. 

Step 1 : Start ’! programs ’!tally 7.2/ tally 9.0 

or 

Step 2: double click on tally icon on desktop 

Step 3 : Select the option create company from company information screen 

Step 4 : the company creation window gets opened and user can enter all the details of company 

like Name of company , Mailing name , Company address , Email address of company VAT 

Regd no if any , using of currency symbols as Rs. the financial year of company. 
 

 
Figure 10.1 

Then click on yes button to accept the details, and company gets created . 
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Figure 10.2 

 

Alteration of Company :- Company details can be altered by selecting alter command from 

company information services where in user can altered the details of Company. 

 

 
Figure 10.3 
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The configuration must be done before creating and starting work of the company. 

 

10.b.4 Master Configuration 

The master configuration is to configure the details like Currency Symbol, No. of 

decimals places, symbol to be displayed for decimal places like paisa in case of Currency Sign, 

Rupees, Display of names in Reports and Style of dates. 

 

Steps to Configure 

1. Press F12 key to configure 

2. In the configure option menu click General option then 

1. Select the steps of names i.e Default appearance of names in Reports. 

2. Default appearance of Stock Item Names 

3. Select Style of Dates as dd-mm-yy 

4. Select the configuration of numbers to display Decimals 

Thousands Seperation to use, Put currency Sign 

Show numbers in Millions( and not in lakhs) : No 

and Other option to be selected are 

5. Show monthly Reports to : Yes 

Reports are configured to display Graphs. 

 

Use Separate Menu : This option is used to display Final Account Statements such as 

Balance sheet & Profit & Loss A/c directly on the Gateway Tally. 

 

If This option is set to Yes , The final statement of Balance sheet and P & L A/C 

statement can be accessed from Gateway Tally. 

The above Statements show Tables with Masters only in current Language selected in 

Language Configuration. 

Numeric Signs : This allows to set the number styles. 

 

Master Configuration of Accounts and Invoice Information 

This Master configuration allows to configure Accts/ Inv information and Voucher entry 

information. This allows user to decide details to appear in this master for Accounting Voucher 

and Inventory Voucher. 

 

Using F12 Function key can configure Voucher entry details and Printing options to 

configure the printing voucher, Invoice statement layouts etc. 

 

Groups 

The accounting principle follows some conventions for presentation of the financial 

reports. Transactions of similar nature are grouped and balanced into entities called Ledger 

Accounts. 

These Ledger accounts are further organized into hierarchical levels called Account 

Groups. 
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Accounting Groups 

This are a method of organizing the large population of ledger accounts into a tree 

structured into hierarchical view 

Ledger Accounts give the details of individual transactions. 

The accounting entities are further mainly divided into 

• Liabilities 

• Assets 

• Incomes 

• Expenses 

 

Tally classifies and organizes these Accounting Entities into groups. 

Some examples of Ledgers and Groups 

1. Current Assets - Group 

a) Bank A/c - Ledger 

2. Cash-in-hand 

a) Cash, Petty cash — Ledger 

3. Deposits 

4. Loans and Advances   

5. Stock  

6. Sundry Debtors 

 

The ledger Accounts are transacted into Voucher 

 

Account Group do not Participate in any Voucher but they are used to organize the 

Ledger Account . 

 

 

Reserved Accounting Groups 

Once a company is created Tally automatically creates 28 predefined Account Groups 

called Reserved Groups. They cannot be deleted to maintain consistency and integrity of the 

accounting system representing Income and Expenditure, Assets and Liabilities. There are 28 

reserved Groups, of which 15 are top level primary group, and 13 are sub groups of these 

primary groups. 
 

Some of reserved groups of Assets and Liabilities are  
 

Examples of Accounting Groups 

Group of Liabilities   Group of Assets 

Capital A/c    Fixed Assets A/c 

Reserves and Surplus 

Loans     Investments 

Bank OD A/c    Current Assets 

Secured Loans   Bank Accounts 

Unsecured Loans   Cash-in-hand 

Loans & Advances 

Current Liabilities   Deposits 
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Duties and Taxes   Stock-in-hand 

Provisions    Sundry Debtors 

Sundry Creditors 

Misc. Expenses 

Suspense A/c 

Group of Income   Group of Expenses 

Sales Accounts   Purchase Accounts 

Direct Income   Direct Expenses 

Indirect Income   Indirect Expenses 

 

Creation of Groups 

To create Groups select Account Info Menu at Tally main menu and follow steps:- 

1. Select Groups from account Info menu 

2. Select Create from Single Group Option to get Account group creation screen 

3. At Group name field: Enter a unique Group name. 

4. At under field Select parent group from the list of Groups, the new group is placed under the 

selected parent group and will inherit its properties. 

 

 
Figure 10.4 
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Figure 10.5 

 

 
Figure 10.6 

 

 

Alteration Of Group 

1. Select Accounts Info > Groups > Alter and select the Account Group to get in alteration 

mode.  

2. he respective record is displayed. Overtype the data to modify data in any field. 

To change in Parent group Select Group from the list. 
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Figure 10.7 

 

Deletion of Group 

To delete a Group 

1. Select Accounts Info > Group > Delete  

2. Select the group from the list to delete. 

However, If the Group contains any ledgers there under then the group cannot be deleted 

unless the ledgers created under that group are deleted. 

 

10.b.5 Creation of Ledgers 

Tally automatically creates two ledgers Cash (under Cash –in-hand group) and profit & 

Loss A/c (primary ledger). 

To create other Ledgers Select Create under Single ledger to get Ledger creation screen. 

 

1 Ledger Name : Enter Ledger Name at Name field. 

2 Under : Select Group of Ledger from the list of Ledgers.  

3 Opening Balance : Enter Amount. 

Tally shows the opening balance at the right side with Dr. for Assets and Expenses Cr for 

Liabilities & Income. 
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Figure 10.8 

 

Display of Account Master: To display any Account master Select display option from the 

respective menu to display Group or Ledger. 

 

Alteration of Account Master: To alter any particulars in any Master Select Alter from the 

respective menu., the steps are 

Alteration of Ledger : 

1. Select Accounts Info > Ledger > Alter and select the Account Ledger to get in alteration 

mode.  

2. The respective record is displayed. Overtype the data to modify data in any field. and Press 

CTRL + A to save changes. 

 

Deletion of Ledger :- To delete a Ledger 

1. Select Accounts Info > Ledger > Delete. 

2. Select the Ledger from the list to delete. 

However, If the Ledger contains any entry there in then the Ledger cannot be deleted unless 

the entries there in are deleted. 

 

10.b.6 Accounts Voucher 

Accounts Voucher is the primary document in which complete details of accounting  

transactions are recorded. Like 

• Payment of Salary to Employees 

• Withdrawal of Cash From Bank Account 

You make an accounts voucher when you receive money or pay cash. But there are 

instances of non cash business transactions like 
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• Credit Sales 

• Provision of Depreciation for Fixed Assets. 

 

Tally Account Voucher Types 

As per the accounting principle all accounting transactions are entered in Journal 

Voucher. The following are the types of Voucher used by all kinds of business units, irrespective 

of their nature, size or book keeping methods. 

• Contra 

• Receipt 

• Payment 

• Journal 

Following types of Voucher are used for Journal Vouchers 

 

Sales : To record all sales . However Cash sales can be recorded through Receipt Voucher, Credit 

Sales through Journal Voucher . 

 

Purchase : To record all purchases, However Cash Purchase may also be entered as payment 

Voucher and Credit Purchase as Journal Voucher. 

 

Debit Note & Credit Note : These transactions are recorded through Journal voucher. 

 

Voucher Configuration 

To configure the voucher , Click F12 : Configuration at Gateway and select Voucher 

Entry at Configuration menu. Set Yes at Single entry mode for Payment, Receipt, & Contra 

Vouchers. Tally provide two forms for Single entry and Double entry for convenience, Internally 

data is stored in the same way . You may get same results in Single or Double mode. 

 

 
Figure 10.9 

CREATION OF VOUCHER : To record a transaction through a Voucher entry , Select 

accounting Voucher type at Tally main menu. 
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Figure 10.10 

 

To Enter Voucher press any of the Function Key as displayed in menu for each of 

Voucher type. 

To Enter Voucher press any of the Function Key as displayed in menu for each of 

Voucher type. 

Voucher Header : At the voucher header , Enter the following details:- 

Voucher No : Tally displays voucher no serially generated in a sequence for each voucher type. 

Voucher date : Current date is carried at this field to denote the date of voucher 

Voucher Ledger Account : This is a Tabular area where each Ledger transaction and related data 

is entered. 

ledger Sign : Press D for Debit and C for Credit at first column to indicate Debit or Credit 

Transaction. 

Ledger Account : At Particulars field select the Ledger account from the List of Ledgers. 

Ledger Amount : As per By/ To enter in the first column type Ledger amount in Debit or Credit 

Column . The Ledger entries are terminated as soon as the total Debit or Credit is Equal. 

Voucher Narration : At narration field , enter voucher Narration describing the voucher 

transaction. 

Cheque Number Entry : When any Bank Account (ledger placed under Bank Accounts) is 

transacted in Voucher, Tally prompts Ch. No. at Narration field, enter Cheque no and enter 

narration next to cheque number. 

Voucher Alteration 

To alter any data in any field before saving , click on the field, or use Shift + Tab or Up 

Arrow Key 

Saving the Voucher 

After complte entry of the voucher Type Yes at Accept ? to save the Voucher or CTRl + A 

to save the voucher. 

Tally shows each voucher type in distinct color like 

 

Voucher Type Screen colour 

Contra White 

Payment Yellow 

Receipt Green 

Journal Blue 

Figure 10.11 

 

Voucher Entry Rules 
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Tally follows certain rules for voucher types These rules are validated during voucher 

entry and any violation is trapped immediately. 

 

Contra Voucher 

Contra voucher is used for fund transfer between cash and Bank Accounts 

Following transactions should be entered in Contra Voucher : 

a) Cash deposited in Bank 

b) Cash withdrawn from Bank for business use 

c) Cheque of one bank deposited in another Bank. 

d) Cash given to / received back from Petty cash 

 

Entry of Contra Voucher : Press F4 function key ( F4 Contra) at the Voucher Entry Screen to 

enter Contra Voucher. 

 

Entry Rules : The entries in Contra Voucher follow the rule shown below 

 

Pariculars    Debit    Credit 

Cr Source of Funds   (Amount) 

Dr Destination of Funds     ( Amount) 

The first entry is always a credit. From 2 nd entry onwards you may Debit or Credit a 

Ledger under Cash, Bank Accounts and Bank OCC Group only. 

 

Examples of Contra Vouchers 

1. Rs. 24000 withdrawn from Bank of Baroda, So the entry would be 

Cr Bank of Baroda     24000 

Dr. Cash    24000 
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Figure 10.12 

 

Payment Voucher 

All payments are recorded in Payment Voucher Such Payments may be towards 

Purchases, Expenses, Acquisition of Fixed assets, payment to Creditors, Loans / Advances paid 

by you, or Repayment of Loans and Advances taken earlier. 

Press F5 Function Key ( Click F5 : Payment Button ) at the Voucher entry screen. 

 

Voucher Rules : Payment Voucher follows the rules as stated 

Particulars     Debit   Credit 

Dr Ledger Account Paid to     (Amount) 

Cr. Cash / Bank Account   (Amount) 

 

Entry Rules : The first entry is always Debit and second entry onwards you may specify Debit 

or Credit. Ledger Account placed under the Cash in hand, Bank Accounts or Bank OCC Group 

must be Credited. 
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Entry screen 

 
Figure 10.13 

 

Receipt Voucher 

Cash Receipts (In Cash or through Bank) are recorded through receipt voucher. Such 

Receipts may be through Income , Debtors, Loans / Advances taken or Refund of Loans and 

Advances given earlier.  

Press F6 Function key ( F6 Button) at the Voucher Entry screen to get Receipt Voucher. 

Voucher Rules : Receipt Voucher follows the rules as stated 

Pariculars     Debit   Credit 
Cr Ledger Account Recd From    (Amount) 

Dr. Cash / Bank Account   (Amount) 

 

Entry Rules : The first entry is always Credit and second entry onwards you may specify Debit 

or Credit. Ledger Account placed under the Cash in hand, Bank Accounts or Bank OCC Group 

must be Debited. 

 

 

 

 

 

 

 

 

 



Paper III Accountancy & Tally Finalised 

499 

 

 

 

Entry screen 

 
Figure 10.14 

 

Journal Voucher 

Journal is an Adjustment Voucher , normally used for non cash transactions like 

adjustments in Ledger Accounts. 

Press F7 Function key ( F7 Button) at the Voucher Entry screen to get Journal Voucher. 

 

Entry Rules : In a Journal Voucher , only Non Cash /Bank Accounts (Ledger Accounts other 

than Cash , Bank, Bank OCC) may be transacted. The first entry must be Debit. 

 

Voucher Alteration Deletion and Cancellation 

You may perform Voucher Alteration, Deletion & Cancellation at Voucher Alteration Mode at the 

following : 

Current Voucher : The voucher on the screen you are working is the current voucher. Until you 

save it is in Alteration mode. 

Other Vouchers : You may get any other voucher by pressing 

Pg Up : for Previous Voucher 

Pg Dn : for Next Voucher. 

To get any voucher of any other date 

Press F2 and change the voucher date and then scroll through vouchers using Pg Up and Pg Dn 

keys. 
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Account Voucher Printing 

After Voucher entry you may print the Voucher in two ways: 

On line Voucher Printing during entry : Just after completing the Voucher entry you can 

print the current voucher before saving it. 

Off line Voucher Printing saved Voucher : You may print all Vouchers of a day at once 

after the vouchers have been saved. 

 

Tally Configuration for Voucher Printing 

In the Voucher printing screen, click F12 : Configure to get Voucher printing 

configuration screen for the respective voucher types. Set the configuration options as desired: 

 

 
Figure 10.15 

 
Figure 10.16 

All accounting books and Day books can be printed by selecting option from the printing 

menu of Tally 
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Figure 10.17 

10.c.1 Reports 

After the Voucher entry, its effect is reflected in various reports. Tally provides powerful 

display facility to view reports at various levels of details and contents of the screen. 

 

Some top level reports like Balance Sheet, Profit & Loss Account at main menu while other 

reports are available through Display option at Main Menu. 

 

Click Display to display menu from Main Menu. 

 

Accounting Group Summary 

This report shows the summary of Account groups. 

Select Display > Account Books > Groups Summary. 

Select an Account Group to get Group Summary for the Group. 

Primary Group Summary 

The primary Group Summary shows the figures of all Primary Groups. Select any Group 

to get required Group Summary. 
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Figure 10.18 

 

Ledger Summary 

It shows the Summary of each Ledger for the current period. At Group Summary. 

Click F5: Ledger wise to show Ledger summary of child ledgers of the Group. 

 

Trial Balance 

Trial Balance shows the Closing Balance of Account Groups/ Ledger. 

This is the next level report to Ledger. 
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Figure 10.19 

 

 At Primary Group Trial Balance Click F1: Details to Detail Trial Balance showing next 

level groups/ Ledgers. 

 

Trial Balance Configuration 

At trial balance , Click F12 : Configure to get Trial Balance Configuration options: 

 

 
 

Figure 10.20 
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Profit and Loss Statement 

The Profit & Loss Statement (popularly known as Profit & Loss Account) displays the 

figures of all Nominal Accounts and the Net Profit / Loss. Sales , Closing Stock, Direct and 

Indirect Income heads appear in the Income side; Opening Stock, Purchase, Direct and Indirect 

Expenses appear in the Expenditure side. Excess of Income over Expenditure shown as Nett 

Profit, Deficit as Nett Loss. 

 

 
Figure 10.21 

 

Balance Sheet 

Balance Sheet is the top most Financial Statement that reveals the State of Affairs of a 

company as on the date of the Report. Assets side shows what the Company Owns and Liabilities 

side lists what is Owes. All Real and Personal Accounts appear in Balance Sheet. 

 

Primary Balance Sheet 

It shows with closing balance for Primary Group of Liabilities in one side , Assets on the 

other in horizontal (T) format. 

Select Balance Sheet at Gateway Tally to get Primary Balance Sheet. 
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Figure 10.22 

 

Detailed Balance Sheet 

In Primary Balance Sheet, click Alt + F1 : Detailed toggle button to get Detailed Balance 

sheet showing next level Group/ Ledger details. 

 

Balance sheet Configuration 

In Balance Sheet , Click F12 : Configure to get Balance Sheet Configuration, set Yes at 

show Vertical Balance Sheet at Configuration options. 

 

10.d.1 Ratio Analysis 

Ratio Analysis is technique of analysis and interpretation of financial statements. It is the 

process of establishing and Interpreting and helping in making certain decisions. 

It is a means of understanding the financial strength and weaknesses of a firm. 

Financial accounting system contains massive data relating to P& L  Statement Balance 

Sheet and contains substantial data in the form of amount only. To get intrinsic view about 

health, liquidity or earning capability of an enterprise,. Financial analysts look for some key 

figures & ratios to assess the strength & performance of an enterprise. 

 

Classification of Ratios 

The Ratios have been classified as 
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Long term Solvency and Leverage ratios or Financial operating Ratios 

Long term solvency ratios convey a firm’s ability to meet the interest costs and, 

repayments schedules of its long term obligations. E.g. Debt Equity Ratio and interest coverage 

ratios. Leverage ratios show proportion of debts and shareholder’s funds in financing to the firm. 

 

Activity Ratios 

These ratios are calculated to measure the efficiency of the resources of a firm have been 

employed. These ratios are also called turnover ratios because they Indicate the speed with which 

assets are being converted into sales. 

E.g. Debtor turnover ratio, Stock turnover ratio etc.. 

 

 

Profitability Ratios 

These Ratios measure the results of business operation or overall performance and 

effectiveness of the firm.,  

Eg, Gross Profit ratio, Net Profit ratio ,operating ratio or return on capital employed. etc. 

Profitability ratios are two types i) In relation to sales and ii) In relation to investments. 

 

Creation of Ratio Analysis 

In Tally main menu , select Ratio Analysis to get Ratio Analysis. 

The screen is divided into 2 panes. Left pane displays Principal Groups and Right pane 

lists Principal Ratios . 

 

 

Principal Groups 

At the left part some principal groups are shown 

 

Working Capital 

It is computed as Current Assets - Current Liabilities .Current Assets include 6 reserves 

Groups namely, Stock-in-Hand, Bank Accounts, Loans and Advances (assets), Deposits and 

Sundry Debtors .While Current Liabilities consists of 3 Reserved Groups namely, Duties & 

Taxes, Provisions and Sundry Creditors. 

Normally Working Capital balance of a running concern is a positive figure. Low 

working Capital is an indicator of Insolvency while high level is indicator of under –Trading. 

 

Cash-In- Hand & Bank Accounts : 

It shows the total of all current bank accounts and cash accounts, showing the free cash available. 

This figure helps Cash Management and Payment Decision. 

 

Bank OCC Balance 

Indicates Overdraft as on Day. 

 

Sundry Debtors & Creditors :Reveals balances as on the date along with dues till today , helps 

credit Management. 
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Sales & Purchases: Shows net value of Sales & Purchases 

 

Stock-in-hand: Reveals funds blocked in stock 

 

Net Profit or Loss : Shows the overall results for the period. 

Working Capital turnover: Indicates the number of times working Capital has been rolled over. 

It is arrived by dividing Sales with Working Capital This indicates how good the working Capital 

has been deployed into productive return . Higher figure indicates efficient utilization of 

available resources. 

 

Inventory Turnover 

Indicates the number of times Stock has been made into sales. It is arrived by dividing Sales with 

Stock-in-hand. Higher figure indicates better management of Inventory. 

 

Principal Ratios 

At the right side you get principal ratios. 

 

Current ratio 

Computation : Current Assets / Current Liabilities  

This ratio speaks about health of the organization and measures the relative ability to pay 

Short term Debts. 

 

Quick Ratio 

Computation Formula : [Current Assets – Stock ] / Current Liabilities. 

It is also termed as Acid Test Ratio. The Assets which can be quickly converted into liquid assets 

are considered for computation of this ratio and is considered as a better tool to measure financial 

strength of an organization from the liquidity Perspective. 

 

Debt / Equity ratio 

Computation Formula : Long term loans (liability) / Net Capital( Capital + Reserves ) 

This ratio is the proportional of long term debts to Net owned Capital. This ratio is 

indicator of Financial structure of the Company. Higher the Ratio, higher the risk of failure to 

repay Loans. 

 

Gross Profit % 

Computation Formula : ( Gross Profit / Net Sales) x 100 

This serves as an index of overall efficiency of main business of the organization. 

 

Net Profit % 

Computation Formula : ( Net Profit / Net Sales) x 100 This serves as an indicator of overall 

performance of the organization. 

 

Operating Cost % 

Computation Formula : 100- Net Profit ratio 
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This shows the component of expenses incurred on productive activities. Lower it is, higher the 

profitability. 

 

Receivables Turnover in days 

It is also called as Collection Ratio which is an indicator of average collection of period of Debts. 

 

 

Return on Investment % 

Computation Formula : ( Net Profit / capital Employed ( Capital + Reserves) x 100 

An important indicator for utilization of resources to generate earnings. 

 

Return on Working Capital % 

Computation Formula : ( Net Profit / Working Capital) x 100  

Indicates rate of return on Working capital. 

 

Thus Principal Group figures coupled with Ratio Analysis shows the performance of the 

organization to exercise proper control at appropriate time for better performance and return. 

 

10.e.1 Cash / Funds Flow 

Cash & Funds flow indicates the movement of resources into various forms of Assets and 

Liabilities. 

Cash Flow Statement 

It is a statement which describes the inflows (sources) and outflows (uses) of cash 

equivalents in an enterprise during a specified period of time. A Cash flow statement summarizes 

the causes of changes in cash position of a business enterprise between two periods of two 

balance sheets. 

Select Display > Cash & Funds Flow to Cash & Funds flow menu 

 
Figure 10. 23 

 

Cash Flow 

Select Cash flow at the menu to get Cash Flow Statement showing movement of money 

In and Out in your Business. 
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10.e.2Funds Flow 

Funds Flow provides the information of Movement of funds, i.e. source and utilization of 

Fund showing the increase or decrease in Working Capital. It is a report of the financial 

operations of the business undertaking. It indicates various means by which funds were obtained 

during a particular period and ways in which these funds are employed. 

 

Function Keys used in Tally 

Function keys in tally are used for different purposes at different places.  Same function 

key works for one function in one place and for other purpose in different place. 

Ex: Alt + F1 is used for shut company at tally gateway. However same key combination is used 

to get detailed display of Profit & Loss Account or Balance sheet when we are in that screen.  To 

name a few functionalities or usages of function keys in tally the below table may be useful. 

 

Function Key Purpose 

F1 Select a Company 

F1 (Alt+F1) Shut Company, Detailed display of 

Profit & Loss Account or Balance 

sheet etc. while in those screens. 

F2 Date 

F2(Alt+F2) To change accounting period 

F3 Company information 

F3 (Alt+F3) To change company basic data or 

information. 

F4 Contra Entry 

F5 Payment 

F6 Receipt 

F7 Journal 

F8 Sales 

F8 (Alt+F8) Credit Note 

F9 Purchase 

F9 (Alt+F9) Debit Note 

F 10 Reverse Journal 

F10 (Alt+F10) Memos 

F11 Features 

F12 Configuration 

 

Note: Function key with underline is denoted for using the function key with the 

combination of “ Alt ”  key in the keyboard. 

 

 

 

 

 



Paper III Accountancy & Tally Finalised 

510 

 

 

Short Answer Type Questions 

1. What are the function Keys used in tally? 

2. How to create new group in tally? 

3. What is the use of Accounts information? 

4. What is Inventory Information? What options are available? 

5. What is a Ledger? How to create in tally? 

6. How to display reports? 

7. What are the different report viewed in tally? 

8. What is trial Balance? 

9. What is a Cash flow statement? 

10. What is a Funds flow statement? 

 

 

 

Long Answer Type Questions 

1. Write the procedure to create company in tally? 

2. What is a Balance sheet? How to configure it and display the report? 

3. What is ratio Analysis? What are the Principal groups you see in a report and how does it 

help the organization? 

4. What are Cash flows and Funds Flow statement and how to obtain reports?  

 

 

 

 

Reference Books: 
1. Intermediate First year Accountancy Text book prescribed for C.E.C and M.E.C. Groups . 

2. Financial Acccountancy Part I & II for class XI by NCERT. 

 

 

Android Apps: 

ePathshala by NCERT 
 

Web sites: 
https://en.wikibooks.org/wiki/Accountancy for open books 

 

 

 



COMPUTER SCIENCE & ENGINEERING 

I YEAR 
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PERIODS PER WEEK: 4                                                     PERIODS PER YEAR : 135 
 

BLUEPRINT 
 

S.NO. UNITS 
NO.OF 

PERIOD
S 

WEIGHTAG
E OF 

MARKS 

NO. OF 
SHORT 

QUESTIONS 

NO.OF ESSAY 
QUESTIONS 

I 

Introduction to Computer 
systems 

and Hardware 

20 10 2 1 

II 
Overview of Operating 
Systems:- 20 10 2 1 

III MS Word 35 24 3 3 

IV MS Excel 35 16 2 2 

V MS Power Point 25 8 1 1 

 Total 135 68 10 8 

 
 

Note: After completion of every unit one assignment will be given to 

the students Note:- The question paper contains TWO Sections. 

SECTION – A contains 10 short questions carries 

2marks each, SECTION – B contains 8 Long 

questions carries 6 marks each. 

The student has to answer ALL questions in SECTION – A  

 

Any FIVE Questions in SECTION-B. 
 

On the Job Training : August, September & October 
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BLUEPRINT 

 

S.NO. UNITS 
NO.OF 
PERIODS 

WEIGHTAGE 
OF MARKS 

NO. OF 
SHORT 

QUESTIONS 

NO.OF 
ESSAY 

  QUESTIONS 

I 

Introduction to 

Problem Solving 

Techniques 

(Algorithms and 

flowcharts) 

15 10 2 1 

II Features of ‘C’ 40 24 3 3 

III Arrays in ‘C’ 30 16 2 2 

IV Functions 40 10 2 1 

V Structures in C 10            8 1 1 

 Total 135 68 10 8 

 

Note: After completion of every unit one/two assignments will be given to the students 

 
 

Additions / Deletions/ Changes: 

1. In unit –III File operations are deleted. 

2. Arrays precedes the Functions. 
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BLUEPRINT 

 

S.NO. UNITS 
NO.OF 

PERIOD

S 

WEIGHTAGE 

OF MARKS 

NO. OF 

SHORT 

QUESTIONS 

NO.OF 

ESSAY 

QUESTIONS 

I Introduction to Accountancy 

5 8 1 1 

II Double Entry System:- 
5 8 1 1 

III Journal 
10 2 1 - 

IV Ledger 
10 2 1 - 

V Subsidiary Books 
15 8 1 1 

VI Cash Book 
15 8 1 1 

VII Bank reconciliation statement 
15 8 1 1 

VIII Trail Balance and rectification 
10 8 1 1 

IX Final Accounts 
20 8 1 1 

X Tally Package 
30 8 1 1 

 Total 135 68 10 8 

 

Note: After completion of every unit one/two assignments will be given to the students 

       Additions / Deletions/ Changes: 
 

Unit VII   “journal proper” has been deleted and introduced “Bank reconciliation statement’. 

 
 

 

 

 

 

 

 

 

 

 

 



 

 

 

COMPUTER SCIENCE & ENGINEERING 

 

I YEAR 

 

MODEL QUESTION PAPER 

 
PAPER-I   COMPUTER FUNDAMENTS & MSOFFICE [THEORY] 

 
Time:- 3 Hrs Max. Marks:- 50 

SECTION-A      10 X 2=20 

Note:-  1. Answer ALL Questions: 

                     2. Each Question carries 2 Marks. 

 

01. Define a Computer? 

02. Write the names of any two input and two output devices. 

03. Write any four DOS internal commands. 

04. Define an operating system. 

05. What is auto correct? 

06. What are different views in ms-word? 

07. What is a worksheet?  

08. Write the number of Rows and Columns in Spreadsheet. 

09. What is presentation? 

10. What is slideshow? 

 

 

SECTION-B 

Note:-   1. Answer any FIVE Questions from the following 5 X 6= 30. 
2. Each Question carries 6 Marks. 

 

11. Draw the block diagram of computer and explain each block in it. 

12. Write any 6 DOS Commands with proper syntax and examples. 

13. Explain any six File menu options. 

14. Explain formatting toolbar in ms-word 

15. Explain Mail merge procedure with an example 

16. Explain any three  types of Charts in Excel 

17. Explain any five statistical functions in Excel. 

18. What is presentation? Write the procedure for perfect presentation. 

 



 
 

 

COMPUTER SCIENCE & ENGINEERING 

 

I  YEAR 

 

MODEL QUESTION PAPER 

 
PAPER-II    PROGRAMMING IN ‘C’ [THEORY] 

 

Time:- 3 Hrs Max. Marks:- 50 

SECTION-A      10 X 2=20 
 

Note:-  1. Answer ALL Questions: 

                     2. Each Question carries 2 Marks. 
 

01. Define an Algorithm? 

02. Write the symbols of Flowchart with purpose. 

03. Define variable and constant  in C. 

04. What is goto statement? 

05. Write the syntax of  SWITCH statement 

06. What is an Array? 

07. What are applications of two dimensional Arrays? 

08. Define a function. 

09. What is Recursion? 

10. Define Union. 

 

SECTION-B 

 

Note:-   1. Answer any FIVE Questions from the following 5 x 6= 30. 

2. Each Question carries 6Marks. 

 

11. Write an algorithm for biggest of given three numbers 

12. Explain arithmetic operators with examples. 

13. Write about if,if..else statements in c. 

14. Explain various  looping statements in c. 

15. Write a program for sorting n numbers in an array. 

16. Write a C program for matrix addition of two matrices. 

17. Write a c program to find factorial of given number by using function. 

18. What are the differences between structure and union. 



COMPUTER SCIENCE & ENGINEERING 

I  YEAR 

MODEL QUESTION PAPER 
PAPER-III   ACCOUNTANCY AND TALLY [THEORY] 

 
Time:- 3 Hrs Max. Marks:- 50 

SECTION-A      10 X 2=20 
 

Note:-  1. Answer ALL Questions: 

                     2. Each Question carries 2 Marks. 
01. Define Account. 

02. What is double entry system? 

03. Define journal. 

04. Define ledger? 

05. What is debit note? 

06. What is petty cash book? 

07. What is BRS? 

08. Define trial balance. 

 09.What is bad debts? 

         10.What are the  function keys in Tally package? 

 

SECTION-B 

 

Note:-   1. Answer any FIVE Questions from the following 5 x 6= 30. 

2. Each Question carries 6Marks. 

 

11. Describe the major concepts in Accounting. 

12. Write about types of accounts. 

13. Write about subsidiary books. 

14.  Enter the following transactions in Simple cash –book 

Vamshi traders. 2017 Oct1st– Balance of cash 9000 
3 Goods purchased 3000 

5 Sales 2500 

8 Interest paid 1000 

10 cash purchases 1500 

15 Cash Sales 2000 

19 Received cash from N 1800 

22 Paid cash to R 1100 

26 Purchases furniture 500 

29 Received commission 900 

31 Paid rent 1000 

15. What are the causes when the passbook balances is not tallied with cash book balances. 

16. what are the objectives of trial balance? Explain. 

17. Explain the following 

a) Drawings 

b) Liabilities 

c) Outstanding expenses  

18. Explain the procedure to create a company account in Tally. 
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